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FACULTAD DE INGENIER!IA U.N.A_.M.
DIVISION DE EDUCACION CONTINUA
A LOS ASISTENTES A LOS CURSOS

Las autoridades de la Facultad de Ingenieria, por conducto del jefe de la

Division de Educacién Continua, otorgan una constancia de asistencia a

quienes cumplan con los requisitos establecidos para cada curso.

El control de asistencia se llevara a cabo a través de la persona que le entregé
las notas. Las inasistencias seran computadas por las autoridades de la
Division, con el fin de entregarle constancia solamente a los alumnos que

tengan un minimo de 80% de asistencias.

Pedimos a los asistentes recoger su constancia el dia de la clausura. Estas se
retendran por el periodo: de un afio, pasado este tiempo la DECFl no se hara

responsable de este documento.

Se recomienda a los asistentes participar activamente con sus ideas '
experiencias, pues los cursos que ofrece la Division estan planeados para que
los profesores expongan una tesis, pero sobre todo, para que coordinen las

opiniones de todos los interesados, constituyendo verdaderos seminarios.

Es muy importante que todos los asisténtes llenen y entreguen su hoja de
inscripcién al inicio del curso, informacién que servira para integrar un

directorio de asistentes, que se entregara oportunamente.

Con el objeto de mejorar los servicios que la Divisién de Educacién Continua
ofrece, al final del curso "deberan entregar la evaluacién a través de un

cuestionario disefiado para emitir juicios andénimos.

Se recomienda llenar dicha evaluacién conforme los profesores impartan sus
clases, a efecto de no llenar en la liltima sesién las evaluaciones y con esto

sean mas fehacientes sus apreciaciones.

Atentamente
Divisiéon de Educacién Continua.

Patacio de Mineria Calle de Tacuba 5 Primer piso Deleg. Cuauhtémoc 06000 México, D.F. APDO, Pﬁslal M-2285
Telefonos: 5128955  5t2-5121  521-7335 621-1987 Fax  510-0573  521-4020 AL 26
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SOPORTE A MICROSOFT OFFICE PARA WINDOWS 95
Del 26 al 30 de mayo de 1997.
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1997.
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WINDOWS 95

1.- INTRODUCCION A MICROSOFT
OFFICE 95
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Soporte a Microsoft Office para Windows 95
para personal profesional de S.C.T.

Objetivo: El asistente conocera con detalle el manejo de Microsoft Office 85 para poder brindar un
adecuado soporte técnico a los usuarios finales.

. Introduccién a Microsoft Office 95

-h

* Lo nuevo en Microsoft Office

+ Requermientos de hardware

¢ Optimizacion de los recursos de la computadora para el uso de Microsoft Office 95
» Barra de acceso directo a Microsoft Office

¢ Uso conjunto de varias aplicaciones de Office

+ Personalizacion de Office

» Opciones de instatacion (desde el servidor, nodo de red o local)

2. Elaboracién de documentos en Word 95

. Creaéic’m EieT primer documento en Word

.« Creacion de membretes y sobres

¢ Creacidn de un boletin sencillo

» Creacitn de un prospecto

» Creacion de un .plan de negocios

» Insercion de imagenes y graficas en un documento

s Mejorar el aspecto de un documento en Word

3. Trabajo con hojas de calculo en Excel 95

» Creacion del primer ilbro de Microsoft Excel

» Mejorar el aspecto de una hoja de caiculo con Microsoft Excel
» Creacidn de un grafico con los datos de una hoja de calculo

» Agregar una grafica a un documento

» Personalizacién de una grafica

4. Elaboracién de presentaciones en Power Point 95

e Creacion de Ia primera presentacion de Power Point

» Preparar rapidamente una presentacton en Blanco y Negro

= Creacidn de documentos para los participantes y notas del orador
» Personalizacion de presentaciones

+ Transferencia de-informacién entre Power Point y otras aplicaciones



* Comunicar ideas mediante imagenes
« Preparar presentaciones electronicas

¢ Hacer una presentacion electronica

5. Manejo de bases de datos con Access

s Creaci6n de la primera base de datos de Microsoft Access

» Disefiar una base de datos de inventario personalizada

. Movér una lista de producto a Microsoft Access

s Agregar proveedores a una base de datos de inventario

» Introduccion sencilla de datos ‘

+ Mejorar el aspecto de un formulario de productos . ,
» Creacién y mejora de un informe de inventario

s Convertir una base de datos de inventario en una aplicacion

6. Intercambio de informacion a través de la red
« Compartir documentos electrénicamente

« Reviston en equipo de un documento en Word
« Compartir libros de Microsoft Excel

s (Creacion de un manual en pantalla

+ Trabajo en una base de datos compartida

7. Programacion de citas, tareas y reuniones
» Programacion de una cita
+» Mantenmiento de una lista de tareas pendientes

* Programacion de una reunion
Duracién: 30 hrs

Requisitos previos: Conocimientos generales de Windows 95 y versiones anteriores de Microsoft
Office .



Nuevas formas de
trabajar

por Patty Winter y Rick Winter

| hecho de combinar los productos de software para venderlos como un
10do no resulta nuevo, Los paquetes de software han existido desde hace

afos. No obstante. la novedad radica en la integracidn total de esos produc-
tos de software. La integracion ya no consiste en conmultar entre aplicacio-
nes. o en una aplicicion que trata sin éxito de realizar la tarea de cuatro apli-
cagignes a la vez.
En lo que se denomuna el paguete mtegrado. los principales vendedores de
softvarc ofrecen aplicaciones esenciales de oficiny tales como procesadores
de textes. hojas de cdlculo, bases de datos y grificos de presentacion. Los
productos esenciales conforman las aplicaciones estrella en sus respectivas
categorias. Los vendedores afiaden a este nucleo aplicaciones auxiliares.
tales como correo electrénico. creacton de graficos. gestion de inforrnacion
personal y organigramas, ofreciendo el paguete completo de productos por
un precio total que representa hasta el 50% menos gue el precio de compra
de te suma de cada uno de los productos, :
Microsoft Office 95 e sitdu a Ia cabeza en lo reterente a aplicaciones clave
que tuncionan en conjunio v que ofrecen un interfuz comun de usvanio. Las
apiicaciones se parecen entre si y funcionan de manera parecida, io cual
reduce la curva de aprendizaje v mejora la productividad. Office 95 facilita
a los usuanos ia tarea de comparur mformacion. documentos y graficos a lo
lurgo de Jas aplicaciones.
En este capitulo se estudia:

B Qué mcluve Otfice Y3

B Lus novedades de Oftice 95

#l Lo objetivos de disedo de Otfice 93

B Cdmo determinar la aplicacién a unhizar

Qué incluv+ Office 95

La edicidn estandar de Microsoft Office Y5 incluve kas siguientes aplicaciones:
B Microsott Word para Windows, versién 7.0
B Microsoft Excel. version 70
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M Microsoft PowerPoint, version 7.0

B Microsoft Schedule+, version 7.0

B Cuaderno de Microsoft Office

M Barra de acceso directo de Microsoft Office

La edicion profesional dé€ Office 95 afiade al paquete bdsico una potentc
base de dutos. Microsofi Access, version 7.0.

Las novedades de Office 95

Microsoft Schedule+ y Cuademno de Microsoft Office son dos nuevas apli-
caciones que vienen en el paquete de Office 95. Por afiadidura. se incluven
una serie de nuevas funcibnes a todos los productos, asi como en o que res-
pecta a la operatividad entre ellos.

Windows 95

Windows 95 no forma pante de Office 95. De hecho, antes de nada se nece-
. sita instalar Windows 95 para ejecutar Office 95. Sin embargo. existen-
Lonse;o R muchas funciones de Windows 95 que se integran bien con Office 95.
Par Duscar urrowe
nien en pantalia de
MUV IINCIONEs

; Pantalla

| La nueva barra de areas (véase fig. 1.1) le permite no sélo iniciar aphca-
chyja Ayudo, Temas de ciones. sino también abnr aplicaciones minimizadas con una simple pulsa-
fyuda de Microsoft, i c16n. El nuevo boton de cerrar (x), localizade en la esquina superior derecha
pulse en la ncha j de la ventana, facilita en grun medida las operaciones de cerrar documentos
Buscari v ecrina Lo ‘ v aplicaciones. Cuando mimmiza una aplicacion usando el botén de mni-
fuevn en e efprimer l mizar, rediseniado con un subrayvado, ésta aparecera mimmizada en un rec-
Luanie ae 1extg _tangulo situado en la barra de 1areas.
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’ Las novedages de Dffice 95 ! '

Nombres de archivo v propiedades

Windows 95 actualmente le permite utilizar nombres de archivo de hasta

2535 caracteres, incluyendo espacios. Esta funcién aumenta en gran medida

la flexibilidad, ia bisqueda v la comprension de lo que se ha guardado.

Windows 95 también ha anadido una série de propiedades de archivo. gue

Office 95 amplia. '

Ahora puede examinar rdpidamente estadisticas de su documento tales
como fecha de creacién, mimero de palabras y puardar mformacidn ded
autor v del documento en su archive. Ademnas, directamente disefiadas a
modo de cuadros de didlogo de archivos estdndar. se encuentran posibilida-
des mejoradas de bisqueda que le ayudan a encontrar su archivo en funcién

dei contenido, tiempo, u otras propiedades del mismo (véase fig. 1.2).

Fig. 1.2

Las nombres
de archivo
largos le
avudan a
recordar v
encontrar sus
documentos
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FA Ty
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%) ""ﬁ-‘ﬁi‘u’i vl e E Dime gorBaciier
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Microsoft Exchange v Microsoft Network

En la version 4 de Microsoft Office se incluia con ¢l producto una licencia
para utilizar Microsoft Mail El administrador tenia que establecer el pro-
grama para cada vsuario. En Windows 95, Microsoft Exchange se entrega
con ¢} producto. incluyendo Microsoft Mail ¥ Microsoft Fax. en conjuncién
con otro nuevo producto. Microsoft Network. Ud tendrd la oportunidad de
enviur su documento de Word, hosa de cdlculo de Excel, o presentacion de
PowerPoint a personas que se hallen tante dentro como fuera de su oficina.
Microsoft Mail también se ha combinado con Word para permitirle crear y
acceder a mensajes haciendo uso de todas las potentes herramientas que
ofrece Word (véase fig, 1.3).

Nuevos productos

Ademas de las nuevas funciones de Windows 95, podra encontrar progra-
mus nuevos en Office 95 Schedule+ e« una aplicacidn actual que ha sido
mejorada v anadida a Otfice 95, Cuadermo es una nueva funcion que le per-
mite combinar documentos desde aplicaciones diferentes.

Scheduie+
Microsott Schedule+ fvéase fig 1.4 ha sido afadida a Office 95. El ante-
ror producta se vendia por e pdmdn v comenzd su andadura en 1992,



12

Fig. 1.3
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La version para Office 95 incluye la primera versidn actualizada de
Schedule+1.0. Schedule+ le permite concertar citas, escribir listas de tareas
pendientes v establecer reuniones con sus colegas usando el nuevo Asistente
para reumones. Schedule+ contiene ahora una funcion que le ayuda a esia-
blecer v gestionar sus objetivos. Consulte el Asistente para los Siete Hibuios
de Personas Altamente Eficientes. basado en el famoso semunario v libro de
Steven Covey. Para mds informacion sobre c6mo trabajar con Scheduie+.
remitase ak capitulo 37, “Cémo uulizar Schedule+".
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Cuaderno de Microsoft

Litihce Cuademo de Microsoft para afiadir documentos de Word, Excel y
PowerPaint v crear un dnico documento para la impresién, edicion, aima-
cenamiento y distribucién. La fig. 1.5 muestra un documento cuademo que
contiene dos documentos de Word, una hoja de calculo de Excel y una pre-
sentacion de PowerPoint. La parte 1zquierda de a pantalla muestra ios docu-
mentos que integran el archivo cuaderno, Afiada, elimine y asigne nuevo
nombre a los documentos mediante el Mend Seccién. Abra, guarde, cree ¢
imprima documentos cuadermno mediante el Menii Archivo. Los otros memis
y barras de herramientas cambian en funcidn de los documentos fuente
{Word. Excel y PowerPoint). Para mds informacion sobre el Cuaderno, con-
sulie el capitulo 33, “Cémo utilizar el cuaderno™.

Fig. 1.5
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Mejoras en todos los productos de Office

En Otfice 95 existen mejoras, asi como nuevas funciones que le facilitardn
la conmurtacion entre aphcaviones La tabla siguiente incluye una hsta de las
principales modificaciones. nuevas tuncrones. asi como odo lo necesario
pura niciarse;

Funcion Iniciacién

Autocorreccion estd actuaimente Herramientas,

disponible en Word, Fuee! Autocorreccion o, ::ly
v PowerPoint v puede correpir taltas pulse sobre el botan =

de anovraita o medida que se escnben |Onoypraiial, pagina 86

(continga)
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Funcién Iniciacién

“La Avuda es aciualmente la'misma Ayuda, Temas o
para todas las aplicaciones de Office,  <F1>, pagina 140
Una nueva funcidn de Busqueda
le permite buscar un texta no sélo
desde fos titulos de las piginas de
ayuda (como lo hacia la busqueda
anterior), sino ademas a través del
archivo completo de ayuda o en
algunos casos a traves de multiples
archivos de ayuda.

Asistente para Ayuda ivéase fig. 1.5)  Ayuda, Asistente
es otra nueva funcion de la ayuda ' paro Ayuda,

que le permite escribir una solicitud pagina 144

tle avuda con sus propias pafabras.

El Asistente para scdeas observa Pulse sobre el botén
lo que hace en Wprd y Excel. [Asistente para ideas],
Cuando el Asistente de ideas tenga pagina 152

una sugerencia para facilitar una
tarea, su botén se iluminara.
Puise sobre el botdn para
obtener una nota rapida.

La barra de acceso directo de Programas, barra de
Microsort Omice véase fig, 1. 6) acceso directo de
le permite iniciar nuevos Barra Microsoft Office,

de tareas Imcio Windows archivos. pagina 31

Elna de una sene organizada de
tichas gue muestran los tipos
generates de documentaos, tales

como folletes, cartas, memorandos,
planes comerciales, certihcados,
intormes v 1arjetas de nempo La barra
de acceso directo de Office 1amibnén
IMCIErd una aplicacdn que cree un
documento No iene por qué recordar
la aphcacion que utihzo. La barra

de acceso directo a su verz le permite
concertar citas anacr tareas, agregar
contactos a Schedule~, e iniciar el
Aaistente para Avuda en

toxckas las aphcaciones

Li Libro Obtenua Resulftados Pulse sobre el boton
con Micrennst Office para jLibro Obtenga
Windenas 95 g, 1. 51 esta en el Resultados|

CD-ROM gue viene incluida con

¥ para Windows 95

23 Office. Al pulsar en ¢l
baoton de la barra de acceso directo
vtener ol COD-ROIM de Microsont Orice
on el lecior de CHD-ROM e podran
leer v huecar las instreccwnes deiailadas.,
astcomo Las esphicaCiones sobre tareas
Gue se necesitan ftesar g ¢aho

{continual
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Funcion

Iniciacton

Compatible con Office (fig. 1. 5)
tarnbién inicia informacién sobre el
CD-ROM. Esta caracteristica muesira
otros productos compatibies

con Microsort Qffice.

Puise sobre el boton
[Compatible con

_Ofﬁcel

Fig. 1. 6
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Mejoras en el software individual

Ademds de las mejoras generales realizadas en Office 95. cada uno de los

productos del paquete contiene mejoras.

Microsoft Word para Windows 95

La siguiente tubla muestra algunas de las mejoras de Microsoft Word v [a

torma de imciar ta funcion

Funcidon Iniciacion

Revision onogrdngg. una nueva Herromientas,
wncion, wentifica las-ialtas Opciones,

die ortograiia tan proma coma las Ortogratia. Revisar ko
palabras son escritas, a traves ortografia

de una linea roja ondulada v da automatcamente,

sugerencias puisando el boton
derecho del raton o mediante
<Shtt>+<Retrn; eso>

pagina 196

Autoiormato Megoradn aplica boraes,

ntules, encabezados, rracgiones
v iormato de hista g medida
que escribe.

Herromientas,
Opciones, ficha de
Autoformato
paginal4d)

{continta)
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Fig. 1.7

ta Libreta de
direcciones le
adminstea
nombres v
threCeiones =

Funcion Iniciacion

La Libreta de Direcciones Puise sobre el boton
{véase fig. 1. 7} gestiana sus contactos  [Libreta de

para sobres, etiquetas, combina Direcciones], pagina
correspondencia v puede conectar 925,

con su informacion de
contacto de Scheduie+.

Destacar acentua las partes Pulse sobre el boton
imponantes del documento . [Destacar],
con un fondo de color. pagina 183.

Jene: Femarf,
1
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Microsoft Excel para Windows 95
La siguiente tably muestra algunas de las mejoras de Microsoft Excel v la
forma de niciur la funcion.

Funcion Iniciacion

Dara Magy ivease ng 1 8) representard  Pulse sobre el [Map) O '
sus datos geograncamente pagina 499.

Asitente para Planultas con Datos, Asistente para
seemento de Datos e pesmitira Plantilia, pigina 423.

comeernr sus hoyas de calculo
ac tuales en nguras v capturar o
escnte en una base de datos, separada.

leantinua)
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Funcion : Iniciacion

Autocompletar v Lista de Entradas . pagina 285.
Previas le permitiran completar una
entrada aulomadticamente. Ud. podrd - - .
crear una entrada en funcion de las ' .
entradas previas segun escribe
las primeras letras dentro de la celda
También puede puisar con el botén .
derecho del raton en Elegir de la Lista, '
"y escoger de una [ista de
entradas previas.

Informacidn sobre celdas aparecera. Insertar, Notas,

cuando se detenga con el raton pagina 458.

sobre la celda con una nota

Filtro Automatico con los 10 mds Datq, Filtro, Filtro

le permite ver los items superiores Auvtomahco v a conti-

‘o inferniores de la lista. nuacion los 10 mas,
pagina 428.

AutéiChlcular calcula avtomaticamente Véase barra de esta-

sus datos resaltados seleccionando do, pagina 282.

un rango v visualizando en la barra
de estado la suma, el promedio la
cuenta con el boton derecho del raton,

Los ajustes de Proteger se han Herrammentas,
mejorado con vistas a una Proteger, pagina 453.
protecaion mas completa v

flexible del trabajo del usuario.

© Mpresfl Eacei Poblaoen Fig. 1.8
- Ahora padra
hacer mapas

geoprancos de

: s = ! su mformacion
: R R T I S < e o o
GEONOMORE Ptﬁf_%: S : e con Data Map
GALICIA 2789641
ASTURIAS 1116587
CANTABRIA 52609
PAIS VASCO 1297451
NAVAARA sy I
RIGJIA 260072
ARAGON 1204949 ]
MADRID 4918012 Bien Atapa
CASTILLA LEON 261609
$1]CASTILLA LA MANCHA 6
EXTREMADURA 1131893
CATALUNYA BUZ0450




) 18

——

|

Nuevas formas de hizbajar

Fig. 1.9

Unlice Noltas de
la Reuvruon para
ewr b sus
elementos de
decion e tormg
UL esbes Ggpa-
restanen Lo
uhima diapo-
ailiv

‘Microsoft PowerPoint para Windows 95

La siguiente tabla muestra algunas de las mejoras de Microsoft PowerPoint

y la forma de iniciar la funcidn:

Funcion

Iniciacion

AutoChpArt le sugiere imagenes
apropiadas para su mensaje.

Herramientas,

. AutoClipArt, pagina 515.

Asistente para Presentaciones
Portatiles le permite guardar su
presentacion en un disco para su
visualizacion en otros ordenadores.

Archivo, Presentaciones
portatiles, pagina 657.

Asisfente para Autocontemdo cambia pagina 578

su mensaje en funcion del tamano

v tipo de audiencia y el tiempo de que

disponga para su presentacién.

Animacion de Titulos le permite Ver, Barras de

crear efectos especiales Herramientas Efectos de
para titulos de Ammacion. Animadion o Eectos de

Herramientas, pdgina
657.

Presentacion en red le permite

& un grupo de trabajo repasar
simultaneamente una

presentacion en la red mientras
verificd sus notas, Liming v siguiente
dia positiva.

Herramientas,
Presentacion Remota,
pagina 870.

Natas de fa reunton (véase fig. 1.9) le permite
1omar v guardar notas durante su
presentacion -o exporarlas a Word

para crear actas, Tamhén puede grabar
elementos de accion y mostrarlos

al final de su presentacion.

Herramientas. Notas de
a Reunion, pagina 650
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Jbjetivos de disedn 42 Micraseft Office

Objetivos de disefio de Microsoft Office

El objetive de Micrasoft Office es el de proporcionar a los usuarios lo
stguiente:

B Un interfaz comiin de usuanio-(eperaciones estandanzadas de los mends,

barras de herramientas v cuadros de didlogo)

i Acceso rdpido de una aplicacién a otra dentro del paguete de oficina

B [nformacion compartida a través de las aplicaciones

B Recursos comparnidos u través de las aplicaciones

B informacion comparuda a través de grupos de trabajo

B En el futuro, un jenguaje automatizado de tareas comunes

Microsoft se estd esforzando en cumplir los citados objetivos. Muchas de las
uplicaciones principales se han sometido (v conttndan somenéndose) a revi-
siones con el objeto de alcanzar estos objetivos. Para aquellos imiciados en
los productos principales. el menii actual o los cambios en las barras de
herrarnientas pudieran resultar enojosos. A largo plazo, no obstante, un
interfaz comin de usuano a través de las aplicaciones aumenta el uso efi-

_ciente v real de todas ellas.

Como proporcionar un interfaz comin de usuario

Barra de menus v barras de herramientas de Ao

Una de fas ventajas claras del interfaz comun de usuario a través de las apli-
caciones consiste en que. conociendo una aphcacién del paquete, se cono-

cen los fundamentos operativos del resto de las aplicaciones. La fig. 1. 10 » VEASE *Como utili

19

p VEASE “Avuda en
pantalla”, pagina 1335

tlustra la similitud enire las barras de menls v las barras de herramientas de 557 105 acistentes”,

Excel y de Word Ohserve que Word contiene una opcién de mend Tabla. pagina 134

mientras que Excel contiene una opcidn de mend Dates. Aunque el objeti-

vo sea gl de proporcionar un interfaz comian de usuario. permanecerd en b VEASE “Ver suge-
rencias”, pagma 131

Ventana de documento de \Word
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Fig. 1. 1

i.a harra de
accesn directo
de MICTosolt
Onice tagthig el
A0CES0 2

abnr v crear
documentos v
lunciones del
Artmunsiracdor
e Omece

cada aplicacion un cierto grado de singularidad. No obstante. funciones
comunes principales tales como los comandos Archivo. Abrir. Edicion v
Buscar, se encuentran exactamente en el mismo jugar en cada aplicacion.
Las aplicaciones de Microsoft Office son comsistentes no sélo en lo que s
refiere a barras de herramientas ¥ meniis similares. Los ¢uadros de diidlogo.
tunciones que se pueden personalizar y funciones operativas son tambicn
similares. En las aplicaciones de Office 95, Ia avuda en pantalla estd dispo-
nible de diterentes formas: )

B Aplicacion Avuda

M Asistenies para Avuda

B El uso de Asistentes

B Asistentes para ideas y Sugerencia del Dia

Acceso rapido a otras aplicaciones

Microsoft Office ofrece la barra de acceso directo de Microsoft Office. Por
defecto. esta barra de herramientas aparece en la esquina superior derecha
del escritorio de Windows 95 (véase fig. 1. 11). Puede utilizar la bamy de
acceso directo para io sigwmente:

B Iniciar archivos nuevos basados en plantiltas v asistentes,

M Abrir archivos existentes e iniciar automaticamente la aplicacion corres-
pondiente.

B Agregar tareas, coOncertar cilas v agregar contactos.

B Usar funciones de Office tales como configuracion v Asistentes para
Ayuda.

B Agregar otras aplicaciones a la barra de acceso directo de Office.
M Conmuuar entre aplicaciones de Microsoft Office.
B Iniciar aplicaciones de Microsoft Office.

14
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La barra de acceso directo es tan sélo una de las formas en que Microsot1
Office proporciona xcceso rapido a las aplicactones. En cada aplicacion de
Microsoft Office, la bara de herramientas de la aplicacion ofrece acceso
directo a las funciones correspondientes de otras aplicaciones. Por ejemplo.
en Word podrd insenar una Hoja de Célculo de Excel en un documento sim-
plemente pulsando en un botén de ia barra de herramientas. Esta operacion
inicia Excel v ofrece 14 totalidad de sus funciones para esa hoja de-célculo
incrustada (véase fig. 1.12). Observe que sin necesidad de salirse de Word.
los mends y las barras de herramientas cambian a los de Excel cuando se
edita ia hoja de célculo.

Barra de titulo de Word Nombyre del documento de Word

Fig. 1.12

La conex:on
entre aphicaco-
nes {e permite

insertar una hoja

by oy - e calculo de
| b i;! He aqw un spemplo del conts da U producto X erun sus Yentas ; un efio ::-! Escel en un
garéa i (;l ;\AcnuA i : documente de
e Excel, harras —p— 04 : . —— e Word v editar la
de herramientas « ] B e I I T T g e ol Y e Y Ry ey h o Ctic b
nara de rormolas Y] o Ty ¢ T 41 Teer P 014 e Cdlouin
L, N BE usanedo menas v .
sy (F. 1187 am e E bdrm,s rie
2114887 [T T L TE2 5 213148 i | herramentas de
Hiw g ni I ) .
5101 (1Y (3 ran mn ) E\(‘('f N
N e o o |, o no(exuind e
hoo 10000 o] = salirse e \Word.
R bt e it B 4 o
Ventana de Wonl — o

Ventana de del docur

=y R |
B A e i
* wfiie Bty

Ventana de del documento de Excel

Como compartir datos entre aplicaciones

Los productos de Microsoft Office ofrecen vanos métodos de compartir datos
entre aplicaciones

Método Descripcion

Copar Copia laintormacion desde la aplicacion fuente a la
aplicacién érmino a través del Portapapeles

,

Vincular Vincula una copia de jos datos del documento fuente
on el documento termino Ly guarda los datas con el
documento fuenie)

In¢rustar Incrusta datos del documento iuente en el documento
termino {guarda datos con el documento 1érmino).

Law apheaciones de Microsoft Office comparten informacion con facihdad.
Cuando copra una tabla de Excel @ Word, por ejemplo. aparecerd una tabla
de Word gue retendrid todas las fuentes y formatos de Excel. No necesitarid

n
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P VEASE “Como con-
mutar entre docu-
mentos”, pagma 131

,

» VEASE “Cémo
copiar informacion de
una hoja de calcelo”,
pagina 675

» VEASE “Como ulifi-
7ar procedimientos
comunes para vincu-
far documentos”,
pigina 689

» VEASE “Como utili-
zar clipart galierv de
Microsoft”, pagina
313

Fig. 1.13
Microson Graph,
una e fas
aphicaciones
auxtflares que
vonecla con
Aicrosont O e,
~euhlza para
thhujar uraicos
entodas fas
aphicae iones

dar un nuevo formato a su tabla. cosa que sin embargo podria ocurmir con
otros productos. )

La accién de vincular e incrustar funciones se beneficia de las especifica-
ciones OLE de Microsoft Windows. Los documentos vinculados se uctuali-
zan automiucamente al modificar un documento fuente. Los documentos
incrustados dan acceso a la aplicacion fuente mientras se almacene la infor-
macidn en la aplicacién término. Cada funcidn tiene sus pros y sus contras
y sirve para un proposito especifico.

Microsoft Office amplia la informacién compartida mds alld de la integra-
cidn entre aplicaciones. ofreciendo integracidn entre grupos de trabajo con
Microsoft Exchange. Los usuarios pueden enviar documentos. hojas de cil-
culo v archivos de informacidn desde dentro de la aplicacion fuente. Las cir-
culares pueden unirse a archivos que Exchange a continuacion enviard al
grupo o bien las dingiré a cada persona, secuencialmente. de una en unu.

Coémo compartir recursos entre aplicaciones

En Microsott Office. un elemente clave es que reconoce gue ciertos recur-
508 SON necesanos para mas de una aplicacién. Clip art es necesario para He-
var a cabo. por ejemplo. diferentes tareas: de procesammento de textos. de
hujas de cilculo y de presentacidn de graficos. Microsoft Office no sdlo
duplica estruciura de programa, sino que ademds proporciona una aplica-
cidn auxiliar comun a todas las aplicaciones: Microsoft ClipArt Galtery Es
igualmente necesane hacer comdn a todas las aplicaciones un sistema de
preguntas (gque formule preguntas sobre sus datos), una herramienta para
grificos (véase fig. 1. 13) v una herramienta de dibujo para organigramas.
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—

Cémo ofrecer un lenguaje comiin

El ofrecer un lenguaje comin entre aplicaciones constituye ¢l objetivo mds
ambicioso de Microsoft Office. Anteriormente, cada producto estaba pro-

gramado de una manera diferente y/o tenia un lenguaje de macros ‘distinto.
La version 5.0 de Excel es el primer producto del paguete de Microsoft
Office que ofrece un lenguaje cormmin para todos los productos de Office:
Visual Basic, para Aplicaciones (VBA). VBA utiliza OLE y es capaz de

* p VEASE
“Comprendtendo
Visual Basic para apli-
caciones”, pagina 767

enviar puisaciones a otras aplicaciones (posibilitando que VBA ejecute un
proceso compartido entre aplicaciones.

Hasta que VBA se anada al resto de los productos del paguete, los usuarios
tendrin que aprender WordBasic y VBA para automatizar sus tareas cormnu-

nes de oficina.

Cémo determinar la aplicacion
que se va a utilizar

Ea siguiente tabla presenta algunas de las tareas comunes de oficina v herra-
mientas sugeridas para fa aplicacién. a fin de llevar a cabo cada tarea:

Tarea Aplicacion Comentario

Crear cartas, Word Use Word para proyectos B COHSE]O
m;jmorandos, niormes ex{ensos. i Utdice el buatdin Inicto,
;

v documentos periédicos de Ja barra De Accese
Crear presupuestos, Excel Use Excel para proyecios directo v def2 oue
lacturas, seguimiento que contengan muchas | Gitce decida que
de declaraciones, Cifras v que entrafen | aphcatton fe convie-
de la renta, estadisticas. muchos calculos s e mds enibizar
Crear diapositivas. PowerPoint Use PowerPoint para

esquemas, presentaciones

presentaciones cuando
desec crear diapositivas
de 35 mm, transparen-
cias, folletos y presenta-
ciones por ordenador.

mMantener bistas

Word, Excel

Mantenga la informacion

de correspondencia. v Schedule+ en Word, Excel o
Schedule+.

Crear envios de Word . Fusione la informacion

correpn ¢ documentos sobre [a hista de corres-

personalizados. pondencia en Word para
impnmir portadas, folletos
y etiquetas.

Crear una tabla con Excel Cree una tabla en Excel

mformacion financiera PowerPoint Incruste una tabla en una

para usarla en
una presentacton.

chapositiva de
PowerPoint,

lcontinua)l .
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Tan — .
Tatrodeacis al2red Aplicacidn Comentario
£nviar un documento Word, Cree un documento, hoja
a un grupo - - Excel de célculo, o presenta-
para recibir respuesta. Exchange cion en la aphcacion
deseada.

Envie el archivo usando
la funcién de direcciona-
miento de Exchange.

Ofrecer seguimienta Excel Cree los planes de apoyo
de auditoria entre los Word que necesita Excel

datos de hoja de calculo

v documento de Cree el documento del

informe anual. informe anual en Word.

Use OLE para vincular
los datos de Excel al docu-
mente de Word  Siempre
que se modifiquen ios
datos de la hoja de calcu-
lo, el documento del
informe anua! se actuali-
zard automaticamente.

Crear. impnimie, v Word Cree un boletin de noti-

distnbuir un boletin Exchange cias en Ward. Distribuya

de noticias de . un boletin de noticias

departamento : electronicamente usando
la funcion Enviar de
Exchange.

Teniendo cuatro o cinco aplicaciones de software nuevas tan esmrechamente
integradas. la tarea de decidir qué producto utilizar para cada tarea se hace
dificil. Experimentar con cada aplicacidn es la mejor manera de saber com-
binar las capacidades de cada una de ellas.

Este libro trata de ayudarle en esta tarea. Los siguientes capituios de la Parte
I repasan las caracterisucas comunes de todas las aplicacsones del paguete
de Microsoft y sefialan algunos detalles.

Las Partes 11, 11} v V e guiardn a traves de las funciones vy capacidades de
cada producto. La Parnte I'V le ensefturd a utibizar objetos de multimedia tades
como grificos, imdgenes. somdo v peliculas. La Parte VI ilustra como los
productos de Microsoft Office se complementan. simulando situaciones de
trabajo. La Pante VII le ensenard a personalizar Microsoft Office con sus
propuas barras de herramientas, menis y automatizaciéon (macros v VBADL
La Parte VI le mostrard como utihzar Microsoft Office en un Grupo. La
Parte 1X ha side escritz por cinco expertos en su campo cuyo objetivo es
presentarle potentes écmcas de usuano.

Tome asiento v disfrute con la nuesa forma de rabajar de Microsoft Office.
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Fig. 3.20
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error det texto

Como revisar la ortografia

Microsoft ofrece el comando Ortografia en Word, Excel y PowerPoint, Por
lo general. se suele revisar ta ortografia en un documentio de procesador de
texto, pero ahora es posible revisarta en documentos como hojas de cilculo
vy presentaciones. Los comandos Herramientas v Ortografia buscan palabras
que no estdn en el diccionario. Ademas. el comando Ortografia avisa sobre
cualquier problema de puntuacion y mavisculas, asi como de repeticion de
palabras. Podrd elegir reemplazar la ortografia o ignorar ¢l problema. ¢
incluso podrd agregar la palabra al diccionario para un uso posterior.

Como usar el comando Ortografia

El comando Ortogratia lee el texto y avisa cuando encuentra una palabra
que no estd en ei diccionario principal o en el diccionario personalizado El
cuadro de didlogo Ortografia muestra la palabra en cuestién. sugrere una
palabra de reemplazo v despliega una lista de palabras similares en onogri-
fia que pueden servir de reemplazo.

Existen varias opciones a la hora de resolver un problema de ontografia. Ud.
puede reemplazar Iy palabra, ignorarla, agregarlu al diccaionano. ewc. Este
apartado descnbe estas opciones.

Puara usar el comando Orfografia en Word. Excel o PowerPoint, eliju
Herramientas. Ortografia. El cuadro de didlogo Onogratia apareceri cn
pantatia (véase la fig. 3.200.
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Lu 1ably 3.4 desenibe cada una de las opaiones del cuadro de didlogo
Ortogrutia, ¥ que opeiones existen en cada una de ias aplicaciones,

16
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- Camo revisar 13 ortografia

AP S
sg,. e w“‘.-;\

P -

\J“-'ES;“

PRy
, s~

Descnpcuon

No en diccionario

b

x '

X

Muestra la patabra en
cuestion.

Reemplazar A

Sugiere una onografia
alternativa; es posible
introducir 2 nueva orto-
grafia en este cuadro de
texto.

Eliminar

St el cuadro de texto
reemplazar A esta vacio,
el botdn |Reemplazar|
se convierte en Eliminar,
que borra la palabra.

Eliminar Todo

Si el cuadro de texto
Reemplazar A estd
vacio, of boton |[Reem-
plazar Todo] se convier-
te en Elimemar Todo, que
horea todas las apancio-
nes de la palabra en el
documento.

Consejos

Eha una palabra de la
Iista Consejos para
reemplazar una palabra
mal cleletreada

lpnorar

Se salta la aparicion de
[a palabra.

Reanudar/imaiar

Ef botan [lgnorar] cam-

bia a Reanudar o iniciar -

cuando se pulsa fuers
del cuarlro de dialogo
Onografia para editar el
documenio Ei cuadro
de dialoge: se mantiene
en pantalia. Ehja
IReanudar] o [lmiciari
para volver a empezar
la revisin onogranca.

tgnonar Tado

Se salta 1odas lay apan-
ciones de a palabra en
¢l documento

Reemplaza

Sustituve la palabra mal
deietreada por la pala-

bra sctecconada intrer-

ducida

Conseio

i Tamben puede miciar

i
:

i el correcton ortogran-
0 pulsaraa en of
haten [Onovranal de
Ia parra de berramien-
12y eslancar o pulsan-
N
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Descripcion

Reemplazar Todo

X

Sustituve todas las apar-
ciones de la patabra
deletreada en el docu-
menta por fa palabra
seleccionada o introdu-
cicta,

Agregar

Actualiza el diccionano
por medio de fa inclu-
sion de una palabra que
se tectea a menudo. La
palabra anadida debx
aparecer en el cuaddro
de texto de No se
encuentra en
Diccionario

Consejns

Si la opaion {Sugernir
Stempre! del cuadro de
chialogo de Opciones
esta desactivada elija
|Sugerir] para ver la lista
de Consejos de correc-
c16n de la palabra mal
deletreada.

Agrepar Palabras A

A

Si ha instalado mas de

un dicctonario, seleccio-
ne el diccionano al que
quiere agregar la palabra

en la lista desplegable:.

ALtocorreccion

Agrega palabras mal
deletreadas irecuente-
moente a la hsta Auto-
correccion, Para mas
informacidn, ver mas
adelante en este capitu-
to ol apanado "Deje a
Autocorreccion Corregr
su Ortografia”.

(paiones

Permite elegir parame-
tros predeterminados o
personalizar el Corrector
de Onografia.

Desbacer

Elija |Deshacer| cuando
cambie de parecer sobre
el altimo cambio de
ortografia
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O Jabl R S
Opcién , w E P Descripcion
Cerrar v Cancelar X X X - Cancelar da por termi-
. nada la revision ortogra-

fica y cancela los cam-
bios. Cerrar du por
terminada la revision
orteprafica y puarda los
cambios. El boton
[Cancelar] cambia a
Cerrar después de hacer
un cambin en el docu-

mento.
Avuda on la es- X X X Elija este boton para una
quina superior derecha avuda detatlada de tas
dei cuadro de dialogo opciones del cuadro de

didlogo Ortografia.

Edicion de un documento sin abandonar la correccion
ortografica
Si considera necesario editar el documento despues de haber iniciado ia
correccion ortogrifica. siga los siguientes pasos:
I. Pulse sobre el documento pare activar fa ventana del documento.
El botdn [Ignorar] en el cuadro de dilogo Ortografia reemplazard a Re-
anudar en Word y a Imciar ¢n PowerPoint.

2. Haga lo~ cambios necesanos en ¢l documento.

3. Pulse sobre el botdn [Reanudar] o [lmicia)r para continuar con ¢l proce-
so de revision de la ortogratia.

Uso de los diccionarios

1
Cuando se hace uso del comando Orografia, las tees aplicaciones buscan
por detecto en un diccionano denomenado PERSONAL.DIC. Sin embargo,
podrd crear sus diccionanios personalizados.

Como agregar palabras a un diccionario

El diccionane PERSONAL.DIC, as como cualquier otro diccionario gue
creia. se almacena en el carpeta de Archivos del Programa/Archivos
Comunes/Campeta Prueba o en ¢l carpeta WINDOWSWMSAPPS\PROOF de
su disco duro Siopuisa en el botdn [Agregar] del cuadro de dialogo
Ortogratia. cualywer palabra nuesa que se afada pasard automdticamente o
formar parte del archiva PERSONALDIC Si se agrega una palabra en
Excel o Word, los dos programas reconocerin la palabria afadida
PowerPoint, por el contruno, no reconoceri Ya palabra adadida hasta que cie-
re Word o Excel v PowerPoint, s abra PowerPomi de nuevao,

Como crear diccionarios adicionales
St exste un {évico especifico asoviado con su trubajo, quizds sei conve-
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Fig. 3.21

Il comando
wnograng de
Facel le permite
CI0ar NUeVS
che cionaros a
los que Ward
puetie s ceder

niente crear un diccionario aparte. En este caso, es posible comparur el dic-

" cionario con colaboradores.

Cuando estd en Word podrd crear ¢l nuevo archivo diccionano mientras usa
la Ortografia. Si ¢l comundo Onografia se dettene en una palabra deletrea-
du correctamente. v ha decidido incluirla ¢n el nuevo diccionano personali-
zado, siga los siguientes pasos:

. Pulse sobre el botdn de comando Opciones.

. Pulse sobre el botén comando Diccionarios Personalizados.

[ ]

3. Pulse sobre el botén de comando Nueve.
4. Escniba ¢l nombre del nueve diccionario v elija el boton de comando
Guaordar.
. Pulse sobre Aceptar dos veces para volver al cuadro de didlogo
Ortogrofia.
6. Seleccione el nuevo diccionanio en la lista de Agregar Palabras A
7. Pulse sobre el botén de comando Agregar para afadir la palabra al
nuevo diccionano. _
En Excel también podri crear ¢ nuevo archivo de dicoionario mientras usa
Ontografia. Antes de agregar mnguna palabra, cambie el nombre def archi-
vo en el cuadro de texto de Agregar Palabras A del cuadro de didlogo
Ornografia. Si el archivo de diccionario no eaiste, se le pedird que lo cree.
Eliju [Si] para crear el nuevo diccionario (véase la fig. 3.21).

tn
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Cuundo w vusa ¢l comando Onografia, tante Word como Excel revisan todos
los diccionanios dispanihles Lino puede estar comprobando la onografia de
un documento Word o Excel v encontrarse con una palabra que necesita
agregar a uno de los dicconarios personalizadas. Para seleccionar un dic-
cionario personalizado, pulse con li flecha en la lista de Agregar Palabras
A v después sobre el'diccionario gue guera utifizar,

Cémo activar y desactivar diccionarios

A veces es necesano utiltzar un diccionane creado para un léxico especifi-
code una compania o industria Sjse encuentra en Word y el diccionario que
gurere uttizar no esta en la lista, siga los sigutentes pasos:

1. Pulse sobre ¢l botén Opciones en el cuadro de duilogo Ortografia.

2. Pulse wobre ¢l hoidn Diccionanios personalizados del cuadro de didlogo
Opciones.
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3. Seleccione €l nombre del archivo de diccionario en Jla hsta de
Diccionarios personalizados. (Una marca de verificacion significa que
el diccionario estd activado.) ‘

4. Seleccione Aceptar en ¢l cuadro de didlogo Diccionarios personaliza-
dos. <

5. Seleccione Aceptar en el cuadro de didlogo Opciones.

6. Pulse con la flecha en el cuadro de la lista Agregar Palabras A v selec-
cione de Ta Hsta el diccionario que desea utilizar,

Deje a Autocorreccion corregir su
ortografia

Al usar Autocorreceion. puede ordenar a Word, Excel o PowerPoint gue
carrma los errores de ortografia segin se cometen. Si, por ejemplo. tecleu
con frecuencia dle en vez de del.  Autocorreccion puede subsanar el error
inmediatamente después de que €ste se produzca.

La funcién Autocorreccién corrige errores ortograficos y de formato auto-
mimeamenic. o reemplaza caracteres tecleados por palabras o frases especi-
ficas. Ei uso de esta funcion le ahorrard uempo. Imagine que tiene que teche-
ar Rechuyo de la Violencia Orgamizada, S. AL de forma constante: mejor yue
escribirio wodo cada vee, se puede agregar la abreviatura Rdlve a la lisia de
Autocomeceion v dejar que Word. Excel o PowerPomt hagan el trabajo de
escribirlo entero. Ex posibte mtroducir errores comunes o abreviaturas de
este LIpo en Autocorreccion. de modo que la proxima vez gque se cometa el
error o se escriba la abreviatura Word. Excel o PowerPoint los cormyan aute-
maticumente.

Atencion

St PowerPomt no admite sus nuevas entradas Autocorreccron,
salza de PowerPomnt y Word o Excel, v abra PowerPoint de
nuevo

Como agregar palabras mientras se corrige la
ortografia

Para agregar palabras o Autocorreccion mientras comge la ortografia en
Word o Excel. asegurese de que la palabra incorrecta estd en el cuadro de
No en Diccionario v la correcta en ¢l cuadro de Reemplazar A. Entonces
chifa ¢! boton Autocorreccion mejor que el de Reemplazar o Reemplozar
Todo en ¢l cuadro de didlogo Onografia,

Agregar palabras desde el meni de Herramientas

Para fijur opciones v construir entradas para Autocorreccion, elija el coman-
do Herramientas. Autocorreccion. La figur 3.22 muesira ef cuadro de did-
logo Autocorreccidn con una nueva entrada para Word v Excel.
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El cuadro de didlogo Autocorreccion en Word ofrece cinco opetones. inclu-
da Ta de conversion de comillas y de carreccién de problemas de mayiscu-
las. Puede elegir entre mantener estas opciones activas o inactivas, Ef cuadio
de dialogo de Excelno ofrece las opeiones de Comillas o Frase. Los cuadios
de texto Reemplazer y Con le permrten introducir sus propios elementos. \
la hstz de la parte infertor del cuadro de didlogo Aulocorreccion ensefia Jas
listas por defecto de Word v Excel ademds de los elementos afadidos por
Ud.. Es posible anadir y elirminar elementos en cualquier monento,

Para utilizar la funcion Autocorreccion, siga los siguientes pasos:

1. Elila Herrgmientas, Autocorreccion. Ap.iruerd ¢l cuadro de didloge
Autocorreccion.

2. Seleccione las opeiones gue quiera wtilizar,
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Tenun muchas palabras que contienen nameros, como meidas en nn docu-
menta  quiere que Word mnore ostas palabras,

Selecoione Herramientas, Opciones v seleccione la ficha Onegrafia En la zona
ienordr eloa Palabras con Numeros Flia fAceptar] para cerrar el cuadro de ehi-
ionan,

¢ Jnero ediar afdunas palaheas en un diccionano personalizado

seleccione Herramientas, Opeiones v cofec cione la ficha Orografia. En la zona
Diccionarios Personalizados, wleccione el dictionano que quiere modficar y,
dispues puise sebre el boton [Fditar]

i
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3. Si introduce elementos en los cuadros de texto Reemplazor y Con,
pulse sobre {Agregar] para afiadirlos a la lista. Para eliminar una entra-
da de la lista. seleccione el item en el cuadro de lista. v pulse .snhr? \"\
iEliminar].
&—kg%ffc te,

4. Elija IAceﬁtar] para cerrar ¢l cuadro de didlogo.

NIRRT

Cémo buscar y reemplazar un texto -

Microsoft proporciona la posibilidad de buscar y reempiazar (opcionalmen-
te) un texto especifico de sus documentos, hojas de cdiculo o presentacio-
nes. Por ejemplo. es posible buscar todas las apariciones del valor 1995, v
reemplazarlo por 1996.

Cémo usar el comando Buscar

Se puede Buscar en un documento entero, en un libro de trabajo o presenta-
cién. o inicamentc en una drea seleccionada. Para buscar en un documento
o presentacion enteros, desplace el punto de insercion a la pane superior.
Para buscar en un libro de trabajo completo, seleccione una celda simple.
Para buscar en una area o rango especificos. seleccione el drea o rango en el
que guiera buscar, A continuacion. siga los siguientes pasos:

1. Elija Edicién. Buscar: o pulse <Control> + <F>. El cuadro de didlogo
Buscar aparecera (véase ta fig. 3.23).

2. En el cuadro de teato Busear. introduzca los datos que quiera buscar.
Después, especifique tas opciones de busqueda descritas en la tabta 3.5

3. Pulse sobre |Buscar Siguiente] para empezar la bisqueda. Cuando la
aplicacion locahza tos caracteres, pulse sobre |Buscar Sigumente] para bus-
car la sigwente apancion. o en |[reemplazar] para acceder al cuadro de dia-
logo Reemplazar (esta opcion s¢ exphica en el siguiente apartado).

4. Elija |Cerrar| para finalizar la bisqueda v cerrar el cuadro de didlogo,

Fig. 3.23

H comandoe
Buscar Ir-
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tento espeLiiico
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Cémo usar el comando Reemplazar

El comando Reemplazar i<Control>+<H>) es simular al comando Buscar

porgue le permuie localizar caracieres especificos en su documento (Excel,

Word o PowerPoint), Después. ¢l comando Reemplazar le permite reempla- :
zar los caracteres con nuevos datos.

ra
Wl



Capitulo 4 - . .

Administracién de archivos
y areas de trabajo
por Rick Winter y Patty Winter

l l no de los cambios mis Hamativos de Microsoft Office para Windows
93 se encuentra en lo referente a la admimstracion de archivos.

Particularmente a ia hora de guardar, abrir v buscar archivos. Al trabajar con
archivos. encontrari mis flexibilidad, mis funcitones v mas opciones. Como
ocurre ¢on cualguier cosa nuevi. estos cambios pueden ser abrumadores al
principio. Sin embargo. st emplea tempo en aprender estas tunciones de
admiistracion de archivos., se verd recompensadoe con mejoras importantes.
Las mejoras en la gestion de archivos incluyen nombres de archivos expan-
dido~, muchos cambios en los cuadros de didilogo de los archivos v Ja expan-
s1gn del Resumen de Informacidn a las propiedades del archivo. Los cuadros
de didlogo Guardar v Abrir ahora ienen sus propias barras de herramientas
gue proporcionan visualizaciones v ofras opciones. En vez de la antigua
opcion Archivo Buscar de la versién antenor de Microsoft Office. fas {un-
ciones de budsqueda cstin incluidas dircctamente dentro de los cuadros de
didlogo de los archivos
En esic capitulo aprendera a:

& Abnir, guardur v cerrar documentos

B Scicccionar una localizacién en la que guardar su archivo

B Encontrar un archivo por su nombre. contenido o propredades

W Adpuntar nformacion Wdentificauva a un archivo v visualezar otras pro-
picdades def archivo

B Imprimir docunmientos

B Conmutar o diterenies documentos

Como trabajar con archivos

Para la mavoer purte de las aplicaciones. ¢l trabajo que se hace en pantally
estd anicamente on la memorta del ordenador. Sihay un corte de corriente o
ocurte cualguier otro aceidente, puede perder todo el trubajo o parte de €l
El procéso de guardar un archivo copia la informacion en memona a1 un
archve en un disco blundo. Se puede guardar el archivo mitnualmente o
configurar el progruma para gue gcuarde ¢l archivo aulomdncamente.
Cuando se crerry un archivo, se elimina ki informacion de la memoria del

;
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ordenador o de 11 pantalla. El programa sugrere guardar la informacion si ha
hecho cambios desde la dltima operacion de guardar, s1 adn no se ha guar-
dado el archivo. Abnr un archivo supone copiar la informacion desde un
disco a la memoria, Cuando se crea un archivo nuevo, se abre una ventana
de documento nueva.”

Como usar cuadros de didlogo de archivo

Ademids de utilizar las carpetas del Explorador de Windows v del Escritono.
es posible manejar los archivos por medio de los programas de Microsoft
Office. Cuando abre. guarda o inserta un archivo. aparece un cuadro de did-
logo de archivo estindar. La tabla 4.1 muestra comandos gue ensefian un
cuadro de drdlogo de archivo. Muchas de Tas funciones del cuadro de didio-
2o de archivo son guales tanto s usa Word. Excel o PowerPoint, como i
estd abriendo. guardandoe o insertando. La tabla 4.1 muestra un cuadro de
didiogo Abrir estandar con muchas de las funciones comunes. La barra de
herramientas le ayuda a organizar sus archivos La seccion inferior y el hoton
de comando Bisqueda Avanzada le ayudan a encontrar sus archivos,

La tabla 4.2 mucstra una lista de funciones de cuadros de didlogo v resune
sus usos. En las otras secciones de este capitulo se describen estas funciones
mas en detalle

N T T

B e v o Coremter e cabme -

[ ] T—-.-tt

Tabla 4.1 Comandos que muestran los cuadros de dislogo

Comando Descripcion Aplicacion

Archivo. Abrir Busca v abre un W, F, P
tl umento ya creadn.

Archivo. Guardor Cuarda su trabajo W P

Archivo. Cuarda su trabajo v W.F, P

Guardar Come le: permite ver o crear T

un archivo adicional
con un nuevo nombre,

ra
LN
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Comando Descripcion Aplicacién®

Archive, Guardar  Guarda todos losdogummeritos g
Area de trebajo abiertos de Excel en un

- Contenedor gue fe permitira abnr

o muoltiples documentos a la vez.

£ - -
i Inservar, Archive Sitta un documento existente W
e dentro del documento en curso.

7. Insertur, Imagen Inserta un archivo de graficos W, E P
‘i’* dentro del docurnento.

b

= Insertar, Inserta una tabla de base de w
o Base de Dotos, datos dentro del documento.

o Obtener Datos

}s Insarfar, Obieto, inserta una archivo en su W, E P
o Crear de un Archivo, documento para que pueda

o« Examinar abnr posteriormente el ohjeto

o con {a aplicacion que lo cred,

é Insertar, Diapositivas inserta diapositivas de otro P
L del Archivo archvo de PowerPoint. :

}’ insertar, Digpositivas Crea diapositivas de un esquema p

: del esquema de Word o de Excel.

;

y fnsertar, Pelicula Inserta una pelicula de video P

' - - en la presentacion.

. Insertor, Sonido Inserta somido en la presentacion. P

L

g Herramientas, Utiliza una base de datos 0 un w

Combinar archivo de hoja de cdlculo
Correspondencia Obtener Datos para comhinar datos.

* W= Word, £= Excel, P= PowerPoint

£+ Tabld 4.2 Funciones ‘comunes de los cuadros de dislogo. Archivos .

Boton/Elemento Descripcién Uso

Boton e ayuda Después de pulsar en et
siEno de nterrogacian,

- - pulse sohre la parte del

cuadrou de drdlogo de la

que quiera una explica-

cion
i Botgn Cerrar Cierra el cuadro de dialo-
x g0 sin llevar a cabo
’ accion alguna También

se puede pulsar <Esc> ’
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Botén/Elemento Descripcion Uso
Lista desplepable  _ Lista desplegable Cambna la localizacion de
preg = pPeg, .
Guardar En /Mirar En sus archivos
Cuadro de la Lista Cuadro de Lista Muestra los nombres v
de Comendos opcronalmente otra infor-
D
macion acerca de los
archivos.
T Botén [Subir Va al siguiente nivel supe-
.’. a Nivel Superior] rior en la jerarquia de los
contenedores de archivos.
: Boton Va a las localizaciones
{Buscar En Favoritos] que designe como favan-
' tas con el botén |Agrepar
Favormtos]
oton regar Favoritos] Anade el archivo o la car-
- Boton [Ag F tos] Anade el arch |
o FE; peta a la localizacion en

donde tiene sus docu-
mentos mas usados,

— Botgn [Crear Crea una nutva cameta
ﬁ(- Nueva Carpeta| en la localizacion sefala-
; da en la lista desplegable
Guardar En/Mirar En
oo Boton jListal Muestra los nombres de
o -
Boa- archivos s6lo de las listas

de contenidos.

Boton [Detalies| Muestra el nombyre, tama-
g fio y fecha de los archi-
VOs.

Boton [Propiedades) Muestra informacicn
- intraducida por el usuano
acerca del archivo,

73e
friv)

Baton Muestra la pnimera parte
[Presentacion preltminar| del archivo
i

Botan [Comandn) Muestra el meni de

v [Confipuractones] opciones de impresion,
lay propredades de eds-
cion, dastficdcion, sub-
carpetas, y Buarda bas
busquedas

|| &

T Botones Guardar Lleva a cabo las acciones
/Abririnsertar/iAceptar]  requendas con todos kos
parametros del cuadro de
didlogo
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Boton/Elemento Descripcion Uso
T IBotn Cancelar] No hace nada. Vuelve al
. i documento.

Botdén Opcicnes Muestra cuadros de didlo-
go de las opciones de
guardar.

i Boton Sugiere capacidades
~- Busqueda Avanzada avanzadas de encontrar
: archivos.

Cuadro de Texto Nombre de Archivo Teclea el nombre del
archivo o usa comodines
para desplegar una fista

) reducida de archivos.

Cuadro de Texto Tipo de Archivo Cambua ef despliegue

. /Guardar como Tipo para mostrar archivos cre-
ados por programas dife-

- rentes o guarda el archivo
prara que otrg programa
pueda abrirlo.

Cuadro de Texto Texte o Propiedad Busca texto dentro del

documento o en los para-
metros de propiedad.

Cuadro de Texto

Ulhma modificacion

Busca archivos basado en
la fecha en gue fueron
guardados por Gltima vez,

Casilla
de verificacion

Casilla de verificacién
Leer solamente

Abre archivos de miodo
que no se pueda sobres-
cnibir en el archivo exis-
tente

o Bowcw ghve |

Botén Buscar Ahora

Aplica los critenos de
bisqueda v busca un
archivo,

Boton Nueva Bisqueda

Elmuina cualquier criterio
de hisqueda.

Casilla
de vericacton

Casilla
de verificacion
Vincular a Archive

Al tnsertar un archivo,
adjunta tnstrucciones
para leer el archivo en
disco, pera no inserta un
verdadero archivo en el
documento.

Casilia
de veriticacion

Casilla de Verficocion
Guarder con Documento

Al vincular un archive,
incluye el archivo com-
pleto en el documento.
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-+ } Tabla 4:3:Méfodos para Guardar ABHE y Cerrar archivos

Como Guardar, Abrir y Cerrar archivos

Los procedimientos para guardar. abrir y cerrar archivos son similares entre
si. Ud. elige tos comandos necesanos usando un botén, un jtem de ment o
unz tecla de método abreviado. En 1a mayoria de los casos. un cuadro de dii-
logo archivo estandar se abre y le pide informacion acerca del nombre dei- -
archivo, la localizacion (disco y carpeta) y el tipo de archivo que estd usan-
do. A veces ¢l cuadro de didlogo no se abre. Por ejemplo, cuando guarda un
archivo después de darle un nombre, el programa da por supuesto gue quie-
re utilizar las opciones predeterminadas del cuadro de didlogo de archive
para el nombre, localizacién y el tipe de archivo. Se puede cambiar ¢l nom-
bre del archivo con el comando Guardar Como.

La tablz 4.3 muestra los distintos métodos de guardar, abrir y cemrar archi-
VoS,

A ‘-n-_ - 2 L-J.\-vv-vll.v\l'.u'

Accién Botén Comando del Mend  Tecla de método abrewado

<Control> + <5>

Guardar Iﬂl Archive, Guordar

Cuardar No hay  Archivo. Guardar Como
Como tecla de

método

abreviado

<Control> + <O>

Abrir ' ﬁ'l Archivo, Abrir

<Control> + <N>

Nuevo ' DI Aschivo, Nuevo

Carsar le Archivo, Cerrar <Controk> + <F4>
0 dioble

pulsacion

en el icono

del menu -

Cémo guardar un documento

St quiere volver a uilizar un documento 0 mantener una copia del mismo,
necesitard puardar el documento. S para crear un documento se NECEsL un
rato (digamos que mds de 15 minutos), también le serid conveniente guardur
el documento para protegerio de contes de cornente. de problemas desagri-
dubles que ocurren cn fos ordenadores v de darle al botén equivocado

Se puede guardar el documento de vanas maneras. Ud. puede pulsar en el
bown Guardar de Ja harra de herramientas estandar, pulsar <Control> +



C&mo quardar. abnr y cerrar documentes | _19§

<S> 0 elegir Archivo, Guardar. Cizando intente cerrar un documento no
guardado o salir de un programa con un documento no guardado. puede
contestar Si a la sugerencia para guardar los cambios. Sea cual sea el méto-

Fig. 4.2
Cuando cuarda

-li:'f;[_l Uz ocurerecr
ot .

un documento
por primera vez
o cuando elige
Archive,
Guardar Como.
obtendra el
cuadro do did-
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do que ¢hja. la primera vez que guarde un documento deberd entrar en el
cuadre de didlogo Guardar Como. segin s¢ muestra en la figura 4.2,

Para guardar el archivo. escriba el nombre en el cuadrd de texto Nombre de
Archivo. elija una loculizacion en la hsta desplegable Guardar En. y el el
botén |Guardar)

Como asignar nombre a un documento

Las vicjas reglas para dur nombre a un documento con un miximo de ocho
caricteres. un punto v otres caracteres mis era demasiado limutada. Estas
reglas producian nombres de archivo cripticos como PLNNEG.DOC.
ROCUPO.XLS. v PRBACQO.PPT. Ahora puede tener nombres como Plan
de Negocios, Rowwra de Cucentas por Parcentaje. v Presentacién de Bandu
Comuntrarta, Una de las adiciones mids utles es ia capacidad de utilizar
espacios a la hora de dar nombres .

Los nombres vilidos de archivo pueden contener ahora lo siguiente:
H Espacios
B Hasta 223 caracteres

8 Todos los caracteres excepo N/ o[ "< > v

Windows 95 no ahtera realmente el sistema de dar nombre a archivos de 8
+ 3 de DOS. Windows 95 convierte €l nombre de archivo que teclea en un
nombre aceptahle que consiste normalmente en los seis primeros caracteres
sin espacios, una tilde y un 1 para el primer caso de ese nombre {un 2 para
el sepundo, etc.). Por ejemplo, el nombre de archivo Word Plan de Negocios
se convierte ep» PLANDE~1.D0OC. Cuando copta o usa este archivo en un
ordenador DOS, el nombre del archivo es la version reducida. En los siste-
mas Windows 95, el nombre largo se ailmacena con una referencia al nom-
bre cono del archivo. Para ver los nombres cortos de archivos DOS cuando
estd en un cuadro de didlogo de archivo, pulse con el botén derecho del
raton, elija Propiedades, y mire en fa ficha Propiedades Generales.
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Los caracteres on mavuscuela v muntscula se muestran generalmente ta v
como los teclea, pero no es posible darle a un documenio el mismo nombre
en casos diferentes (no se pueden tener un archivo Hamado PLAN y otro lia-
mado plan en la misma carpeta).

Como guardar cambios en un documento con nombre
Después de guardar los cambios por primera vez. el nombre del documento
aparece en i1 barra de titulo, segin se muestra en la hgura 4.3, Cuando que-
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ra guardar un documento una segunda ver y continuar usando el mismo
nombre. use¢ cuaiquiera de los procedimientos mencionados antenonmente
(el botén Guardar, <Conrrol> + <S>, Archive. Guardar. o sabir del docu-
mento ¢ programa v seleccionar Sipara guardar los cambios)

S$1 desea darte al documento otro nombre. ¢lija Archivo, Guardar como. Fi
cuadro de didlogo Guardar como apareceri con el nombre existente en ol
cuadro de texto Nombre de Archivo. Edite ed nombre del documento o cam-
bie 1a localizacion en la hista desplegable Guardor En.

Como guardar todos los documentos abiertos

Si continiia abnendo documentos o creando nuevos documentos s cerrar
cl antenor, tendrd mids ¥ mids decumentos en memona para la aphicacion en
uso. Para ver una Lista de documentos en memorta, clija el meni Ventana.
Lo documentos abiertos aparecen en la parte infenor del mena. segin ~¢
muestriten la ficura 4.4

(En Word e posible guardar todos los documentos abiertos con Archivo.
Guardar Todo. Si no ha dado nombre a uno 0 mas documentos, ¢i cuadro
de didlogo Guardar aparecerd. sugiriéndole el nombre y localizacion del
archivo.
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Eleccién de una [ecalizacidn para guardar su archivo

Cuando se guarda un archivo, &ste va 4 alguna parte del disco. Bn el mds
senctllo de ios €asos, un ordenador puede tener un disco duro dentro del
mismo ondenador (unidad C:), y ofra unidad de disquete (unidad A:). Sin
embargo, su erdenador personal puede tener muchas unidades de disquete y
discos duros adicionales, caruchaos de discos y lectores dpticus removibies,
y un CD-ROM. Su ordenador también puede estar conectado a una red, din-
dole acceso a Lnidades de ordenadores que oo estdn conectados directa-
mente con si ordenador personal.

Cuando entra por primers vez en un cuadro de didlogoe archivo estdndar,
verd una lista desplegable. En el cuadro de didlogo Guardar vera 1z lista
Guardar En. En ¢ cuadro de didlogo Abir, verd la lista Buscar En. Una
. sugerencia ¢n li list2 representa Iz localizacién ¢ contenedor ¢n curso donde
pucde guandar o abrir archivos, Debajo de Ia lista desplegable hay una gtan
.drea abiertz (el cuadro de ja lisia de contenidos) que le muestra e} conteni-
do del contenedor en curso. E] contcnido puede ser oos contenedores o
arclhivos. : :
Cuandto selecciona la lista desplcgable tal y como se muestea en la figura
4.5, se Ie proporciona una vista general de los contenedores disponibles para
que guarde ¢ abra archivos. Se despliega una lista de localizaciones cn cas-
cada. Buta Nsta represenma la jerarquia de localizaciones en donde puede
encontrar ¢ almacenar archivos. Esta jerarquig puede tener muchos njveles
diferentes; cada nive) se representa por una sangria. Cuando elige un. nivel
de la lista desplegable, ¢l contenido del nuevo nivel se jouestra en €] cuadro
de lista de comnlenidos, Si la lista tiene mis ftems de los que caben, verd una
barra de desplazamiento vertical a Ja derecha del cuadro de lista Si desea
volver 4 un nivel superior, puede elegir Ias listas desplegables Guardar en
o Buscar en ¢ pulsar en ¢l botén Subir nivel superior.

La jerarquia se muestra en forma diagramidtica én la fizura 4.6. En el nivel |

superior estd el Escritorio indicando que todus las localizaciones potancia-
Jes parten de esta ubicacidn. Las dos camas principales que parten del
Escritoric son Mi PC y Entorna de Red, indicando que estd trabajando con
un archivo que ¢s parte fisica del sistema de su ordenador o de otros orde-
nadores que cstén conectados al suyo por medio de una red.
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Si selecciona Entomo. de Red en 1a lista desplegable, verd una lista de Jos
erdenadores de su red en e cuadro lista de contenidos segin s¢ mucstra ¢o la
fgura 4.7. Si realiza entonces una doble puls@ddn cn cualquicr ordenador

Fig. 4.5

Localice el lugar
en donde guiera
tiabajar con los
archivgs en la
lista desplegable
Buscar En
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Fig. 46

La jeramuia
para almacenar
archivgs ocn-
tiene muchos’
niveles dife-
renles.

Fig. 4.7

Hay dlos orde-
natdores anata-
dos en esta red
de ¢rdonadores,

1

ademds del suyo, aparecerd una lists do carpetas compartidas en el cuadra
lista de contenidos. Si realiza una doble pulsacién en una carpeta poded ves
1as subcarpetas y archivos en el cuadro lista de contenidos.
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Bajo Mi PC cn la lista desplegable estén los distintos sparatos de almacena-

-miento conectados al ordznador, tales como una unidad de disquete de 3

1/27 {AZ) y otro de discos blandes de 5 1/47 (B:), mostradas con antetioni-
dad en La figura 4.5. Cuando pulsa sobre una d¢ estas unidades, realizard su
trabajo con archivos de disquetes. Si va a guander un archive, pucde optar
entre teclear A: o B: antes del nombre del archivo ¢n el cuadro de toxto
Nombre de archivo. . ’

Elicono de un disoo duro (normalmente fijo dentro de su nrdenador) es lige-
ramenic diferente en la figura 4.5 ¥ va normalmente indicadoe con una £,
Camo el disco durg tiene mucho mds espacia, los archivos van normalmen-
1e colocados denlro de carpetas. En (g figura 4.5. el resaliado €518 en Ja car-
peta Rechazo dz la Violencia Organizada, que es una subcarpeta de Datos.,
Para navegar por o jerarquia de los ordenadores, diszcos y carpetas, pued:
optar por cualguicea de los siguientes pasos:
B Usar cf cuadro de lista desplcgable Guardar En o Buscar En.
M Rcalizar una doble pulsacin €n una carpeta del cvaded de lista.de con-
tenidos para ver ¢l contenido de ia cameta. ‘
W Pulsar sobre Ja carpeta con ¢l bowdn derecho del radn v pulsar en [Abriz)
para ver €l contenide de 1a carpeta.
B Pulsar subre el botdn [Subir nivel superior] pam volver a un nivel supe-
rior cn la jerarquia.
B Pulsar sobrs el botdn [Crear] nueva carpety pare créar una carpeta deba-
jo del contenedor o carpets identiticada en 1a lista desplegable Guardg
En.

B Si conoce la localizacién de la carpeta que guiere abrir o guardar, pucde
22
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teelaar Je jerarqula de discos y carpetas en ¢l cuadro de texto Nombre
de Archivo como en este ejemplo: C:AOffice 9NExceNmpinsrosd5

Cémo abrir un documento

Existen mis opciones para abor un documento que para guardario. Algunas
dc estas opcianes fueron descritas en o capitulo 2, “iniciarse & Identiftcar
Partes de 1a Pantalla™. Este apartado conticne un resumen de jas gpriones
existcnies pata abyir un docemento,

Desde fuera de un programa, siga vno de los siguientcs pasos:

W Desde 1a bara de acceso directo de Microsoft Office, pulsc sobre el
boton [Abrir Documento], acleccione I localizacién y elija ol archivo.
Tambicn pucde personsdizar Ia barra de aceeso directo para que conten-
pa archivos ¥ carpotas. Ver ¢l capimlo 34, “Personalizacion del
Escritario, Barras de Herramientas ¥y Mends®, Después de pulsar en el
cotén JAbrir Documento], enteara en un cuadro de difloge Abnr.
W Desde la bura de tarcas de Windows, elija inkio, despuss Documentas
y pulse sobre uno de sus Glimos L5 documentos.
M Desdelabarra de tarcas dc Windows, elija [nicio, después Programas,
v busgue el archivo por medio del Bxplorador de Windows.
B Minimice o cierre todes los programas abiertos y realice una doble pul-
sac16n en un rcong del eseritorio, como (Mi PCl. {Eatorno de Red), o
carpetas de acceso directo ¥ navegue Por las ventanas para £nconirar su
archive,
B Desde la harra de tareas de Windows, elija Inicio y después Abrir docu-
mento de Office. > VEASE “Cimo alriz
B Pulse cualquier tecla de método abreviado que haya asignado a un archi- UM dicarento”, pig
vo usando 1a ficha Accesa Directo en el cuadro de didlogo Propiedades
de un icone de mdétodo abreviado. (Véase ¢] apartado siguiente “Cdomo
usar Bisqueda avanzada de archivos™.)
Desde dentro de un programa, siga itno de las siguientes pasos:

8 Puls= sobre el botGn {Abrir).

M Pulsc <Conool> + <0 - ' . « VEASE 2Coeng faie
) . aa ms”, pi
M Elija Archivo, Abrir, 261’ programas”, pag,

Si elige cualquiera de sstos pasos entrard en ¢l cuedre de didlogo Abnr. e o ]
Eseriba ¢l nombre del archivo en ¢l coadro de texio Nambre de orchivoy  # YEAE“Coom abrir -
elija la docalizacion en ir lista desplegable Buscar en. UnS ReSCHACION €515

Tambi€n ez posible caconmar ficilinente uno de Jos riltimos archivos con los (e pag. 350
que ha trebajado. En la pane inferier del mend Archive hay una jista de las

archivos usados mis recientemente (véase fa fig. 4.8}, Si no apareee ningtn

disco ¢ carpeta con el nombre del archivo, éste procede de la carpeta acliva,

Eiija c] nombre del archivo para abriflo.

34
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Fig. 4.8 |

Los dltimos
archives que
abre agarecen
en |a parte
inferies del
meni Archivo.

SOLUCION DE FROBLEMAS

Cwando busco un archivo, el nombre del archive no aparece en cof cuadro de
lista de contenides. ‘ . ‘

El nomkre del zrehivo puede no aparecer en un cuadro de lista de conlenidos
por vanias razones. En primer lugar, s posible que sea necesario vsar la barra
de desplazamienlo para acceder a mas archivas de la fista. En seaundo lugar,
el archive puede no ser del tipe adecuado. En el cuadio de lista Tipo de

Archivo, seleccione Todos los Archives, v mire si su archivo ests en la lista. En

tercer lugar, es posible que tenga que reemplazar ! disco y la carpeta, Por (ti-
mo, ¢ tada lo demés falla, busque af archive usande las funciones descritas gn
el siguiente aparado, *Coémo buscar Archives”.

No pueds scceder 2 un archivo detf ordenador de ctra persona de fa red.

En el Escritorio de Windows elija Entomo de Red, y daspués elija ef nombre del
ordenador de la otra periona. El otra ordenador tiene que tener archivos com-
partidos para permititle acceder a sus archivos. -

No puedo leer un archivo def CO-ROM.

Asegurese de que e} CD-ROM ests instaledo carrectamente. 5§ no lo ha hecho,
instale el CD-ROM eligiendo Inicio en €] barra de tareas de Windows. Entonces
efija Instakar, Panel de Control, Agregar Noevas Programas, v siga al Asistente
pata Programas. Ademds, asegdrese de que tiene el reproducior de CD-RCM
encendida y que ¢l CO apropiado estd en Ja unidad de CD.

- Como buscar archivos

Es posible uiilizar el bouén [Abnr Documento] en 12 Barra de acceso Directo
de Microsoft Office para abrir un documento ¢ iniciar el programa que 1o
cred al mismo tempo, Después de puizar en el botdn Abrir Decumenlo, apa-
recerd el cuadro de diflogo Abrir. Este cuadro de didlogo es el mismo gu
aparece cuando estd en ¢l progeama y usa Archivo, Abrir,

Una vez estd et el cuadre de didlogo Abrc ticns muchas opriones para res-
mngy ¢ expandir su bisqueda. Bs posible reemnplazer ja organizacién y

’




CGmo buscar archives 109

orden de los archivos, utilizar comodines en los nombres de los archivos.
elegir un tipo de archivo o 1dentificarlo por su contenido, fecha u otras pro-
piedades. Estas opciones del cuadro dz didlogo Abrir sustituyen a la funcién
Buscar Archivo de la version anterior de Microsoft Office.
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Como abrir listas de archivos

Después de seleccionar un ordenador, una unidad y una carpeta por medio
de 1a lista desplegable Buscar En. verd una lista de archivos (y posiblemen-
te otras carpetas) en el cuadro de lista de contenidos. Ud. dispone de cuatro
opciones para ver esta lista de archivos. Las figuras 4.9 a la 4.12 muestran
las diferentes modalidades de ver los argivos. Pulse sobre uno de los
sigaientes botones:

Fig. 4.9

Pulse sobre el
boton [Lista)
para acceder a
s nombres de
archivos.

Fig. 4.10

Pulse sobre el
boton [Detalies)
para acceder a
los nombres de
archivos, el
tamano, el tipa
v ta fecha.
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Fig. .11
Pulse sobre el
holén

[Propredacdes] |

para acceder a
los nomibres de
archivo v la
informacion
acerca del
archivo
proporcionada
por el usuano.

Fig. 4,12

Putse sobre el
hoton
[Presentacion
preliminar! para
VO Una imagen
del archivo,

Roministracidn de archivos g areas de trabajo

Boton Nombre Propdsito
gk Lista Muestra nombres de archivos con un
Ry icono del tipo de archivo solamente.
. Deialles : Muestra nombres de archivos, icono
del tipo de archivo, tamano del
archivo, tipo de archivo y hora v
fecha de modificacién.
T Propiedades Muestra informaciéon resumida ana-
i dida por el usuario como titulo,
autor, palabras-clave, etc.
sy Presentacion Muestra qué aspecto tiene la primera
5L preliminar parte del archivo.
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Como clasificar la lista de archivos

Cuando elige el boton [Detalles]. la lista de archivos aparecerd con el nom-
bre del archivo. el tarnaﬁgi el tipo y la fecha y hora de modificacion. La parte
3
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1

superior del cuadro de lista de contenidos.muestra los encabezados de
columna Nombre, Tamafio. Tipo y Modificacion, tal y como se muestra en
la figura 4.10. Pulse sobre cualquiera de estos encabezados de columna para
clasificar la lista de forma ascendente segln esa categoria. Vuelva a pulsar
en el encabezado de columna para clasificar la lista de forma descendente
seglin esa categoria. Por ejemplo, para clasificar los archivos segun la fecha.
pulse sobre el encabezado Modificacion. Pulse otra vez para clasificar los -
archivos con la gltima fecha en la parte superior de la lista.

Cémo usar los comodines para reducir la lista
de archivos

Sisu lista de archivos es particularmente larga, posiblemente quiera limiar- Consejo
la segiin el nombre de archivo. Dos comodines pueden ayudarle a mitar la -
lista segun los caracteres del nombre del archivo: * (asterisco) y ? {signo de '[
interrogacion). El asterisco significa sustituir cualquier numero de caracte-
res. El signo de interrogacion significa sustitu'i{ un caracier. En el cuadro de oles asterscos dentro
texto Nombre de Archivo del cuadro de didlogo Abrir puede teclear el | " b
texto con comodines y después elegir el botén de comando Buscar Ahora. | ¢ o

La lista siguiénte muestra varios ejemplos. '

A diserencia del
comodin e DOS, es
posible utdizar mkii-

Para climinar el comodin y todas las restricciones de la lista de archivos.

elija el boton de comando Nueva Bisqueda. :
Tipo . A Mostrar

B* Todos los archivos que empiezan por B

Rev?? Revys, Rev9o, Revdr

“Don* ~ Razonces para Donar, Donaciones YTD,

Orientacion a Donantes, Curriculum de
Don Campbel|

Como buscar un archivo por la fecha

Cuando lu lista es larga v Ud. no se acuerda de la fecha exacta. pero si de
cuiando aproximadamente irabajo con ¢l la dluma vez, puede limitar 1a hista
de archivos para que muestre dnicamente agueltos archivos modificados en
un periado determinado. Use la lista despic¢eable Ultima Modificacion v
pulse sobre el boton de comando Buscar Ahora para limitar la lista de archi-

Fig. 4.13
- . Yy .
lu.m v—— [wmm mrmT Para acceder a
. : archivos que
it Wy cumplan ¢rite-
Cefanafiazaly { .
12 semang rnos de fecha,
[y oa i elia la lista
desplegahle
Ultima
Vo por ttempo. La figurd 413 muestra que las opciones de Ultima Modificacion

Modificacion incluven hoy. aver. la semana pasada. esta semana. el mes
pasado v este mes. Para hacer que 1a lista de Ychivos muestre todas las
fechas, seleccione cualquer tiempo,




Fig. 4.14
Todos los

S Coitulo 4 Administracién de archivas y areas de trabajo

archivos que
contienen Rick

como parte del

documento ¢

propiedad se

muestran agui.

Cémo buscar un archivo por el contenido

Ud. puede recordar donde ha puesto un archive pero no tener idca de gué
nombre le dio. Puede buscar un archivo por el contenido del archivo o por
la informacion resumida afiadida por Ud. al archivo. En el cuadro de texto
Texto o Propiedad. escriba algo de texto que haya incluido en ¢l archivo,
como a quién dirigié el archivo, el tema o quizds una categoria de gastos. La
figura 4.14. muestra todos los archivos que contienen Rick. lo que significa
que Rick puede estar escrito en el archivo. o ser su autor o paric de alguna
otra propiedad del archivo. Después de llenar el cuadro de 1exto Texto o
Propiedad. elija el botén Buscar ahore. '

Para remiciar el cuadro de didlogo Abrir, elija el boton de comande Nueva

Busqueda.

AT e 2> g s it e el
1 [P lis ey v b L]

Cémo expandir la basqueda para que incluya
subcarpetas

Si el texto a buscar no es encontrado en la carpeta en uso. puede expandir
su husqueda a otros carpetas en el disco duro. Elija el nivel mas alto en el
gue guiera buscar (por ejemplo. la unidad C:) en la lista desplegable Buscar
En. Entonces elija el botén Comandos y Configuraciones. Del menu des-
plegable eliju Buscar Subcarpetas, segiin se muestra en 1 figura 4.15,
Ahora, cuando unlice cualquiera de los procesos de busqueda tales como
Nombre de Archivo. Texto o Propiedad. Ultima Modificacion. o
Busqueda Avanzada. aparecerin las subcarpetas ademds de los archivos.
Para agrupar los archivos segin sus subcarpetas, verifique Archivos de
Grupo por opcion de Carpeta en el botén Comandos y Configuraciones.
Para hacer gque solo se muestre el contenido de la opcion Buscar En, desac-
Jgive la opeion Buscur Subcarpetas.

Desplegaf tipos de archivos

Sientra en el cuadro de didlogo Abrir a través del botdn [ Abrir Documento|
de Ta barra de acceso directo de Microsoft Office, el cuadro de didlogo mues-
tra archivos de todos Jos tipos. Si entra en los cuadros de diilogo Abrir o
Guardar desde un programa especifico, como Word, Excel, o PowerPoint.
por defecto se muestran sélo aquelios archivos creados por ese programa. Si
desca ver una hista de todos los archivos, elija la lista desplegable Tipo de
Archivo y elija Todos los Archivos. También podri ver archivos de otros pro-
cesadores de texto como WordPerfect u hojas de cdlculo como Lotus 1-2-3.

1
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El cuadro lista
de contenmidos
nuestra carpelas

v archivos

deniro de

carpetas gue
salis1acen sus

CIRETios,
N ]
{if-an;srmmdummcuuum ERERE ;c“!‘_:_;;‘_ at ". e
Aplicacion
que abre el Archivo Tipo de Archivo Resultado
Word Hoja de célculo Tabla Word (puede ser un
de documento Excel combinacién de datos.
Aplicacion Tipo de Archivo Resultado
que Ahre el Afchivo \
PowerPoint Word (esquema) Encahezado 1 = titulo de
diapositiva, Encabezado
2. 3 = puntos vy subpuntos
PowerPormnt Hoja de calculo Cada fila se convierte en
de Excel el titwlo de la diapositiva
Si la lista Tipo de archivos tiene mas opciones de las que puede ver, apare-
cerda una barra de desplazamiento vertical, permitiéndole desplazarse a
otros items de la lista y seleccionar el tipo de archivo que desee.
. Jaschivos d= Miciosol Ewced th 4.16

Esto resulta atil si quiere abnr un archivo creado por un programa diferente
0 st quiere guardar un archivo con un tformato diferente para utilizarlo con

Togos kos aichvor
sexitwe g de Vhzece ot B sl

“larTnvos o testn

Archeves de Loer 103
facriecs de Guatio™ro/ D07
|arrnno: de Miziosalt wiar :

Use Tipo de
archivos para
abrir 0 guardar

.J archivos que no

son clel tipo
predeterninado
£nsu '
apticacion.

otro programa. La figura 4.16. muestra algunas de las opciones Archivo de
Tipo para el cuadro de didlogo Abnr de Excel. Estos tipos incluyen archivos
de texto. diferentes formatos de hojs de cilculo. antiguas versiones de Excel .
v lomutos de archivos de bases de datos.

40
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Fig. 4.17

Para buscar on
L hista
despicvable
Frocnedades.
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(rapiedaed

Normalmente modificari el tipo de archivo cuando desee convertir un archi-
vo de un tipo a otro, como una hoja de cédlculo (Lotus 1-2-3 a Excel). un
documento de procesador de texto (WordPerfect a Word) o una base de
datos (dBASE a Access). En algunos casos. sin embargo. es posible que
quiera abrir un tipo de archivo diferente. Por ejemplo. puede abrir un archi-
vo de hoja de calculo de Excel en un documento Word. La tabla 4.4 mues-
tra algunas posibilidades de apertura de distintas clases de archivos.
Cuando intente abrir un archivo de tipo diferente. si su aplicacion no puede
convertir el tipo del archivo. aparecerd un mensaje de error dlClendu que ¢l
tormato del archivo no es vilido.

Como utilizar bisqueda avanzada de archivos

Aunque la opcién Texto o Propiedad busca el contenido del archivo o cual-
quicra de sus propiedades, puede limitar la busqueda @ una sola propiedad o
utilizar muchas propiedades al mismo tiempo. Siga los siguicnies pasos:
1. Pulse sobre el botdn {Abrir] de la barra de herramientas estindar de su
programa o puise sobre el botén [Abrir Documento| de la barra de acce-
so directo de Microsoft Office.

2. Si yuiere. reliene las opciones Nombre de Archivo. Texto o Propiedad.
Tipo de Archivos y Uima Modificacion. tal y como se describio ante-
rrormenite. .

3. Flija el boién Busqueda Avanzada. El cuadro de didlogo Busqueda

. Avanzada aparecera con las clecciones que hizo en el cuadro de didlogo
[ Abrir|.
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b la Tista desplegable Propiedades v seleccione 1a propiedad que
quicid. seeun se muestra en L figura 117,

thn

el cuadro de eato Valor. escriba el textio gque busca.
. Flija el boton Agregar a la Lista.
/

-~

7. Si desea afiadir aleuna otra condicion, elija ¢l botén opeion Propiedad
Y tlas dos condiciones deben cumplitse) o el boton opcion O (una de
Las dos condiciones (Icﬂc cumplirse) v complete los pasos 2-6.
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8. Cuando termine de rellenar el cuadro de didlogo Biisqueda Avanzada,
elija el botén Buscar Ahora en la parte inferior izquierda del cuadro de
didlogo Busqueda Avanzada.

Volveri al cuadro de didlogo Abrir con la lista de archivos que satisfacen su
criterio en el cuadro Lista de contenidos.

Algunas de las otras opciones del cuadro de didlogo Bisqueda Avanzada se
enumeran en la tabla 4.5.

Cémo guardar y utilizar criterios de bisqueda
guardados

Si busca de forma continuada la misma clase de archivos, quizas quiera
guardar sus pardmetros de bisqueda. Después de identificar el nombre del
archivo, la localizacion. la informacion de propiedades. texto o los crite-
rios de busqueda de fecha, puede guardar estos parametros. Siga estos
pasos: :
1. Si sc encuentra en un cuadro de didlogo Abrir. elija Avanzada para
abrir el cuadro de didlogo Buisqueda Avanzada. ;

2. Elija el boion Guardar Busqueda.
3. Escriba e[ nombre de la busqueda y elija el botén [Acepiar].

Cuando quiera utilizar una blisqueda con nombre, seleccione la busqueda
desde el botén Abrir Busqueda. Para borrar la biisqueda, elija el botdn
[Eliminar|. La figura 4.18 muestra una lista de bisquedas guardadas (con
nombre).

Fig. .18
Seleccione
bsquedas
auardadas en el
cuadro de lista
Busquedas
Cuardadas.

Documertos ge wod
. {Uocumenios Lasgos

Como guardar sus archivos y carpetas favoritos

Si usa los mismos archivos o carpetas una y otra vez, puede guardartos en
un carpeta especial llamado Favoritos. En un cuadro de didlogo Abnr des-
plicese a su archivos o carpetas v pulse sobre el boton [Agregar a
Favoritos}.

42



L Rdministracidn de archivos y dreas de trabajo

LI T T e R

LI Tem e T vt w T R La e

5 optiones del Gualne e diblopyibisgiieda avanzada

FRUTTNEA ML Tl WP NS~ - SCRpitts. e e S P

Descripcién

Casilla de verificacion
Coincidir Todas las
Formas de palabras

Para contenidos, comentarios y otros
items de busqueda, puede encontrar
archivos que casen con las diferentes
formas de Ia palabra. Por ejemplo, si
el Valor es ser, la bisqueda incluye
ser, soy, eres, es.

Casilla de verificacion
Comncidir Mayvs/minus

Para contenidos, comentarios v otros
items de la opcion Propiedod, puede
encontrar sdlo los ftems gque comngi-
dan con la primera letra de la palabra
(maytscula o minuscula) segun hava
tecleado las opciones en el cuadro
de texto Valor.

Boton Eliminar

Pulse sobre uno de los items en Buscar
Archivo que cumplan las condiciones
siguientes y después elija el hoton
Eliminar para borrar los criterios.

- - Bolén Nueva Busqueda

Elimina todos los criterios y empieza de
nuevo.

Lista desplegable Condicion

Esta lista cambia segun ia Propiedad
seleccionada y le permite encontrar coin-
cidencias que contienen la opcion Valor
por completo, una parte de elia, uno de
los items cle la opcion Valor, item< mavo-
res 0 menores que una fecha, y otras
COsas.

Lista desplegable Buscar En

Es to mismo que Buscar En el cuadro de
didlogo Abrir; le permite cambiar la loca-
lizacién de su basqueda.

Casilla de verificacion
Buscor en Subcarpetas

Es lo mismo que la opcion de menu en el
ment Comandos y Configuraciones del
cuadro de dialogo Abrir; le permite incluir
archivos de |a carpeta en uso vy todos las
subcarpetas que desee.

Boton Guardar Basqueda

Guarde cualquier criterio de husqueda
con un nombre para recuperarlo mas
tarde.

Boton Abrnir Busqueda

Elija una de las busquedas con nombre
creadas por Ud. con el comando Guardar
Busqueda.

Boion Cancelar

No ejecuta ninguna de las opciones
Busgueda Avanzada y vuelve al cuadro de
didlogo Abrirtal y como lo dejo Ud.
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Cuando quiera ver sus archivos.o carpetas Favoritos, pulse sobre el botén
[Buscar| En Favoritos en el cuadro de didlogo de cualquier archivo.

Como Copiar y Mover archivos, Imprimir y otras
funciones ocultas

Cuando se encuentra en un cuadro de didlogo Abrir o Guardar, dispone de
otras opciones que estan ocultas y que no se presentan como eleccion en el
cuadro de dialogo. Puede acceder aestas opciones seleccionando un archi-
vo 0 archivos y realizando después una pulsacién con el botén derecho del
ratén (véase la fig. 4.19).

Puede seleccionar archivos de varias rianeras:
B Pulse sobre el nombre de un archivo.

B Mantenga presionada la tecla <Control> y pulse sobre varios archivos
para seleccionar mas de un archivo.

W Pulse sobre el primer archivo. mantenga presionada la tecla de
<Mayuis> y pulse sobre el ultimo archivo para seleccionar un grupo de
archivos adyvacentes.
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Después de seleccionar su archivo o archivos. pulse con el boton derecho
del raton en parie de la seleccion y elija uno de los siguientes procedi-
mientos:

B Elija Abrir para abnr todos los archivos seleccionados.

B Eiija Abrir Leer Solamente para abrir los archivos, pero necesitara asig-
narles un nuevo nombre si desea guardarios.

B Elija Imprimir para imprimir los archivos.

E] Maletin es una nueva funcién de Windows 96 que le permite mantener
sus documentos actualizados entre un ordenador de mesa y uno portatil.

S

& B

Fig. 4.19
Pulsando con el
hoton derecho
del raton en un
archive le
pProporciona
mds opciones
de pestion de
archivos.
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B Elija Enviar A. después elija una unidad de disquete para copiar el archi-
vo. Receptor de Fax para enviar el archivo por fax, Receptor de Correo
para enviar una version de correo del archivo, o Mi Maletin.

8 Elija Cortar para mover archivos al Portapapeles (y eliminar los archi-
vos originales).

B Elija Copiar para copiar archivos al Portapapeles (y mantener los archi-
vos originales en su lugar).

B Elija Crear Accéso Directo para crear oiro icono en el directorio que es
un atajo al archivo (pulse con el botdén derecho del raton en el nombre
abreviado y elija Propiedades para dar a Ia abreviatura una combinacion
de teclas. El nombre abreviado comienza con “abreviatura De™.)

- R
,....,Y -.a --4,,,

S borra archlvos acc:dentalmente,{puede. recuperar!os si:no ha vacnado la
-"Papelera de Reciclaje: Con'todos 16s programas.minimizados,-elija Papelera

de Reciclaje en el Escntorlo de 'Windows:'Elija el nombre del archivo y ellja

Archivo, R&shurar T T Sz s e

B Elija Eliminar para borrar los archivos de la Papelera de Reciclaje.
M Elija Cambtar Nombre para dar a un archivo un nuevo nombre.

M Elija Propiedades para asignar una combinacién de teclas a un archivo
de acceso directo. o ver informacidn de archivos como nombre de archi-
vo DOS., fecha de creacion. atributos de archivo. informacién resumen
y estadistica.

Si elige Cortar o Copiar. ehija la localizacion a donde quicra que vava el

archivo vy después pulse con el botdn derecho del ratén v ehija Pegor en el

menu de acceso directo,

Como cerrar un documento

Puede cerrar un documento de vartas maneras:

B Realice una doble pulsacion en el icono del meni de Control situado en
la esquina superior izquierda de la ventana del documento, tal y como se
muestra en {a figura 4,20,

B Pulse una vez en el icono det ment de Control y elija Cerrar del ment
desplegable.

B Elija Archivo, Cerrar.

B Pulse <Control> + <W>

B Puise sobre ¢l botén [Cerrar] del documento (X}

Si ha guardado sus dlumos cambios en el documento, el documento se cie-
rra. Si ha hecho cumbios desde que guard6 por Gltima vez o no ha guardado
ain, se le avisa de que guarde el documento, segin se muestra en la figura

4.21.
45
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Camo iniciar un documento |~ " 7

Atencion

Asegurese de que pulsa en el botén Cerrar del documento v no
en el botén Cerrar del programa  Si el documento estd maximiza-
do, el boton Cerrar del documento -estd en la misma fila que la
barra del mend. Si el documento no esta maximizado, el boton

Cerrar estd en la parte derecha de la barra de titulo del documen-
" to. o
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Clija uno de los siguientes botones:

W LClija [S{] para guardar los cambios. Si va le ha dado al documento un
nombre. el documento se cierra. Si no le ha dado un nombre al docu-
mento. aparece el cuudro de didlogo Guardar Como.

W Elija [No] pura no guardar los cambios. Perderd cualquier cambio que
haya hecho desde la tltima vez que guardo. o ¢l documento entero si no
lo ha guardado nunca.

B Elija [Cancelar] para volver al documento sin guardar ¢! documento o
saltr de €.
St no ha guardado Jos Gditimos cambios cn su archivo v lo cierra usando
cualguier método normat. incluida la salida de 1a aplicacion. el aviso mos-
trado en fa figura 4.21 le pregunta si quicre guardar los cambios. Si elige

Si. el cuadro de dialogo Guardar Como aparecerd si no ha dado nombre al
archivo.

Obwviamente, no obtendra ningiin aviso para guardar su documento si Ud. o
la madre naturaleza corta el suministra eléctrico del ordenador.

Como iniciar un nuevo documento

En Excel o Word, cuando se pulsa en ¢l boton hevo o pulsa <Conurol> +
<IN>. »¢ abre una ventana de documento vacia. En PowerPoint, se abre una
nuevi presentacion con la pregunta qué upo de diapositivi desea. Siousa el

Fig. 4.20
Pulse sobre el
botan {Cerrarl
para cerrar un
documento

Fig. 4.21
St intenta cerrar
un documento

- ne euardado. u

cuadro de
¢ialogo le
proeguntara s
qurere guardar
los cambios
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< VEASE “Como ini-
ciar un documento
desde la barra de
acceso directo”, pag.
29

» VEASE “Como usar
los asistentes para
plantilfa”, pag. 245

P VEASE
“Comprender docu-
mentos maestros y
plantillas, pag. 571

» VEASE “Como
crear una presenta-
cion usando um asis-
tente”, pag. 37

Fig. 4.22

Bl hoton [Inicio
de Nuevo
Documento]
presenta of
cuadro de
didloso Nuevo
con planulias v
Jsistentes pard
tas aplhicaciones
de Microsoit
(Mhice

comando del meni Archivo, Nuevo en un programa o puisa en el botn
| Inicio de Nuevo] Documento en la Barra de acceso directo de Microsoft
Oftice. el cuadro de didlogo Nuevo aparecera con una serie de fichas en la
parte superior. tal y como se muestra en la figura 4.22. Las fichas presentan
categorias gencrales de archivos que puede crear. En cada licha hay archi-
vos que son plantillas o asistentes. Las plantillas son archivos que pueden
haber almacenado formatos, macros. estilos, texto y diversos menus y barras
de herramientas. Después de abrir una plantilla con el comando Archivo,
Nuevo. atin serd necesario darle al documento un nombre para guardarlo,

" Los asistentes son una serie de cuadros de didlogo que le guian en los pasos
a seguir para crear un documento o ejecutar una funcion. -

SOLUCION DE PROBLEMAS i

Cuando elijo subcarpetas con el botén Comandos y Configuracion no veo nin-
guna subcarpeta.

No se ven subcarpetas con la opcién lista seleccionada. Debera pulsar en los
botones Detalles, Propiedades o Presentacion preliminar. Otra posibilidad s
que no tenga ningun archivo en otras areas que coincidan con sus cniterios de
husqueda.

Sé que el archivo estd en la carpeta, pero no lo veo.

Es posible que tenga que usar la barra de desplazamiento en la parie inferior o
derecha del cuadro de lista de contenidos. Otra posibilidad es gue tenga crite-
nes de busqueda que excluvan su archivo., Pulse sobre el boton Nueva
Busqueda en un cuadro de didlogo de archivo. Asegdrese de que su tipo de
archivo es correcto en la lista desplcgable Tipo de Archivos.

Laintende pya Mewoaiun Meoandum
merrin arwd creyores g

Ve er wean T
g s RERP,

Como usar las opciones guardar

Aungue la mavor parte de las aplicaciones exigen que guarde sus archivos,
Word v Excel e permitenarear copias de seguridad asi como establecer un
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de guardado automadtico. Adn asi. deberia utilizar el botén [Guardar]. el
comando del men o la tecla de método abreviado para guardar a menudo.
especialmente después de emplear una significativa cantidad de esfuerzo en
darle al documento el aspecto que desea o antes de llevar a cabo una opera-
cion de envergadura en el archivo (como una correccion ontogrifica. una
clasificacion, una sustitucion, un formato automdtico 0 una 1mportacion).
Puede utilizar la funcién Guardar Como para guardar diferentes revisiones
del mismo archivo hasta que el provecto esté completo.

Un archivd de seguridad tiene un icono diferente y el nombre comienza con
Copiu de Seguridad de (véase la fig. 4.23). Ud. crea un archivo de seguri-
dad después de que hava guardado el archivo al menos una vez. Cuando
guarda ef archivo la segunda vez y 1odas las veces subsiguientes. el proce-
dimiento de copia de segundad asigna nuevo nombre al viejo archivo en cl
disco con el mismo nombre del archivo. pero con un prefijo Copia de
Seguridad. El documento en pantalla se guarda con el nombre original del
archivo. St necesita utilizar su archivo de seguridad cambie el tipo de archi-
vo a Todos los Archivos o escriba Copia de Seguridad * en ¢l cuadro de
texto Nombre de Archive. Para iniciar el procedimiento de Copia de
Seguridad. clija <l comando Archivo. Guardar Como v después clija el
botén de comando Opciones, v compruebe la casilla de verificacion Crear
Siempre Copia de Seguridad.

’Bq::ug\‘: ae [_] M:s documentos _’j"
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En Word y Exacel. puede fijar la funcién de guardado automdtico de modo
yue el programa guarde su trabajo a mtervalos de tiempo especificados por
Ld. En Word. fije la funcion de guardado automitico de esta manera:

I. Eiija Herramientas, Opciones '

2. Pulse sobre la ficha Guardar

3. Compruebe la casilla de verificacion Autoguardar cada e introduzca
los parametros de Minutos tecleando o usando los botones de incre-
mento.

Silo desea. para cambiar it locatizacion donde se guardan los archivos. con-
linde como sigue. o salte al paso 7:
4. Puise sobre la ficha de Localizacién de archivos

5. En ¢l cuadro de lista Tipos de archive. pulse sobre Autoguardar archi-
vos v elija el boton Modificar. 48

6. En el cuadro de didlogo Modificar localizacién, escriba el nombre de la

lowealiraecion donce cunery anardar e archivac As Autarnardada am ol

Fig, 4.23

Et icono de tipo
de archivo
cambia para
mostrar un
archivo de
seguridad.
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Fig. 4.24
Escriba el
nombre de la
carpeta de
seguridad el
cuadro de texto
Nombre de
Carpeta.

Fig. 4.25

Active la opaon
Autoguardar en
el cuadro de
cidlowo Macros
Automaticos
para activar el
cudrdado
AUOMARICO,

’

cuadro de texto Nombre de carpeta. tal y como se muestra en la figura
4.24 y elija | Aceptar].
7. Elija el botdn |Cerrar] en el cuadro de didlogo Opciones.
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Fije la funcién Autoguardar en Excel de esta manera:
1. Elija Herramientas. Macros Automaticos Disponibles. EI cuadro de
didlogo Macros Automdticos aparecerd. tal y como s¢ muestra en a
— figura 4.23.
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El cuadro de didlogo Macros Autométicos puede tener un aspecto distinto
en su pantalla debido a su instalacién.

2. Active la castlla de venficacion Autoguardar v elija [Aceptar].

3. Paru activar Autoguardar. elija Herramientas, Autoguardar. El cua-

dro de didlogo Autoguardar aparecerd.

4. Active ta casilla de verificacién Autoguardar cada v rellene el pardme-
tros Minutos.

5. Elija [Aceptar] para vBiver al documento.
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Cuando reinicia Word tras un problema de corriente, el archivo puede apa-
recer automdaticamente en pantalla debido a la funcion de guardado automa-
tico. En Excel, el programa le avisa para que le dé un nombre al archivo si
todavia no lo ha guardado.

- Cémo usar las propiedades de archivo

En la anligua version de Windows el nombre de los archivos estaba limita-
do a 8 caracteres mds una extension de tres caractercs. Windows 95 ¥
Microsoft Office han ampliado notablemente la capacidad hasta 235 carac-
teres. Si necesita algo mds que el nombre de su archivo para identificar un
documento, ahora dispone de muchas propiedades que puede rellenar en la
funcién de nuevas propiedades.

Como ver y editar las propiedades de archivo
Puede introducir o ver propiedades de archivo de muchas maneras. Las lis-
tas siguientes describen algunas maneras de usar las propiedades de archi-
vo. )
Para ver y modificar {as propiedades de archivo:

B Con el archivo abicrto en Word, Excel, o PowerPoint, elija Archivo,
Propiedades. ‘

M En un cuadro de didlogo, seleccione el archivo y pulse sobre el botdn -
[Comandos] y [Configuracién). Después elija Propiedades en ! mend. E

Para ver las propiedades inicamente:

M En un cuadro de didlogo, seleccione el archivo y pulse sobre el botdn ==
[Propicdadess]. Las propicdades del archivo seleccionado aparecen en | e-lzf]
una drea pequefia por la que puede moverse con una barra de desplaza-
micnto vertical, tal y como se muestra en la figura 4.26.
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.Sdlamente puede imprimir las propiedades de los archivos Word. Elija
Archivo, Imprimir y en la lista desplegable Insprimir eliju Resumen.
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Un repaso a las prqpiédades del archivo

Dependiendo de cémo haya introducido las propiedades de archivo. verd un
cuadro de didlogo similar al que se muestra en la figura 4.27. En el cuadro
de didlogo Propiedades aparecerdn hasta cinco fichas. Las fichas se descn-
ben en los siguientes apartados.

Ficha general

La figura 4,27 muestra la pagina General de un documento de Word. El pro-
grama ha introducide la informacidn en esta ficha. La informacion incluye
lo siguiente:

Ficha Resumen

La figura 4.28 muestra la pagina Resumen, donde puede introducir infor-
macidn acerca del archivo para ayudarle a organizar el archivo v a locali-
zarlo mas tarde. Elija cualquiera de los cuadros de texto (Titulo, Asunto,
Autor, Director, Compaiiia, Categoria, Palabra-Clave o Comentarios)
introduzca el texto que desee. Aunque puede introducir mis caracteres, s0lo
podra ver 42 en cada uno de los campos excepto Comentarios. El campo
Comentarios tiene una drea de visién grande y puede utilizar ta barra de
desplazamiento vertical para ver mas texto del que cabe en el cuadro de hsta.

Ficha Estadisticas
La figura 4.29 muestra la pagina Estadisticas. Esta informacion le dice cudn-
do se creo su archivo, y cuando se modifico, se accedio a €l o0.se imprimio;

Item Descripcion

Nombre de archivo En la parte superior de {a ficha, el
nombre muestra asimismo un icono
que representa el tipo de programa.

Tipo: Tipo de archivo. Este ejemplo muestra
Documento Microsoft Word.
Localizacion: Nombre de carpeta que contiene al
< archiva.
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item

Descripcion

Tamano:

E! tamanio del archivo se muestra
tanto en KB {kilobytes) como en

bytes.

Nombre MS-DQOS:

El nombre convertido basado en los
seis primeros caracteres del nombre
del archivo, un punto, vy la extensidn
del tipo de archivo. Utilizara este

nombre si copia el archivo a un siste-

ma DOS:

Creado:

La fecha en que creo (o copid por
primera vez) el archivo.

Modificado:

La Gltima vez que guardo el archivo.

Usado:

St esta viendo el archivo en este
momento, Ia fecha de hoy.

Atributos: .

No puede cambiar estos atributos
desde el comando del programa
Archivo, Propiedades, pero si puede
modificarlos si introduce las propie-
dades a través del Explorador.

Atributo Sélo Lectura

Puede leer el archivo pero no guar-
darlo con el mismo nombre.

Atnbuto Archivo

Fl archivo ha sido modificado desde
[a dltimarcopia de seguridad

Atributo QOculto

El archivo estd normalmente oculto
de las listas de archivos.

Atrihuto Sislema

El archivio es un archivo del sistema

necesario para hacer funcionar ¢l sis-

tema operativo y no debe ser modifi-
cado.
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Fig. 4.28
Rellene la
pagina Resumen
de la hoja
Propiedades
para que le
avude a
encontrar o
administrar su
archivo.
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Fig. 4.29

La pagina
Estadisticas
muestra
informacion
acerca de
fechas, horas,
edicion y
longitud de
documento.

quién lo guardo por fitima vez; cudntas veces ha sido revisado. v cudl es el
tiempo total de edicion del mismo. Asimismo, Word incluye la longitud del
documento en paginas, parrafos, lineas, palabras, caracteres v bvtes.

= = Ficha Contenido
La informacién en la pagina Contenido depende del tipo de archivo que
tenga. Si el archivo es un archivo Excel. aparecerdn los nombres de la hoja
de cilculo o de los modulos. Si el archivo es un archivo PowerPoint. apare-
cerdan los nombres de cada diapositiva asi como informacion sobre el for-
mato (véase la fig. 4.30). Un archivo Word muestra sélo el Titulo de-la pagi-
nit Resumen.
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Ficha Personalizada

Si quicre crear sus propias propiedades, dispone de mucha flexibilidad con
la pdgina Personalizada. Puede aiiadir sus propios nombres de campo y
valores para cualquier prggiédud gue desee (véase la figura 4.31).
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Para agregar sus propias propiedades, siga estos pasos:

1. Elija Archivo, Propiedades.

2. Pulse sobre la ficha Personalizada.

3. Escriba el nombre de su campo en el cuadro de texto Nombre o elija
entre uno de los mads de 20 nombres de campos del cuadro de lista des-
plegable. Incluidos en la lista desplegable hay items como Comprobado
por. Depurtamento. Origen y Registrado por.

4. Einu el tipo de dato de la lista desplegable Tipo/. Los tipos inctuven
Texto. Fecha. Nimero. y Si o No.

5. Escriba un Valor en el drea Valor o elija St o No (si el tipo de dato es Si

o No. verd tinicamente opciones Si, No). El valor tiene que coincidir con
¢l tipo de dato.

Si activa la casilla de- verifi caClén Vinculor Contemdm o Ia pagina de
" Personalizado, el cuadro de Valor tendrd’ unia-lista’ desplegabie de donde
podra elegir items dentro del documentg:: a wnculaf, tales como un marca-
dor en Word 0 una celda con: nombre en Excel :

D R
. PN

p——

6. Elija ¢l botén de comando Agregar.

7. Repita los pasos 3-6 para mds campos.

SOLUCION DE PROBLEMAS

!

No veo cinco tichas en mi hoja de Propiedades.

Asegurese de que estd usando ¢l archivo original, y no un nombre abreviado,
cuando mne las propiedades de archivo.

Necesito asociar mis documentos con numeros de cuenta.

. Abra el archivo v elija Propiedades de Archive v pulse sobre la ficha
Personalizado. Pulse sobre el cuadro de texto Nombre y escriba Numero de
Cuenta. Fhija un Tipo v escriba el nimero en el campo Valor.
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Fig. 4.31

Un conjunto
personahzado
de propredades
Word puede
mcluir la
nrormacion
adicienal que
necesita para
gestionar sus
documentos.
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Fig. 4.32

B cuadio de
thalogo
fprim e
permite
especicar lo
que guiere
IMDEEMIT ¢ on
Mmas detaile

Cémo imprimir documentos

Para impnmir o ver una presentacion preliminar del documento en curso.
puede utilizar comandos de mend. botones de barra de herranmientas. o teclas
de método abreviado. Como se menciono en un apartade anterior. puede
imprimir uno o mds archivos pulsando con ¢l botdén derecho del raton en un
nombre de archivo del cuadro de didlogo Abrir v cligiendo después el
comando Imprimir.

Cémo imprimir todo el documento o parte del
documento

Para imprimir el documento en curso. elija el comando Archivo, Imprimir,
presione’ <Control> + <P> o pulse sobre el boton |[Imprimir| de L barra de
herramicntas Estandar.

Si usa el boton [Imprimir] o la tecla de método abreviado. se impnimiri el
documento entero. Si utiliza el comando del mend. aparcceri un cuadro de
+ didlogo similar a la figura 4.32. presentando mds opciones.

Las opciones en el cuadro de didlogo Imprimir le permiten imprimir el docu-
mento entero. la pigina en curso, piginas especificas o texto seleccionado.
También puede especilicar el ndmero de copias a imprimur. En ¢l cuadro de
texto Paginas en Word o en el cuadro de exto Diapositivas cn PowerPoint.
puede saltarse pdginas (puede teciear 1-2. 4-7 o sencillamente 13- para
impnmir desde la pagina 13 al final del documenton.
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Como modificar las opciones de impresion

S1yuere realizar opciones de impreston adicionales. use el cuadro de didlo-
2o Preparar Pigina, mostrado en ta figura 4.33. Las opciones en este cuadre
de didlogo e permiten fijar mdrgenes. imprimir encabezados v pies de piai-

na. especificar la orientacion de lu i impreston y modificar los parametros de
la impresora. 3
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Aplicacion Comando de Menij

Word Archivo, Preparar Pagina
Excel - Archivo, Preparar Pagina
PowerPoint Archivo, Preparar diapositiva

Para modificar mdrgenes. tamano de papel y otras funciones. use el siguien-

te comando:

Para cambiar [a impresora. elija una impresora de la lista desplegable en [a
seccion Impresora del cuadro de didlogo lmprimir.

Tabla 4.5 Opciones de Presentacion preliminar -

Fig. 4.33

Puede
especiticar
opciones de
Impreston
adicionales en
el cuadro de
didlogo Preparar
Fagina de Excel

Opcion Word Excel
Modificar margenes X
Ver Regla (para cambiar X

margenes, sangrias y tabulaciones)

\umentar/Zoom X X
Zoom en direrentes tamanos X

Paginas muitiples X

Ajustar & X X
Imprumi X X
Echicion X

Sigiente dr a2 la pagina siguientel X
Anterior ur a la pagina anteriori X

Preparar Pagina X

ur al cuadio de
didlovo Preparar Pagma)
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Fig. 4.34

La Presentacton
prelimimar de
Word puede
mostrar mas de
una pagina a la
vez

Fig. 4.35

Puede modificar
los margenes v
visuahizar un
documento en
la Presentacion
preliminar de
 Excel

Como usar la Presentacién preliminar

Aunque su pantalla muestra lo que verd en la pagina impresa. Word y Excel
tienen una opci6n Presentacion preliminar que le permite ver la pagina
entera (o mds de una pagina), incluidos los encabezados vy pies de pdgina.
nimeros de pigina y mdrgenes. Para entrar en Presentacién preliminar
elija el comando Archivo, Presentacion preliminar. La tabla 4.5 muestra
las funciones disponibles mientras se estd en modo de presentacién prelimi-
nar.

La figura 4.34 muestra la Presentacion preliminar de Word. v la 4.35 la
Presentacion preliminar de Excel.

Para modificar mdrgenes, pulse sobre el boton Mdrgenes o {Ver Reglal.
mueva el puntero del ratén a la parte superior o lateral hasta que cambie a
una doble flecha negra y arrastre el margen. Para aumentar. pulse sobre ¢l
botén [Aumentar] (Word) o Zoom (Excel) y pulse sobre el documento en
donde quiera aumentar. Para desactivar el aumento, pulse sobre el docu-
mento otra vez. En Word, para editar el documento, pulse sobre el boton
[Aumentar] para desactivar el aumento y activar la edicién. En Excel. para
usar Ajustar a, elija el botén Preparar Pagina, pulse sobre la ficha Pagina
y elija Encajar en y rellene los cuadros de texto Ancho por Alto de la
Pagina(s).
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Conmutar entre documentos

Cuando abre mds de un archivo a ta vez, tiene una ventana para cada archi-
vo. puede conmutar entre documentos abiertos de cualquiera de las siguien-
tes maneras:

M Elija el documento abierto en la parte inferior del ment Venfana.

W Pulse <Control> + <F6> para desplazarse por los documentos abiertos.

B S: partes de un documento son visibles en pantalla, pulse sobre el que
quiera ver. Si un documento csta minimizado. tal y como se muestra en
la f1gura 4.36, realice una doble pulsacion en su icono.

AR Lo~ TS Scfr 7l 2 ol X F et BE TN AL TR E N

Si quiere copiar informacion de un documento a otro, puede mantener visi-
bles dos 0 mads ventanas. En Word. Excel y PowerPoint puede utilizar la fun-
c1on arrastrar y colocar para mover o copiar items de una ventana de docu-
mento ¢ otra. Para mover. sélo pulse v arrastre el item a otra ventana: para
copiar, mantenga presionada la tecla <Control> mientras arrastra.
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«VEASE “Conmutar
entre programas”,
pag. 38

Fig. 4.36

Fn Word u otra
aplicacion
cualguiera,
pulse sobre ef
boion Minimizar
para reducir el
documento a un
icono: realice
una doble
pulsacion en el
iono para abrir
el documento.

Fig. 4.37

En Word, elija
Ventana,
Organizar Todo

fara organizar
las ventanas de
los documentos
cn 1orma
hortzontal.
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Fig. 4.38
tn Excel. elna el
comando
Ventanag,
Organizar, En
Mosaico para
presentar ias
ventanas en
cuadrados de
wual tamano.

Fig. 4.39 -

Fn PowerbPoint,
elija el comando
Ventana,
Cascada para
apiiar Jas
ventanas e
diocumento,
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W En Word. elija el comando Ventana, Organizar todo. paru visualizar
los documentos tal y como se muestra en la figura 4.37, .

B En Excel. elija el comando Ventana, Organizar. Apareceri un cuadro
de duilogo, preguntindole como quiere organizar las ventanas. La
opcion en Mosaico presenta las ventanas ¢n pequeiion rectingulos
vease la fig. 4.38). Honzonl'ol presenta las ventanas cn filas (como
Waord). Vertical las muestra en columnas. Cascada apila las ventanis.,
dejando ver Las barras de titulo de cada una de las ventanas,

B L'n PowerPuint. elija ¢l comando Ventana, Organizar Todo para pre-
sentar los documentos en forma de Mosaico. También puede elegir cl
comando Ventana, Cascada para apilar las ventanas, mostrando las
burras de titulo de c?da una de las ventanas.

Cuando varios documentos estdn visibles. una barra de titulo oscura indica
gud ventand estd activa, Para activar otra ventana. pulse sobre ella. Para
mostrar una de las ventanas a pantalla completa. pulse sobre el boton
Mauximizar o realice una doble pulsacion en la barra de titulo.
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Aplicaciones .

por jeff Bankston ~'.'

Las aplicaciones de Microsoft Oftice le ofrecen una serie de entornos va-
riados v divergentes para llevar a cabo tareas comerciales. El cuaderno que
unifica todos estos entornos es OLE 2.0 (vinculacion e incrustacion de ob-
jetos) v ¢t programa que controla OLE 2.0 es Visual Basic para Aplica-
ciones (VBAJ. VBA es un entorno de programacion que sera finalmente
el lenguaje de-macro para todas las aplicaciones de Microsoft Office. OLE
¢s una extension del entorne Windows que permite vincular una aphca-
cion al archivo de datos de otra aphicacion directamente en su propio ur-

“chivo de datos. La combinacion de archivos de datos es una poderosa he-
rramienta que podra utilizar en VBA.

En este capitulo aprenderi a:
B Comprender Visual Basic para Aplicaciones
B Comprender la diferencia entre Visual Basic para Aplicaciones y olros
tenguujes Basic
B Utilizar Visual Basic para Ap-hcaci(me.s para automatizar tareds
8 Crear pequenos programas en el lenguaje Visual Basic para Aplica-
ciones

_6mo comprender Visual Basic para
\plicaciones

Visual Basic para Aplicaciones e un entorno de programacion.basado en
el lenguaje de programacion Visual Basic para Windows. VBA ocupa el
lugar de fos rudimentarios lenguages de programacion de macro que se en-
cuentran generalmente en las aplicaciones.

Ademuis de ser una poderosa herramients para desarrollar aplicaciones,
VBA busca conciliar la diferencia entre la facilidad de los lenguajes de
macro v {a necesidad de lenguajes de programacion orientados a objetos.
Los nuevos usuarios pueden grabar sus acciones v crear macros sin nece-
sidad de aprender las complejidades del lenguajé8De hecho. grabar accio-
nes v observar luego el codigo grabado es la forma mds ficil de empezar
a aprender VBA por su cuentit.
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En la actualidad, en Microsoft Office para Windows 93. VBA se encuen-
tra por completo desarroilada unicamente en Excel. Word contiene su pro-
pio lenguaje de programacion, llamado Word Basic. que es un poco dis-
tinto de VBA. PowerPoint no contiene un lenguaje de programacion.

Microsoft planea integrar a largo plazo VBA en todas sus aplicaciones
principales, incluyendo MS Access para Windows 95. Microsoft ha mar-
cado ya el comienzo con la difusion actual de sus productos. Dado que
VBA se implementa en otras aplicaciones. podra usar los procedimientos
desarrollados aqui en las otras aplicaciones con muy pocas © casi ninguna
modiftcacién,

Comprender los objetos

p VEASE “Como
vincular una ho-
ja de cilculo de
Excel a un docu-
mento de Word”
pag. 90.

» VEASE “Como
vincular datos
entre hojas de
calculo de Ex-
cel”, pag. 90.

La diferencia entre Visual Basic para Aplicactones v otros lenguajes de progra-
macion Basic radica en que VBA esta onentada para objetos. Ya ha visto obje-
tos en accion dentro de Microsoft Office. En el Capituio 30, "Comeo trabajar con
Asistentes, miltiples documentos, cortar, copiar y pegar”, ha incrustado grafi-
cos (objetos grifico) y rangos de Excel (objetos rango) en los documentos de
Word. Estos objetos saben como manipularse y mostrarse a si mismos, incluso
cuando estin incrustados en un documento de otra aplicacion. Visual Basic pa-
ra Aplicaciones aprovecha estas capacidades para controlar estos ohjetos.
Visual Basic para Aplicaciones utiliza un modelo de programacion orien-
tado al objeto. Si comprende los programas ortentados a objeto (OOP). Ie
resultard sencillo entender el uso que VBA hace de ellos. Si no sabe como
funcionan estos programas. no s preocupe, ya que el concepto no es tan
comphicado como parece.

Los ohjetos VBA representan una forma conveniente de almacenar y ocul-
tar datos v codificar un programa. En lugar de escribir un programa para
manipular algunos valores de datos. encapsula los datos v el cadigo que
los manipula dentro de un objeto. A parur de ello. solo deberd acceder al
objeto para uulizar o ver los datos.

Puede ver esia capacidad en accion cuando incrusta un objeto de una iph-
cacion en otra. El objeto incrustado se autogobierna v ¢l objcto en el gue se
incrusta tan solo debe otrecer al objeto incrustado un lugar para despiegar-
s¢. Cuando  adjunta un boton de Visual Bidsic a una hoja de célculo. por
cjemplo. la hoje de calculo no necesita saber como hacer funcionar el bo-
ton cuando pulsa -el boton se ocupa de cllo.

En cadigo. hace casi lo mismo. No intente manipular [os datos de un ob-
Jeto directamente. envie mensajes al objeto v deje que éste haga el trabajo.
Los objetos VBA incluyen botones. ftems de mend. rangos de celdas de ho-
Ja de caleulo ¢ incluso una hoja de cdiculo. es decir casi todo lo que pue-
de ver en pantalla mientras una aplicacion se estd ejecutando en un objeto.

Comprender objetos en Visual Basic para
Aplicaciones  ~

Podri visualizar los objetos de Visual Basic como una seric de contene-

—
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_dores (véase la figura 35.1). El contenedor mas grande es el objeto Apli-
cacion. que es el programa gue estd ejecutando actualmente. como por
ejemplo. Excel. En Excel. el objeto Aplicacion contiene objetos Mends.
objetos Control. objetos Libro de Trabajo. etc. Dentro de los objetos Libro
de trabajo se encuentran los objetos Hojas (hojas de calculo. hojas de ma-
cro. hojas de médulos. hojas de didlogo. etc.) y dentro de los objetos Ho-
ja se encuentran los objetos Rango (rangos de celda). Otras aplicaciones
contienen objetos similares para cubrir sus necesidades especificas. Véa-
se fu documentacion v avuda en pantalla para las diferentes aplicaciones
de Microsoft Office para acceder a una lista de los objetos que conticnc
cada aphicacion.

Fig. 35.1

Haojas
Modulos de hoja Hojas de didlogo Fl modeio obieto
Visual Basic para
Mends Anlicaciones,
contenedores
dentro de
Libro de e Libro de contonedores.,
trabajo T trabajo
_____:_ . e .
Aplicacion

Las celdas individuales no son objetos en Excel, pero se accede a ellas co-
mo objetos Rango que a su vez contienen una celda o un rango de celdas.

Como acceder a objetos

Para tener acceso a un objeto especifico de Visual Basic para Aplicacio-
nes. deberd comenzar con el objeto contenedor mis externo, seguido por
un punto. seguido por el siguiente objeto contenedor del interior. seguido
por un punto. etc.. hasta alcanzar el objeto deseado. Para acceder a la cel-
da BS en una hoja de cdleulo de Excel cuvo nombre es Hoja3 en un libro
de trabajo denominado Libro2. por ejemplo. ppdria utilizar la siguiente
referencia: '
Application Workbookse " Libro2” | Worksheetst "Hoja3” ).Range( " B5™ )
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Dado gue Visual Basic para Aplicaciones trabaja con objetos. cada apli-
_cacion que registra su objeto con el sistema operativo de Windows pone
dicho objeto a disposicion de Visual Basic. Por eso. incluso si estd ejecu-
tando Visual Basic para Aplicaciones en otra aplicacton, podrd acceder a
un objeto en Excel casi de la misma forma en que lo haria si estuviera tra-
bajando en Excel. La dnica diferencia radica en que debera incluir el nom-
bre que utilizan las otras aplicaciones cuando se registran para especificar
el objeto Aplicacion a usar. Por ejemplo, puede utilizar la siguiente refe-
rencia en Project para acceder a una celda en Excel:

Excel Application. Workbooks( "Libro2” ) Worksheets( "Hoju3" ).Ran-
gel "BST ' -
Esta referencia puede resultar demasiado lirga. por lo que Visual Basic pa-
ra Aplicaciones realiza una suposicién gue le permitird omitir algunos
contenedores. Para cada contenedor no incluido en fa parte 1zquierda de la
referencia a un objeto (como por ejemplo la referencia al libro de trabajo
o a la hoja de cdlculo). Visual Basic para Aplicaciones presupone que el
objeto actualmente activo de este tipo es ¢l que estd siendo referenciado.

-

Por eso. podrd casi siempre omitir la aplicacion. asi como también el hi-
bro de trabajo. Sin embargo. deberd tener cuidado y-asegurarse de cuales
son os objetos activos antes de omitirlos en la especificacion. Omitir los
contenedores agiliza sus procedimientos, Si omite todo pero conserva el
objeto Rango. su codigo siempre se aplicard a la hoja actualmente activa,
por io que no deberd cambiar ¢l nombre de la hoja para aphcar su codigo
a una hoja diferente. Ademas de las hojas y libros de trabajo n()mbrddos
podri usar los objetos ActiveWorkbook. ActiveWorksheet. ActiveCell
para referenciar los objetos actualmente activos sin necesidad de conocer
sus nombres. :

Recuerde que si utiliza nombres de libros de traba]o y hojas especificos en
sus procedimientos, éstos funcionaran sélo en esos libros de trabajo nom-
brados y procedimientos. Al omitir parte de una especificacién de objeto,
hace que el codigo pueda aplicarse a todos los objetos de la misma clase
gque ha omitido.

Comprender clases y colecciones

Una ¢ fuse de objetos es una reterencia a un tipo o clasificacton general de
objetos. En Visual Basic para Aplicaciones. por ejemplo. cada celda o ran-
go de celdas en una hoja de cdleuto es un objeto Range. gue es un gjem-
plo de Ja clase Range.

Si combina todos los objetos de una clase especifica en un grupo. ese gru-
po se denomina cofeccidn. Por eso. todos los libros de triabajo en el obje-
to Application estin en la coleccion Workbooks. y todas las hojas de cil-
culo dentro de un libro de trabajo, se encuentran en fa coleccion
Worksheets. De esta forma. todas las hojas de cilculo estin en la colec-
cién Sheets. 1o que incluv@todos los tipos de hojas (hojas de cilcuto. de
grafico. de madulo v de didlogo) dentro de un libro de trubajo.
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Como acceder a colecciones

Las colecciones le permitirdn acceder a fa mayoria de los objetos. Para ac-
ceder a miembros especificos de una coleccion. coloque después del nom-
bre de la coleccion ya sea una cadena que contenga el nombre del c_)bjeto
o un ndmero entero entre paréntesis. Por lo tanto. Worksheets(“Hoja1”),
se refiere a la hoja denominada Hoja1, mientras que Worksheets{2) se re-
fiere a la segunda hoja de cdlculo de la.coleccién compuesta por todas las
hojas de célculo del libro de trabajo activo. Si desea acceder a la celda B.S
en la tercera hoja de cdlculo dentro de un libro de trabajo denominado Li-
bro2, podra utilizar la siguiente referencia:

Workbooks/{"Libro2”).Worksheets(3).Range{"B5")

Si omite el nimero v el paréntesis cuando referencia una coleccion., la re-
terencia se establece para todos los miembros de la coleccion.

Atencion |

Tenga cuidade cuando whliza ndmeres para seleccionar abjolos e
una coleccion. Si agrega o elimina miembros de una coleccion, la
numeracion de todos los otros miembros de la coleccion puede
cambiar v su numero podria seleccionar un objeto diferente.

Comprender las propiedades

La intormacion de un objeto es lo que se denomina propiedad de un obje-
t0. L.u mavoria de las propiedades son legibles. aungue no todas pueden
escribirse o modificarse. Véase el apartado acerca de la ayuda en pantalla
de Visual Basic para Aplicaciones para obtener una descripcion de cad
una de las propiedades. En la descripcion de cada objeto encontrard una
lista de fas propiedades aplicables al mismo.

Para un objeto del tipo Range (una o mis celdas de hoja de cadlculo), ia :
- Lo s > - Consejo

fuente. ¢l color. el tamafio de fuente, el contenido. etc. son propiedades de -

lectura/escritura, pero su ubicacion es solo de lectura (las celdas no se des- } Cada obyeto tiene pro-

! predacies de tamano,

plazan). Las propiedades pueden refenirse a la informacién directa conte- '
l torma v color.

nida en un objcto. como por ejemplo el valor de una celda o a los vaiores
de datos que controlan el aspecto y comportamiento de un objeto. como
por ejemplo el color.

Los valores de propiedad pueden ser cadenas de texto. de nimeros. cade-
nas logicas {True o False) o listas enumeradas. Una lista emumerada es
una hista de opciones numerada. en la que el niamero se unliza para selec-
clonar una opeion especifica. Por ejemplo. la propiedad Color de la ma-
voria de los objetos es una hista enumerada en la que 0 es igual a ningin
-color, | es negro. 2 es blanco. 3 es rojo. 4 es verde. 3. es azul, etc.

Para las listas enumeradas. VBA v las otras aplicaciones en Microsoft Of-
fice contienen listas de constantes predefinidas para utilizar en lugar de
numcros. Usar las constantes resulta mucho nfs informativo que utilizar
los mimeros. Las constantes aplicables a una propiedad se encuentran lis-
tadas en la descripeidn de las propiedades en |la avuda en nantalla. Podri



706 | Cimo incciar Yisua! Basic para ApNicaciones

acceder a una lista de constantes buscando constantes o variables en la
avuda en pantaliz v seleccionando los temas “Resumen de palabras clave
de variables y constantes” y “Constantes de Visual Basic™.

. Cémo acceder a las propiedades

La manera mas sencilla para saber qué propiedades establecer v a qué va-
lores. es iniciar la Grabadora de macros, realizar los cambios, detener lu
grabadora v copiar en su programa los cambios de propiedad grabados.
Tanto Excel como Word cuentan actualmente con grabadoras de macro.
La sigwente es la sintaxis gue le permite acceder a las propiedades de un
objeto
objeto.propiedad
En este ejemplo. “objeto” es el objeto cuyas propiedades desea modificar
o ver y “propiedad” es el nombre de la propiedad. Si la construccion an-
tenior estd en el lado derecho de la instruccidn, estd levendo el valor de la
’ propiedad desde el objeto. Si la construccion se encuentra en el lado is-
quierdo de la instruccidn, esta estableciendo el valor de la propiedad. Pa-
ra establecer el valor de la propiedad Formula (el contenido de lu celda)
- - de la celda BS en =ABS(B4) cuando BS estd en la hoja de catculo Hojal
(dentro del libro de trabajo Libre2), podrd utilizar fa stguiente instruccion

WorkBooks(“Libro2”).WorkSheets{"Hoja1”).Range("B5").Formula =
”=ABS[B'4) " 3

Para leer la musma propiedad desde la celda v almacenarla desde [a mis-
ma celda en fa vanable miFormula, podré utilizar la instruccion:

miformula =

WorkBooks(“Libro2”},WorkSheets(“Hoja1”).Range{"B5”}.Formula

Aqui se aphican las reglas que conciemen a la omision de objetos de los
contenedores {descritas en "Cdémo acceder a los objetos™ antenormente en
este capitulo). Dado que debe incluir un objeto con la propiedad. no po-
dra omutir el objeto Range para obtener 1a formula en cualquiera que sea
la celdaactiva Para este caso u orros similares que traten objetos. algunas
propiedades especiates devuelven el objeto actuaimente activo o seleccio-
nado. La tabla 35 | lista estas propiedades especiales.
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Propiedad Descripcion

ActiveCell La celda activa en la ventana activa

ActiveChart El grifico activo en un libro de trabajo

ActiveDialog La hoja de didlogo activa en un libro de tra-
bajo

ActiveSheet La hoja de célculo, grifico. médulo u hoja
de didlogo activa en un libro de trabajo

ActiveWorkbook El libro de trabajo activo en una aplicacicn

Selection Et objeto actualmente seleccionado en la

hoja actualmente seleccionada

Atencion |

Asegurese de que un ohyeto del upo esperado sea el objeto acti-
v antes cle intentar usar las propredades activas, como por efem-
plo ActiveSheet, en un procedimiento. St un objeto del tipo espe-
cificado no es un ohjeto activo, estas propiedades no devolverdn
nada v es posible que el procedimiento que las utilice fracase.

Para obtener la formula contemida en la celda acuva de la hoja de cédlcule
Hojad, por cjempio. podrd unthzar la siguwiente insiruccion:
miFormulo =

WorkBooks(“Libro2”). WorkSheets{"Hoja1”).Range(“B5").Active-
Cell.Formula

Si Libro2 1 Hoja2 son el libro de trabajo v la hoja de cdlculo activos ac-
tualmente. podrii usar la instruccidn,

miFormula = ActiveCell.Formula

Si Libro2 e el Iibro de trubajo activo pero Hoje3 no es necesariamente fa
hoja de cdiculo activa, podrd utihizar Ta siguente instruccion:

miFormulc -~ WorkSheets|{“Hoja3"). ActiveCell. Formula

Si desea acceder a te celda BS en cualquier hoja de cdlculo activa en Li-
bre2, podri utthyar la sigurente instruccion:

miFormula = Workbooksi{“Libro2"}. ActiveSheet.Range(“B5”).Formula

Todo lo gque ~w encuentra a ks 1izquierda del dlimo punto debe ser consi-
derado como pante de un objeto o una coleccion de objetos.
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Comprender los métodos

fos miérodos de Visual Basic para Aplicaciones son blogues de cédigo al.
macenados en un objeto que saben como manipular los datos del obeta,
Para un objeto Range, por ejemplo. el método Calculate hace que ¢ vuej-
van a calcular las férmulas de las celdas seleccionadas v ¢l método Clear,
borra el contenido de la celda. Los métodos actian sobre los objetos v des -
datos que éstos contienen. en oposicion a las propiedades que establecen
valores. Para aprender mds acerca de los detalles especiticos de los dife-
rentes métodos ¥ para descubrir qué método se aplica a cada objeto, véa-
se ¢l apartado de ayuda en pantalla de Visual Basic para Aplicaciones

Coémo acceder a los métodos

Accede o gjecula tos métodos de un objeto casi de la misma forma en que
accede a lay propiedades de un objeto. La diferencia principal radicu en
gue siempre accede a una propiedad como parte de una formula. pero un
método deberd ser parte de una formula sélo «i devuelve un vator. Ef md-
todo Rows, por ejemplo. devuelve una coleccion yue contiene 1odas las 13-
las del rungo. Para usar este método a fin de cstablecer la propiedad Row-
Height de todas las filas del rango actualmente seleccionado en 20, utilice
una formula come la sigutente:

Selection.Rows.RowHeight = 20

Para obtener el numero de filas de la seleccidn actual, podrd usar el mé-
todo Rows para devolver una coleccion y la propiedad Count para devel-
ver el mimero de items en la coleccion, tal y como se muestra a continuu-
cion:

numFilas = Selection.Row.Count

Algunos imétodos requieren argumentos para que funcionen Por ejemplo,
¢l método Insert, cuando se aplica a un objeto de upo Range, necesita de
un argumento que le indigue cdmo mover las celdas que ya estdn en la se-
leccion El mérodo Rows necesita un nimero indice para seleccionar una
solu fila en la coleccidn de filas. Dado gque el método forma parte de un
tormula. el argumento deberd ir entre puréntests. Para obtener ¢l alto de fi-
la de la segunda fila en la colecaion de filas, podri utilizar la siguiente ms-
truceion; s

AltodeFila = Selection.Rows(2).RowHeight

S el médo esti so6lo siendo ejecutado vy no forma parte de una tormula,
cologue oy argumentos a la derecha de la referencia al método. Para uni-
lizar ¢l métodu Insert a fin de insertar celdas vacias en la seleccidn actual
v desplazar la seleccion hacia abajo para crear espacio. podrd usar esta
senienesy

Selection.Insert x1Down

Ll argumento e~ en realidad un nimero entero, pero la constante incorpo-
rada se utthza aqui para que el cédigo sea mas legible. Puede ubtener las
constantes incorporadas que se aplican a un método en la descripoion def
método de la avuda en pantalla o puede buscar coustantes o vartables en

65



(dms crear procedimientes con 12 grabadura de macres 709

ta avuda en pantalla y seleccionar los temas “Resumen de palabras clave
de variables y constantes™ y “Constantes de Visual Basic™.

Coémo crear procedimientos con la
grabadora de macros

La forma mas conveniente de aprender a usar Visual Basic para Aplica-
ciones es crear procedimientos con VBA, usando la Grabadora de macros.
Cuando activa la Grabadora de macros y crea una hoja de cdlculo. la gra-
. badoru escribe el cédigo de Visual Basic que realiza las mismas acciones
yue huce a4 mano, Examinado el cddigo, podrd aprender a utilizar VBA
para acceder v modificar los objetos de una aplicacion,
En tos sigutentes apartados, creard una simple hoja de cdlculo que caleu-
la el impuesto sobre el costo de un item v luego calcula el costo total. La
hoja de cilcuio tiene una celda de entrada y dos celdas de salida calcula-
das. la celda de entrada acepta un costo v las celdas de salida muestran ef
mpucsto v el costo toal.

Como iniciar la Grabadora

Para preparar la hoja de cilculo y abrir el cuadro de didlogo Grabar nue-

VA MUCTO. SiZa estos pasos:

1. 51 adn no lo ha hecho. Inicie Excel

2. Abra un nuevo hibro de trabajo cligiendo Archivo, Nuevo, seleccione
Libro de trabajo v pulse en | Aceptar, |

3. Elija Herramientas, Grabar macro, Grabar nueva macro v luego
eliga el boton Opciones. Aparecerd el cuadro de didlogo Grabar nueva
nucro (véuse la figura 3523

4. En ¢l campo Nombre de o macro, escriba ImpuestoCifra.

3. En el campo Descripeion, escriba esta linew:
Creoar una hoja de cdlculo para calcular el impuesto sobre un item

6. Deje los otros campos con los vaiores por defecto que se muestran en
la figura 35 2 v elija [Aceptar. )
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Fig. 35.2

El cuadro de
didlogo Grabar
nueva macro le
permite
establecer el
nombre v otras
OpCIONes ara
un nuevo
procedimiento

p VEASE “Como in-

troducir datos”, pag.

305.

» VEASE “Como se-

feccionar celdas v
rangos”, pag 309,

p V[ ASE “Como ior-

matear numeros”,
pag. 4t
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El botdn [Detener macro] aparece en una barra de herramientas tlotante
la Grabadora de macros graba lo que hace. registrando todas las pulsa-
ciones de tecla y pulsaciones del ratén hasta que pulse en el botén [ Dete-
ner macro.}

Cémo grabar un procedimiento

Para crear un procedimiento basta con crear la hoja de cilculo como sue-
le hacerlo. Paru crear una hoja de cdlculo, siga estos pusos:

1.

i

f SO

~ o tn

Seleccione la celda B4 y escriba Costo.
Seleccione la celda BS v escriba Impuesto.

. Seleccione la celda B6 v escriba Total.

. Seleccione lu celda C4 y escniba 12,43,

. Seleccione la celda C5 v escriba =C4*0.0825

. Seleccrone la celda C6 y escriba =C4 + C5

. Seleccione la celda C4. elija Formato, Celdas v seleccione la ficha Nui-

mero Seleccione el npo de formato Moneda. seleccione el formuto -
$1243,10 v ehja [Aceptar] Repita este paso con la celda C6. Repita
este paso con la celda C5, pero utilice el formato Namero.

. Seleccione la celda C3. elija Formato, Celdas y seleccione la ficha

Bordes.

. En el cuadro de didlogo Bordes. en su parte 1zguierda pulse en Infenior

para ¢) emplazamiento del borde v en la zona derecha. pulse en el cua-
droanfenor 1zquierdo para el estilo. Pulse en [Aceptar| para continuar.
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La hoja de cdlculo deberd parecerse ahora a la que muestra la figura 35.3

Fig. 35.3

La hoya de
cdlculo
terminada antes
de desactivar la

< Grabadora de
e TR B v | i e [ R T | YR i T
=% TA i BT Pl B RRRE G | A i e e mﬁl macros {bserve

N Microaet L uc er tehin?

I

2 j en el lado

3. B derecha el hotén -
4] Coste 12 Bt i Detener

5 Impestos £ |Detene

5] Total 73 i grabacion |
6 "

7 X

ER G

01 4

[ 12 § u

.13 1 ¥ .
1R o Detener grabacion
51— - i - . 5

hid E

18 -l

o | =

S E) wiee

La barra de estado indica que
la macro se estd grabando

Como detener fa Grabadora

Detener la grabadora es una tarea sencilla: simplemente pulse en el botén ‘ B
Detener macro.

Como examinar un procedimiento

Para examinar el procedimiento creudo recieniemente, busque la ficha
Modulo T situada en la parte inferior de |a pantalla ¥ pulse en ella. Su pro-
cedimiento aparecerd en pantalla v deberd parecerse al de 1a figura 35.4,
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Fig. 35.4

La prabadora de
macros de Excel
coloca los
comandos
grabat:os £ un O

madcule, 1al v Y Tmpuest: Hacio
COMO se muestra YoMArra grabads 13704756 poar Salwvader O, Rubin

aqui para ¢ .
procedimiento Sub Impuestol)

derivecall . FormulaRlCl = "Coste”™
Range ("B53" .Select

Attivesell FormulaRiCl * "Impuestoa™
Fange=!"B5") .SelecT

Atrivele]l, FormulaRlCl * “Toiml™
Range 47k, Select - L
AtLiveCel!, FormulaRict = =12 42°
Fange i"C5Y) Select I
ActivaCel. . FormulaFlll = ==F,-1]C*0.0825" .
Range “C6") .Select -
ActivaCe]ll FoermulaRlll = "=R[-2])C+R[-1]C"

Fange (“T4") ,Selact

Selection. Nwunberforiwar = “§, 880 §°

Fang= ("C¢") , 5elect wl

PP

Impuesio
Cura

AT

Consejo L.a lista de los procedimicntos se muestra en la lista 35.1

Pt eidrens para cada Lista 35.1 El procedimiento ImpuestoCifra
modulo y proced- '

miento sc aimacena | ' i
demre de Ja hojade Impues ifra Macro :

coleulus e cuarda ' Crear una hoja de calculo para calcular el impuesto scbre un item.
conelio Siviene pro- '

blenas para compren-
aer aleun codigo, bus-
cuelo en Edicion

Sub impuestoCifral)

Especal or camo Range({"B4") Select

Lvar Visual Rase de .9 '

1o petonal Prennice AChV&C&H.FOﬂ'ﬂUIGR] c‘ - "COSfO"

sl Range("B5").Select
ActiveCell.FormulaR1C1 = "Impuesto"
Range("B4").Select
ActiveCell.FormulaR1C1 = "Total"
Range({"C4"}.5elect

ActiveCell FormulaR1C1 = "12.43"
Ronge{"C5").Select

ActiveCell.FormulaR1C1 = "=R[-1]C*0.0825"
Range{"C6"].Select

ActiveCell. FormuloRYCT = "=R[-2]C + R[-1]C"
ReinglCA™, Select,

Selection.NumberFormat = "$#, ##0.00"
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Range("C6").Select
Selection.NumberFormat = "$#,##0.00"
Range("C5").Select )
Selection.NumberFormat = "0.00"
Selection.Borders(xlLeft).LineStyle = xINone
Selection.Borders{xIRight).LineStyle = xINone
Selection,Borders{x{Top).LineStyle = xINone
With Selection.Borders(xIBottom) -

Weight = xiThick

.Colorindex = xiAutomatic
End With
Selection.BorderAround LineStyle:=xINone _

'End Sub

St observa esta lista y la compara con los pasos antériores. podrd ver que
cada paso corresponde a una o mas lineas de cédigo insertadas en el pro-
cedimiento. Existen también muchas lineas adicionales en el procedi-
miento. son las que establecen los parametros que no ha establecido de
forma explicita al crear su hoja de cdlculo. Estas lineas adicionales apare-
cen cuando elige [Acepiar] en un cuadro de drdlogo que establece varios
pardmetros. Aunque modifigue sélo un pardmetro en el cuadroe de didlo-
20, al cerrar el cuadro se ajustan fodos los parimetros que se muestran en
el cuadro v se insertan fas lineas correspondientes en el procedimiento que
extd grabando.

En el cuadro de didlogo Bordes, por ejemplo, ajusta s6ld la opci6n Inferior
{paso9}, pero se insertan 8 lineas en el procedimiento, que establecen los va-
lores de todas fas otras opciones. En muchos casos, podrd eliminar las |fne-
as adicionales del procedimiento sin modificar sus resultados. -

El procedimicnto aparece en color. con los comentanos en verde. las pa-
labras clave en azul v todo lo demas en negro. La barra de herramientas de
Visual Basic aparece flotando en la pante derecha de la ventana del proce-
dimiento. La barra de herramientas puede aparecer flotando o anciada en
cualquiera de s lados. La figura 355 muestra la funcién de cada boton
de la barra do ¢ -ramientas de Vicual Basic Los primeros tres botones. de
izquierda a derecha, son Insertar mddulo. Exammador de objetos v Edi-
tor de memis, Los siguientes cinco botones sirven para ejecutar y manipu-
lur modulos ¥ los cuatro altimos pard depurar méduios.
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Fig. 35.5

La barra de
herramientas de
Visual Basic
contiene
controles para
gjecutar v
depurar un
programa

Fig. 35.6

£l cuadro de
didlogo Macro le
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seleccionar v
crecutar
procethmientos
{ste cuadro de
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ademas una
trp sengiila
e docahizar,
editar o ehnunar
provedinichios

Insertar modulo  Examinador de  Ejecutar macro  Detener  Alternar punto
| objetos grabacidn  de interrupcion
|

Recorrer
todo

I
Grabar macro |
Recorter

Inspeccion prncipal
instantdnea

Editor de mends Reanudar macro

Paso a paso

Como ejecutar un procedimiento

Para ejecutar este procedimiento. siga estos pasos:

1. Seleccione una hoja de cilculo no utilizada, Asegurese de que estd sin un-
lizar o no contiene nada itil en el rango B4:C6 porque et procedimiento
sobreescribe ese drea.

2. Elija Herramientas, Macro. Apareceri el cuadro de didlogo Macro mo--
trado en la figura 35.6 v podrai observar en €l todos los procedimientos dis-
pontbles en esta hoja ¥ en la hoja general (actualmente ninguno!

3. En el cuadmo de didlogo, seleccione el procedimiento ImpuestoCifra v ¢ii-
ja Ejecutar. Aparecerd la hoja de cdlculo v el procedimiento se ejecutara.
estableciendo el contenido v formateando las celdas de la hoja de cdleulo

La hoja de cileule temminada es idéntica a la que hu creado manualmenie

Comprender el procedimiento

Ahora observe de nuevo v en detalle 1a hsta de procedimientos seleccio-
nando la ficha Modulo 1. Las primeras lineas del procedimiento son co-
mentanios Un procedimiento en ejecucton ignora los comentarios v éstos
pucden contener cualquier teato.
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Todo tex1o a continuacién de las comillas simples es un comentano, Esios
pueden aparecer al principio de la linea o a la derecha de cualquier ins-
truccidn vilida de VBA,

£

' ImpuestoCifre Macro

' Crear una hoja de calculo para calculor ef impuesto sobre un
item.
[}

1 4

A continuacion de los comentanos aparece el encabezado de! proceds-
nuento. que e da un nombre-

Sub ImpuestoCifra()

A continuacion del encabezado del procedimiento, se encuentran 12 ins-
trucclones gque seleccionan de forma alterna cada celda en el rango B4:C6
e ipsertan texto. un valor numeérico 0 una férmula. Las dltimas cuatro i-
neas insertan férmulas, pero aparecen escritas en estilo R1C1 y no en el
esfilo A1 de localizacion de celdas. Este es €] método por defecto para
cuardar formulas insertadas, independientemente del método que haya
utilizado para crear la hoja de cdlculo mientras la grabadora estaba en eje-
cucion. Cuando se reproduce este procedimiento, las formulas adoptan au-
tométicamente el estilo por defecto de la hoja de cilculo activa. Las 12
INSIrUCCIONES sOn COMQ €s1as:

Range("B4").Select
ActiveCell.FormulaR1C1 = "Costo™
Range("B5").Select
ActiveCell.FormulaR1C1 = "Impuesto”
Range{"B&").Select
ActiveCell.FormulaR1C1
Range{"C4").Select
ActiveCell.FormulaR1CY = "12.43"
Ronge("C5").5elect

ActiveCell.FormulaR1CY = "=R[-1]C*0.0825"
Range("C6"}).5elect

ActiveCell. FormulaR1C1 = "=R[-2]C + R[-1|C"

Las dos instracciones siguientes seleccionan ¢l rango C4 v aplican el for-
malo monedd i evd ceida. Lo mismo ocurre con la celda C6.

Range({"C4").Select

Selection.NumberfFormat = " $#,##0.00"

Range("C6").Select

Selection.NumberFormat = " $#,##0.00" \

"Tohln
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Lémo nictar Yisual Basic para Aplicaciones

Las iltimas nueve lineas del procedimiento son el resultado de seleccio-
nar la celda C5 y hacer modificaciones en el cuadro de didlogo Bordes.
Observe que si bien ha seleccionado s6lo el cuadro Inferior, el procedi-
miento establece valores para todas las opciones del cuadro de didlogo.
Los valores x1None, x1Bottom, x1Thin, efc.. son constantes incorpor:-
das en Excel. Véase la ayuda en pantalla para acceder a una lista de las
constantes disponibles para utilizar con las diferentes propiedades v mc-
todos. Las lineas son como estas:

Range("C5").Select
Selection.Borders{xILeft). LineStyle = xINone
Selection.8ordersixIRight).LineStyle = xINone
Selection.Borders{xiTop). l.meSI'er xINone
With Selection.Borders(x|Bottom)

.Weight = xIThick

.Colorindex = xiAutomatic
End With _
Selection.BorderAround LineStyle:=xiNone

La estructura With, End W’rlh en el procedlmnemo es un método para dis-

minuir el tamaiio de un procediniiento’y ordenar conjuntamente las ins-
trucciones que se-aplican a un objeto-especffico. La instruccién With fun-
ciona insertando el objeto que sigue-a la palabra With ‘antes del punto en
cada {fnea debajo de la misma. Por lo tanto, los dos siguientes bloques de
codigo son equwalentes

Weight = xdThick - i ‘_ AR
Colorindex = xlAutomatic :~ % “: . - -8
End With R

Selection Borders (xJBotiom) Wug!ﬂ :d'lhn -
Selection.Borders{xlBottom).Colorindax = :dAulotmhc

La dluma instruccion en el procedimiento es el pié de pagina del procedi-
miento. que marca el final de! mismo:

End Sub

Cémo crear una aplicacion

Ahora que va conoce los objetos. las propiedades y los métodos. puede
empezar u combinar la informacién para crear una aphcacion. La apli-
cacion que va a crear es un creador de recibos, como el gue podrig uti-
hizar en los sitios en donde no hay una caja registradora normal. El pro-
grama ntroduce datos a través de un cuadro de didlogo. inserta fos
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datos en un formulario en una hoja de cétculo de Excel e imprime ¢l
formulario.
La estructura basica de este programa -datos de entrada, su almacena-

miento. hacer algo con ello- compone la base 'de muchos programas, co-

mo programas de inventario o un organizador personal. Deberd ser capuz
de adaptar los métedos descritos aqui para diferentes aplicactones.
El programa utiliza una hoja de cdlculo y un mddulo. La hoja de cdlculo
contiene el formulario de recibo que almacena Jos datos hasta que esté his-
to para imprimur, El médulo conttene el codigo que recoge los datos. los
almacena en la hoja y los imprime. En primer lugar. cree la hoja de cilcu-
lo. No se preocupe si no comprende lo que hace el codigo. se explica en
los siguientes apartados.

Para crear una hoja de cilculo, siga estos pasos.

1. Seleccione una hoja de cilculo no utilizada. Elija Formato, Hoja,
Cambiar nombre o reahice una doble pulsacion en la ficha en la parte
mterior de la hoja y cambie el nombre de la hoja por Recibo en el cua-
dro de didlogo v pulse en [Aceptar].

2. Scleccione la celda A2 y escriba Papeleras XYZ

3. Seleccione la celda A3 v escribu Calle Alguna parte, 1127,

4. Seleccione la celda Ad v escriba Aqui mismo, 28000 Madrid.

5. Seleccione lu celda B6 v escriba Item.

6. Seleccione |z celda C6 v escriba Costo.

7. Seleccione la celda A7 v escriba 1.

8. Seleccione la celda AR v escriba 2.

9. Seleccione lus celdas A7:AS. seleccione el cuadro de seleccion en la es-
quina interior derecha y arrdstrelo hacia abajo hasta A16 para crear la
sere de ndmeros de 1 a 10,

10. Seleccione C16, elija Formato, Celdas, selecc;one la ficha Bordes.
seleccione un estilo de linea grueso. pulse en el cuadro Inferior v elija
[Aceptar].

11. Seleccione las celdas C7:C19. elija Formato, Celdas, seleccione la fi-
cha Numero. seleccione el upo monedu. scleccione el {ormato -

51,234,19 v chja [Aceptar |

12. Seleccione la barra entre los encabezados de columna B y C v arristre-

ta hasta que el ancho de columna tenga un valor de 27.00 caracteres.

13. Seleccrone 1a celda B7 v escriba TnpOlest usando Insertar, Nom-
bre, Definir.

14. Seleccione las celdas AL.D20 v asigneles ¢l nombre PrintRange.

15, Elija Archivo, Preparar pégina, scieccione la ficha Encabezado/Pie
v establezea en Uninguno” el encabezado v el pie de pagina. Seleccio-
n¢ a fichu Hoja. desactive la scleccion de todas las casillas de venfi-
cacion v elija [Aceptar].

La hoja de cilculo debe parccerse a la de la figura 35.7
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El stguiente paso consiste en crear los procedimientos en un médulo v ad-

juntartos a dos botones en el formulario.
Para crear los procedimientos, siga estos pasos:
t. Ehya Insertar, Macro, Modulo, para insertar un nuevo madulo.

2. Seleccione el modulo y cambiele el nombre por CreadordeRecibos eli-
giendo Edicién, Hoja, Cambiar nombre o reatizando una doble pulsa-

c10n en la ficha de nombre del médulo.

3. Escnba en el madulo los procedimientos que se muestran en Ia hsta 35.2

Lista 35.2 El programa Creador de recibos

‘Creador de recibos

‘Un programa para crear recibos

Option Explicit  ‘Force the declaration of cll variables.

Dim laHoja As Object  ‘Pointer to the Worksheet.

Dim RangoSalida As Object ‘Pointer to the list of items.

Const MaxNumlfems = 10 °  ‘Maximum number of items allowed.

‘Get entries.
Sub GetEnfries()

Dim eliten As String, elCosto As Currency

Dim lofila As Integer, Numltem As integer

‘Define the pointer to the worksheet.

Set laHoja = Application.Workbooks{"Ejemps.xls”).
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Worksheets(“Recibo”)
‘Define the pointer to the top of the tables items.
Set RangoSalida = laHoja.Rango(“ParteSuperiorlista”)
ClearRange RangoSclida ‘Clear the table of items.
Numitems = 1 i
Ask for the name and cost for up to 10 items.
Do While Numltems <= MaxNumltems
‘Get the name.
Elitem =InputBox("Nombre Item:”, “Crear Recibo”}
* If the user didn’t enter anything, _ he must be done, so quit.
if eiltern = “” Then Exit Do
Get the cost.

ElCosto = Val{lnputBox(“Costo Item:”, “Crear Recibo”))
* Insert the items name and cost on the worksheet.
OvutputRange.Cells{Numltems, 1).Formula = elltem
OutputRange.Cells{Numitems, 2).Formula = StrielCosto)
- Numitems = Numltems + 1 ‘ Increment the number of items.

Loop

Totalizar * Calculor e imprimir totales.

* Ejecutar procedimientos Totalizar y prueba

" attached to the worksheet.

LaHojo.OnEntry = “Tokalizar”  ’ Volver a totalizar si el ususa-
rio realiza modificaciones.

End Sub

* Calculor subtotal y total
Sub Totalizar()
Dim laFila As Integer
Dim SubTotal As Currency, Impuestoltem As Currency
Dim elTotal As Currency
SubTokal = 0
;\Calculute the total by extracting the valves from the works-
eet,
For Ic [ilo = to MaxNumitems

SubTorsi = SubTotal + Val(Outpuiﬂunge.Ce‘HslluFila,
2).Vaiue)

Next laFila

‘Insert the subtotal, tax, and total on the worksheet.
With RangoSalida

.Cells(MaxNumltems + 1, 1).Formula = “Subtotal”
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.CellsiMaxNumitems + 1, 2).Formula = Str(Subtotal)
.CellsiMaxNumltems + 2, 1).Formula = “Impuesto”
JImpuestoltem = ellmpuesto(SubTotal) ‘Calculate the tax.
LellsiMaxNumitems + 3, 1).Formula = “Total”
CellsiMaxNumltems + 3, 2}.Formula = Str{ellotal)
End With :
End Sub

‘Clear the output range.
L

Sub Cleachnge{elRur_lgo As Object}
Dim loFila As Integer
For laFila = 1 To MaxNumltems + 3

| ‘Clear the cells. Use ClearContents to only clear the vo-
ues

‘and not the formatting.
elRango.Cells{laFila, 1).ClearContents
elRango.Cells{laFila, 2}.ClearContents
- - Next laFila

End Sub

‘Imprimir el recibo.
I

Sub ImprimirRecibol)
laHoja.OnEntry = “* "Turn off the automatic retotaling
laHoja.Rango("ImprimirRango”).PrintOu¥ Print the worksheet.
End Sub

‘Calculate the tax on an item.
Function elimpuesto(Costo As Currency) As Currency
Const Tesalmpuesto = 0,0825

elimpuesto = Costo * Tasalmpuesto
End Funchon

4. Conmute 4 la ho{a de cdlculo Recibo v despliegue la barra de herra-
mientas Dibujo ehgiendo Ver, Barra de herromientas. .

*h

. Pulse en la herramurenta Crear botdn en la barra de herramientas Dibujo
[ v dibuje el boton Crear recibo. tal y como se muestra en fa frgura 35.8.
Cuando aparesca ¢l cuadro de didlogo Asignar macro. seleccione Ge-
tEntries para la macro y elija [Aceptar.

6. El boton deberd permanccer seleccionado, de lo contrario, pulse en a
[\:‘ herrumienta Dibujar seleccidn en la barra de herramientas Dibujo v se-
lecaione el boton. Scleccione ¢l texto sobre el botdn v e introduzca
Crear Recibo
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7. Cree el botén Imprimir recibo, adjiintelo a la macro ImprimirRecibo v
asignele el titulo Imprimir recibo.

-8. Cierre 1a barra de herramientas dibujo realizando una pulsacién en X en
la esquina superior derecha de la barra de herramientas.

9. Guarde el hbro de trabajo.como EJEMPS.XLS.

La hoja de calculo deberd parecerse a la de la figura 35.8. §i ha hecho to-
do comrectamente. podrd-utilizar el programa para crear un recibo.

. Atscresoft | xcel - Libsu? P31 E1 Fig. 35.8
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1. Conmute u ta hoja de cdlculo Recibo v pulse en el botén [Crear recibo].

2. En el primer cuadro de didlogo gue aparece, escriba el nombre de un
item v pulse <lntro>.

3. Iin el segundo cuadro de didlogo. escriba el costo del ftiem v pulse <Intro>

4. Siga introduciendo nombres v costos hasta escribir todos los ilems gque
tesed usar en el recibo.

. Para tinalizar la hsta. pulse <Intro> o pulse en ef botdn [Cancelar] en ei
cuadro de dialogo Nombre del item. Los totales se calculardn y se mos-
trardn en ¢l recibo.

“6. Puisc en cl botén [Imprimir) recibo para impnimir ¢l recibo.

h

Cdmo ramificarse'y tomar decisiones

A medida que lee la lista de algunos programas, es posible que encuentre
Ly stgurente linea;

If elitem = * “ Then Exit Do
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La linea es una instruccién If que examina los valores de efltem para v c-
rificar si contiene una cadena vacia,-La variable elltem contiene ¢l nom-
bre de texto del item que se agregara al recibo. Si la vanable estd vacia. ¢f
usuario ha terminado de introducir datos v ejecuta la instruccion Exit Do
para salir de la estructura Do/Loop. Por lo tanto. la instruccion If contro-
la una ramificacion de la estructura de! programa.

Estructuras If de bloque

Una estructura if de blogue le permite utilizar una ecuacién de condicion
ldgica para decidir qué blogue de cédigo e_]CCUla.I' La stguiente €5 una ex-
-tructura i de bloque:

If condicionT Then
instrucciones|
Elself condicion2
instrucciones2
Else
instrucciones3
End K

Cuando se ejecuta la instruccién I, se examina condicidn v o1 el resul-
tado es True, el bloque instrucciones ] se ejecutard. S condicion es Fal-
se, se examina condicion2 v st el resultado es True, el blogque instruccio-
nes2 se ejecutard. La estructura puede tener miltiples cliusulas Elself
cada una de elias se examina individualmente. en busca de aquella cuva
condicion de como resuliado True. Si ninguna de las condiciones e True,
la cliusula Else se ejecutara. Se ejecutara solo el bloque de instrucciones
gue sigue ¢ la primera condicién que da como resuliado True, sc omitirin
todos aguellos que estin debajo hasta Hegar a la instruccion End If, aun-
gue sus condiciones se evalden como True.

Formulas logicas

Las condwiiones usadas en bas instrucciones If son valores Iégicos. férmu-
fas que dan come resultado un valor légico o formulas numéricas cuvo re-
sultado es cere {False) o no-cero (frue). Comiinmente. las térmulas logi-
cus se crean comparando dos valores utilizando uno de los operadores de
comparacién que se muestran en la tabla 35.2. Podrd combinar expresio-
nes logicas con los operadores Booleanos hstados en la tabla 35.3. Para
mads intormacion. busgue operadores de comparacion y logrcos en el apar-
tado de ayudu en pantalla de Visual Basic para Aplicaciones.
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Operador Descripcidn

= J gual a

<> Distinto de

> Mayor que

< Menor que

>= Mavor o igual que
<= Menor o igual gque

T3 o

Operador . Descripcion

And And légico

Eqv - Equivalencia idgica
Imp_ [mplicacion logica
Not Negacion lgica
Or Or [ogico

Xor Or exclusivo JGgico

Select case

La estructura Select Case ejecuta una funcion similar a la de la estructura
If de bloque. en el sentido que una expresién se utiliza para seleccionar un
blogue particular de instrucciones. En Select Case, la expresion devuelve
un valor ¥ ese valor se utiliza para determinar qué blogue de instrucciones
ejecutar. La sintaxis de Select Case es la siguiente:

expresion Select Case
Case listal
instrucciones T
Case Else
instrucciones2
End Select

v

Cuundo se ejecuta la instruccion Select Case, se evalia una expresion.
Despuds de una instruccion Select Case aparecen una o mds instrucciones
Case. El valor de expresién se compara con la lista de valores delimita-
das porcomas en lista . Si uno de los valores es afin. se ejecutari el blo-
que instrucciones 1. De lo contrario. se ignorard el blogue v se revisard
la siguiente instruccidn Case para encontrar afinidad. Si no se encuentra
minguna instruccion Case afin, se ejecutara el blogue instrucciones2 que
sigue a Case Else. Al tgual que con {a estructura If de blogue, se ejecuta-
rid sdlo uno de los blogues de instrucciones.
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C6mo acceder a las celdas de la hoja de
calculo

En el ejemplo Creador de recibos. de:pues de que el ususario introduce ef nombre v
el costo del ften. esa Informacidn se inserta en fas celdas de by hog de cilealo \
continuacion se presenta el codigo que ejecuta la msercion:

Set laHojo = Application.Workbooks (“Ejemps. xis”).
Worksheets(”Recibo” )

‘Define the pointer to the top of the table of items.

Set OutputRange = laHoja.Ronge (“ParteSuperioriista”

‘Insert the item's name on the worksheet.
OutputRange.Cells[Numltems, 1).Formula = elltem .
- OutputRange.Cells{Numltems, 2}.Formula = Str.{elCosto)

- Deberd uulizar una referencia de range y una instruccion Set para detinir
una variable de objeto que sefiala a la celda denominada ParteSuperior-
Lista n la hoja de calculo. Esa referencia de rango se utitiza con ¢l méto-
do Cells para seleccionar las celdas de la hoja de calculo en posiciones re-
talivas a lo celda ParteSuperiorlista. Después de obtener una referencia
de rango para una celda. unlice las propiedades Value v Formula para ob-
tener o establecer el valor de una celda. Observe que la propredad Valor
contiene el valor de una celda -es decir. el ndmero que aparece en la hoja
de cdlculo- mientras que la propiedad Formula contiene 1o que ha escn-
to en la celda. En este caso. dado que ninguna de las celdas contiene una
formula, s propiedades Value v Formula son 1guales.

L a referencia de rango de fa variable Outpulﬂange se refiere a una celda con
nombre. Es preferible emplear esta referencia que referenciar una celda ex-
plicita ya que podrd reorganizar de esta manera ia hojade céalculo v el c6-
digo seguirs obteniendo el valor de la celda correcta.

Pedri referenciar las celdas usando una referencia de celda o por fila o co-
fumna, usando Cell, que también devuelve un objeto Rango. Las siguientes
tres instruccrones referencian el contentdo de la ceidu C7 en el gemplo:
elCosto = loHoja.Rango(“C7").Value
elCosto = laHoja.Rango(”ParteSuperiorLista”).Cells {1, 2).Valve
elCosto = laHojo.Cells{7, 3).Volue )

El procedimiento Totalizar venfica la lectura y modificacion de los valo-
res de lus celdas de la hoja de cilculo. La primera parte del procedimien-
10 ohiiene el valor en cada una de las celdas de la columna € que contre-
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nc un valor v calcula un subtotal. Esto se muestra en el siguiente frag-
mento de cadigo: -

SubTotal = .

‘Calculate the total by extracting the values form the worksheet.

For laFila = 1 To MaxNumltems
SubTotal = SubTotal +Val(OutputRange.CellsfiaFila, 2).Value)
Next laFila

Las instrucciones For v Next forman un bucle que ejecuta la instruccion
SubTotal para cada fila en el rango de datos det recibo. El valor de la cel-
da se obuene v totaliza en Ia variable SubTotal,

e Ty

Obsérvese como se aplica la funcion Vﬂl fal CUHICI‘IIdD ﬂt T [ffdﬂ parg ase-

gurar que un nimero ha pasado a la variable. Sin la.funcidn'(, el usuaric
puege introducir en una celda una cadena que podria romper su cédigo si
intentara almacenarlo en una variable numérica. La funcion:Vat convierte
una..cadena en un nimero y evita ese problema potencral Sh GRS

B

La segunda mutad del procedimicnto escribe los rotulos y valores para el
subtotal, el impuesto v ¢l total en la hoja de cilculo: '

With OutputRange
.CellsiMaxNumltem + 1, 1).Formula = “Subtotal”
.Cells{iMaxNumltem + 1, 2|.Formula = Str{SubTotual)
.Cells[MaxNumitem + 2, 1).Formula = “Impuesto”
Impuestoitem = elimpuesto{SubTotal}  “Calculate the tox.
.Celis(MaxNumitem + 2, 2).Formula = St {Impuestoltem)
elTotal = SubTotal + Impuestoltem
.Cells(MaxNumltem + 3, 1).Formula = “Totol”
LellsiMaxNumitem + 3, 2).Formyle = SirlelTotol)

End With

Este blogue de instrucciones también demuestran el uso de fa instruccion
With para un:r las celdas en blogue v ahorrar la tarea de escritura. Las ins-
trucciones estan lopicamente umdas en bloyue porgue referencian al mis-
mo objeto v permien shorrar escritura dado que debe introducir el obje-
to sSlo una v: |, Flobjeto gue sigue a la cliusula With {OutputRange) se
adjunta antes oo, punto a todas lasnstrucciones situadas entre las cldusu-

la~ With v End.

Como llamar a los procedimientos

El procedimiento Totalizar ¢+ un efemplo de un subprocedimiento que ¢
llamado por otros procedintentos El procedirmento GetEnnes necesita -
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Como acceder a las celdas de la hoja de
o calculo

En el ejemplo Creador de recibos, después de que e} ususario introduce el rombre v
el eosto del ftemn, esa informacion se inserta en las celdas de la hoju de cileulo. A
" connnuzcion se presenta el oidigo que ejecuta la insercion:
Set laHojo = Application,Workbooks (“Ejemps.xls”).
Worksheets(”Recibo”)
‘Define the pointer to the top of the table oF items.

Set QuipuiRange = loHoja.Range (*ParteSuperiortista”)

‘Insert the item’s name on the worksheet.

OutputRange.Cells{Numltems, 1).Formula = elltem
s OutputRange.Cells|Numltems, 2).Formula = Str.(elCosto)
Deberd utilizar una referencia de rango y una instruccién Set para definir
una varable de objeto que sefiata a la celda denominada ParteSuperior-
Lista en la hoja de cdlculo. Esa referencia de rango se wtiliza con ¢l méto-
do Cells para scleccionar las celdas de ta hoja de cilculo en posiciones re-
lativas u la celda ParteSuperiorLista. Después de obtener una referencia
de rango para una celda. utilice lay propiedades Valve v Formula para ob-
tener o establecer el valor de una celda. Observe que la propiedad Valor
conticne ¢l valor de una celda -es decir, el nimero que aparece en la hopu
de cilculo- mientras que lu propiedad Formula contiene lo que ha escii-
to en la celda. En este caso. dado que ninguna de las celdas contiene una
formula. las propiedades Value v Formula son iguales.

o Sd e et n-:).', Lo
" La referencia de rango de fa variable Oznpufkanga se refi iere a una celda con
nombre. Es preferible emplear esta referencia que referenciar’una celda ex-
plicita ya que podr reorganizar de esta maneraia ho;a de célculo y ef co-
digo seguirs obteniendo el valor de fa celda correcta A

Podra referenciar las celdas usando una reterencia de celda o por filz o co-
fumna, usando Cel! yue también devuelve un objeto Rango. Las siguientes
tres instruccione: * wrenciah ef contemda de la celda C7 en el ejemplo:
elCosto = laHoja.Rango{“C7").Value
elCosto = laHoja.Rango(“ParteSuperiorLista”).Cells {1, 2}.Value

elCosto = laHojo.Cells{7, 3).Value

El procedimiento Totalizar verifica la lectura y modificacién de los valo-
res de tus celdus de 1a hoja de calculo. La primera parte del procedipien-
to obtiene el valor cn cada una de las celdas de lu columna C que contie-
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ne un valor y calcula un subtotal. Esto se muestra ¢n el siguiente frag-
mento de cédigo:
SubTotal = 0
‘Caleulate the total by extracting the values form the worksheet.
For laFila = 1 To MaxNumitems '
SubTotal = SubTota! +Val{OutpulRange.Celis{laFila, 2}.Value)
Next laFila

Las instrucciones For y Next forman un bucle que ejecuta la instruccion
SubTotal para cada fila en el rango de datos del recibo. El valor de la cel-
da se obtiene v totaliza en la variable SubTotal.

La segunda mitad del procedimiento escribe los rdtulos y valores para ei
subtotal. el impuesto y el total en la hoja de cilculo:

With QuiputRange
" CellsiMaxNumltem + 1, 1).Formula = “Subtotal”

.Celis(MaxNumitem + 1, 2}.Formula = Str{SubTotal)
.CellsiMaxNumltem + 2, 1}.Formula = “Impuesto”
Impuestoltem = elimpuesto(SubTotal]  “Calculate the tax.
Celis{MaxNumitem + 2, 2).Formula = St (Impuestoltem)
elfotal = SubTotal + Impuestoltem
.CellsiMaxNumltem + 3, 1).Formula = “Total”
.CellsiMaxNumltem + 3, 2).Formula = Str(elTotol)

End With '

Este blogue de instrucciones lambién demuestran el uso de ia instruccién
With para unir las celdas en bloque v ahorrar Ja tarea de escritura. Las ins-
trucciones estin logicamente i:nidas er blogue porque referencian al mis-
mo objeto y permiien ahorrar escritura dado que  debe introducir el obje-
to s6lo una vez. El objeto que sigue a la clausula With [OutputRange) se
adjunta antes del punto a todas las instrucciones situadas entre las cldusu-

las With y End.

Como llamar a los procedimientos

El procedimiento Totalizar e un ejemplo de un subprocedimiento que es
llamado por otros procedmmientos. El procedimiento GetEntries necesita

[ ]
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poder calcular y mostrar los totales en la hoja de cdlculo y para ello a-
mard al procedimienio Totalizar, Ambos procedimientos pueden encon-
trarse en !a hoja de cdlculo Creadorderecibos.

Al principio del procedimiento GetEntries, deberd eliminar toda entrada
anterior del recibo. Se llamard al procedimiento ClearRange para que eje-
cute esta accion: '

Sub ClearRange (elRango As Object)

Dim loFila As Integer

For loFila = 1 To MaxNumitems + 3
‘Clear the cells. Use Clear contents to only clear
‘the values and not the formatting.
elRango.Cells{laFila, 1).ClearContents
elRango.Cells(laFila, 2).ClearContents

Next loFila '

End Sub

El procedimiento necesita de un objeto para un argumento denominado el

Rango en el procedimiento ClearRange. En el procedimiento GetEntries,

el procedimiento CleurRunge es llamado con la siguiente instruccion:
ClearRange OutputRange ‘Clear the table of items.

Dado que esta llamada de procedimientos no forma parte de una formula,

no serd necesario colocar el argumento entre paréntesis.

El procedimiento de la funcién ellmpuesto también es otro procedimien-

to que es llamado desde otro punte del programa:

I

‘Calculate the tax on an item.

s

Function ellmpuesto[Coste As Currency) As Currency
Const Tasalmpuesto = 0,0825
elimpuesto = Costo * Tasalmpuesto

End Function

Observe que en este procedimiento, el argumento es una variable de tipo
de moneda denominada Costo. La funcién es reclamada como parte de
una formula de Totalizar:

Impuestoitem = elimpuesto{SubTotal)]  “Calculate the tax

En Totalizar, ia funcion elimpuesto pasa a la variable subTotal como un
argumento, Esta variable sefiala una localizacién de memoria y ésta pasa
a la funcion ellmpuesto, donde se a2 denomma Costo. Ambos nombres
sefialan la misma localizacién de memoria, por lo que 1 el valor de Cos-
to se modifica en ellmpuesto, el valor de SubTotal cambiari en Totalizar
cuando la funcion termine de ejecutarse.

En algunos casos. es posible que desee asegurarse de que un procedimien-

to no modificard un argumento, por lo que deberd pasar el argumento co-

[V
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mo un valor en lugar de pasarlo como una ubicacién de memoria. Podrai ha-
cer esto en el encabezado del procedimiento o en el programa de llamada.
En un encabezado de procedimiento, por ejemplo, deberd anteponer al ar-
gumento la palabra clave ByVal, tal y como se muestra a continuacion:
Function ellmpuesto(ByVal Costo As Currency) As Currency
La otra posibilidad es transformar el argumento en el programa de llamada
en una formula. La ubicacién en la que se almacena el resultado de la for-
mula se enviza al procedimiento en lugar de las ubicaciones de cualquiera
de las variables. Transforma una variable en formula. colocando el nombre
de la variable entre paréntesis, tal y como se muestra a continuacion:

Impuestoltem = ellmpuesto ({SubTotol)) ‘Caleviate the tax
El procedimiento Totalizar es un procedimiento evento adjunto a la hoja de cdl-
cuto. Esto se realiza al final del procedimiento GefReceipt, tal y como sigue:

‘Make the Totallt procedure an event procedure attached

‘to the worksheet.

LaHoja.OnEntry = “Totalizar”  ‘Volver a caleular el total si el

ususario realiza modificaciones. -
Mis%adelante en el programa, el procedimiento Totalizar aparece separa-
do de la hoja de cdlculo en el procedimiénto PrintReceipt, tal y como si-
gue:

laHoja.OnEntry = “*  ‘Turn off the automatic retotaling.

La propiedad OnEntry de una hoja de cilculo contiene el nombre de un
procedimiento gue debe ejecutarse en el momento en gue el usuario mo-
difica el contenido de una celda de la hoja de cédlculo. Convirtiendo el pro-
cedimiento Totalizar en un procedimiento eventol, el usuario podr4 reali-
zar cambios en el recibo antes de imprimirlo y esos cambios se incluirdn
de mmediato en los 10tales situados en la parte inferior del recibo.

Como usar bucles

El procedimiento Totalizar debe buscar entre las celdas de la hoja de cil-
culo y agregar contentdo para calcular el subtotal. Si desea escribir refe-
rencias de rango para las 10 celdas de la hoja de cileulo, podra hacerlo,
pero probablemente no quiera perder su tiempo escribiendo la misma ins-
truccién una y otra vez. Para solucionar estos problemas. utilice bucles.

For/Next

El bucle mas comin es el de For/Next, que ejecuta un bloque de instruc-
ciones un determinado niimero de veces. La sintaxis del bucle For/Next
e la siguiente:

For loopvariable = start To end Step stepval
.instrucciones

Next loopvariable

Consejo

| Planifique sus bucles

jenun pape! antes de
hacerlo en céiigo, Le
permitira anorar ho-
ra< ge trabajo depu-
fando annitos bucles
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En el bucle For/Next, loopvariable es una variable estandar. La primera
vez que se ejecuta el bucle, Ioopvoriuble tiene el valor sfart y se ejecuta-
rin todas las instrucciones situadas por debajo de la instruccion Next. La
segunda vez que se ejecuta el bucle, se agrega stepval a loopvariable '
ese valor se compara con end. Si Joopvariable es mayor que end, ¢l bu-
cle finaliza. De lo contrario, las instrucciones dentro del bucle se vuelven
a ejecutar. La cldusula Step stepval puede omitirse, en cuyo caso el step-
val es 1. Si stepval es negativo, el bucle cuenta hacia abajo en lugar de
hacia arriba hasta que loopvoriable es menor que end.

El procedimiento Totalizar utiliza el bucle For/Next para seleccionar to-
das las celdas que contengan valores en la hoja de cdlculo, a continuacion
¢l procedimiento calcula un total para todos los valores hallados:

For lafila = 1 To MaxNumitems
SubTotal = SubTotal +Val{outputRange.Cells(laFila, 2).Value)
Next loFila

En este ejemplo, faFila es una variable de bucle y su rango va desde 1 has-
ta MaxNumEntries. Cada vez que se ejecuta el bucle, se selecciona unu
celda diferente de 1a hoja de calculo, usando el método Cells.

| Do/Loop

El bucle Do/Loop emplea una condicion para determinar cuantas veces de-
be ejecurar el bucle. Puede comprobar ta condicién al comienzo o al final
del bucle, y éste podra continuar mientras la condicién sea True o hasta gue
Ia condicién de como resuttado True (mientras sea False).. Por eso. ta sin-
taxis presenta cuatro variaciones, tal y como se observa a continuacion:

Do While Condicién Do until condicién

.instrucciones .nsfrucciones

: . T
.

Do Do

instrucciones instrucciones

Loop While Condicion Loop While Condicién

El procedimiento GetEntries utiliza una estructura Do/Loop para realizar
el bucle de las 10 lineas de entrada permitidas en el recibo. En este caso,
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la construccién Do While se utiliza con una condicién que permanece
True hasta que el valor de Numltems es menor o iguil que MaxNumi-

tems:
Do While Numltems <= MaxNumltems .

‘Get the name.
Elitem = ImputBox(“Nombre del them:", “Crear Recibo”} -
‘If the user didn’t enfer anything, he must be done, so quit.
If elltem = “” Then Exit Do
‘Get the cost.
ElCosto = Val(ImputBox(“Costo del tem:”, “Crear Recibo”)) «
‘Insert the item’s name and cost on the worksheet.
OutputRange.Cells{Numitems, 1).Formula = elltem
OutputRange.Cells{Numitems, 2).Formula = Str{elCosto)
Numltems = Numlitems + 1 \ ‘Increment the number of
items.

- foop .
Todas las instrucciones que se encuentran entre 1a cliusula Do y la cldu-
sufrloop se ejecutaran hasta que la condiciyn sea False, Si el usuario pul-
sa Cancelar vy la instruccion if dentro del bucle tiene una condicién True,
OCUTTS una excepeidn:

If elltem = “” Then Exit Do
Na condicion es True, se ejecutard la instrubcion Exit Do, terminando n-
medijatamente el bucle y comenzando la ejeducion en la instruccitn que si-
gue 3 Ia instruccidn Loop. Existe también una instrucci6n Exit For para sa-

lir dé un bucte For/Next en una fase 1cmprana
I

ForEgch /

El d\uc]c For Each se utiliza para realizar algunas acciones para todos los
elementos de una matriz o coleccidny La sintaxis es la siguiente:

kor Each elementa In group
S

instrucciones
Next rU

El bucle For Each se aplica sélo a matrices y colecciones. El bucle se eje-
cuta una vez para cada elemento de la matriz o coleccidn. Este bucle es
itil cuando no sabe (o no lv » ‘porta} eudntos elementos hay en una co-
leccion. El efemento variable rucle es el mismo tipo de informacién que
los elementos en la coleccion grupe. Cada vez que se calcula el bucie, el
elemento asumc el valor de otro miembro de la coleccion.

Como acceder a los archivos de disco

Si ha jugado con los ejemplos. es posible que haya observado que cada
vez que crea un nuevo recibo. desaparecen todos los valores de datos. Lo

9

L
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Por lo eeneral. no es i

aconsejable colocar |

archivos en el drecio- |

10 raiz de cualquier ‘
disco durg.

que falta es una forma de guardar los datos para que pueda recuperarlos
y utilizarlos. Es posible que, quiera siber cuantos items y de qué tipo se
han vendido, o que desee calcular el total de recibos por dld para compa-
rarfos con los recibos de la caja.

Cuenta con dos opciones: puede almacenar los datos en olr.x hoja de cileu-
lo para que se guarden en un libro de trabajo. o puede abrir un archivo de
disco v almacenar los datos inmediatamente. Estos métodos ofrecen dife-
rentes ventajas. dependiendo de lo que desee hacer con los datos. Si guar-
da los datos en una hoja de cilculo, podra aplicarles todas las funciones de
base de datos de Excel. Si los guarda en un archivo de disco. otros progra-
mas podrin abrirlos directamente. En este ejemplo va a guardar los datos
en un archivo de disco. Agregue cédigo al procedimiento PrintRange para
anadir los datos al final de un archivo de datos, tal y como se muestra {las
lineas agregadas aparecen en negnita} en la siguiente estructura:

‘Print the receipt
Sub PrintReceipt {)
Dim laFila As Integer
laHoja.OnEntry = " “Turn off the automatic retotaling.
laHoja.Range{“ImprimirRango”).PrintOut *Print the worksheet.
‘Save the data from the receipt
Open “C:\data\ejemps.dat” For Append As # 1
For laFila = T To MaxNumltems
Write # 1, OutputRange.Cells(laFile, 1).Value,
" Write # 1, OutputRange.Cells{laFile, 2).Value
Next iaFila
"Write the subtotal, tax, and totual,
With OutputRange
Write # 1, “SubTotal”,
Write # 1, .Cells(MaxNumltems + 1, 2).Valve
Write # 1, “Impuesto”,
Write # 1, .CellsiMaxNumltems + 2, 2).Valuve
Write # 1, “Total”,
Write # 1, .Cells(MaxNumltems + 3, 2].Valve
End Witk _
Close #1
End Sub

En las lineas agregadas, el archivo se abre para utilizarlo como apéndice,
usando un nimero de archivo de 1. El apéndice coloca cada nueva entra-
da al final de] archivo. El bucle copia después los datos de la hoja de cdl-
culo y los escribe en el archivo. El programa parece seguir funcionando
igual. pero ahora los datos se guardan cada vez que se pulsa en el botén
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[mprimir recibo. Después de introducir los datos y pulsar en el botén [Im-
primir recibo], aparece el siguiente texto en EJEMPS.DAT:

“Lapices”,2,35
“Cuademo de cuentas”, 1,8
“Papel de impresora - caja”,18,95

i

’

“Subtotal”,23,1
“Impuesto”,1,9058
“Total”,25,0058

Obs&rvese que la instruccién Write delintita los datos en el archivo colo-
cando las cadenas de texio entre comillas y comas entre los items que se
escriben en el disco. Estos delimitadores facilitan el uso de la instruccidn
input para que el programa vuetva a leer los datos para su tratamiento pos-
terior, Si utiliza Print en lugar de Write, el texto y las cadenas se escriben
en el archivo sin delimitadores, creando un archivo de texto mas adecua-
do para impresion que para ser leido en olro programa.

Para mds informaci6n acerca de leer y escribir archivos, busque input en
et apartado ayuda en pantalla de Visual Basic para Aplicaciones y selec-
cione ¢l tema “Resumen de palabras claves de entrada y salida”

Coémo utilizar los cuadros de didlogo
incorporados

Visual Basic para Aplicaciones ofrece dos cuadros de didlogo incorpora-
dos que podrd utilizar en sus programas para enviar y obtener datos del
usuario. Estos dos cuadros de didlogo han sido creados con las funciones
MsgBox{) e InputBox(). Ya ha utihizado la funcién InputBox() para obte-
ner datos del usuario en el programa Creador de recibos. La funcién Msg

Box abre un cuadro de didlogo que contiene un mensaje y uno 0 més bo-
tones en los que podri pulsar para cerrar el cuadro de didlogo. Ambas
funciones recogen uno o mds argumentos para establecer el texto de avi-
s0. el titulo del cuadro. €l nimero y tipu de botones, etc. Véase la ayuda
en pantalla para obtener una lista completa de los afgumentos.

Ademds de estos dos cuadros de didlogo. puede utilizar dos cuadros de
didlogo de Excel para realzar sus programas cuando abre o guarda archi-
vos. Los dos cuadros de didlogo se abren con los métodos GetSaveAsFi-
lename y GetOpenFilename.

El método GetSoveAsFilename abre el cuadro de didlogo estandar Guar-
dar como y obtiene un nombre de archivo del usuario. En realidad, el cua-
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Fig. 35.9

Un cuadro de
chdlouo
personalizado
antes cle 1a
edicidn, La barra
de herramientas
[hdlogy aparece
otando en la
parte supernor de
1a pantalla

dro de didlogo no suarda nada, simplemente le da una via de acceso
y un nombre de archivo para usar. Después, deberd utilizar la instru-
ceién Open para crear realmente el archivo y guardar algo en él. El méto-
do GetOpenfilename opera de Ja misma manera, pero en su lugar ahre ¢l
cuadro de didlogo Abrir.

Cémo crear cuadros de didlogo -
personalizados

Ademis de los cuadros de didlogo incorporados, podrad crear los suyos
personalizados y adjuntarlos al programa Visual Basic para Aplicaciones.
Por ejempio, el programa Creador de recibos podria utilizar un formulario
de entrada de datos reemplazando los dos cuadros de didlogo necesarios
para introducir una sola entrada:

Para realizar esta modificacion, siga estos pasos:

1. Abra el lJibro de trabajo EJEMPS.XLS vy puirdelo como
EJEMPS2:XLS. _ . ’

2. Elija Insertar, Macro, Didlogo. Su hoja de cilculo deberi parecerse a
la de la figura 35.9. con un cuadro de didlogo personalizado en blunco
y 1a barra de herramientas Didlogo. Esta barra de herramientas puede
aparecer flotando o anclada en la parte superior o inferior de la pigina.
Las herramientas de esta barra se listan en la tabla 35.4
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Herramienta

Nombre de la herramienta

Descripcion

Crear rétulo

Crea un rétulo de texio.

Cuadro de edicién

Crea un cuadro de edicidn para
introducir datos,

Cuadro de grupo

Crea un marco de grupo para
agrupar visualmente otros con-
troles y agrupar funcionalmente
botones de opcion.

Crear botdn

Crea un boton de comando
que puede ejecutar un procedi-
miento.

Crear casilla de
verificacion

Crea una casilla de verificacién
con ‘un rotulo para seleccionar
opciones no exclusivas.

Crear botén de opcidn

Crea un botén de opcion con un
rotulo para establecer opciones
exclusivas. (Crea un grupo de
botones de opcidn dentro del
marco Grupo).

Cuadro de lista

Crea un cuadro de lista para se-
leccionar una valor de una lista
de valores en un cuadro por ¢l
que podrd desplazarse.

)
[4[+E)

Crecur despiegable

Crea un cuadro de lista desple-
gable para seleccionar una va-
lor.

2l

Crear cuadro
combinado de lista

Crea un cuadro combinado de
lista (combinacion entre cuadro
de lista y cuadro de edicién).

m!
]+ K]

Crear cuadro combinado
desplegable

Crea un cuadro combinado des-
plegable (combinaciGn entre
cuadro de lista desplegable y
cuadro de edicidn).

Ko

Crear barra de
desplazamiento

Crea una barra de desplazamien-
1o para introducir un valor des-
plazando un marcador o para
usar como tndicador de un valor.

4

Crear controles de giro

Crea un control de giro para pa-
sar rdpidamente de un paso a
otro en una lista de valores ente-
TOSs.

timo crear cuadros de didlogo persanalizades . 733
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Herramienta

Nombre de la herramienta

Descripcion

Formato objeto

Abre el cuadro de didlogo For-
mato objeto para establecer las
propiedades de control.

Editar cadigo

Busca el procedimiento asigna-
do al control seleccionado.

Alternar cuadricula

Activa o desactiva una cuadricu-
la para simptlificar la alineacion |
de los controles ent un cuadro de
dialogo.

Ejecutar didlogo

Activa el cuadro de didlogo por
lo que cambiando valores o rea-

“lizando una pulsacién en los bo-

lones se ejecutardn los procedi-
mientos adjuntos.

3. Seleccione el titulo de didlogo, escriba Creador de recibos y pulse en
cualquier drea en blanco de la hoja de didlogo.
4. Ehja Formato, Hojo, Cambiar nombre y cambie ¢l nombre de 1a ho-

ja por Dialogltem. Pulse en [Aceptar].

5. Usando el botén [Crear rétulof en la barra de herramientas didlogo. di-
buje dos rétulos en el cuadro de didlogo, tal y como se muestra en Ia fi-
gura 35.10. Seleccione el titulo del primero y escriba Nombre de
Item:, Seleccione el segundo titulo y escriba Costoltem:.

Fig. 35.10

Disefio del

cuadro de '
didlogo Creador

de recibus

‘ahl

6. Usando ¢l botén {Cuadro de edicién|, dibuje dos cuadros en el cuadro
de didlogo. tal v como se muestra en la figura 35.10

7. Seleccione ¢l cuadro de edicidn proximo al réwulo Nombre de ltem y

cambie el nombre por CuadroNombreitem.

Para cambsar el nombre de un comrol en la hOja de dtélog‘ ‘seleccione el
* control. Luego pulse en el cuadro de nombre'en la parte: lzqu:erda de la ba-
ma de educ;én escnba el nuevo nombre V pulse <Imro> QR




8. Seleccione el cuadro de edicién préximo al rétulo Costo del-ltem y
asignele el nombre CuadroCostoltem.

9. Elija Herramientas, Orden de tabulacién. Seleccione CuadroNom-
breltem v desplacelo a la parte superior de Iz lista. Seleccione Cuadro-
Costoltem v desplicelo debajo de CuadroNombreltem. Este procedi-
miento hace que CuadroNombreltem se seleccione en primer lugar
cuando se abre el cuadro de didlogo. CuadroCostoltem se selecciona en
segundo lugar, cuando’ el usuario pulsa la tecla <Tab>. Elija [ Aceptar]

CGma crear coadros de didloge personahzados
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para completar los cambios en el orden de la tabulacién.

10. Conmute al médulo Creadorderecibos, realice las siguientes modifi-
caciones en el procedimiento GetEntries (los cambios aparecen en ne-

grita) v guarde el libro de trabajo:

£

‘Get entries

I

Sub GetEntries|)

Dim elltem As String, elCosto As Currency

Dim laFila As Integer, Numltems As Integer

Dim elDialogo As Object ,

‘Define the pointer to the worksheet.

Set laHoja = Application.Workbooks(“Ejemps2,xls”)

Worksheets{Recibo”)

“‘Define the pointer to the top of the table of items.
Set OutputRange = laHoja.Range{“ParteSuperiorlista”}
Set elDialogo = Application. Workbooks (“Ejemps2.xls”)

DialogSheets(“Dlalogoltem”)

ClearRange OutputRange ‘Clear the table of items.
Numltems = 1 :
‘Ask for the name and cost for up to 10 items.

Do While Numitems <= MaxNumltems

‘Clear the edit boxes
elDialogo.EditBoxes(“CuadroNombreltem”).Text = “*
elDialogo.EditBoxes(“CuadroCostoltem”).Text = “”
elDialogo.Show
‘Get the name . . _
elitem = elDialogo.EditBoxes(“CucadroNombreltem”).Text

‘If the user didn’t enter anything, he must be done, so quit.

If elitem = ** Then Exit Do
‘Get the cost

elCosto = Val(elDialogo.EditBoxes({“CuadroCostoltem”).Text)

‘Insert the item’s name and cost on the worksheet.
QutputRange.Cells(Numltems, 1).Formula = elitem

11
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Fig. 35.11

El cuadro de.
didlogo Crear
recibo,

OutputRange.Cells{Numltems, 2).Formula = Str{elCosto)

Numltems = Numltems + 1 ‘Increment the number of items.

Loop .

Totallt ‘Calcvlate and print the totals.

‘Retotal it if the user makes changes.

LoHoja.OnEntry = *Totalizar”

End Sub _

La primera modificacién en el procedimiento define un nuevo objeto de-
nominado elDialogo que referencia a la hoja de didlogo. Luego ese ob-
jeto ‘se utiliza con la coleccién EditBoxes para despejar los dos cuadros
de edicién. El método Show se utiliza para abrir el cuadro de didlogo.
Después de que ¢l usuario elige el botén |Aceptar|, el contcnido de los
dos cuadros de edicion es devueito al procedimiento y procesado ipual
quc antes. ]
Cuando ejecuta el programa realizando una pulsacidn en el boton {Crear]
recibo en la hoja de cilculo, aparcce el cuadro de didlogo, tal y como se
muestra en la figura 35,11. Escriba el nombre del item. pulse <Tab>, es-
criba el costo del item y pulse <Intro>. El primer item se insertard en el re-
cibo y reaparcceri el cuadro de didlogo. Para finalizar una entrada, pulsc
<lntro> sin escribir en el cuadro de didlogo. Se calcularin ios totales.

Cémo utilizar las herramientas de
depuracién

Los fallos de programacion son algo muy comtin ¢n la vida de los progra-
madores de ordenadores. Independientemente de lo cuidadoses que sean,
casi siempre aparecen fallos. Debe encontrarles y eliminarlos de sus pro-
gramas. Los fallos mas sencillos son los errores de simiaxis. en {os que los
parimetros de llamada son incorrectos. VBA encuentra normalmente los
’errores de + vtaxis tan pronto como los comete, Otros fallos son tos erro-
res de tiem;.- de ejecucién, que surgen cuando se utiliza un tipo de varia-
ble equivocada o cuando se ejecuta un cdlculo numérice incorrecto (por
ejemplo, la raiz cuadrada de -1). VBA también detecta cslos errores tan
pronte como se ejecuta la instruccidn incorrecta. Finalmenle, existen los
errores logicas, por los cuales un programa no realizard lo que ordena.
Los errores légicos son tos mds dificiles de detectar porque ¢l cédigo de
programa compiia, pero el programa stmplemente no realiza [o que habfa
piancado que hiciera, :
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Visual Basic para Aplicaciones cuenta con una serie de poderosas herra-
mientas de depuracmn que le ayudardn a detectar y corregir los fallos de
programacion. Puede colocar puntos de interrupcion en cualquier lugar del
programa para forzarlo a detener 1a ejecucién en ese punto. Después de de-
tener el programa. elija Herramientas, Inspeccion instantanea para ver
los valores de cada variable o expresion. Luego podrd seguir ejecutando
un programa ¢ pasar una tnstruccidén por vez hasta encontrar el problema,
También podrd establecer puntos de inspeccion que interrumpan automa-
ticamente el programa cuando una variable o expresion alcance un valor
determinado. .

Modo Interrupcién

Ei modo Interrupcidn es el punto en el que se detiene un programa en eje-
cucion con todas sus variables intactas. Por lo general, cuando finaliza un
programa, se pierde €l contenido de todas las variables, No obstante, el
modo interrupcion es una pausa durante la ejecucion del programa. por lo
que el contenido de las variables a los que se ha asignado valon:s durante
la elc(,uuon siguen estando disponibles. _

Cuando un programa entra en el modo interrupcion, por encontrar un error
o porque ha pulsado <Control> + <Inter>, aparece el cuadro de didiogo
Error de macro, que le ofrece la posibilidad de sahr. continuar o abrir ia
ventana Depuracion.

Puntos de interrupcién y puntos de inspeccién

Los puntos de-interrupcion y los puntos de inspeccion también hacen que
un programa entre en el modo interrupcion. Un punta de interrupcicn es
un marcador en una linea de c6digo que obliga a un programa a detener la
ejecucién cuando Visual Basic para Aplicaciones intenta ejecutar la linea
marcada. Un punto de inspecciéon es un marcador en el valor de una va-
riable o de una simple formula. Cuando el valor de un punto de inspeccion
cambia de una determinada manera, ¢! programa se detiene y entra en el
modo interrupcion. Véase en Iz figura 35.12 el punto de interrupcién Sub
GetEntries(]. Cuando se introdcce este procedimiento, se establece el mo-
do interrupcion. Dado que se ha introducido un punto de interrupcidn, no
existen datos en el Punel de inspeccidn. {No hay dutos para inspeccionar!

13
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Flg 35.12 B Dcpuracnm Ldyos Mool 3

La ventana
Depuracion con
un punto de
interrupcion
establecido

Sub GetEmcrics | |

Dim ellcem as Scraing, elCosta A CuCrency

Dim laFila A8 Integer, Nusltem i# loceger

‘Pefiu= =) punterd> a la hsia de raloylo -
Ser LaHDja = Application.VWorkbocks("Ejemps.xla”™).Usrkshewts([(“Recikheo™
'[afine #, puntars a la parte "up~risi de lox clemen™n® /e la canis U
Zet RangoSalida = LwAoje,Rapngu{“PartejuprriorLista~) 6! -
'SlearRange Pangodaiida  ‘Mociw todos loF elmmentes dr (A teble ‘33

L O TR LR A
A

B Para colocar un punto de interrupcidn, abra el médulo que contiene su pro-
—\“_]H‘ cedimiento y seleccione la linea de c6digo en la que desea que el programa
se interrumpa. Elija Ejecutar, Alternar punto de inferrupcién para intro-
ducir un punto de interrupcién. Elija nuevamente el comando para eliminar
un punto de mterrupcion seleccionado o elija Ejecvtar, Eliminar todos los
puntos de interrupcidn para. quitarios todos. Luego ejecute su codigo.
Cuando alcance el punto de interrupcion, el codigo se detendra y entrard en
modo interrupcién, Cuando un programa entra en el modo interrupcion por
haber encontrado un punto de interrupcién o inspeccién, abre directamen-
te la ventana de depuracidn, que se describe en el siguiente apartado.

"
1)

La ventana Depuracion

Si elige Depurar en el cuadro de didlogo Error de macro, o se encuentra
con un punto de interrupcion o inspeccion, aparece la ventana Depuracidn.
(véase la figura 35.13). La ventana Depuracion es una ventana dividida,
yue presenta €l procedimiento que se esta ejecutando en su mitad inferior
y el panel Ejecucidn o panel Inspeccion en la parte superior. En la mitad in-
ferior de la ventana, podrd seleccionar lineas de c6digo, agregar o quitar
_puntos de interrupcidn y seleccionar cédigo para los puntos de inspeccion,

Ficha para seleccionar el panel  Ventapa Llamadas
Ejecucion Ventana Inspeccion
Fig. 35.13

La ventana
Depuracion para
un codigo
detenido en un
punto de
Inepeceson.

o Depanacon Liwng Modubhsl

] - .

g

Dim ellcem ap Btrang, elCosts AR Curiency - Panl}l de

iz laFilw ax® Inceger., Numlter A5 Integer . Cédmo

LaTing S) punterw & la RaA Ao taléuls 1

et LaKo)a - applicarion Hormuolu("!;rupa.xl-ﬂ.vu:k:hunts:"nzcmg";-‘j

Uefins L jURLECO a 16 PATILE SUPEI L e iGS BlemeRtor Ae la Tanla g punlo de

Set Fangodajide = LaMoje Raagd ("Pearceduperiorbister™)

Tlemrbang- RANQOYALLOA  'luriA TONGY tos eiementos = la fakdla v 4 |nterfupcién
tagre] . . i P T | ]
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La ventana Depuracién que se muestra en la figura 35.13 presenta el pro-
grama detenido en un punto de interrupcidn establecido en Ja instruccién
If destacada en el Panel de c6digo. El panel Inspeccién muestra los valores
actuales de elltem, elCosto y elDidlogo.EditBoxes(“CuadroCostol-
tem”).Text como variables de inspeccién. Observe que elCosto aiin no tie-
ne valor porque todavia no ha pasado el valor en elDidlogo.EditBo-
xes(“CuadroCostoltem”).Text. En este punto, puede continuar la
ejecucion del procedimiento, establecer o eliminar puntos de inspeccién,
examinar el valor de las variables o ejecutar el procedimiento instruccidn
por instruccion.

panel Ejecucion

En el panel Ejecucién de la ventana Depuracién, podrd escribir o ejecutar
casi todos los comandos de Visual Basic para Aplicaciones. La tGnica res-
wriccidn radica en que el comando deberd tener una extensién mdxima de
una linea. El panel Ejecucidn recibe también todos los valores impresos
generados por la instruccién Debug.Print, que se utilizan para imprimir
los valores de un programa que est4 siendo ejecutado. .
panel Inspeccion y expresiones de inspeccién

E{ panel Inspeccién muestra el valor actual de los puntos de inspeccion y
expresiones de inspeccion. Puntos de inspeccién y expresiones de inspec-
cion aparecen en el panel Inspeccién y muestran continuamente el valor
actual de las variables y expresiones. La diferencia entre ambos radica en
que aunque los dos muestran un valor, un punto de inspeccién puede de-
lener su programa si el valor seleccionado se modifica de alguna manera.

Utiliza Inspeccidn instantdnea para ver el valor actual de una variable o
expresion sin necesidad de colocarla en et panel Inspeccién.

La figura 35.14 muestra el resultado de seleccionar la variable elltem en E
la ventana Depuracién y elegir Herramientas, Inspeccion instantanea. W
Si elige el boton [Agregar]. la variable Inspeccién instanidnea se con- Aalall
vierte en una expresion de inspeccién y es afadida al panel Inspeccion.

; Dgpuac-in V-l'.bo.?,iﬂildulul e . - . i Fig. 35.14

: : 3 i Un panel de
Inspeccion
instantanea,

et LalHoja = Applxcn:xon.uurl‘boout'!)mp:.xlu").Uo:nhezcs('kecxbc@
‘Define =1 puntero a la parte superior de los elem=ntos d= la tabla <
Set RangoSalida * LaHoja.Rango ("ParteSuperiorlista®)
'Cl=arRang= RangoSalida ‘borce todos leos eiementos de la tabla
Num]tems = 1

*fregunta el nombre’ y el coste de 10 articulos. : ﬂ
Do ¥hile Numltems <+ RaxNumltems
‘(btener nombre. “'
fllten ~ ImpwtBox( Nombre [tem:®, *Crear Rocibo )
g e T P Tt PR -
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* Los comandos paso

Llegado este punto, puede utilizar dos comandos paso para gjecutar una
linea de su programa y detenerlo otra vez en el modo wnterrupeion: Ejecu-
tar, Recorrer todo y Ejecutar, Recorrer principol. E! comando Ejecutar,
Recorrer todo hace que el programa ejecute una linea a la vez. Si el pro-
grama se encuentra con un procedimiento. €l siguiente paso tiene lugar
dentro de ese procedimiento llamado.

E! comando Ejecutar, Recorrer principal es similar, pero cuando encuen-
tra una de procedimiento, ejecuta el procedimiento por completo antes de
detenerse v entrar nuevamente en el modo interrupcidn. Por eso. ¢l co-
mando Recorrer principal aparece para recorrer las llamadas de proced:-
mientos ¢n el procedimiento que estd ejecutando.

La ventana Llamadas

La ventana situada en la parte superior derecha de la ventana Depuraciin’
yue se muestra en la figura 35.14, presenta el procedimiento mtroducido.
Si pulsa en el cuadro con puntos suspensivos en el extremo derecho de ks
ventana DEPURACION. justo debajo de la X. se abrird lIa ventana Lla-
madas. Esta ventana muestra el nombre del procedimiento que contiene el
punto actual de ejecucion. St selecciona ka ventana Llamadas, ésta se am.
plia v lista todos los procedimientos activos en cste programa. Procedi-
mientos activos son aqueltos que o bien estdn ¢jecutando la tarea actuul o
bien pueden haber llamado a otro procedimuento para realizar otra tareg

0
)



Capitulo 38 Ry

C6émo usar Microso
en una red

por Robert Garrison

]ohn Donne escribié: “Ningin hombre es una isla en si mismo.”

Como usuario de Microsoft Office. tampoco es un usuario en si mismo.
Despsés de todo, ;tendria un ordenador para no compartirio nunca con

nadie?

Cuando usa Microsoft Office en una red, existe una mejora potencial en su
productividad. Obtienc este aumento de productividad trabajando en equipo.
En este capitulo aprenderd a:

8 Usar diccionarios compartidos en Word .

B Anotar documentos de Word
- I8 Usar revisiones de documentos de Word

W Programar reuniones con Schedule+

B Unlizar Uso compartido de archivos en Excel

B Utilizar Presentacion remota en PowerPoint

Como establecer diccionarios compartidos

En el capitulo 3 aprendié a usar diccionarios para verificar la ortografia en

sus documentos. Si se encuentra en una red trabajando con otros usuarios,

es posible que desee compartir diccionarios comunes. También es posible

que en sy oficina o industria se emplee un diccionario de términos especifi-

cos. Puede afadir hasta ocho diccinnanos para agilizar su trabajo. El dic- -~
cionano personahizado por defectc * llama Personalizado. Cuando agrega ¢ VEASE "Cémo revi-
palabras durante una revision ortogrifica, éstas se anaden al diccionario per-  sar la ortografia",
sonalizado. En este apartado usara Word para aprender mds cosas sobre los  pig. %0
diccionarios.

Pura crear un diccionario compartido, siga estos pasos:

1. Elija Herrdmientas, Opciones.
2. Pulse en la ficha Ontografia. Apareceri el cuadro de didlogo Opciones,
tal y como se muestra en la figura 38.1,
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Fig. 38.1

La ficha
QOrtografia le
permite
personalizar las
directrices para
usar los
diccionarios.

Consejo

Las palabras escritas
de forma incorecta
aparecen indicadas
¢con un4 linea ondula-
da roga 151 se establece
esta opConf £

Fig. 38.2

Al trabajar con
diccionanos
personalizados,
Ofice aprende
sus palabras
especiiicas

A medida que i + : Sugiere
escnbe, se verifica — oriografias *
la ortografia de las posibles
palabras

Imptde que el
corrector
ortografnco muestre
palabras can todas
las letras en
maytisculas

Marque aqui cuande no desee sugerencias de los
diccionarios personalizados

3. Para anadir un diccionario personalizado, pulse en Diccionanios
Personalizados. Apareceri el cuadro de la figura 38.2.

Pl S AT 3 e Lo ) e Y i Hee i Y Ay ) i

Diccmnanas peironabz ades [ 1] %]

Use fos botones de opcidn de Diccionarios Personalizados para hacer lo
siguiente:
Bl Nuevo le permite crear un diccionario personalizado.

B Edicién le permite editar el diccionario seleccionado. E! diccionario es
un documento de Word.

B Agregar ' permite hacer que un diccionario existente. probablemente
localize..” <n una Gnidad de disco de red. sea verificado para la orto-
grafia.

B Quitar elimina un diccionario de su lista de diccionarios personalizados.

@ Ruta le muestra la ubicacion del diccionario personalizado seleccionado,

4. Pulse en Nuevo para crear un nuevo diccionario. Aparecerd el cuadro
de didlogo Crear diccionario personalizado (véase la figura 38.3)

5. Despldcese por ¢l cuadro de texto Guardar en para colocar el diccio-
nano personalizado en un directorio de red compartida. Asi. otros

18 P
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podrdn usar su diccionario si agregan el diccionario a su lista de diccio-
narios personalizados. :

6. En el cuadro de texto Nombre de archivo. escriba el nombre del nuevo
diccionario. Por ejemplo, escriba Especial y pulse en Guardar. Se cre-
ard un documento estindar de Word.

7. Ldo que se trata de un nuevo diccionario, no encontrard patabras en €l.
Puede elegir Edicion para agregar palabras manualmemc o agregarlas
— durante una revision ortogrifica.

8. Cuando haya terminado. realice una doble pulsacién en {Aceptar] paru
volver al documento.

Se ttene un Iengua;e especﬂico o términos técmcns que,usa én su traba;o,
podra. colocarlos en un- dtccnonano pefsonah ado* C

necesite, Ehmmar diccionarics’ personairzad 5P
revisién de un documento Sl no utlltza ese’ t:po de

Iabras en ‘el diccmna-
rio todo el tiempo. .

“he .t 3 -
M dre 2 : PRV

o

¢Para qué compartir dlcuonanosi‘ Si en su red hay un numem e!evado de .
usuarios, cada uno de los cuales agrega las T mismas palabras a diccionarios

: personalszados individuales, el gasto de espacio es muy alto. Ademés, )
posible que no todos conozcan la ortografia correcta: Eluso, de un dnccxo-
nario compartido le ayudard a curnphr con los est.’sndares Ia compaﬁsa
de forma coherente, : 7

Wl

Para agrepar palabras a su diccionanio personalizado durante una revision
onogrifica. siga es10s pasos:

1. Etija Herramientas. Ortografia para iniciar la revisién ortogrifica.
Aparecerd ¢l vuadro de didlogo Onografia (vedse la figura 38.4).

2. Para agregar nuevas palabras a su diccionario especial, elija ESPE-
CIAL.DIC de la st desplegable Agregar palabras a:.

3. Pulse en Agregar para agregar la palabra no reconocida al diccionario
especial.

19

Cuando escriba el
nombre de su diccio-

Fig. 38.3

Word puede
almacenar sus
palabras especi-
ficas si fe pro-
pOrciona un
nuevo .
diccionario,

4 VEASE "Como Usar
Cuadros de Dialogo
Archiva®, pig. 98

Consejo

| nano. no escriba un
{ punto ni una exten-

si0n Word apade fa
exensén DI auto-
maticamente
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Fig. 38.4
Ahara puede
verificar la -
ortografia del T ——y—
documento y La palabra que A -
agregar al puede ser — T
diccinnario las reemplazada i
palabras
especiales.
Le permile
seleceionar su
diccionarno
especial
» Ll
Como usar anotaciones
Anotaciones permite & los autores hacer comentarios en un documento sin
VEASE *Como tra- modificarlo. Un uso particular de las anotaciones puede llevarse a cabo den-
bajar con correo dis tro de un documento que estd siendo distribuido por Microsoft Exchange.
tribuido®, pag. 730 Para hacer anotaciones en un documento, siga estos pasos:
= 1. Abra el documento™Word.
- - 2. Coloque el punto de insercién en donde desea insertar una anotacion.
3. Elija Insertar, Anotacién. Se abrird la ventana Anotaciones. tal ¥ como
se muestra en la figura 38.5.
Fig. 38.5
l.a ventina
Anotaciones
contieng
comentarios v
SUBLTENC 1as ————— LTI e s
acuerea del THE e 1 4 P P e

Insertar Ohbjeto de
sorido le permite
incluir anotacianes
SONOras s1 hene una
tarjeta de sonido en
su sistema

documento que
wsta revisando

WEN Lt . . - e, .Ilg

4. Escriba su comentario en la ventana Anotaciones. El cursor se colocara
automiaticumnente alli al elegir Insertar. Anotacion. Fijese qoe cada iuno-
I&nseio tacion conuenea con las miciales del autor y que va numerada secuen-
S — aalmente.
Silac inciales no son »
corteclas cdmbielas . Pulse en [Cerrar] cuando termine con esta anotacion,
oot L i ha 6. Si deseu ver 1odas sus anotaciones, o las de otras revisiones, elija Ver,

|
l -
tnrmagion, det usua- l - Anotaciones. La ventana Anotaciones, mostrada en la figura 38.5. «¢
1
!

n

i desoués de elog mantendra ¢biena en la pantalla.
Herramientus,

Opciones.
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Cémo usar marcadores de revision

Los marcadores de revisin son diferentes de las anotaciones. Mientras que
las anotaciones son comentanios que no alteran el documento, los marcado-
res de revision indican los cambios hechos en el documento.'Revisiones
como la tnsercién, eliminacién o modificacidn del texto pueden aparecer en
colores y fuentes de texto diferentes. Las revisiones de cada autor pueden
marcarse en un color distinto..Hasta ocho autores pueden revisar un docu-
mento sin que se repita los colores. Puede ver como aparecerin las revisio-
nes en su documento eligiendo Herramientas, Opciones y realizando una
pulsacion en la ficha Revisiones.

Puede hacer revisiones en su documento siguiendo estos pasos:

I. Eiijja Herramientas. Revisiones. Se abrird el ‘cuadro de didlogo
Revisiones (véase la figura 38.6).

Las siguientes opciones estan disponibles:
B Comparar Versiones compara el documento en curso con otro en
disco. Todos los cambios se marcardn automdticamente.
W Unir revisiones aplica los cambios de un documento revisado al docu-
mento original.
W Opciones le permute fijar el color y el estila del texto insentado. elifmi-
nado o modificado.

2. Pulse en el cuadro Marcer revisiones mientras se modifica y elija
[Aceptar]. Sus revisiones aparecerdn en pantalla a medida que las vaya
realizando.

3. Ahora haga algunos cambios. Por ejemplo, primero seleccione una frase
y cortela. Después, mserte esa frase al comienzo del parrafo.

Su documento mostrarad revisiones similares a las de la figura 38.7.
Cuando termine con las revisiones. puede guardar el archivo o enviarloa la
sigwiente persona si el archivo le fue distribuido. Una vez que todos han
hecho rodos los comentanos y revistones necesartos, alguien deberd decidir
cudles son las revisiones que hay que aceptar para que formen parte dej
documento. Para ello, siga estos pasos:

1. Elija Herramientas. Revisiones.

2. Pulse en Revisar. y se abrird el cuadro de didlogo Ver revisiones {véase
la figura 38.7).

o« VEASE "Cémo
modificar las opeio-
nes de revision®,

pdg. 219

Fig. 38.6
Use'el cuadro
de didlogo
Revisiones para
indicar las
modificaciones
en el 1exto.
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Fig. 38.7
Cuando se
activan jos
marcadores de
revision, Word

; e 1 tabe s aparurcns ‘ it
muestra qué : TN v ot hpogimobethpssiobe ol e .+ Eiexo msenay

texto ha sido ) - sparcce con
modificado. . . —dﬁllﬁd’inu Palecs g Evpomcmnes = subravado dOb!E,

El 1esior ehmlnadJE)

Todo el texto que

presenta marcadores aparece tachado %o
de revisidn viene o #
indicado por barras A v
verticales en los 1.
mirgenes — g:c
MM - Ee we WBh
hm@mmmw E-TBE«'- i
Use el cuadro de didlogo Ver revisiones para aceptar o rechazar las revisio- ’
nes propuestas en st documento. H
- l"
= » e . -
Como usar Schedule+ para reuniones
Uno de los mayores retos que plantean ios lugares de trabajo hoy en dia. es :
encontrar el tiempo para reunirse, hacer planes y tomar decisiones. Si todos ¢
sus colaboradores estdn usando Microsoft Office (y. por supuesto. 1o estin E
» VEASE “Como pro- haciendo} puede utihizar Schedule+ para programar esas reuniones a la con- b
oriimar s liempﬂ‘f veniencta de todos los asistentes. f
-] ' .. .
pag. 834 Para programar una reunidn con colaboradores, siga estos pasos: E
1. Connute a Schedule+ v pulse en la ficha Plan. La ventana Plan de ~u |
agenda apATECeTh. 1ol v COTD 32 ThoRsTa e fa figora 308, Firse gue bos Y;
parucigantes de cu.s'lqmer Teunion anterior apareceran en el cuadro :
Asistentes para facilitar 1a tarea de planificacion.,
fig. 38.8
Planmcando
TUMONe: B

RIUPO Plan mensual

— C drndan mens

Le permite
selecoonar |
dsistentes of
v NECEsanos
reCUTSS

5 | i | 895

[ [t o il |

Envia una

conv atona de Asistentes ¢

rareninn g Lo adctantes reunioncs
anterniores H

b
J
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2. Seleccione una hora para la reunién manteniendo presionado el botén
del ratén y armastrando éste hatsa el horario de finalizacion de la reunidn.

3. Puise en Invitar para seleccionar a los asistentes. Aparecerd el cuadro de
didlogo Aststentes, tay como se muestra en la figura 38.9,

Y

Turle i win lentey_aden

Recursos
necesarios para ia
reunion, Los
recursos vienen
determinados por

tste cuadro muestra
los asisientes

opcionales
el adminstrador
del sistema, y
pueden incluir
habitaciones o
Lista de Nombres equIpo.

e .t
Este cuadro'mdestra los asistentes necesarios

4. Seleccione la libreta de direcciones apropiada usando la lista desplega-
bie Mostrar los nombres que figuran en. normalmente fa lista de direc-
ciones del servidor de correo,

5. Seleccione un nombre de persona o de recurso en [a lista de nombres.

6. Pulse en Necesario para agregar una persona a la lista de asistencia
necesaria.

7. Pulse en Opcional si 1a asistencia de la persona no es obhgatona

8. Pulse en Recurso si el nombre dz la lista es un recurso,

9. Repita los pasos 6-8 todas las veces que sea necesario. Pulse en
| Aceptar] cuando termine (véase ia figura 38.10),

18, Pulse y arrastre cubriendo el intervalo de duracién de a reunion,

11. Pulse en Convocar reunidén y se abrird una ventana de mensaje
Microsoft Exchange. Rellene la el cuadro de texto Asunto y escriba el

9
W)

B VEASE "Como crear
un mensaje’, pag. 717

Fig. 38.9
Invitando a su
personal a una
reunién.

Consejo

L

Para eliminar un nom-
bre de una de las lres
listas, pukse en el
nomixe v pulse
<Supr>. Aseglrese de
borrar los signos de
Nt ¥ Coma que
separan los nombres al
eliminar un nompre

Fig. 38.10

Ef programa de
reunidén
completo.

et L
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C6me esar Hicrosaft Ofice en ona red

Fig. 38.11
Vease {a reunion
programada a
pantir de las citas
del dia, del
mensaje de
convocatoria de
la reunicn

El asunto de la reumdn
es el mismo que
aparece en el cuadro
de 1oxto Asunto

T =

Fig. 38.12

La ventana Cira
muestra los
detalles de la
FEUNIoN
pragramada.

texto del mensaje. Pulse en [E'nwar] para que Microsoft Exchdngc
envie por correo la convocatoria de r=unién.

12. Pulse en la ficha Dia y verd su agenda personal para ese dia‘(véase la
ﬁgura 38.11). '

El scono Reunion
indica una reunién
prograrnada en iuga:
de una cia

TV R R s
e e T T e Y "uﬂ".z"%ﬁ
bl & -J"'W:t SRR LT D

El lugar de la
reunion aparece
tras e} 1Icuno casa

Aviso de
alarma

13. Si desea informacién adicional sobre la reunién o desea cambiar |a
hora del aviso, realice una doble¢ pulsacion en uno de los i iconos. Se
abnird la ventana Citas (véase la figura 38.12).

La ficha General
muestra la hora de {a
reunion

Una descripcion gue
puede ser editada

La hora de aviso,
que puede ser
djustada

s -

k4. Pulse en la ficha Asistentes para acceder a informacién adicional
(véase la figura 38.13).
Tarnbién puede crear notas sobre la reunion para su uso personal. Las notas
onginales son el texto del mensaje de convocatoria. Pulse en la ficha Notas.
La ficha Plan muestra una mmni-vista del Pian.
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;;15 signo 7 delante del
& nombre indica que el

o q'm‘lado 10 ha
;ij"mspondido . l E

Le permite afiadir
mas personas a la
reunion

Como utilizar Uso compartido de archivos
en Excel

Cuapdp esté trabajando en una red con otros usuarios. querrd utilizar la fun-
cién Uso compartido de archivos de Excel para algunas de sus hojas de cdl-
cule- Yso compartido de archivos permite que muiltiples usuarios puedean
acceder v modificar una hoja de cdlculo en una unidad de disco compartida.
Si un archivo se guarda cuando ¢sta opcidn estd activada, no se podrin
modificar Jos formatos de celda ni las férmulas.

Para utilizar Uso compartido de archivos, siga estos pasos:

1. Pulse en Archivo, Compartir y después pulse en la ficha Edicion.
Apareceri el cuadro de didlogo Uso compartido de archivos (véase la
figura 38.14).

ALETT) cnqumdo [« LT hnms

2. Pulse en la ficha Estado de) cuadre de didlogo mencicnado para ver
quién hiene el archivo abiento {véase la figura 38.15).

Si efectia un cambio en Ia hoja de célculo e intenta guardarlo mientras otro
usuario estd usandola, se le preguntard si desea actualizar el archivo com-
partido. Para poder conocer los cambios realizados.utilice Mostrar historial

25

Fig. 38.13
Como
comprobar
quién mads
asistird a fa
reunion.

Fig. 38.14

A través de Uso
compartido de
archivos, otros
usuartos en red
podran acceder
simultaneamente
a una hoja de
célculo.
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Lime usar Microsoft Office en una red

Fig. 38.15

Excel mantiene
el seguimiento
de los usuanos
que tienen un
archivo abierto
cuando se activa
fa opcion Uso
compartido de
archivas para

ese archivo,

h
"

de conflictos. Cuando se activa la opcién Mostrar historial de conflictos
para un archivo. se agrega una hoja de célculo al libro de trabajo que pro-
porciona un seguimiento de los cambios efectuados.

1y compesid,

Cémo utilizar una presentacion remota

El comando Herramientas, Presentacion remota le permite revisar una
presentaci6n de PowerPoint durante su desarrolio o realizar la presentacion
final a través de la red. Los asistentes no tienen que desplazarse para ver Ia
presentacidn, sino que permanecen sentados a sus mesas de trabajo.

Para llevar a cabo una conferencia, use el asistente para Presentaciones
remotas para preparar la presentacién. Como moderador de la conierencia
puede usar Notas de la reunién para crear notas en el transcurso de la pre-
sentacion, agregar actas y planes de actuacién. También puede utilizar
Desplazamiento por diapositivas para ver y bifurcar hacia sus diapositivas a
medida que avanza en su presentacion.

Para organizar la Presentacién remota tiene que conocer los nombres de los
ordenadores de los asisientes. Los participantes pueden obtener el nombre
de sus ordenadores inciando Red desde el Panel de Control y realizando una
pulsacién en la ficha ldentificacidn.
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Ron Person ha escrito mas d=
18 libraos para la Corporacion
Que, incluidos la Edicion
Especial de Como Utilizar
Word 6 para Windows, ia
Edicién Especial de Como
Utilizar Excel para Windows
495, y fue e autor principal la
Eclician Especial de Como
Utilizar Windows 95, Siendo
una de los socios asesores |
veleranos de Microsoit, Ron
ha estifo desarrollando las
solucianes de Microsoft Office
v preparando a los encargados
del desarrollo corporativo
durante siete anos.

Cémo Construir
Formularios

-y Cuadros
“de Dialogo Llenar

En e! pasado, una de las labores de oficina que los
procesadores de texto no podian realizar correc-
tamente cra rellenar formulunios. Se necesitaba
siempre una mdquina de escribir para rellenar un
formulano. Por otr purte. los almuacenes v archi-
vadores ocupaban demasiado espacio sélo pury
guardar inventarios y formulanos mensuales, que
en algunos casos se empleabun tan rarmmente gue
incluso vencian antes de ser retirados de Jos estan-
tes.

Las nuevas funciones de formulanios de Wond
constituyen un gran paso hacia fa supresion de los
formularios presmpresos. Ahora. con Jas tuncio-
nes de autoedicidon de Word, muchus compariiis
disefan formularios que guardun como plamtitlas,
v que se imprimen cuando es nécesano, Bl ahorro
en el costo de impresion de gran cantidud de for-
mularios puede ser inmenso.

En la actualidad. Word incluve fademis de su
capacidad de producir formulanos de alta calidad
a peucion) funciones que facilian la tarea de
rellenar formulanos. Usando dos campos de for-

TBCRICAS e 1os
Profesionales

por Ron Person
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mulario de Word, podrd colocar cuadros de edicién, casillas de venificacién
v listas desp) sﬁ ables directamente en sus documentos. El uso de los campos
(fill in) y {ask} hace posible que un documento muestre cuadros de didlo-
go solicitando informacién,
En cste capitulo aprenderd a:
B Crear una plantilla en la que podra colocar cuadros de edicion, casillas
de venticacion o listas desplegables
B Bloquear la plantilla para impedir que los usuarios cambien partes no
autorizadas del documento
M Especificar listas de datos que aparecen en listas desplegables, o forma-
tear los datos introducidos por un usuario en un cuadro de introduccidn
de datos
B Usar un campo {fill in] para abrir un cuadro de didlogo
B Solicitar una sola vez un item de informacion y utilizarlo varias veces a
lo largo del documento
M Crear una macro sencilla que controle cada cuadro de didlogo al abrirse

Conceptos basicos de los formularios

Un formudario es un tipo especial de documento protegido que incluye cam-
pos en fos que se puede escribir informacién. Cualquier documento que
incluye campos de formutano es un formulario. Un campa de formulario es
una ubicacion en pantalla en la que puede hacer una de estas tres cosas:
introducir texto. activar o desactivar una casilla de venﬁuuun o seleccio-
nar de una lista despiegable.

Dado gue Jas celdas de una (abla son el marco ideul para fos rétulos de un
formulario v para los campos de informacion, muchos formularios basan su
estructura en una tabla. Podrd escnibir rotulos en algunas celdas € inscrtar
cumpos de formulario en otras. Las tablas también facilitan 1a tarea de agre-
gar sombreados y bordes a un formulario. Podri cotocar un borde oscuro
alrededor de un grupo de celdas seleccionadas en una tabla, por cjemplo.
dejundo el resto de Jas celdas sin borde. Una tabla no tiene por qué tener
aspecto de tabla en absoluto, s1 las cuadriculas estdn desactivadas, por fo que
constituye ¢f marco rdeal para un formulario,

LUn formulano puede basarse en cualquier ipo de documento. Un contriuto
mmobiliano. por ejemplo. puede incluir varias pdginas de pidrrafos
descriptivos que contienen campos de formulario en los que podrd insertar
informacién. El texto de los pdrmrafos no cambiard ya que insertard Ja infor-
macién dnicamente en los campos de formulario.

Puede incluir tres t1pos de campo de formulario en un formulario: texto,
castila de verificacion y lista desplegable. Asimismo pucde personalizar
cada uno de estos upos de campo de muchas maneras, Por cjemplo, podri
formatear un campo de texio para que acepte dnicamente fechas e imprimir

Techas del upo 1 de enero. 1995, como 1/1/95. o en cualguier otro tormato,

Las figuras 39.1. 39.2 v 30.3 muestran ¢jemplos de los tres formularios qut,
sé pucden crear usando Word. .

28
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Podra utilizar formularios de varias maneras a fin de ahorrar tiempo, esfuer-
7o y dinere. Puede crear sus propios formularios de negocios de uso corrien-
te, como facturas de venta, hojas de pedido, fichas de personal, calendarios
v contratos normalizados, Asimismo puede imprimir una copia de su for-
muliriv en blanco v reproducirlo en grandes cantidades, empleando color si
lo desea. Despuds. impnima unicumente ia informacion conlenida en su for-
mutirio en los formulanos prcnmpresos v la informacién se colocard correc-
tamente.

También’ puede automatizar los formularios que no necesita imprimir.
Distribuya al personat de su compaiia plantillas de formularios, en lugar de

29

Fig. 39.1
tiemplo de un
formulario de
pedido/entrega.’

Fig. 39.2
Ciemplo de un
tormulano de
factura.
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Fig 39 3 U« Mhiceseft Woud Alll'ltl
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Ex

Jo mensajes dtiles en pantalla y macros automdticas.

Puede incluir cdlculos en los formularios (por ejemplo, sumar los precios de
los items de una factura de ventas, de modo que se muestre el imporie ol
de la factura), Asimismo podrd agregar campos de formulario a documen-
tos que no sean formularios. Cuando los campos aparecen sombreados, la
gente reconoce faciimente donde debe introducir la informacion necesaria.

Los formularios mas dtiles estdn basados en plantillas, que se pueden usar
una y otra vez. Cuando uno rellena un formulanio de este tipo. lo que hace
es rellenar una copia, con 1o que el onginal no cambia. (Obviamente puede ~
crear un formularto como documento en vez de como plantilla si va a utli-
carlo sélo una vez}. Cuando algwen crea un nuevo documento basado en
una plantilla de formulario hecha por ud.. esa persona podrd escribir la infor-
macion unicamente en los campos dcslgnados por ud. cuando ¢red y prote-

g6 el formulario.

Atencion

formularios en papel. Puede simplificar el uso de los formularios incluven-

A no ser que anada proteccién con una contrasena, cualquiern
que use el formulario puede desprotegerlo v realizar cambios no
sdlo en los camnos, sino también en otras partes del formulario.
Mds adelante » este canitulo, aprenderd a proporcionar 1d
mixima proteccion a las plantilias de formulario,

Puede crear formulanos usando dos herramientus importanies:

W Insertar. Campo de Formulario. que se usa para insertar v personali-

zar campos de formulano

M La barra de herramientas Formulario, que contiene herramientas para

crear v personalizar formularios (véase la figura 39.4).

30
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Fig. 39.4

La barra de

herramientas

Formulario
Puede desplegar la barra de herramientas Formulario eligiendo Insertar.  incluve
Campo de Formulario y eligiendo Mosirar Barra o eligiendo Ver,  herramientas-
Barras de Herramientas y seleccionando Formulario de la lista Barrgs ~ para avudarle a
de Herramientas. Como altenativa, puede pulsar con el botdn derecho ”‘Ta' Y 'perso-

. del ratén en la barra de herramientas Estandar y seleccionar Formulario de lr:‘a“:f:r ormu-
la lista desplegable de barras de herramientas. h

Cémo crear formularios

El proceso de creacion de un formulario simple consta de tres partes.
Pnmero: deberd crear una plantilla nueva; construir la estructura del formu-

* ldrio (el marco del formulario); anadir rétulos, formato, sombreado. bordes
v cualquier otro elemento que no se modifique cuando los usuarios rellenen
el fomnulario. Después, inserte los campaos de formulario donde desee escri-
bir la informacidn al rellenar el formulario. Por dltimo. proteja v guarde el
tommiano.

Cémo crear y guardar la estructura del formulario

Ontra forma de crear un formulanio es utilizando marcos. Cuando enmarca
una tabla o texto seleccionado. puede colocarlos en cualquier Jugar de la
pagina yue desee (véase la figura 39 5). De esta manera, puede separar la
porcion de un docsmento que contiene los campos en los que debe insertar
informacicn proventente de otras partes del documento donde es posible que

el texto no se modiique.

*. Antes de empezar a disefar un formulario en su'ordenador, ‘e aconsejable
- hacer un borrador en papel, especialmente si usa una tabla como estructu-
ra para el-formulario. Gracias al borrador, . sabrd cudntas:filas y columnas

. hecesita en su tabla, dénde escribir los rétulos y ddnde insertar los campos
de formulario. Incluso si cambla el formulano en el proceso, I¢ resultaré més
‘ficil empezar con un plan. ’ e -

.

Para crear v guardar la estructuray del tormulario como pl.mulla slg__d estos
pusos;

1. Ehja Archivo. Nueve. Apareceri el cuadro de didlogo Nuevo.

2. En fa lista Plantilla. seleccione la planiilla que desea usar como base
para su formulanio. En Ta mavoria de los casos, puede usar la plantilla
Normual. ‘

3. Seleccione Plantilla del grupo Nuevo,

4. Elija |Acepiar].

3. Establesca ta estructura det formulano de alguna de las siguicntes
maneras:

31
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fig. 39.5 .
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Inserte una tabla e]ig}éndé Tabla, Insertar Tabla. o realizando una pul-
sacion en el botén [Insertar tabla] de la barra de herramientas Estindar.

. |Conseio"‘
"OSELIa BN nuesg for-

mular o cora docu-
mMerse DOGL seeuls

Escriba los rotulos v cualquier otro texio que no vaya a cambrar en el for-
mulano. Formalee fa tabla con lineas, bordes v sombreado.

Cree un formulario basado en pirrafos insentando campos de formutario

donde fos necesite a medida que escribe texio en su documento. Lea el
sigente apartado. "Como agregar campos de formularie”, para aprender
dansertar campos de formulario. ' '

audrdandolo coma
uny: ptanti fa,
Guardely amra vez
wsando archi o,
Guardar Comio

Sele cione Phanlla
de Documento
~.DOT enlatita
desplezaile Guardar
{unln,

En la pane superior de su documento, inserte la tabta o tipo de texto que
va i contener los campos de formulano. Seleccione, enmarque v cologue
esta porcion de su documento. Después escriba el resto del formulario,
que incluird el texto que no cambia cuando se rellena el formulano.

6. Elija Archivo. Guordor como para guardar fa plantilla. Escriba e! nom-
bre de la plantilla en el cuadro Guardar como, y después elija { Aceptar].
Deje su plantilla abierta para poder agregar los campos de formulario.

Las plantillas normalmente se guardan en la carpeta PLANTILLA situada
bajo ta carpeta que contiene a Word. Si se instala Microsoft Office, las plan-
Lillas se almacenan en lu carpeta MSOFFICE\PLANTILLA.

_ Como agregar campos de formulario

Conseto . ) . .o
PR Después de establecer Ja estructura de su formulario (1anto si es una tabla,
S eacendoun un blogue de texte enmarcado o un pirmafo), puede agregar los cumpos de
formule-io que conlies | i lario. Los o de § luri : | us introducir datos
e machos campos de | _formulario. Los carnpos de formulario permiten al usuano introducir datos.
AR Como se ha mencionado anteriommente, los tres tipos de campos de formu-
00213 bempo lariv son 1ealo. cusn_ilu de venﬁqucmn y lista desplegabie. Pucde’ agrepar
COBMIRGO LT €m0 campos de fomuularic a su plantilla usande un comando de mend o reah-
ue g mulans exsien- zando una pulsacion en los botones de la barra de herramientas Formulano.
te v pegandolo o L
nueva uhx acion,

e

Para agregar campos de formutario a su documento usando un comando de
mena. SR €510s PasOy”

L2
(%)
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Fig. 39.6

El cuadro de
didlogo Campo
de Formulanio le
pérmite elegir ef
tpo de campo.

1. Coloque el punto de insercidn donde desea que aparezca el campo de

formulario.

2. Elija Insertar, Campo de Formulario. Aparecerd el cuadro de didlogo

Campo de Formulario (véase 1a figura 39.6).

3. Seleccione Texto, Casilla de verificacién. o Listo desplegable del

grupo Tipo.

4. Elija [Aceptar|. El campo de formulano aparecerd en su documento

(véase la figura 39.7).

x =
Fig. 39.7
'_'] &mm thWW*MzIWWMMMA Ln campo tle

formulario
aAparcce en su
documenio,
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Puary agregar campos de formulario a su documento usando la barra de herra-

mientas Formulano, siga estos pasos:

A VEASE *Como ulifi-

1. Despliegue la barra de herramientas Formulario eligiendo Insertor, 7ar las barras de
Campo de formulario. y realizande una pulsacién en el boton Mostrar — herramientas en apli-
barra. Aparecerd la barra de hemumientas Formulario (véase la figura  caciones de Microsoft

39.8).

Office”, pag. 41

Como alternativa. use otra técmica para desplegar 12 barra de herramien-

tas Formularto,

)
(v
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Fig. 39.8

Puede usar la
barra de
herramientas
Formulario para-
simplificar la
creacién de un
formulario.

Fig. 39.9

j o campos de
formuiario apa-
recen sombyre-
ados cuando
pulsa en el boton
de vpuitn
Sombyresdo de
campo en la
barra de herra-
mientas For-
mulario.

Fig. 39.10
Sino puisa en el
botin Sombre-
ad de camyxa,
los campos de
tormetlano con
teat no apare-
Leran en
absoluto, nuen-
tras gue los
campus Lon
Casilia de veni.
cacn v lista
desplepable w
TEIAN
enmarcaclos

e o

2. Coloque el punto de insercién donde desee agregar un campo de for-
mulario.

3. Pulse en una de las herramientas que aparecen a la izquierda de la barra
de herramientas Formulario: i

I_Iab’ Para insertar un campo de texto, pulse en el botén [Campo con texio].

Para insertar una casilla de verificacion. pulse en el botén {Campo con

I X | casilla de verificacién].
r@“ Para insertar una lista desplegable, pulse en el botén {Campo con lista

desplegable]. (Observe que una lista desplegable esu vacia hasta que la
personaliza agregindole items: véase el apartado "Como personalizar
campos de formulario con lista desplegable”. mds adelante.)
Aparecera un campo de formulario en su documento,

4. Repita los pasos 2 y 3 para agregar campos de {formulano a su docu-

mento, .
=] i} S 2 FI eI o (W19 2] e
fraimiee mlpe At e e wimiw e oo e

J-ﬁni-,..

Tewxn
Caeyle de varfietion
Lidadecplematble

Obhsérvese que la bura de herrumientas Formulario contiene un botén con
fa opcion Sombreado de campo. Si selecciona esta herramienta. los campos
de formulario apareceran como rectdngulos sombreados en su pamalla
(véase 1a figura 39.9). St no selecciona esta herramienta. los campos con
tealo aparecerdn sin sombreado o borde, los campos con casitlas de venti-
cacion aparecerin con un contomo cuadrado. y los campos con lista desple-
gable aparecerin con un conlomo rectangular (véase la figura 39.10).

Los pasos anteriores insertan cuadros de texio, casillas de verificacion o lis-
tas, pero no podri usar estos campos de formulario hista que proteji su
documento o plantilla. 1al ¥ como se describe en el sigutente apariado.

Tt Lrisin: you! ymain; Lty ) tivesrmariin | Lithe Shpbend L0, A (i T a9 o
'Cla] ST B|T] nkitE] i Dejef g 5T O
frorea 2 [Nrrseveny™ N :,‘ME".}.:‘M:!_}
v, ; S TR & a0, T AL S oy
Toxt~
= Casitha de vemnicacien
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Cémo proteger y guardar el formulario

Hasta que no proteja un docurnento que contiene campos de formulario,
podri editar cualquiera de sus partes, campos con texto o los campos de for-
mulario. Una vez que el documento estd protegido, podra rellenar un campo
de formulario, pero ya no podra editar el documento.

Un formulario protegido difiere de un formulario no protegido en varios
aspectos. Por ejemplo, Cuando un documento protegido estd en el modo de
ver Disefio de pagina. no puede editar €l documento, sélo podra insertar una
respuesta’en un campo de formulario. No podra seleccionar el documenio
enteta, ni usar la mayor parte de los comandos. incluidos los comandos de
forrgatp. Las tablas y los marcos estdn fijos, y los campos con férmulas
reflejardn resultados en vez de las férmulas.

Padri desproteger un documento fiiciimente cuando desee editarlo, a no ser

que alguien lo haya protegido con una contrasefia. Para aprender a usar la
proteccién con contrasena. consulte el apartado "Cémo proteger y desprote-
ger un formulario con una contrasefia”. mas adefante. Para aprender a pro-
teger sélo una parte del formulano, véase mds adelante el apartado "Cémo
proteger parte de un formulanio”.

Siempre y cuando designe como planulla su nuevo documento, W()rd aulo-
midticamente lo guardari como plantilla (usando la extension DOT) y pro-
pondrd guardarlo en la subcarpeta PLANTILLA, en donde deberd perma-
necer para gue Word sea capar de encontrarlo cuando cree un nuevo
documento. Para utilizar su formulano como plantilla que aparece al clegir
Edicion, Nuevo. no cambie ni la carpeta nj la extensién de archivo. (podrd.
sin embargo. especificar que desea almacenar todas las plantillas en una sub-
carpeta diferente eligiendo Hemamientas, Opcienes, seleccionando la ficha
Archivos. y modificando las Plantillas personales.)

Para proteger v guardar su formularnio, siga estos pasos:

1. Elija Herromientas, Proteger documento. Aparecerd el cuadro de did-

Ioeo Proteger documento (véase la figura 39.11).
2. Scieecione Formulanios. y elija [Aceptar].

A I v T L saSes. 21
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3. Elija Archivo, Guardar como (vfus la figura 39.12). Escriba un nom-
bre en el cuadro de texto Nombre de archive. asegiirese de que
Plantilla de documento est4 seleccionado en la lista Guardar como v
que la subcarpeth PLANTILLAS y la carpeta MSOFFICE estdn selec-
cionadas en la lista de carpetas. La carpeta PLANTILLAS estd ubicada
bajo la carpeta WINWORD si no tiene Office 95,

4. Elija [ Aceptar] para guardar el archivo como plantilta. .
Para desproteger su formulario, elija Herramientas, Desproteger
documento.
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Si su formulario estd protegido con una contrasefia, deberd introducir la
contrasefia para desproteger el formulanio. Véase la seccion "Cémo proteger
y desproteger un formulanio con una contrasefia”, mds adelante. ’

Para proteger v desproteger su formulario usando la barra de herrammentas
Formulario, pulse en ¢] botdn [Proteger formulariof de 1a barra de herra-
miemas Formulario. Si el botdn aparece presionado. el formulario estd pro-
tegido; si aparece en relieve, el formulano estd desprotegido.

Word tiene dos maneras de guardar formularios. Puede guardar ¢l formula-
rio completo. incluidos Jos campos, rétulos y la informacion introducida en
el mismo. O bien puede guardar solo la informacién intreducida en un for-
mulario. de modo que pueda usar estos dalos con otro programa. Véase el
apartado "Como guardar formularios en pantalla” mas adelante en este capi-
tulo, para detailes acerca del segundo método.

- Cémo uiiiizar un formulario en pantalla

La gran ventaja que ofrecen fos formularios es que en vez de editarlos, abre
una copia vaciy del formulario (conservando intacto ¢l original) y despuds
e desplaza de un campo a otro. introduciendo la informacion donde corres-
ponda.

Los tres bipos de carnpos de formularios (texto, casilla de vertficacian v Hsta
despleguble) no »dlo presentan un aspecto distinto. sino que adémis cada
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uno requiere que utilice un enfoque especifico (véase la figura 39.13)

Puede personalizar su formulano de varias maneras. Por gjemplo. puede
personalizar un campo de texto de modo que contenga sdlo fechas y que for-
matee Ia fecha que introduce de una determinada forma. Cualquier tipo de
campao puede llevar adjunto un mensaje de ayuda de modo que cuando entre
en el campo o pulse <Fi> Jas instrucciones de uso del campo aparezcan en
la barra de estzdo. En algunos campos, alguna respuesta particular puede
producir algun tipo de accion en ofra parte del formulario: por ejemplo. una
respuesta positiva a un campo con casilla de verificucion puede activar otro
campo postenor en el formulario. Manténgase alerta sobre lo que ocurre en
{a pantalla mentras rellena su formulano.Para abnr un formulano. siga estos
PisOn: '

L. Elija Archivo, Nuevo. Aparecerd el cuadro de dulogo Nuevo (véase la

figura 39.14)

2. En la lista Plontilla. seleccione el nombre de su jormulario.

3. Elna {Aceptar]. Una copia sin titulo del formulario apareceri en la pan-
talla. con el primer campo del formulario seleccionado.
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Alin en el caso de que su formulario no estd basado en una plantilla. podra
usarlo abriéndolo como un archivo normal. Elija Archivo, Nueve, localice
y seleccione su formulario y elija [Aceptar]. Guardelo con un nuevo nom-
bre para conservar el enginal.

Cémo rellenar un formulario en pantalla

Cuando abre un formulario nuevo y protegido, el primer campo aparece
seleccionado (destacado).

Para rellenar los campos en un formulario, siga estos pasos:
1. Responda al campo seleccionado segin convenga.
En un campo con texto, escriba el texto o nimero requerido.

Realizando una pulsacién en las casillas de verificacion. éstas se activan
o desactivan. Palse una vez la barra espaciadora para marcar una casilta
de venficacién vacia; pulse la barra espaciadora una segunda vez para
quitar la marca de la casilla. (Las casillas de verificacidn pueden estar
marcadas por defecto; si este e el caso. pulse una vez la barra espacia-
dora para guitar la marca. 'y pulsela por scgunda vez para volver a poner
la murca). '
En un campo con lista desplegable, pulse en Ja flecha para desplegar una
lista de selecciones. y después puise en el ftem gue desee seleccionur,
bien. con el teclado. pulse <Ale+flecha hacia abajo para desplegar la
lista ¥ pulse las teclas de flecha hacia arriba o hacia abajo para selee-
cionar un item de la lista.

2. Pulse <Tab> o <intro> pura aceptar su entrada. Pasard una de dos cosas:
St su entrada es aceptable, Word seleccionari el siguiente campo.
Si su entrada es inaceptable. Word desplegari un mensaje de error v
regresara al campo actual para que pueda hacer una entrada correcta.
Por ejemplo, es posible que se encuentre con un mensaje de error, cuan-
do escribi texto en un campo con exto que estd formateado para conte-
ner numeros.

3. Conuiniie rellenando los campos hasta completar el formulario.

Si comete un error v desea volver al campo anterior, mantenga presionada
la tecla <Mawis> mientras pulsa la tecla <Tab> o <intro> hasta quc se
encuentre en ese campo, Para desplazarse al campo siguiente sin hacer una
entrada. sencillamente pulse <Tub> o <Intro>. También puede moverse de
un campo a otro pulsando las teclas de flecha hacia arriba o hacia abajo.
lgualmente podri desplazarse al inicio o al final de su Formulano pulsando
<Control>+<Inicio> o <Control>+<Fin>.

Paru cditar una entrada en un campo que ya ha dejado atrds, use ¢l ratén o
fas teclas de flecha para colocar el punto de insercién junto al teato que
desca editar: pulse <Retroceso> para borrar caracleres, o escriba los carac-
teres que desea insertar, '

Si desea insertar un cardcter tabulador en un campo sin desplazarse ol
siguierle campo, mantenga presionada la tecka <Control> mientras, pulsa
<Tub>.
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Preste atencion a 1a manera en que Word interpreta su respuesta a un campa.
Por ejempto, st un campo de texto estd formateado para incluir niimeros for-
mateados sin decimales y responde deletreando un niimero {cuatro, por ejem-

plo). Word interpretard su respuesta come 0 {cero} porque lo que espera es un

nimero v no letras. Regrese al campo y escriba la respuesta correcta.

Si el formulane no estd protegido, el primer campo no estara seleccionado
cuando abra el formulario, ¥ no se podrd desplazar de un campo a otro pul-

. sando <Tab> o <lIntro>. Para rellenar un formulanio desprotegido. utilice Tus

técnicas usuales de Word para mover el punto de insercion de un.campoe a
otro. O mejor ain. proteja el formulario eligiendo Herramientas, Proteger
documento v seleccione la opcién Formulario.

Coémo guardar un formulario en pantalla

Dado que la mayoria de los formularios en pantalta estin basados en planti-
lias. no tienen nombres cuando los abre. Deberd guardar y dar un nombre a
los formularios. (Si un formularic no est basado en una plamilld use los

siguientes pasos para guardar su formulario con un nombre tnico. De esta.

miaera, conservard el original para usos futuros.)
Para_guardar un formulario. siga estos pasos:

1. Elijx Archivo, Guardar como. Apareceri el cuadro de didlogo Guardar
como.

3, Escriba un nombre en el cuadro Nombre de archivo. y seleccione la
carpeta para ¢! formulano de la lista de carpetas. Puede guardar el for-
mulario en una unidad de disco diferenie seleccrondndola de la ha
Guardar en.

3. Elija [Aceptar].

SOLUCION DE PROBLEMAS

He abierto un tormulario nuevo y el primer campo no estd seleccionadae,
El dormulario no estd protegido. Para rellenarlo, protéjalo eligiendo
Herramientas, Proteger documento. (ks aconsejable abre la plantiila de for-
mutario v protegerla, para que la proxima vez que abra el formulario esté
protegido.)

Como personalizar campos de formulario

Hay muchas maneras de personalizar los campos de formulario para que sus
{ormularies resulten mas informativos, automatizados y faciles de usar. Los
campaos de fecha v hora automiticos. por ejemplo. insertan la fecha u hora
actual en su formulano. Las entradas por defecto sugieren una respuesta
posible al campo. Los mensajes de ayuda dan pistas a los usuarios de cdmo
rellenar un campo deterrmnado. Los controles impiden ciertos tipos de erro-
res. Las férmulas calculan los resultados en un campo. Las macros se eje-
cutan cuando los usuarios entran o salen de un campo particular. Los con-
troles impiden cieno tipo de errores.

39
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También puede aplicat la mayoria de los tipos de formato a los campos de
formutario. Por ejemplo, puede convertir en negrita un campo de formula- -
rio para que la respuesta se destaque. O bien. puede aplicar un borde a un
campo de formulario para agregarle cuadros a un formulario que no esié
basado en una tabla.
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Puede personalizar campos de formulario mientras crea su formulano. per-
sonalizando campos a medida gue los insenta. o después de haber creado su
formulario, editando campos seleccionados. Para editar campos de formula-
rio después de haberlos insenado. el documento deberd estar desprotegido.
Para personalizar campos de formulanio a medida que los inserta, siga estos
PisOn:

. Elija Insertar, Campo de formulario. Aparecerd el cuadro de didlogo
Campo de formulario (véase la figura 39.15).

2. Del grupo Tipo (Texto, Casilla de verificacién, o lista desplegable).
elya el upo de campo de formulario gue desea insertar y personalrzar.

3. Pulse en ¢l botén Opciones. Apareceri un cuadro de didlogo conte-
niendo las opciones para personalizar el tipo de campo de formulario
gue hava seleccionado (véase la figura 39.16). ’

Pura personalizar un campo de formulanio existente, siga estos pasos:

L. Desproteji su documento, s estil protegido, eligiendo Herramientas,
Desproteger documento o realizando una pulsacién en el botén
|Proteger tormulanio] de la barra de herramientas Formalario,

2. Reulice una doble pulsacidn en el campo de formulano que’desea per-
sonalizar, abnendo el cuadro de didlogo Campo de formulario con texto.
Q) bien. seleccione el campo de formutario que desea personalizar reah-
<ando una pulsacion en él. colocando el punto de insercién por encima
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o por debzjo del mismo y pulsando 1a tecla de flecha hacia arriba o hacia

ubajo, v colocundo el punto de insercidn junte al misme y manteniendo

presionada la tecla <Maytis> micntras pulsa la tecla de flecha hacia la

izquierda o hacia la derecha. Después, haga alguna de eslas cosas:
Pulse ¢en ¢l botdn |Opciones] de la barra de herramientas Formulario.
O bien, pulse en ¢l campo de formulario que desea personalizar con el
botdn derecho del ratén para desplegar el memi contextual. Sclecciane
Opciones de campo de formulario.

3. Seleccione las opciones que desee, y clija | Aceptar].

.

Como personalizar campos de formulario

con texto

Loy cumpos con texto son probablemente los mds personalizabies de los tres
lipos de campos de formulario. Puede personalizarlos por tipo (nomal,
ndnyero, fecha o cileulo, por cjemplo). por texto por defecto, por ¢l lamafio
del camnpo. por el ndimere miximo de caracleres en la respuesta, o por el for-
mate de lu respuesta. Al igual que sucede con todos los tipos de campos de
formularios, también podri personalizar campos de texto agregando macros
{(véusc mds adelanic el apartudo "Como agregar macros a un {formulario™,
aiadiendo texto de ayuda (véase el apartado "Cémo agregar Ayuda a un for-
mulario™), asignando un nuevo nombre al marcador (véase "Cémo asignar
nombre y encontrar campos en un formulario”), o inutilizando el campo para
entradas (véase "Como inutilizar campos de formulario™).

Para especificar restricciones en un campo de formulario con texto. siga
CALOS pasos:

| Campo de fomutatio con texto

e g O

g

ShAh) LT

L. Abri ¢l cundro de dhilogo Campo de fonnmulario con texto (véase la figu-
ra 39.17).

2. Seleccione de entre los siguientes tipos de opeiones (véase las siguicn-
tes tblas para detalles sobre Tas opeiones Tipo y Formato).
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OPCION DESCRIPCION
Tipo (véase la tabla 39.1) Seleccione de entre seis tipos de entradas de
P texto: Texto normal, Ndmero, Fecha, Fecha

actual, Hora actual y Cilculo,

Texto predeterminudo Escriba el texto que desea que aparezca
como cntrada por defecto en este campo.
Los usuarios pueden cambiar la entrada.

Largo maximo Escriba o seleccione "llimitado” o el nimero
de caracteres o numeros que desea que
acepte el campo (hasta un total de 255).

Formato del texto Seleccione de entre diferenles tipos de for
mato de texto, numérico y de fecha, depen
diendo de lo que haya seleccionado en la
opcion Tipo (véase la tabla 39.2).

3. Elija [Aceptar].
A menudo usard dos o mids de estas opciones juntas. Por ejemplo, st sclec-
ciona Nimero como ¢l Tipo. cs posible que elija 0,00 como ¢l"Formato a
fin de que aparczca una respuesta numérica con dos decimales.
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SELECCIONE ESTA OPCION:  CUANDO LOS USUARIOS DEBAN
RESPONDER ESCRIBIENDO:

Texto Normal Texto, Word formateard ol texto de
acuerdo con su seleccion en la lista
Formato del lexto.

Nomero Un numero. Word formateard el nomero
de acuerdo con su seleccién en la hsta
Formato del ndmero, y desplegard un
mensaje de error si el ustario escribe
texto.

Fecha Una fecha. Word formateard la fecha de

acuerdo con su seleccién en la lista

Formato de fecha. Word desplegara un

mensaje de error (Se requiere una lecha

vilida) si el usuario escribe lexto o un

. rumera no reconocible coma fecha y of
usuario regresard al campo actual para
buscar una respuesta apropiada. (No
obstante, servird casi cualguier respuesta
parecida a una fecha),

Fecha actual No se permile una respuesta por parte
del usuario. Word inlroducird la fecha
actual (y actualizard la fecha al abrirse
el documento®). .

4}
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L

Hora actual Nop se permite una respuesta por parte
del usuario. Word introducird la hora
actual (y actualizara 1a hora al abrirse ¢l

documento®).

Introduzca una férmula cuando inserte o
edite esle Campo; no se permile una res-
puesta par parte del usuario. Word apli-
card su formula, e imprimira el resultado
del cilculo en este campo. Por ejemplo,
puede insertar una simple férmulka de
SUMA para sumar los nimeros de una
columna st su formulario se basa cn una
tahia (Word actualizara el resullado al
abrirse el documenlo®)

Ciélculo

* puede especificar que Word aciualice la fecha, hora 0 una férmula
cumndo imprima su formulario, eligiondo el comando Herramientas,
‘Onciones, seleccionandn a continuacion la ficha Imprimir v despuds
Actualizar campos en las Opciones de impresién. Tambign puede usar
unacmacro de salida para actualizar fos campos.

LR A s
il et
TIFO DE OPCION OPCION FORMATO  ASPECTO QVEASE “Trabajando
DEL TEXTO DE LA ENTRADA con tablas”,
Texto Normal Mayusculas TODO MAYUSCLULAS pig 286

Minusculas lodo minasculas

Primera Mayuscula

Caja de Titulo

La primera letra de la pni-
mera palabra es mayus-
cula

La Primera Leira De Cada
Palabra es Mayuscula

Numero ( 123456
0,00 123456.00
# ##0 123.456
#.480,00 123.456,00
SH.#40.00;(84 880,000 $1 23.436,(K)
0% 10%
0,00% 10,00%
Fecha M/ld/aa 1/1/95

dddd, MMMM d, aaa
d MMMM, aaaa

Domingo, Enero 3, 19495

3 Enero, 1995

d-MMM-aa 3-Ene-95

MMM, aa Ene, 95

MM/ddlyy hamm 01/03/95 2:15 PM
AM/PM

Mm/ddfyy h:mimiss
AM/PM

01/03/95 2:15:58 PM
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Hora h:mm AMIM 2:15 PM
h:mmiss AM/PM 2:15:58 PM
H:mm 2:15
H:mm:ss 2:15:58

Fecha actual

Lo mismo que Fecha

Lo mismo gue Fecha

Hora actual h:mm AM/PM 3:30 PM
h:mmi:ss AM/PM 3:30:00) PM
H:mm 15:30
H:mm:ss 15:30:00

Calculo Lo mismo que Numero Lo mismo gue Namero

Coémo personalizar campos de formulario con Casillas
de verificacion

Podri personalizar los campos con casilla de verificacion, que exigen del

usuirio gue una respuesta simple de "si o no”, determinando el tamaiio y cli-
= giendo si estardn marcadas o no por defecto. Al igual que con todos los otros
' tipos de campos. también puede personalizar los campos con casilla de ver-
ticacién agregando macros (véase més adelante el apartadoe "Cdmo agregar
macros a un formulario”), agregando texto de ayuda (véase ¢l apartado
"Cémo agregar Ayuda a un formulario”), asignando un nuevo nombre al
marcador (véase "Cémo asignar nombre y encontrar campos cn un fonnula-
rio”). o inutilizando el campo para entradas (véase "Cdomo nutilizar campos
de formulanio”),

Para personalizar un campo con casilla de verificacidn, siga estos pasos:
1. Abra el cuadro de didlogo Campo de formulario con casilla de verilica-
cion (véase fa figura 39.18).
2. Determine ¢l lamafio de la casilta de verificacion scleccionando la
opcidn apropiada: ‘
. B Secleccione Auto para ajustar el tamaiio de la casilla de verificacion
al tamario del texto que a rodea.

B Scleccione Exacto para darle a la casitla de verificacion un thimado
especifico. Pulse en lx flecha hacia armiba o hacia abajo o pulse la
techa de flecha hacia arriba o hacla abajo para aumentar o disminuir

F'g' 39.18 Campo de formulatio con casilla de venlicacién
Puede dar a una TR A T N S SR e

casifla de )
verificacion ¢]
lamano exaclo
que dusee, v
puede
especiicar s va®
maicagda o Ne
por deledo,
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el tamafio de la casilla. O escriba el tamaiio que desec; por ejemplo,
eseriba I12p para una casilla de 12 puntos, §,25" para una casilla de
cuarto de pulgada, 1 pi para una casilla de | pica, 0 1 cm para una
casilla de 1 centimetro. (Cuando abra el cuadro de didlogo la proxi-
ma vez, la medida se conventind en un valor equivalente en puntos.)

3. Determine cl Valor predeterminado seleccionando una de las siguicnies
opciones; )
Si sclecciona Sin marea, la casilla de verificacién aparceerd vacia por
defecto (una respuesta negaliva). El usuanio deberd pulsar la barra espa-
ciadora para marcar la casilla.
Si selecciona Marcado, la casilla de verificacién presentard una marca
por defecto (una respuesta positiva). El usuario deberd pulsar la barra
espaciadora para desactivar la seleccién de ' casilla,

4. Elija [Aceptar].

Como personalizar campos de formulario con lista
desplegable

Una lista desplegable ofrece a |l)b usuarios 25 items entre los que qu,lr
Dado que 1a lista contiene dnicamente respuestas vilidas, ayuda a asegurar
yue ka respuesta del usuario a un campo es vilida, Ademds, ayuda a los usua-
rios a rellenar el formulario, porque no ticnen que adivinar qué tipo de res-
puestit requiere el campo,

Con toda probabihdad. personalizari un campo de formulario con lista des-
plegable al inscrtarlo. ya que la lista no contiene nada hasta que le anade los
itemy. Sin emburgo. ¢s posible que, posteriormente, desec agregar items a
[a lista, eliminar algunos o reordenarios. Puede h.JLCl' esio edilando el campo
desplegable.
Para agregar items a la lista cn un campo desplegable, siga estos pusos:
1. Abra ¢l cuadro de didlogo Campo de formulario con lista desplegable
{véase la Higura 39.19). ~
2, En el cuadro Elemento de la lista, escriba el flem que desca aiadir a Ja
lista.
3. Pulsc ¢n cl boton | Agregar).

Camno dn lnn'lm!auo con lista de:pleqable . I} Fig. 39.19

ek Puede agiepas
items a ung lista
dusplegable,
chminarlos o
reordenarlos,

5 Eswmff? e

R T 1&; 4 e {2 RepTeRIn
—E e makil IOt »
&ﬂ‘a::.uﬁ% i"""é o o)

*"45“?’#
Mn."r
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4. Repita los pasos 2 y 3 para agregar mas items a la lista,

5. Elija | Aceptar].
Para guitar items de un campo con lista desplegable, siga estos pasos:

L. Seleccione el campo desplegable y abra el cuadro de didlogo Campo de

formulario con lista desplegable.

2. Seleccione ¢l item que desea quitar de la lista Elementos en la Lista.

3. Pulse-en el botdén Quitar. '

4. Repita los pasos 2 y 3 para yuitar mds ilems.

5. Elija {Aceprar],
Para reordenar los items en un campo con lista desplegable, siga estos pasos:

I. Seleccione el campo desplegable y abra ¢l cuadro de didlogo Campo de
lormulario con lista desplegable,

2. Seleccione el item que desce desplazar en la lista Elemento de la Lista.

3. Desplace ¢l item hacia arviba realizando una pulsacion cn la {lecha
Mover hacia wmba, o desplicelo hacia abajo realizando una pulsacién
en la flecha Mover hacia abajo. (Con ¢l teclado, pulse la flecha hacia
arriba o hacia abajo-para scleccionar el item que desce desplazar, pulse
<Tab> para seleccionar ta flecha Mover hacia arriba 0 Mover hacia
abajo y después pulse la barra espaciadora para desplazar el ftem selec-
cionado hacia amba o hacia abajo.}

'k

4. Repita los pasos 2 y 3 para desplazar mis items.
5. Elija [Aceptar].

Coémo formatear campos de formulario

Los usuarios no pucden (ormatcar entradas en wn formulario protegido
cuando estdn rellenando el formulario, Sin entbargo, cuando estd creando
un formulario, puede aplicar formato de fuente y parrato al campo, asi como
muchas otras opciones de formato. Las respuestas aparecerin posteriormen-
te ¢n ese formato.

4 VEASE “Camo tra- Debe insertar un campo de formulario antes de poder formatearlo. Recuerde

bajar con celdas, cua- que ¢l documento debe estar desprotegido.
dros de texto y cam- ) . . .
pos”, pig, 68 Para formatear un campa de furmulario, primero seleccione ¢l campo de for-
mulario que desea fornatear. Después cinplee uno de los siguientes méto-
dos para aphear ¢l lomato: '

e - ™ ¢ . .
4 VEASE “Como for- M Elija el comando formato que desea utilizar y seleccione lus opeiones de

:?g":;;“'" ' {formato que desea aplicar. | )
' M Pulsc en una opcién de formato en una barra de herramientas.
B Pulse las teclas de formato de método abreviado.

B Pulse en cl campo seleccionado con ¢l botén derecho del ratén para des-
plegar el mend contextual y seleccione Fuente, Pdrrafo, o Numeracién
¥ vifictas. Despuds, seleccione las opciones de formato que desca,
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Como inutilizar campos de formulario

En la mayoria de los formularios, se pretende que los usuarios respondan a
todos los campos. Pero a veces deseard inutilizar un campo con ¢l objeto de
que los usuarios no puedan responder. Es posible que descc incluir una
entrada por defecto en los campos inutilizados. '
Paru inutilizar un campeo, siga estos pasos:

1. Desproteja el documenio, si ¢s necesanio.

2. Seleccione el campo que desea inutilizar, y desplicgue el cuadro de did-

logo Campo de Formulario.

3. Eliminc la opcion apropiada: Permitir llenado (para campos con texto),
Permitir seleccionar (para campos con casilla de verificacion), o
Permitir desplegar (para campos con lista desplegabie).

4. Eliju | Aceptar).

Cémo asignar nombre y encontrar campos en un
formulario

Cada uno de los campos que introduce en un documento tiene un nombre: -
su mrarcador, Puede usar este marcador para encontrar un campo ripida-
mente. Por defecto, Word numcera los campos que  inserta, denomindndolos
Texto1, CasillaZ, UsiuDesp]eguble]:i, cte. Asignar cualguier nombre a un
campo de formulanio (ateniéndose. sin embargo, a tas reglas para asignar
nombies o los marcadores).
Para asignar nombre a un campo. siga estos pasos:
i. Desproteja el documento, si es necesario.
2. Seleccione el campo. v abra ¢l cuadro de didlogo Campo de formularnio,
3. En el grupo Especiticaciones, scleccione ef cuadro de texto Marcador
v escriba el nombre.
4. Elija [Aceptar.|
Pura buscar un campo con nombre, siga es10s pasos:
1. Desproteja el documento.
. Eliju Edicién, Marcador,
. Escriba el nombre que desea buscar en el cuadro Nombre de marca-
dor o scleccionelo en L lista. ‘ . ) '
4. Pulse cn el boton Ir @, Word abriri ¢l campo sin cerrar ¢l cuadro de did-

logo. Vaya a otro campo o elija [Cancelar] para cerrar el cuadro de didlo- .
go. * * Consejo I
. ‘ tl documento deberd

Cémo agregar Ayuda a un formulario estat prolegido para
(Ue aparezca s Men-

Puede facilitar 2 los usuarios la tarea de responder correctamente 2 un campo | saje de ayuda; de lo
en su formulano agregando mensajes de ayuda. Cuando el campo esti sclee- | wnirano, pulse <F1>
cionado en su formulario, 1os mensajes de ayuda pucden aparecer en la barra | pana desplegar la

de estado en la parte inferior de la pantalla 0 como un cuadro de mensaje que | Ayuds de Word,

se despliega cuando el usuario pulsa la ecla <Fl>. '

L
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Fig. 39.20

La avuda puede
aparecer en la
barra de estado
si usa la ficha
Barra de estado,

h

Fig. 39.21

La ayuda puede
aparecer coimeo
un cuadro de
mensaje cuanto
o} usuario pulsa
<F1> < usala
ncha Tecla de
ayuda 1F1).

Consejo

2 Un Campo, incluyas
tambtén un mensye
e barea de estado
yue diga “Pulse H
para Avua” de miiv
que fos usudrios
sepan dunde encon-
frar fa yuda.

Testo de ayuda pua log ‘mmulcnu:

& :
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Puede ¢scribir su propio texto para un mensaje de ayuda. o usar una cntra-
da existente de Auiotexto. Por cjemplo, puede tener una emrada de
Autotexto gue diga "Pulse <F1> pura Ayuda”™ y que puede mcluir como un
mensaje de Ayuda de la barra de estado en cada uno de los campos para fos
gue haya incluido ayuda de <Fi> (véase la figura 39.20).
Para agregar ayuda a un campo de formulario, siga cstos pasos;

1. Abra ¢l cuadro de-didlogo Campo de Formulario para ¢l campo en el

que quicra agregar la ayuda.

Te-ln de nwda para los loimulanay [
s s e .

Lomoroebe que ¢ eo ety compieln (e E rpace]

.
t’_

i

N

- 2. Pulse en ¢! botén Agregar ayuda.

3. Seleccione la ficha Barra de estado para agregar una linea de ayuda en
la barra de cstado o seleccione la ficha Tecla de ayuda (F1) pam agre-
gar lu ayuda que haya de aparecer en un cuadro de mensaje cuando ¢l
usuario pulse <Fl> (véase la figuru 39.21).

4, Para agreyar su propio mensaje de ayuda, scleccione la opeidn Escriba
SU propio exto y escriba su mensije (hasta 255 caracteres).

O bien. para usar el texto de una entrada de Autotexto como ayuda,
scleccione la opeidn Elemento de Autotexto, y seleccione en la lista la
catrada de Autotexto que desea usar,

5. Ehja [Aceptar).

6. Elija [Aceptar| de nuevo para cerrur ¢l cuadro de didlogo C.\mpo de for-
mulario y volver a su documento,
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Si estd incluyendo mensajes de ayuda en la barra de estado. tenga presente
que incluso si su formulario estd protegido, los usuarios podrian desactivar
esta linea de ayuda en la barra de estado. Asimismo, tenga presente que los
usuarios no tienen modo de saber si la ayuda <Fi> estd adjunta a un campo
(aungue un mensaje en lu barra de estado puede ser dtil, si se puede visuali-
car). 8i su formulario estd basady en una plantilla, intente incluir un mensa-
Je (para alertar a los usuarios de la existencia de ayuda <F1>) en la macro -
AutoNuevo que se gjecuta cuando los usuarios crean un nuevo formulario.

Cémo agregar macros a un formulario

Las macros pueden automatizar sus {formularios de muchas maneras. Pucden
activar o desactivar campos, dependiendode ld respuesta del usuario a un .
campo anterior. Pucden actualizar campos que contengan cdlculos. Pueden

hacer que Word ignore campos innecesarios,

Para usar una macro en un formulario, deberd crear la macro anles de apli-
carli a un campo particular del formulario. Las macros funcionan en uno de
dos momentos: cuando el usuario entra en el campo o cuando sale del
mismo.

Al grabar o escribir macros para su formulario, lenga presente que las
macros usan marcadores para localizar campos particulares y ascgoirese de
que su formulario no contiene nombres duplicados de marcador. Puede
conocer el nombre automitico del marcador de cada uno de los campos, o
asignar al campo un nuevo nombre de marcador, seleccionando el campo,
desplegando ¢l cuadro de didlogo Campo de formulario, y mirando despuds
cl cuadro de (exto Marcador (para mds detalles, véase el apartado anterior
"Cémo asignar nombre y encontrur campos en un formulario”).

Para lograr que sus macros sean dtiles, adjintetas a la plantilla en la que se
basa su formulario. Lo mds ficil es hacerlo al crear fa macro. pero también
podrd. adjuntar una macro a su plantilla eligicndo Archivo, Plantitlas. reali-
zando una pulsacion en cl botén Organizador, y eligiendo después la ficha
Macros,

Para pocler aplicar macros a un camipo, en pamer lugar el documento dche-
ra estar desprotegido. Recuerde ‘yue para poder aplicar una a un camipo de
formulario, antes deberd crear ln macro.
Para aplicar una macro o un campo de formulario. siga estos pusos;
1. Scleccione el campoe ai que desea aplicar ka macro, y abra ¢! cuadro de
diidlogy Campu de Formulario.
2. Si desea que la macro se cjecute cuando el usvario colague el pumo de
insercion cn el campo, scleccione la opeion Al entrar cn ¢l grupo
Ejecutar macro y seleccione li macro que desca en la Lsta.
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Fig. 39.22
fseriba su
conlrascna en el
cuadro
Contrasena.

Fip. 39.23

Para confirmar
su contrasena,
debera
roescribirla
exactamente
coma lo hizo la
primera vez.

O bien, si desea que la macro sc ejecute cuando el usuario coloyue el
punto de insercion fuera del campo, seleccione la opeion Al salir en cl
grupo Ejecutar macro y seleccione la macro que desed en la lista.
3. Eliju {Aceptar].
Si no aparccen macros en la lista Al entrar o en la lista Al salir, eso quicre
decir que no hay macros disponibles en la plantifla de su formulano. Deberi
© bicn crear una macro, o adjuntarla a su plantilla,

Cémo proteger y desproteger un formulario con una
contrasenia '

Si no desea que los usuarios cambien su formulanio, protéjalo con una con-
trasenia. De csta manera, cualquiern gue intente desproteger ¢l formulario
deberd introducir la contrasefia (ud. incluido: no olvide su contrasefa)
Para proteger un decumento con contraseiia, siga estos pasos:
1. Elija Herramientas, Proteger documento. Aparccerd el cuadro de did-
lago Pruteger documento (véase la figura 39.22).
2. Scleccione la opcidn Formularios.

3. Seleccionc el cuadro Conlrasefia, y cscriba su contraseda. Elija
| Aceptar], Aparccerd el cuadro de didlogo Contirmar contrasena ¢ véuse
la figura 39.23).

 Confimar contrasena

4, En el cuadro Vuelva o escribir la contrasefia. reescriba su contraseiia,
El deletreo, el espaciado y 1a cuja deben ser exactamente iguales, Elija
[Aceptar], (Si no reescribe la contrasefia exactamente igual a como lo
hizo originalmente, obtendrd un mensaje de error. Elya |Aceprar] ¢
inténteto de nuevo.)

49



[

T e, e

—
dyecgic

v '

PR e

825

Cimo persenalizar campos de formularios con fexto }

5. Elija | Aceptar] para volver a su documento.

Para desproteger un documento con proteccion de contraseia, siga estos
pasos:

1. Elija Herramientos, Desproteger documento, o pulse en el boisn
{Proteger formulario] de la barra de herramientas Formulario. Si el
documento estd protegido con contrasefia, aparecerd el cuadro de didlo-
go Desproteger documento (véase la figura 39.24).

2, Lscriba la contrasefia exactamente igual a como la escribid original-
mente en el cuadro Contrasefia. El deletreo, el espaciado y la caja deben
scr exactamente iguales,

AT
ey 3 <

[ Ay s L3
ELontratarih, ',“p.ggz.

EFE,....I

i
&

ih

3. Ehijo fAceptar]. Si ha escrito la contrasefia correctamente, su documento
quedard desprotegido. Si escribio la contrasefia de forma incorrecta, Word
mostrard un mensaje diciendo que fa contrasena es incorrecta y  debend
clegir Aceptar para volver a su documento, que permanecerd protegido.

Coémo proteger parte de un formulario

Si su formulario estd dividido en secciones, podrd proteger panes del
mismo. al tiempo que deja otras sin proteccidn. Podri incluir proteccion de
contruseiia para las secciones protegidas,

Para proteger o desproteper parte de un lormulanio, siga estos pasos:
1. Elija Herramientas, Proteger documento. Apareceri el cuadro de did-
logo Proteger documento.
2. Sceleccione la opeidn Formulario.
3. Pulse en ¢l boton Secciones para desplegar el cuadro de didlogo
Proleger secciones {véase la frigura 39.25),
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4. En la lista Secciones protegidas, seleccione cada una de las secciones
que desea proteger, de mado que aparezcan con una marca en ¢l cuadro,
Quite 1a marca de todas aquellas secciones que no desca que cslén pro-
tegidus.

5. Elija [Aceptar] para volver al tuadro de didlogo Proteger documento.
(Si deseu proteger las secciones con una contraseiia. higalo ahora. Para
mis detalles, véase el gpartado anterior "Como proteger y desproteger
un formulario con una contrasena.”)

6. Elija [Aceptar] para volver al documento.

Como transformar formularios existentes

Al
Los formularios que desea crear pueden existir ya en papel o en formato de
otro programa. A veces, la forma mis ficil de transformar un formulario cs
sencillamente reescribirlo, pero en otras ocasiones es posible gue quiera uli-
lizar dalos cxistentes.

Puede emplear un escdner para facilitar 1a reescritura de un formulario exis-
tente. Escanec ¢l formulario como dibujo. e insértelo en un cuadro de texto.
Cuando el dibujo esté en ¢ cuadro de texto. podrd desplazarto a fa capa
detids del texio en su documento. Ln la siguiente capa, podrit calear ¢l for-
mulario escaneado para crear su nuevo formulario. Cuando lennine, sclec-
cione y borre el formulario escaneado.

Aunque no puede importar campo de formulanio de un documento creado
por otro programa a un documento Word, si puede importar texto. Si un for-
mulario existe en otro programa, importe el texio, formatéelo conveniente-
mente ¥ agreguce los campos de formulario. Puede convertir ¢l texto ¢n una
tabla seleccionando ¢! texto y cligiendo Tabla, Convertir texto en tabla.
Para mis detalles acerca de las tablis, véase el Capitulo 11, "Cdmao trahajar
con tablas y bordes”.

1)

- Cémo imprimir un formulario

Pucde imprimir un formulario de tres maneras distintas, Pucde imprimir ¢l

formulario exactamente como aparece en pantalla, incluyendo los rdtulos,
£ VEASE “Cémo posibles grificos y los datos de los campos. Es posible que guicra imprimir
imprimic documen- los datos dnicamente en formularios preimpresos, o bien gue guiera impri-
los', pég. 128 mir solamente los rétulos y los grificos, a fin de crear un formulario preim-
preso.

C6émo imprimir el formulario una vez completado

Pura imprimir ¢! formulario cotnplelg, incluyendo todo lo gue aparece en su
pantalla, utilice los comandos de impresién normales de Word. Lmplec este
mélodo para imprimir formularios que ya haya rellenado.

Para imprimir e} formuiario completo, siga estos pasos:
“L. Rellenc el formulario. o abra un formuiario completado.
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2. Elija Archivo, Imprimir.
3. Seleccione las opciones de impresion que desea en ¢l cuadro de disilogo
Imprimir. y elija | Aceptar). '
Para mids dewalles acerca de las opciones de impresion, consulie ¢l Capitulo
8, "Cémo revisar e imprimir documentos.”

Cémo imprimir solamente datos de formularios

Imprima solamenice los datos cuando use formularios preimpresos. Dado que
se usa la misma plantilla de formulario para imprimir el formulario en blan-
€0 que la que usa cuando se imprimen s6lo los datos. los datos del formula-
no se alineardn correctamente con los campos.

Para imprimir solamente datos cn un formulario preimpreso, siga cstos
pasos: _

- 1. Inserte el formulanio preimpreso en su impresora.
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2. Elija Herramientas, Opciones.
3. Scleccione la ficha hinprimir (véase la bigura 39.26)
4. Scleccione Imprimir datos s6lo para formularios del grupo Opciones
para ¢l documento actual. v eliju [Aceptar].
5. Elija Archivo, lmprimir, seleccione las opciones de impresion. v elija
[ Aceptar. .
Obscrve gue este procedimiento asegura que cada vez que imprme este for-
mulario, dnicamente ¢ imprimirdn datos. Repita el procedimiento, desacti-
vando la seleccion i opeion Imprimir datos sélo para formularios del paso
4. si desen imprimir todo ¢l formulano,

Cémo imprimir un formulario en blanco

Pura crear su propio fornmulario preimpreso, imprima anicamente ¢l formu-
lario, sin los datos.
Para imprimir un lormulanio en blanco, siga estos pasos:

~
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1. Elija Archivo, Nuevo: scleccione ¢ formulario que quiere impriniir de
la lista Plantillas y clija jAccptar].
2. Sin reflenar el formulario, imprimato, cligiecndo Archive, Imprimir;
seleccione las opciones de impresion y clija |Aceptar).
Recuerde que los campos de un formulario aparecen sombreados si el botén
Sombreado de campo estd seleccionado en la barri de  herramicntus
Formulario. Estc sombreado no aparecers cuando esté imprimicendo sus for-
mularios. Si desea que el sombreado aparezea en un formulario impreso,
use Formato, Bordes y Sombreado para sombrear iireas seleccionadas en su
formulano, ‘

SOLUCION DE PROBLEMAS

Cuando imprimao los datos del formulario, no se alinean con lus campaos de
formulario en ol formulario preimpreso.

Asegurese de que estd utilizando el mismo formulario para imprimir sus
datos que el utilizado para erear el formulaiio preimpreso.

Cémo guardar sélo los datos

s posible que desee utilizar los dinos recogidos en sus formularios con otro
programa, como por ejemplo una base de datos. Para cllo, guarde dnica-
menie los datos e imp6ricios al otro programa. Word guardard una copia de
los ditos en un documento Sélo texto (con ia extension TXT), creando un
documento delimitado por comas que sélo contienc las respuestas en sus
CaAMmpos.

Muchas aplicaciones pueden leer los datos almacenados en archivos deli-
mitados por comas. Microsoft Excel. por ejemplo. puede abrir y separar
automdticamente cada porcidn de informacién en una celda de hoja de Gil-
culo si el archive usa laeatension VSC (valores separados por comas),

Para guardar solo datos de su formulario, siga estos pasos:

1. Elija Herramientas, Opciones.

2. Scleecione la ficha Guardar.

3. En ¢l grupo Opciones, scleccione 1 opeion Guardar datos sdlo para
termularios.

4. Elija |Aceptar]. ' . :

3. Elija Archivo, Guardar Como para guardar y asignar un nombre a su
archive de datos.

Como crear formularios con cuadros de
dialogo Llenar

Con campos {llenar). pucde designar una cana de formutario, de manera
yue sélo sea necesario introdukir un dato (como por ¢jemplo. un nomiwe)
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“lina sola vez, independientemente del nimero de veees que aparezca en la
cana. Esta opcidn es extremadamente util para rellenar facturas, contratos,
propuestas, o formularios de negocios cn los que la mayor parte del cuerpo
del texto permanece intacto. Los campos { llenar) son asimismo ttiles cuan-
do necesita insertar frases personales en grandes mailings. La figura 39.27
muestra un documento gue pucde crear para observar cémo funcionan los
campos {llenar}.

En primer jugar, deberd crear una plantilia nueva para las cartas de formau-
lario,

Para crear una plantilla nueva, siga estos pasos:

1. Elija Archivo, Nuevo. Aparcceri el cuadro de didlogo Nuevo (véase la
figura 39.28).
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2. Scleccione la opcién Plantilla cn ¢l cuadro Nuevo.
Normal debe estar ya scleccionado cn la lista Plantilla.

3. Seleccione una plantilla diferente en 1a que basar la carta, si 1o preficre.
Puede haber creado una plantilla. por ejemplo, que incluya un membre-
te o ¢l logotipo de la compania.
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Fig, 39.29
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4, Elija [Accpiar]. ‘ ) ""'"“‘":""3'-:‘::';';":‘;"_'"“*""""“““-"
5. Modifique I~a'plami_l'ln para que incl(uyn cualquicr cucrpo de texto, griifi- T,
cos, lablas, clc., que desee incluir.en fa canta de fonmulario. Formatee ¢l
discfio de pagina de la plantilla para el membrcte, si es necesario,
Mantenga Ja plantilla abicrta y en pantalla de modo que ‘p'imda afladirle cam-

pos {llenar), 1al y como se describe cn el siguicnte apartado, " ™« 2%

Cémo usar campos {1lenar) . o,

Para que su plantilla inste al usuario a introducir informacion clave. utilice
campos {llenor). La figura 39.29 mucstru una pregunta de cuadso de didlo-
2o generada por un campo [llenar).

Para insertar ¢l ¢odigo de casnpo (llenar) en un documento, desplace ¢l
punto de insercion donde desee que aparezca Iy informacion del operador.
Elija Insertar, Campo. Ascpirese de que [Todos] esti seleccionado cn la
lista de catcgorias, y después elija Lenar en la lista Nombre del campo. En
el cuadro de texto Cadige, coloque ¢l punto de insercién después de LLENAR,
escriba la pregunta para el usvario (siticla entre comillas) y clifa Aceplar,

W Microsalt Word

Como ahemativa, puede cscribir ¢l campo {llenar) en la plantilla. Para
c¢llo, coloque el punto de insercién donde desce que aparczean los resulta-
dos, y después pulse <Control>+<FU>, la tecla de método abreviado Insertar
campo. Cologque cl punto de inscrcidn catre fos caracteres del catnpo, y
escriba cl tipo de campo y las instrucciones siguicnies:
llenar "Escriba ks direccién del diente.”

Para abrir ¢l cuatdro de didlogoe que solicita el nombre del clicnte y poara
actuatizar cl campo (llenar), siga cstos pasos:

1. Scleccione el cardcter de campo en cualquicra de los extremos del codi-

go para seleccionar cf campo {llenar).
2. Pulsc <9, Aparecerd el cuadro de didlogo Llenar,

J. Escriba la direccidn de un cliente en el cuadro. Para empezar una nucvs
linca en ¢l cvadro, pulse <Intro>, Elija [Aceptar] para completar el cua-
dro ¢ inscrie su entrada ¢n ¢l documenlo.

La entrada introducida por ud. aparecerd en ¢l documento en ¢l mismo lugir
quc ¢l codigo de campo. El icxto situado a continuacion de la entrada inser-
tada sc desplaza hacia abajo o hacia Ja derecha, como si hubicra eserito ¢l
lcxlo cn csa ubicacién manuvalmente. Par pasar de un campo a otro y ver
sus resultados, pulse <Al4<F9>, o abra cl cuadro de didlogo Opciones
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(eligicndo Herramientas, Opciones) y pulse en la casilla de verificacicn Consew
Cadigos de campo de la ficha Ver.

r’.xm act usl ar s

(ampos {20 sther
. aps [
Coémo reutilizar los resultados de los campos. | un docmena oo
L. L R .. Cepletogne oen el
Siutiliza codigos de campo en cantas de formulario. puede pedir informa- LM + e -
ctin al operador una vez, puro hacer que esa informacién aparezca en mtl- puie <his
tiples ubicaciones. Para reuttiizar una entrada de un cuadro {Henar| en otras Acuahizan

ubicaciones de una canta de formulanrio, deberd emplear los siguientes tres
codigos de campo:
 {fijor datos de marcador| asigna datos a un marcador, que almacena
"la informacién para que se pueda usar mds tarde. En el siguiente cjem-
plo. dado que ¢l argumento de los datos para {fijar) son un campo {lle-
nar]. la emrada del operador en respuesta al campo {llenar} se alma-
vena en ¢l nombre de marcador Nomclien. Si el dato es texto expliciio
que no cambia, como por ejemplo Monkana. deberd incluirlo entre
comllas, No incluva un espacio en el nombre de marcador.

] K llenar [instruccion]} despliega un cuadro de entrada de informacicin en
g que el operador puede introducir datos. Los corchetes ([ ]) indican gue
_liminstruccion es opeional,

iref marcador} muestra ¢l contenido de un marcador en 1 ubicacion
del campo. Introduce este campo para repetir el contenido del marcador
en otras ubicaciones dentro del documento.

La figura 3930 muestra un codigo de campo gue pide ¢! nombre del clien-
1e v 1o almacena en el marcador Nomclien. El campo {llenar} pide ef nom-
bre. B t campo {ﬁ[nrl t1ju Nomclien igual gyue 1a entrada l"enor} El campo
Iref | mucestra Lientrada almacenada en Nomelien. Puede usar [refl en toda
fa cara después del campo {ﬁlclr}. tncluso si el dato se ha introducido sdlo
uni ves,
i fa tigura 30,30, los datos del cammpo {llenar} se introdujeron en un cua-
dro de duilogo. Bt cadhgo de campo [ﬁiar] dlmacena la entrada en ¢l mar-
cidor Nomchen. Los datos almacenados en Nomclien pueden ser mostrados
otra vez en cualguier parte del documento con {ref Nomchen). El cadigo
de campo {ref} referencia los datos almacenados en ese marcador. Pucde
reunilivar {ref} en ¢l documento tantas veces como lo desee. Usando los
conmuaclores. podrd tormatear la informacion que |ref} le devuelva.
Ouizds recuerde que campos ariidaedos son un codigo de campo dentro de
otro chdigo de campo. En ¢l ejemplo., un campo {llenar} esti anidado den--
tro de un campo [ fjarl. EI resultado de {llenar) se unliza para proporcio-
nur uno de los areuinentos requendos por ¢l campo iﬁiori. Para construir ¢l
campo anidado de la figura 30 30 desde dentro hacia afuera, siga estos
[LHRINAN
1. Cologue ¢l punte de insercion donde necesite insertar la entrada.
2 Pulse <Control>+<FY>, la el de método abreviado para insertar
Cumpo,
3. Entre los caracteres del campo. escriba tlenar, un espacio. y después la
mnstruceon para ol operador (incluida entre comillas ), como " Eseriba el
nombre del cliente" ‘
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4. Seleccione el campo gue acaba de escribir. Para seleccionan los caructe-
1es y ¢f contenido de un campo, seleccione un cardcter de campo ea unw
de los extremos para scleccionar el campo entero,

5. Pulse <Control>+<F9> para encerrur la seleceion en caracteres de
campo.

TEM R alg X

v Aaraeelt Wond - Fommulaet (i) x]

{ nevgrar Noae paClieste £ llens ~Esenba ol nombre del clense” } { erf Hompre liente }}
T lleriar "Esomba 1y derenoran del clente” |

Este paso aridla el primer campo completamente dentro de otro grupa de
curacteres de campd. El punto de insercion se desplaza para siuarse
mmediatamente a continuacion del primer cardcter de campo.

6. Escriba {yar inmediatamente después del primer caricter de campo.
luego un espacio v el marcador apropiado. como por ejemplo Nomehien,
Deje un espacio después del marcador, pero no deje espactos en el noni-
bre.

Este nueve campo amidade solicita un nombre y lo almacena en ¢l marca-
dor. pero fa entrada no aparece en pantalia. Para ver el resuliado del campo.
deberd actualizar el campo.

Para actuahzar los doy nuevos campos y ver como se soheita v como se
muestra el nombre del chiente, siga estos pasos:
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L. Seleccione la linea o lineas enteras gue contengan ambos campos,
2. Puise <F9> (Actualizar campas).
Aparecerd un cuadro de didlogo. pidiendo et nombre del cliente (véase
la figura 39.29). '

A. Escniba la entrada tal v como se requiere.

4. Elija {Aceptar].
El campo [ﬁiur} almacena en el marcador el nombre que ha introducido en
el campo {llenar}. El campo {ref marcador! muestra ¢l contenido de un
marcador en la cana. Puede introducir un campo | ref marcador| cn muils-
ples ubicaciones del documento, en cualquier lugar donde necesite que s
repita ¢l nombre. En la figura 39,31, ¢ marcador Nomelten <e repite on a
dluma linea de la pantalla. Sin embargo. el nuevo contenido de tref mar-
cador} no aparecera hasta que cada campo tref marcador} se actualice.
Después de introducir todos los cédigos de campo, elija Archivo, Guardar
como. y clija [Aceptar} para guardar la plantilla.
Estos cumpos muestran datos inroducidos en el blogue direccion: también
suligigan y muestram ¢f upo, modelo, v costo de oy items pedidos por el clien-
te. El conmutador \mergeformat. usado en e} campo {ref marcador \*mer-
geformat}. ascgura que ¢l formato que ha aplicado al nombre de campo en
e} documento no cambia ab actualizar el campo. El formato de los resultados
del campo e corresponde con ¢l formato que ha aplicado a fa letra r en ref.
La inclusién del conmutador \*mergeformat se controla por medio de la .
opcian Conservar formato al actuaiizar en ¢! cuadro de didlogo Campo.

Como guardar y asignar un nombre a la plantilla

Este documento debe ser guardado como plantilla porque  lo ha abierto
como tul. Para guardar su plantilla, elija Archivo, Guardar como. En el
cuadro de texto Nombre de archivo. escriba un nombre de ocho letras para
describir su tormulario. Observe que no puede cambiar muchos de los cua-
dros de texto o de lista. Elja | Acepiar]. Word guardari la planulla v ahadi-
rid lu extension DOT Cuando guarde una nueva plantilta. asignele un nom-
bre yue refleje ¢l tpo de documento que ésta crea.

Como actualizar campos en un formulario

Para comprobar fos campos que  ha introducido, actualicelos. Esta accidn
desplegard o le permitird introducir nuevos valores,

Para introducir datos en los camypers (llenar| y actualizar los campos |ref}.
SIZ CSTOS Pasos:

1. Elija Archivo, Nuevo, v seleccrone una plantilla que contenga campos
{llenar}. Eiija Aceptar.

2. Desplace ¢l punto de insercidn u la parte superior del documento y des-
pués pulse <Flt> para selecoonur el siguiente campo. (Pulse
<Muavuis>+<F1 1> para seleccionar el campo anterior, o seleccione el
documento entero eligendo Edicion, Seleccionar tode para actualizar
todos [os campos._}
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Fig. 39.32
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3. Pulse <F9> para actualizar el campo seleccionado o, st el documento
entero estd seleccionado, para actualizar un campo a la vez, desde el
principio hasta el final del documento.

4. Escriba los datos solicitados. y elija {Aceptar).

Si aparece un error en la ubicacidn del campo. despliegue los codigos de
P campo en el documento. Compruebe que la ortografia v el espaciado sean
correctos. Utilice un espacio entre tipos de campo, instrucciones v conimu-
- tadores.
Consejo Como crear una macro para actualizar campos
Pa conservar automaticamente
enirada anterior,
seiecione Cancelar, Dudo gue este tipo de formulario a rellenar estd diseiiado para usarse repe-
0 ok urrird mada e o udamente, puede hacer que Word le pida automiticamente al usuanio la

SR ung entrada
Jnienor

informacién al abrirse el documento. Puede hacer esto con una macro autes
matica que actualice todos los campos del documento cuando ésic se abre.
Con la plantilla 2 rellenar como documento activo, siga es10s pasos:

1. Elija Herramientas, Macros. Aparecerd el cuadro de didlogo Macros
(véase la figura 39.32).

2. Escriba AutoNuevo en el cuadro Nombre de la macro.

3. En la hsta Macros disponibles en. seleccione la opcion Documentos
basados en [plantilla), donde [plantilla) es el nombre de 1a plantiila. La
macro estard disponible sélo para esta plantilla o para documentos que
se originen a partir de ella.

4. Pulse en el boton Grabar.

. Introduzca +na descripcion, como Actualiza todos los campos auto-
madticames ~. en el-cuadro Descripcion,

6. Elija [Aceprar).

Aparecerd la barra de herramientas Grabar Macro, y el indicador REC apa-
receri destacado en la barma de estado. indicando que la grabadora estd acu-
vada. Siga estos pasos para grabar un proceso que actualiza todos los cum-
pos de un documento:

i. Pulse <Control>+<5> (utilice el teclado numérico) para qeleccmnar el
documento entero.

Lh
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2. Pulse <F9>. Aparecerd una instruccién generada por el primer campo
{llenar).

3. Pulse en el botén [Cancelar] para cada instruccién {llenar}.

4. Pulse <Controt>+<]nicio> para volver a colocar el punto de insercidon en

la parte superior del documento.

5. Pulse en el botén [Detener| de 1a barra de herramientas Grabar macro,
Elija Archivo, Guardar todo para guardar la macro y cerrar la plantilla.
Para verificar la macro. siga estos pasos:

1. Elija Archivo, Nuevo.

2. Seleccione la plantilla en la lista Plantilla.

3. Elija {Aceptar].

Cuando abra el documento, la macro AutoNuevo ejecutard la macro de
actuahzacion. introduzea una respuesta en cada cuadro de didlogo o elija
Cancelar. Si la macro no funciona correctamente, gribela otra vez. Si vuel-
ve a grabar empleando el mismo nombre (AutoNuevo), Word le preguntard
si desea reemplacar fa grabacion anterior. Elija Si.

= % ’ -
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Chapter 1, “"Microsoft Office Architecture,” describes the overall architecture of
Office. It emphastzes the components of Office that are shared among the Office
applications, and provides an overview of the Office features that help the Office
applications run smoothly together.

Chapter 2, “Microsoft Access Architecture.” describes the architecture of
Microsoft Access, including the Jet Database Engine, library databases, ISAMs,
database objects. and how Microsoft Access resolves conflicts.

Chapter 3, “Microsoft Excel Architecture,” describes the architecture of Microsoft
Excel. including information on workbooks, cell values, formulas, cell formatting,
charts, AutoFormats, macros. security, data mapping. and how Microsoft Excel
resolves conflicts. ' :

Chapter 4. “Microsoft PowerPoint Architecture.” describes the architecture of
PowerPoint. including an explanation of presentation templates. design templates,
masier elements, and how PowerPomnt resolves conflicts.

Chapter 3. “Microsoft Schedule+ Architecture.” describes the architecture of
Schedule+, including information on the differences between running Schedule+
in group-enabled mode versus working alone, how Schedule+ resolves conflicts,
and interoperability with Microsoft Exchange.

Chapter 6, "Microsoft Word Architecture,” describes the architecture of Word,
including detailed information about templates and how they work: how Word
resolves conflicts: how to manage styles. AutoText entries, macros, and toolbars;
whether components are stored with the template. the document, pr the Word
application; and how 10 create wizards and add-ins.

56



35

CHAPTER |

Microsoft Office Architecture

= £

In This Chapiar

_ Microsoft Office for Windows 95 teams up with the Windows 95 operating

system to implement a method of work that is centered around information rather
than apphications. Office allows users to create information, then mantpulate it
with a suite of software tools. Each of these tools is a standalone application in its
own right, yet Office integrates their functionality to form a unified work area~—
tike the office metaphor forwhich it is named.

Coordination of Applications 35
Implementation of OLE 36
Interoperability with Electronic Mail 42
Shared Application Tools 44

Shared Code 46

Shared Services 56

Coordination of Applications

Office for Windows 95 coordinates the work of Microsoft Excel, Word.
PowerPoint. Schedule+. and Microsoft Access. From a user’s point of view, this
1s apparent in the consistency of the user interface. Menu and command names are
standardized. not only n their terminology, but in their order and placement on
the screen. If users are already familiar with one Office application. 1t will be easy
for them to use the 100ls of unother application. From an architectural point of
view. the Office applications form an integrated whole.

implementation of OLE OLE is the basis for integration among the Office
applications. Each of the Office applications is written to this standard.

Interoperability with Electronic Mail Each of the Office applications supports
interoperability with a variety of electronic mail systems. including Microsoft
Exchange, the mail client installed with Windows 95,
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Shared application tools. Individual Office applications share tools such as spell
checking, Microsoft Graph, Equation Editor. Data Map, and so forth. These (ools
are provided with the applications whether purchased individually or as part of
Office. )

Shared code As components of Office. the individual applications 1n Office share
code in Office dynamic hink libraries (DLLs). These DLLs provide functionatity
that is not available when the applications are purchased individually.

Shared services Office adds its own services to the Office applications. For
examptle, the Microsoft Otfice Shortcut Bar enhances your ability to customize
and standardize users” desktops, and Office Binders allows users to manage
groups of documents from separate applications as if they were a single
pubhication.

This chapter 1s to help you better understand these features. in order to better
SUPpOT YOUT USers.

Implementation of OLE

OLE is the basis for integranon between the Office applications. OLE allows
users to drag documents from a folder to an Office Binder or to their Microsoft
Exchange Inbox so that the document retains its own properties whie 11 gains the
services of the container or destination application. OLE treats these compound
documents as a single entity, vet maintains the uniqueness of cach document.

OLE also allows users to insert data from a source document into a client
document—cells from a Microsoft Excel workbook into a Word document. for
example. Data can be linked or embedded. A linked object is a reference (o the
source and 1s updated dynamically with the source data. An embecded object is a
copy of the source data that can be edited with the tools from the source
apphcation, it has no link to the source data. Documents with embedded objects
take up more memory than documents with linked objects. This 1s because
embedded objects are copies whereas linked objects are merely references.

. OLE Properties

OLE standurdizes the way thar applications store properties for-documents. Office
uses a standard set of properties across all applications. In addition. users can
define a wide vanety of custom properuies. Properties are stored with the
document file. For details concerning the specifications for properties. see the
OLE Sottwuare Developer s K. published by Microsoft Press and avaitable at
vour local bookstore.
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The OLE properties stored with a document are accessible to any application that
supports OLE. For example. when a user drags and drops a Microsoft Excel
worksheet into a Word documenit. the user can manipulaie the worksheet's
properues through Word.

Office applications include the following sets of OLE properties:

Summary information These properties are standard ones. familiar to users of
Office 4.x as those that appear in the Summary Info dialog box. More properties
have been added in Office for Windows 95 applications.

Document summary information These properties provide an enhanced set of
properties. over and above those found in the Summary Info set.

Custom These properties are defined by the user with string names rather than
property IDs. This allows users to create any property they want with any name
they want. Co

For each of the Office for Windows 95 apphications. the Property dialog box
includes the following tabs:

«  General

»  Summary

« Statistics

«  Contents

»  Custom

Most of the properties that appear on the General, Summary. and Statistics tabs
will be famihar to users of previous versions of Oltice applications. These ute the
Summary Information properues, with ~some Document Summary Informaton
properties added.

Properties that appear on the Contents tab are new. These are Document Summary
information properties.

Properties that appeur on the Custom tab are also new. They are Custom
properties that users define themselves.

The following tables show the source for exzch group of properties, by tab.
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General Properties

The following table lists the source for the information dispiayed on the

General tab. -
Prop;ert_v Source
Icon of appiication that created document System
Filename System
Type System
Location System
Size System
MS-DOS name System
Created System
Moadified System
Accessed System
Attnibutes System

Summary Properties

The following table lists the source for the information displayved on the

Summury tab.

Property Source
Title PID_TITLE
Subject PID_SUBIECT
Author PID_AUTHOR
Manager PID_MANAGER

. Company PID_COMPANY
Category PID_CATEGORY
Kevwords PID_KEYWORDS
Comments PID_COMMENTS
Template PID_TEMPLATE .
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Statistics Properties

The following table lists the source for the information displayed in the

Statistics tab:

Property Source

Created PID_CREATE_DTM:
Modified System

Accessed System

Printed PID_LASTPRINTED

Last saved by PID_LASTAUTHOR

Revision number
Total editing time
Pages!
Paragraphs !
Linest

Words!
Characters!
Bytes!

Slides?

Notes pages!
Hidden shdes!
MM clips!

Presentation Target!

Scale Crop

PID_REVNUMBER
PID_EDITTIME
PID_PAGECOUNT
PID_PARCOUNT
PID_LINECOUNT
PID_WQORDCOUNT
PID_CHARCOUNT
PID_BYTECOUNT
PID_SLIDECOUNT
PID_NOTECOUNT
PID_HIDDENCOUNT
PID_MMCLIPCOUNT
PID_PRESFORMAT
PID_SCALE

I"These statistics are made avalable according to the Office application. For example, Microsoft
Excel uses none of these statistics, Word uses Pages. Paragraphs, Lines, Words, and Characters,
while PowerPoint uses Slides, Paragraphs. Words. Notes, Hidden Slides. and Multumedia Clips.

2 The value displayed here is derived from the property ID and not from the system. as on the General
property tab The value on the General wab tells when the document was created on the system and
is not necessarily when the document was created sbsolutely.
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Contents Properties

The Contents tab stores names of the different sections in the document
{documents in a binder, sheet names in a workbook. slide titles in a presentation,
and so forth), The following illustration shows the contents properties of a
Microsoft Excel workbook.
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Custom Properties

The Custom tab provides an interface for users to create their own properties,
which are either constants stored in the property stream or are linked to some
document content, such as PowerPoint text, a Word bookmark or a Microsoft
Excel named range. A property stream is a predefined part of a structured storage
(file) that is used for storing the property data.

Valid property types are number (VT_l4 or VT R8) date (VT_ DATE) boolean
(VT_BOOL). and text (VT_LPSTR).

When a property is linked 1o document content, the user chooses the source for
the property value. and this value is displayed in the property list with a linked
chain icon next to the entry. If the link source is not available, for example, if the
name the link points to has been deleted, the icon changes to a broken chain link,
shown in the following example.
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 Deleting @ named reference in the Samples
workbook broke this finked custom property.
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— Deleting data from the Samples workbook created
a reference error for this custom property, but a
link still exists to the named reference.

User-defined property names are stored separately from other properties so that
users cannot create conflicts by naming a Customn property with the same name as
a Summary Information or Document Summary Information property. For
example, the property Author already exists as a Summary Informadtion property.
but a user could create a property named “Author.” These names are siored
separately in the propenty list and displayed on separate tabs in the Property
dialog box. . .

In addntion, users can hide properties of documents posted to a Microsoft
Exchange public foider by using the underscore character as the first character of
the property name. For example. a user may want to create a property strictly for
selection purposes. such as “"EmployeesEamningGreaterthan80k.” which the user
would never want to appear. The user can make the property invisible in the
Microsoft Exchange viewer by including an underscore character as the first
character of the string (for example, _EmployeesEarningGreaterthan80k™).

Note The undérscore does not cause the Propenty dialog box to hide properues.
Rather, it is an advisory 10 an application that reads properties, such as the
Microsoft Exchange Server, that 1t should not display the property.
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| Interoperability with Electronic Mail

)

0]

The individual Office applications detect whetlier a Messaging API (MAPI), such
as the Microsoft Exchange client, Microsoft Mail, or cc:Mail™, is instatled on-the
system. To determine existence of MAPI, the application checks the DLL32 value-
of the Registry key :
Hkey_Local_Machine\Software\Microsoft\Microsoft Office\95\MapiDLL. and
uses the DLL specifted in this path. If this key does not exist. the application uses
the Windows MAPI DLL, Mapi32.dll.

[f the Office application detects a 16-bit vendor independent messaging (VIM)
system, such as cc:Mail, the application installs a 32-bit DLL that converts MAP]
calls to VIM. Mapivi32.dil, and sets the path in the Registry. Mapivi32.dll is a
32-bit DLL. To communicate with the 16-bit VIM mail provider, it requires the
16-bit DLL. Mapivitk.dll. For more information on how 16-bit applications
communicate with 32-bit DLLs, see “Porting Your 16-bit Office-Based Solutions
to 32-bit Office” in Chapter 12.

If the Office application detects a mail provider, it adds Send and Add Routing
Shp commands to the File menu. This allows users to send documents directly
from their application, without having to launch their mail software manually.

With the Microsoft Exchange client installed. users can use Word as their e-mail
editor (WordMail), and can enable group scheduling by combining the use of
Schedule+. the Microsoft Exchange client, and a postoffice. That postoffice can
be the local type you install with Windows 93 or any other valid MAPI mail
server that supports MAPI 1.0,

Office applications also check for a connection to the Mictosoft Exchange Server
on the user’s system. To determine whether or not a connection to the Microsoft
Exchange Server exists. the Office application checks for the Registry key
Hkey_Local_Machine\Software\Microsoft\Exchange\Client\Extensions for
installed mail providers. I the application finds a value for the Microsoft
Exchange Server, it adds the Post To Microsoft Exchange Folder command to the
File menu. This allows users to post documents to a public folder.

For more informauon about the interoperability between Office and electronic
mail. see “Interoperability with Electronic Mail™ in Chapter 15: - -
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Documents Stored in Microsoft Exchange Public Folders

ik
i

The Microsoft Exchange public folder can store three main types of items:
documents, e-mail messages, and forms. By either dragging and dropping from
the file system or by posting a document from an application, users can store
documents in a public folder. For more information on public folders, see the
documentation that comes with the Microsoft Exchange Server.

Public folders store documents as OLE objects, contained in invisible mail
messages. To users, the documents inside a public folder may appear to be a files
stored in a file structure on disk. However, Microsoft Exchange public folders
treat documents as mail messages, not files. This leads to two major differences
between a Microsoft Exchange public folder and a folder in the disk file structure:

. = Public folders can have multiple documents with the same name.

=  Microsoft Exchange allows more than one person to open and edit a document
at the same time, with optimistic file locking. With optimistic file locking. if
more than one user is accessing the same server, the first user to save the
document will have data saved without any messages. When other users go to
save the document, Microsoft Exchange issues a warning that the message has
been changed by another user. and provides an option for users to lose their
changes or to save the document as a new document.

If each of these users is on a different server, the message is put into a conflict
state. The most recently changed version is designated as the master message,

" and the other messages are attached to it. The master message is marked as
being in conflict. When a user opens it, a form shows the different versions
and allows a user with Edit All permission 1o merge the changes.

Note The Microsoft Excel file sharing feature does not work for documents in
public folders. This is because Microsoft Excel cannot determine whether more
than one person is accessing a docurment when the document is embedded in a
message.

Properties Exchanged with Microsoft Exchange

When users store a documment in a Microsoft Exchange pubiic folder. Microsoft
Exchange initiates a process to read out the properties from the docuthent, and
promote them to be MAPI properties.

There are three different sets of properties that Microsoft Exchange promotes:

The 18 standard SummaryInformation properties

* The new standard DocumentSummaryInformation
s All of the UserDefinedProperties

65



Part1 Architecture

After the properties are promoted, they become available in the Microsoft
Exchange user interface. With the document highlighted, users can click
Properties on the File menu to see the properties. Any user-defined properties that
include an'underscore as the first character are not displayed in the list of property
names in Microsoft Exchange.

Users can search on properties in Microsoft Exchange, using the Advanced bution
in the Open dialog box, similar to how they search for properties from the Open
dialog box in Office applications.

Shared Application Tools

This section discusses tools that are shared by Office applications, such as
Microsoft Organization Chart, WordArt, AutoCorrect, Microsoft Graph. and so
forth. In a way, these are standalone applications. Most include their own
executable (.exe) fiie, and many include their own dynamic link libraries (DLLs)
which must be present for the tool to run. Rather than being cimponents of
Office. these tools are included with one or more of the Office applications. For
example, Word and PowerPoint share Microsoft Graph whether or not Office is
installed on the user’s system.

Applications that serve as tools for the Office applications are identified in the
Registry. under the Hkey_Local_Machine\Software\Microsoft\Shared Tools kevs.
The default installation path for most of these tools is the

\Program Files\Common Files\Microsofi Shared folder.

Many of these tools are applications that must be run from within an Office
application. For example, if users double-click the icon for Graph3.exe in the
Windows Explorer, they will get an error message stating that the application
must be run from within another program. To run Microsoft Graph, the user must
be running Microsoft Word. PowerPoint, Microsoft Excel, or Microsoft Access.
Some of these tools are OLE servers, which means they are available when users

sk Divact on the Tnser menw of any application (a suppons OLE.

The fullowing tablc lists the application tools shared by Office applications. the
applications that share them. and their default location as Office Setup installs
them. For a complete listing of these tools. see Appendix C, “List of Installed
Components.” )

Tool Applications that share Default installation location

Art Gallery Microsoft Access, Microsoft Excel,  \Program Files\Comman Files\
PowerPaint, Word Microsoft Shared\Arigairy

Data Access Microsoft Access. Microsoft Excel \Program Files\Common Files\

Objects Microsoft Shared\Dao

Data Map Microsoft Access, Micro§oft Excel \Program Files\Common Files\

Microsoft Sha'red\DataMap
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" Tool Applications that share Default installation jocation
Equation Microsoft Access. Microsoft Excei,  \Program Files\Common Files\’
Editor . PowerPoint, Word . Microsoft Shared\Equation
. Graphics PowerPoint, Word \Program Files\Common Files\
Filters : ’ Microsott Shared\Grphflt
Microsoft Microsoft Access. Microsoft Excel,  \Program Files\Common Files\
Graph PowerPoint, Word Microsoft Shared\MsgraphS

Microsoft Info  Microsoft Access, Microsoft Excel.  \Windows\Msapps\Msinfo
PowerPoint, Word

Microsoft Microsoft Access, Microsoft Excel, \Program Files\Common Files\
Query Word Microsott Shared\Msquery
Microsoft Microsoft Access, Microsoft Excel.  \Program Files\Cammon Filesy
Organization PowerPoint, Word Microsoft Shared\Orgchart
Charn B .
Spell checking ~ Microsoft Access, Microsoft Excel.  \Program Files\Common Files\
+ % dictionaryl PowerPaint, Word " Microsoft Shared\Proof

, ~=—  Microsoft Microsoft Access. Microsoft Excel,  \Program Files\Common Files\

WordAnt PowerPoint, Word Microsoft Shared\WordArt

1 See the following section for more information about this toal,

Spell Checking Dictionary

The Office applications that implement spell checking all share the same
dictionary file, Custom.dic. The default path for this file is the user’s

\Program Files\Common Files\Microsoft Shared\Proof folder. Customizations that
users make to the spelling list by running spefl check within an application are
saved to this file.

It is possible to create a corporate dictionary, although you cannot share this file
across a workgroup due to potential sharing violation problems.

» To create a corporate dictionary file
1. Open the file Custom.dic 1 a text editor, such as Notepad.

2. Edit the text file.
3. Save the file and install it to users” local workstations.
4. Edit the users’ Registry key

Hkey_Local_Machine\Software\Microsoft\Shared Tools\Proofing \Tools\
Custom Dictionaries to point to the Jocation of the corporate Custom.dic.
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Shared Code

Office DLLs

"
0]

Office applications share code through the Office DLLs. These DLLs allow
Office to integrate operations—such as creating a new document and sharing an
AutoCorrect list—across all the Office applications. DLLs for Office, for the
Office applications, and for shared applications often make calls to other DLLs,
including Windows 95 system DLLs, so if another application on a user’s system
overwrites an existing DLL, Office may not run properly. This section discusses
the Office DLLs and lisis the DLLs called by the Office application programs.

The Office DLL primarily responsible for supporting 21l shared Office
components is Mso95.dil. Mso95.d1l allows users to create new documents in a
way that integrates the Office applications with one another. Mso95.dl1 also
creates a single list of entries that is accessed by AutoCorrect in each of the Office

-applications. The following section describes these two features lhal Mso%5.dll

supports.

Starting a New Document

When users click the Start A New Document button on the Microsoft Office
Shortcut Bar. a dialog box appears., showing all available templates. When users
double-click a template icon, the Office application associated with the template
creaies a new. blank document based on the template. By default, the templates
shown in this dialog box are from the user’s \Msoffice\Templates folder and its
subfolders.

i~ Templates that appear on the General tab are stored in the user's Templates folder
)
’ — Templates that appear on other tabs are stored in subfolders of the user's Templates tolder.
!
I
i

l
%
¥
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Msoffice\Templates is the default location for Iemp]ates on users” local
computers. Users can modify this setting by chckmg Customize on the application
control menu of the Microsoft Office Shortcut Bar and then clicking the Settings
tab. This tab also allows users to set a location for templates on a network share,
by clicking Workgroup Templates location and then clicking Modify.

You can maintdin these settings for your users in the Registry key

Hkey_Current_Usen\Software\Microsoft\Microsoft Office\95\FileNew. The path

specified in the LocalTemplates key is the User Templates location, and the path

specified in the SharcdTemplates key is the Workgroup Templates location. For

information on customizing these setungs during Setup, see Chapter 9.
“Customizing Client Installations.”

If users have defined both the User Templates and Workgroup Tempilates
locations. the New dialog box displays all available templates from both
locations. Templates stored in the root folder of each location appear on the
General tab of the New dialog box, and templates stored in subfolders appear on
separate tabs. The names of the separate tabs match the names of the subfolders.
For4nformation on how to custaomize the tabs of the New dialog box, see
“Supporting Custom Templates™ in Chapter 12, “Support and Troubleshooting.”

AutoCorrect List

The AutoCorrect feature, formerly available only in Word. allows users to
automate corrections to frequently misspelled words and to create abbreviations
that are expanded automatically for commonly used text. Because Office
applications share an AutoCorrect list, all documents that a user creates in Office
will have consistent spellings and stylistic conventions. For example. users can set
AutoCorrect to replace the abbreviation “ppt” with “PowerPoint™ as they type,
and the convention of capitalizing the second “'p™ is maintained automatically,

Office instails a file containing a default AutoCorrect list, Msoffice.acl. to the
user's Windows folder. When the Office application saves the user’s personal list,
1t is stored as Usernamennn acl, where username is the user's logon name and mnn
is a number to further identify the user. You can modify the path for either the
default or the user list. If you do this, you must modify the Windows Registry
entry that poinis 10 this file. as explained later in this section.

When an Office application starts, the AutoCorrect code in Ms095.dll does Ehe
following:

1. Loads the .aci file pointed to in the Registry key
Hkey_Current_User\Software \Microsoft\Microsoft Ofﬁce\95\AutoCorrect\
List with the value named by Path.

12

. Opens the file pointed to 1n the Registry key
Hkey_Local_Machine\Software\Microsoft\Shared Tools\AutoCorrect\List to
find a default path. if the kev/value in step 1 does not exist .
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When the user quits the Office application, the AutoCorrect code in Ms095.dil
does the following:

1. Saves the AutoCorrect list as Usernamennn.acl.

2. Writes the Hkey_Current_User key to point to the user’s list file.

Users can modify AutoCorrect entries by clicking AutoCorrect on the Tools menu.
These entries are stored in the Registry, in the key
Hkey_Current_User\Software\Microsoft\Microsoft Office\95\AutoCorrect\Settings.

Caution The value of the

Hkey_Current_User\Software\MicrosoftWicrosoft Office\95\AutoCorrect\Settings
key is binary and should not be edited. Modify AutoCorrect entries with the
AutoCorrect command on the Tools menu in any Office application.

+ To create a customized AutoCorrect list and distribute it to your users

1. Run an Office application, and modify the default list in the AutoCorrect
— dialog box.

2. Quit the application. and find the resulting Usernamennn.acl file,
3. Store this file where your users can access it.

4. If you want to make this the default list for your users, you can modify users’
Registry key
Hkey_Local_Machine\Software\Microsoft\Shared Tools\AutoCorrect\List
path entry to point to the file.

When users modify the master list and quit an Office application. the default list is
stored on the local computer as Usernamennn.acl. When users customize their
copy of the list, the changes do not aftect the master list. To reinstall the original
masier list, users can delete their customized list and restant the Office application.

LLs Called by Office Applications

Office applications call DLLs from executable program (.exe) files and
application DLLs. This section lists those DLLs that may be called srarically,
when the application starts up tn its default state. Other DLLs could be called
dvnamically, controlled by users while running the applications or while running
macros, converters, drivers, or add-ins.
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The following lists of statically called DLLs are to help you troubleshoot for your
users when they start up an application. For example, if a user’s Office Binder
does not run properly, you could check to see that none of the DLLs associated
with Binder.exe have been deleted or overwritten by some other application on -
the user’s system. The lists include DLLs that are called by other DLLs. For
example, if an application calls Mso95 dll, the DLLs callied by Ms095.d}l are also
listed in the table.

DLLs Calied by Office

Executable files and DLLs associated with Office and its componems call DLLs
as shown in the following table:

Calling file DLLs

Binder.exe Kernel32.dl1, Advapi32.dll, User32.dll, Gdi32.dll, Cmdlg32.dlL.
Shell32.dll, Comctl32.dll, Mso95.dll, Oledlg.dll, Ole32.dli.
Msvert20.d11, Rpertd.dll

Eastboot.exe Kernel32.dil, User32dil, Ole32.dl, Msvert20.41L, Rpcrl4.dllA

Findfast.exe Gdi32.dl, Kemel32.dll, User32.dli, Ole32.dll, Advapid2.dll, Mso95 dll.

Msoffice.exe
Msow.exe
Bdrec.dll

Commtb32.41]
Docobj.dit
Explode.dli

Mfcans32.Qll
Mfcuia32.dlt
M095.dH

Mso95fx dlt
Mstool32.4)1

Openenudil 1|

Osbreg.dll

Shel32.dll. Cemct!32.d1l, Msvert20.dIL Rpertd dit

Kernel32.dil. User32.dll. Gdi32.dll, Advapi32.d|l. Shell32.dll,
Comet}3l.dll

Sheli32.dI. Ole32.dll, Msvent20.d11, Rpend.dil, Advapild2.dil,
User32.dll, Kernel32.d1l Ms095.d11, Gdi32.4d1l. Comcil32.d]l

Kernel32.d1}, Advapi32.dll. User32.dil, Gdi32.dll. Comcti32.dIL
Qe 2aly. Ao uit, ShedS2dll, Msvert Gl Kpertd i

Gdi32.dll. Kemel32.dll. User32.dll
User32.dll, Rpertd.dll. Kemet32.dll, Advapi32.dll

Kemei32.dll, Advapi32.dil, User32.d1l. Gdi32.dll, Sheil32.d1,
Ole32.dll. Msven20.d1, Rpend.dtl, Cometl32.d11

Oleaut32.dll. Ole32.dll. Msvert20.d11, Rpert4.d!l, Kernel32.41l,
User32.dll. Advapi32.dll

Oledlg.dll. Ole32.d11, Mavert20.d1l. Rpen4.dil, Mféan:s32.dll. .
Kernel32.dll. Oleaut32.dll. User32 dil, Advapi32.dil

User32.dIl. Gdi32.d). Advapi32.dil. Shell32,dll. Kernel32.dl1,
Ole32dll. Msvernt2(:dll. Rpenta.dil. Cometl32.d0 . . - -

Kemeld2.dl
Advapi32.dl Kernet32.dll. User32.d1|
Kemel32 dl)
User32.dH. Advapi32 dll, Kemel32.dl1
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DLLs Called by Microsoft Access

Executable files and DLLs associated with Microsoft Access and its components
call DLLs as shown in the following table:

Calling file

DLLs

Msaccess.exe

Wrkgadm.exe

Msaccreg dll
Msaexp30.dll

Msain300.dI1
Msau7032.dll

E

“Msjrei30.dil
Msjtrelr.dl]

0Oc30.dil

Soa300 dl

Msji3032.41, Mswng300.dU, Vba232 dll, Mse95.411, Ole32.dll,
Oleaut3d2.dil. Msvert20.dll, Gdi32.dll. User32.dli, Advapi32.dll,
Kemel32.dll, Comcti32.41l, Shell32.dil, Rpcrtd.dii, Mpr.dil

Comdlg32 dil, Advapi32.dll, User32.dll, Kernel32.dli, Gdi32.dll

Advapi32.dIl, Mpr.dll, Mfcans32.dil, Ole32.dil, User32.dll,
Kemel32 dll, Msvert20.d11, Rpertd.dil, Oleaut32.dl}

User32.dil, Gdi32.dll, Comdlg32.dll, Advapi32.dil. Shell32.dil,
Kernel32.dit. Cometi32.d1

Msveri20.d1, Kemel32.d1l, User32.dll

Version.dll, Gdi32.dll, User32.dl], Comdlg32.dil, Advapi32.dil,
Msvert20.d1l, Msjt3032.d1), Oleaut32.dl1, Kernel32.d1l, Mpr.dll.
Ole32.dll, Rped.dll

Kernel32.dll

Msj3032.d11, Mswng300.d1l, Version.dll, Vbajet32.dll, Gdi32.dll,
Msyter32.d1l. Mpr.dlt, Kernel32.d11, User32.dli, Advap132.dll, Ole32.4d1l,
Oleaut32.dil, Msvert20.d11, Rpentd dll, Msjint32 4l

Mfcans32.dll. Msvert20.d1l, User32.dll. Gdi32.dI}, Comdig32.dll.
Advapi32.d11, Ole32.dil. Shell32.d1. Kernel32.d11, Oleaut32.di1,
Ole32.dl, Rperid.dll, Cometl32.d11

Gd:32.d11. User32.dll, Qle32.dll, Kemel32.dIl, Msvert20.d11, Rpend.dll

DLLs Called by Microsoft Excel

Executable files and DLLs associated with Microsoft Excel and its components
call DLLs as shown in the following table:

Calling file DLLs .

Excel.exe Ms095.dll. User32.dH. Gdi32.dll. Advapi32.dli, Sheli32.dIi.
Kemel32.dH, Qle32.dl, Xlintl32.d1l. Msvert20.dll, Rpend dil.
Comcti32 dll :

Analys32.xll Kemel32.dIl. Xlcall32.dIl .

Solver32.dll Xlcall32.dll, Kemel32.dli, Olecli32.dll, User32.dil

Xlcall32.dll Kemel32.dlI

Xlkey32 dil Kemel32.dM, User32dll '

Xlkey32.dli

Kemel32 dil. User32.dll
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Calling fite DLLs
Xlodbe32.dli Kemel32.dll, Xicall32.dll, User32.dll, Odbe32.dli, Msvert20.d11,
Advapi32.dll
Xlodbe32 411 Xlcall32.dll, Kernel32.d11. User32.d1l, Odbc32.4l}, Msvert20.d1,
Advapi32.dll
Xlgpw.gll Kemel32.dll

DLLs Called by Microsoft PowerPoint

Executable files and DLLs associated with PowerPoint and its components call

DLLs as shown in the following table:

Calling file

DLLs

Powerpnl.exe

Graflink.exe

~Autoclip.dll
Autociip.dll

dhost.dll
Msroute.dl] -
Pngcomp.dl]
Pp4x32.dl

Ppdx32.dll

Ppt7reg.dll
Pptireg.dil
Ppttoolr.dll
Ppttoolr.dil
Ppttools.dll

Presconf.dll
Ttembi2.dil

Kemnel32.dll, Gdi32.dll, User32.dll, Shell32.dll, Advapii2.dil,
Cometl32.411, Ole32.d1l, Oleaut32.d)], Msvert20.dil, Rpertd.dil,
Msa95.di

Comctl32.dll. Kernel32.d1l, User32.dll, Gdi32.dil, Comdfg32.d|1.
Advapt32.dll, Version.dil”

Kernel32.dl], User32.dll, Oleaut32.dll

Kemel32.dll, User32.dll, Oleaut32.dll. Ole32.dll. Msven20.dH,
Rperd.dli

User32.dil, Kermel32.dll
Kemnel32.dll, User32.dll, Gdi32.dll, Advapi32.dll
Kemel32.dll, User32.dll

Ole32.d11. Kemel32.dIL User32.dll, Gdi32.dil. Advapi32.dil,
Msven2(Ldil, Rpertd.dil

01832411, Kernel32.d1l. User32.dI1, Gdi32.dil. Advapi32.dll.
Msver20 dll, Rpertd.dlil

Kemel32.dIl, Advapi32.dil

Kemel32 dl, Advapi32.dil

Kernetd2.di, User32.dl}
Kernel32.dll, User32.dil

Kemel32.dll, User32.dil, Advapi32.dll. Oleaut32.dll. Ole32.d1L
Msvert2().dll, Rpend.dil

Wsock32.dli. Oteaut32.dil, User32.dll. Kermel32.dil, AdvapidZ.dil
User32.dll, Gdi32.dll, Lz32.dIl, Kenel32.dlt
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DLLs Called by Microsoft Schedule+

Executable files and DLLs associated with Schedule+ and its components call
DLLs as shown in the fo[lowm° table:

Calling file DLLs

Schdpl32.exe Gdi32.dil. Advapi3d2.dll, Kernel32.dil. User32.dll, Msvcrt20.dil
Datzap32.d1l Kemel32.dll )

Mscal32.dl} Msspc32.dil. Shell32.d1l, Winmm.dll, Gdi32.dlf, Advapi32.dll. Mpr.dll.
Kemel32.dll. User32.dll, Msvernt20.d11, Comctl32.dlI

Mssed32.d11 Msspc32.dll. Shell32.dll. Winmm.dll, Gdi32.dIl, Advapi32.dll, Mpr.dll,
Kernel32.dll, User32.dll. Msvert20.d1l, Comcti32.dl

" Msspe32.dii Shell32.dll, Winmm.dll, Gdi32.dl], Advapi32.dll. Mpr.dll, Kernel32.d11,

User32.d1l, Msvert20.dll. Comctl32.dl1

Mstre32.dll Msspe32.dll, Shelld2.dIl, Winmm.dll, Gdi32.dll. Advapi32.dll. Mpr.dil,

= £ Kernel32.dil, User32.dil, Msvert20.dli, Comet]32.d1]

Mautrs32.dl Msspe32.dll, Mscal32.d11, Shell32.dll, Winmm.dil, Gdi32.dIl.
AdvapiiZ.dil. Mpr.dll. Kernel32.d1], User32.dll, Msvert20.d11,
Comctl32.d11

DLLs Called by Microsoft Word

Executable files and DLLy associated with Word and its components call DLLs as
shown in the followng table:

Calling file System DLLs

Winword.exe Wwintl32.d11. Advapi32.dil. Gdi32.dll, Kemel32.dli. Shell32.d11
User32.d1k Ole32.dll, Mso095.dH, Comcti32.dit, Msvert2(1dll, Rpertd.dl)

Schdmap.dil Oleaut32.d11. Ole32.dH. Msvent20.dIL, Rpertd.dli, Kernel32.dll.
Uiser32.dlt. Gdi32.dll
Station.dlt Kemnel32.dil, Userd2.dll, Gdi32.dll, Comdig32.dll, Advapi32.dll,

Shelt32 dI, Ole32.d1, Oleaw132 dil, Mapi32.dil, Cometl32.d11,
Myven20 dil Rpertd dit

Wordmail dli Kernel32.dil. Advapi32 dil. User32.dll. Gdi32.di. Comdlg32.dil.
Sheil32.dll, Map132.dl. Mfcans32.d11. Ole32.d11. Mpr dil, 0Icau13" gH,
Comctl32.dll, Msvert20.d1l, Rpertd.dil

Wwintl32.dl Kemel32.dll, User3l.dil
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DLLs Called by Shared Applications

Executable files and DLLs associated with shared apphcauon toolscall DLLs as
shown in the followmg tables:

Sharéd w
application Calling file DLLs )
Ar Gallery Artgalry.cxe Mpr.dIl, Picstorc.dll, Cometl32.dIL, Pubdlg dil,
Kernel32.dll, User32.d1l, Gdi32.dll, Condlg32.dil,
Advapi32.dil, Shell32.dll, Micans32.d1L,0le32.d11,
Msven20.dll, Rpertd.dli, Oteant32.d11
Picstore.dl! Kemnel32.dll, Ole32.d1l, Msveni20.dl, Rpnd.dil,
User32.dll
Pubdlg.dli . Kemel32.dli. Userd2.dll, Gdi32.dll
Data Access Odbcad32.exe  Odbeep32.dll, Msvert20.dll, Kemel32.d11, User32.d01,
Objects Advapi32.dil, Gdil2.dll. Comdig32.dl, L22.dl),
= . Versiondll
- Dao3032.d1I1 Ms;jt3032.dil, Msjter32.dl, Msjintd2.dll,
Kerne!l32.d11, User32.dtl, Advapi32.dll. Oleaut. dil,
Mpr.dll. Ole32.d11. Msvert20.d11. Rpert4.dli
Dbnmpntw.dll  Kernel32.dll, Msvert20.d1). User32.d11
Ds32gt.dll Msven20.dll, Kemnel32.dil, User32.dll
MscpxI32.dl Msvert20.dll, Kernel32.dli, User32.dll
Msjint32.d11 Kemel32.dlL, User32.dil
Msjt3032.d1 Mpr.dil. Kemeld2.dIl, User32.dll, Advapi32.dil.

Msjler32.dll
Msli3032.dI1

Mspa3032.¢11
Msd2x32.411

Mstx3032.d11

Msvert20.dil
Mswag300.dIl

Msxb3032.315

Ole32.dll, Oleaut32.dll, Msvert20.dll, Rpertd.dll
Ms;jint32.d1L, Kemnel32.dl1

Msjt3032.41, Kemnel32.dI1, User32.dit, Advapidl.dil,
Oleaut32.dll, Oie32.d1l, Msvert20.dIi, Rpend.dil.
Mpr.dli

Kerncl32.d]l, User32.dIl, Advapi32.dll

Msjt3032.211, Kernel32.dIl, User32.dl, Advapil2.dil,
Oleaut32.d11, Ole32.dil, Msven20.dll, Rpend.dil,
Mpr.dil

Msjt3032.d1l, Kemnel32.dll, User32.dl}, Advapi32.dil,
Oleaut32.dl, Ole32.dll, Msvert20.dil, Rpend.dil,
Mpr.dil

User32.d11, Kernel32.d11

Msit3032.d11, Msjiee32.d11, Msjint32.dI, Mpr.dll,
Kemne]32.dll, User32.dll, Advapi32.dil, Ole32.dll,
Oleaut32.dll, Msven20.d1L, Rpenid.dll

Kemel32.dll, User32.dll, Advapi32.dil -+ - ~
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Cdexi32.dl)

Odfox32.dll

Odpdx32.d1t

Shared
application Calling file DLLs
Data Access Msx13032.d1l Msjt3032.d11, Kernel32.d1Y, User32.dll, Advapi32.dil.
Objects ) Oleaut32.diL Ole 32.d1L Msvert20.d11, Rpend.dll,
(conttnued) Mpr.dil .
Odbe32.d1 Msvert20.d1l. Kernei32.d1), Advapi32.dil, User32.dll
Odbc32gt.dll Msvert20.d1L Kemel32.dll, User32.dll
Odbecep32.dll - Msver20.d1E, Kernel32.dll. Advapi32.dll, User32.dIL,
Gdi32.dll. Comdig32.dil, Lz32.dll, Version.dl!
Odbeer32.dll Odbc32.d1, Kernel32.dll, User32.dll, Shell32.dll,
- Advapi32.dll, Gdi32.dll. Comdlg32.dll. Cometl32.d11,
Msvert20.dl1
Odbejt32.dl Odbcjil2.dll, Msjt3032.d1. Msjter32.dll, -
’ ) 0Odbeil32.d1, Odbeep32.dH, Kemel32.d11,
Advapi32.dll. User32.dll. Comdig32.dIL
.= _ Msvert20.d11, Gdi32.dli, Mpr.dil. Ole32.dlL
Oleaut32.dil, Rpend.dll, Msjint32.dll. Lz32.dIL
Version.dll
Qdbetl32 dll Kemnel32.dll, User32.dil. Msvert20.d11
(Oddbse32.dl Odbc)t32.dll. Odbcji32 dil. Msjt3032.d11,

Msjter32.dll. Odbetl32.dl1. Odbeep32.dll,
Kemnel32.dIL Advapi32.dii- User32.dll.
Comdlg32.dll, Msvernt20.d1l, Gdi32.d1. Mpr dll.
Ole32.dll, Oleaut32. dll. Rperid.dll, Msymi32.dl1,
Lz32 dll, Version.dll *°

Odbcjt32.dil, Odbeji32.dll, Msj3032.d11
Msjter32.dll, Odbeti32.dll, Odbeep32 dil
Kemnel32.d1l, Advapi32.dil, User32.dll,
Comdig32.dil, Msvert20.dll. Gdi32.dIl. Mpr dH,
Ole32.dil, Oleaut32.dll. Rpend.dil. Msjint32.d11,
L232.dIL. Version.dil

Odbcej32.dil, Odbeji32.dil, Msjt3032.d11,
Msjer32.dll Odbet132.d11. Odbeep32.dil,
Kernel32.d1), Advapi32.dil. User32.dli,
Comdig32.dll. Msvert20.dll. Gdi32.dli, Mpr.dll,
Ole32.dil. Oleant32.d11, Rpertd.dll, Msjint32.dY,
Lz32.dll. Version.dll o

Odbejtd2.dil. Odbejid2.dil, Msjt3032.d11,
Msper32.dil, Odbet132.dH. Odbeep32.dit,
Kernet32.dil, Advapi32.dll, User32.dl,
Comdig32.dll. Msvert20.dll Gdi32.d1l. Mpr.dll,
Ole22.dli, Oleawt32 dll, Rpertd.dll, Msjint32.d11,
Lz32.dl, Version.dll
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Shared

application Calling file DLLs '
Data Access Odtex32.dl]1 | Odbcjt32.dil, Odbeji32.dil, Msje3032.411,
Objects Msjter32.d11, Odbetl32.d1, Odbecp32 dil, - -
(continued) Kemel32.dll, Advapi32.dll, User32.dll,
Comdlg32.dll, Msvert20.d11, Gdi32.d11, Mpr.dll,
0Ole32.dil. Oleaut32.dll, Rpcnd.dll. Msjint32.dl,
Lz32.dll, Version.dll
Sqlsrv32.dll Kemel32.dll, Msvert20.dl1, User32.dll. Advapi32dll. . .
Odbeep32.dll, Version.dll. Netapi32.dll, Gdi32.dll.
Comdlg32.d1), Lz32.dll, Netbios.dil
Vbajet32.d4ll Msvert20.d11. Kemnel32.d1
Data Map Datajnst.exe Mitmdl32.d11, Kemel32.d11, User32.dll, Gdi32.dil.
Comdlg32.d1l, Advapi32.dll, Shell32.d1,
Comcti32.dil
Datamap.exe Mitmdi32.d1l. Kemnel32.dll, Gdi32.dl. User32.dIl.
ca ® Comdlg32.d11, Advapi32.dil, Shell32.dIl,"
B Comctl32.dll, Mfcans32.dIl, Oleaut32.dll, Ole32.dl,
—_— Msven20.d1l, Rpentd dli, Mfcuia32.dll,
Midi10in.dlt Kernei32.dll
Mitmdi32.dl Kemel32.d1l, Gdi32.dl1, User32.dll
Mo10in32.dli Kemnel32.dil
Tmitm32.di Kernei32.dll
Equation Egnedt32.exe Kemel32.dll, User32.dll. Gdi32.dll, Advapi32.dll.
Editor Ole32.d1l. Shell32.d11, Cometi32.d1l, Msvert20.d11,
Rper4.dil
Graphics Msbmp32.dil Kernei32.dli
Filters
Msgif32.dil ~ Kemel32.dll
Msjpeg32.dll Kemnel32.dli
Msjpeg32.dil-  Kemel32.dll
Mspecd32.dl] Kemnel32.dil, Pedlib32.dl. Gdi32.d11, User32.dll
Mspex32.d0 Kernel32.d11
Msiga32.dii Kemel32.dil
Mst1ff22 dil Kernel32.d11
Pcdlib32.d1 Gdi32.dll, Kemel32.41], User32.d1l
Text Wpequs32dll  Kemel32.4ll
Converters

Microsoft Info

Msinfoll.exe

Imgwalk.dll

Version.dll, Kemnel32.dil, User32.dll, Gdi32.dl).
Advapi32.dll, Shell32.d1l, Cometl32.411

Kerne[32.d1l, User32.dll
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Shared Services

Shared .
application Calling file DLLs
Microsoft Msgry32.exe Qryint32.d1l, Kenel32.dll, User32.dll. Gdi32.dl\,
Query Comdig32.dll, Odbc32.d1, Advapi32.dll.
. Msvert20.411
Qrvint32.dil Kernel32.dIl
" Microsoft Orgchart.exe Kemel32.dll. User32.dH, Gdi32.d1l, Comdlg32.dll.
Organization Advapi32.4ll, Ole32.dll, Comct132.d11, Msveri20.d11.
Chart Rpert4.dll
Proofing Tools  Mssp232dil =~ Kemel32.dll, User32.411
Msth32.dit Kemnel32.dll, User32.dli
Gramn32.dll Gdi32.dll, Kemel32.dll, User32 dll
Hyph32.dll Kernel32.dll, User32.d11
Microsoft Wrdart32.exe User32.dll. Gdi32.411, Kemnel32.dlt, Pubole32.diL
WordArt Mfcans32.dll, Ole32.dl1, Shell32 dil, Advapi32.dll.
\ - Cometl32.d11, Oleaut32.d1l. Msvert20.dil. Rpertd.dil
Pubole32.d1l User32.d11, Gdi32.dll, Kernel32.d11, Advapi32.dil,
Ole32.di1, Msvert20.d1l, Rperid.dll
Visual Basic Vba232.dil Ole32.d1, Oleaut32.dll, Gdi32.dll, User32.4ll,
for applications Msvcri20.dit, Kemnel32.dil, Advapi32.di,
Winmm.dll, Rpert4.dll .
Vba32.dil - Ole32.d1, Oleaut32.dlt, Gdi32.dil. User32.dIl.
Crtdli.dil, Mpr.dll, Kernel32.dl1, Advapi32.dll,
Winmm.dll .
Vbar2]32.dlt Ole32.dHl, Oleaut32.dll, Gdi32.dil. User32.dll.
Msvert20.d11, Kernel32.d1], Advapi32.dll. Rpcrid.dil
Help and Cue Cuecrd32.dll User32.dlt, Kemel32.dHl -
Cards
Visx.exe User32.dll, Kernel32.d11
Hlp95en.dil Kemel32.dli, User32.dil, Gdi32.dh

Services that Office adds to the individual Office applications are designed to
unify common actsvities such as creating and opening documents, making
appointments. or adding tasks or contacts. In this way, users do not necessarily
“run Schedule+" or “stant Microsoft Excel.” Instead, they go straight to a task, and
Office opens the tools necessary to accomplish the task.

In particular. the services that Office provides are the Microsoft Office Shortcut
Bar. Office Binders, and the Find Fast utility.
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Microsoft Office Shortcut Bar .

"
1.3

1}

The Microsoft Office Shertcut Bar is an upgraded version of the Microsoft Office
Manager from Office 4.x. Itis a set of toolbars that users can use to start
applications. By default, the Shortcut Bar includes toolbars for Office, Desktop.
Programs, Accessories, and the Microsoft Network (MSN) if MSN has been

installed on the system.

Users can create their own toolbars, and can include buttons of their choice for
creating single-click shortcuts to their most commonly used documents and
applications. They can create a shortcut by dropping any file system object (such
as files, folders, printers, or the control panel) onto any Shortcut Bar toolbar.

As an administrator, you can also create and distribute custom shortcut toolbars.
The toolbars that appear on the Shortcut Bar are *.tbb files stored in
WMsoffice\Office\ShortCut Bar on the user’s computer. The buttons that appear on
the Office toolbar by default are shortcut files in

Misoffice\Office\ShortCut Bar\Office. You can use the Network Installation
Wizard to modify the collections of files in these locations on users’ computers.

_ For information on using the Network Installation Wizard, see Chapter 9.

“Customizing Client Installations.”

The folder iocation for the toolbar you create must also be specified in' the
Windows Registry. Each toolbar is listed under its own key under the kev
Hkey_Current_Usenr\Software\Microsoft\Office Shortcut Bar\Tootbars:

\Hkey_Current _User\Software\Microsoft\0ffice Shertcut Bar
\Position
\Height
\Left
\Top
\W1dth
\Toolbars
Key: \<{path>
Value: <RGB: '4 bytes> <Buttons> <{Rows: 2 bytes>

Each toolbar has a binary value pair where the name of the value is the folder path
and the value 1s set to a null delimited and double null termunated string of the
files in that folder and their ordering. Separators can be specified by a hyphen (-)
character. The fou- » - tes preceding this list are for the value of the toolbar color.
The final two bytes of the value are reserved for the number of rows of buttons
last displayed on the toolbar.

For example, if a folder C:\My Documents\Work were listed under Toolbars, then
its entry mught look like this:

[key) c:\my documents\work [valuel<rgb-4 bytes>my first f11e()my second
f1le()my thaird file()-()my last file()()<rows-2 bytes> .
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In this case. the toolbar would contain three buttons, then a separator, then the last
button; the buttons would comespond to each file and would appear in the order
listed. Filenames in the list prefixed with an asterisk (*) are interpreted as hidden,
so they will show up in the Customize dialog bax. but not on the toolbar:

Office Binders

1

Office Binders are based on the metaphor of a three-ring binder, where all work
that pertains to a single topic can be stored conveniently. Users can store
spreadsheets, charts, documents, and presentations together in a binder, where
they are saved and opened as a single unit, and can be printed in a single pass,
with consecutive page numbering. Users can also disassemble a binder’s contents
and save each section as its own file.

Binders are OLE containers for embedded document objects. That is, opening a
Word document section of a binder activates the Word tools necessary for editing

-the document, but any changes to the document are not refiected in the source

document; likewise any changes-to the source document are not reflected in the
binder.

For more information about Office Binders. see “Supporting Office Binders™ in
Chapter 12, "Support and Troubleshooting.”

Find Fast Indexer

The Find Fast indexer is a utility provided by Office that allows a user’s system to
create an index of document files on the local system or on a network share, Find
Fast indexes are not seen by users. but are used by Office applications to make

file searches faster. Indexes correspond 1o folders: the name, scope and location of
each index matches that of its associated folder.

The indexer and indexes do not greatly tax system resources. The indexer can
work in the background as an idle-time process, and indexes are usually less than
five percent of the size of the document collection being indexed. For more
information about using the Find Fast indexer, see “Finding and Managing
Documents within a Workgroup™ in Chapter 15.

By default, Setup installs the indexer as the file Findfast.exe in the user’s
WMsoffice\Office folder. copies a Find Fast shortcut to the )
\Windows\Start Menu\StartUp folder, and installs Find Fast in the Windows
Control Panel. Setup also installs the Find Fast log file, Ffastlog.txt, in the user's
\Window s\System folder. The location of the indexer is specified in the Registry
key Hkey_Local_Machine\Software\Microsoft\Shared Tools Location. and the
location of the log file 1s specified in the Registry key
Hkey_Locul_Machine\Sotiware\Microsoft\Shared Tools\Find Fast\95.
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Users can access the Find Fast-ind=xer by going to the Control Panel and double-
clicking on the Find Fast icon. The Find Fast dialog box allows users to create and
delete indexes, to force an update to their index, to suspend indexing. and to see
information about their index. By default, the Find Fast indexer creates an index
of all Office documents, but users can choose to index whatever type of files they
want. For example, they can index only PowerPoint presentations (*.ppt and *.pot
files), or they can expand the index to include all files (*.*). Users can also choose
the Jocation of the index, such as the \Msoffice folder or the root folder of their
hard drive. When the indexer creates an index, 1t creates the files _ ofidx.fia,
__ofidx.ffl, and __ofidx0.ffx in the folder being indexed. Indexes cover all
searchable files of a folder, including subfolders. [ndexes are updated
automatically by defauit.

Instead of a root-level index. users may elect to create several smaller indexes tor
each volume that they want to search. Users can create as many indexes as they
want, providing corresponding folders don’t overlap. That is, the folder of one
index cannot contain the folder of another index. Following are some reasons that
maltple indexes might be practicai:- - ~ - -

= =The user has multiple hard drives. such as a C and a D drive.

»  The user may want to index a Windows for Workgroups share. Because the
folder for one index cannat be above or below the folder for another index. the
user needs to create several indexes to cover all documents of a drive. For
example. if the Windows for Workgroups folder is top-level. the user may
want to create additional indexes for each other iop-level folder.

» The user creates un index for a share on a NetWarew server, Tt would be
unnecessary for the user to create an index for a Windows 95 or NT file server,
as these servers should already be running an instance of the indexer,
matntaining an index ot server files.

How Indexes are Updated

When the Find Fast indexer creates an index. it produces a single master index
that is optimized for speed and size. The Find Fast indexer updates and optimizes
the master index as follows:

1. Perform a simple update to produce a sorted term list. The list contains one
term for each document that is out of date. Documents are out of date if their
current last-saved time stamp differs from the time stamp stored in the index.

[ ]

Periodically merge collections of sorted term lists to produce a shadow index.
A shadow indcex is structured the same as a master index, and is usually much
smalier and faster than the collection of term lists it replaces.

3. Periodically merge 10gether ull shudow indexes and the previous master index
10 produce a new masier index.
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The interval between automatic updates is adjusied automatically by the indexer
based on past updates, according to the following rules: '

» Update interval initially is two hours.

= If more than 10 files are out of date on the current update. then the update
interval is shortzned by 15 minutes, down to 2 minimum of 30 minutes. Files
added, deleted. or modified since the last update all count as being out of date.

» If 10 or fewer files are out of date on the current update. then the update
interval is lengthened by 15 minutes up to a maximum of 24 hours.

Find Fast indexer Log

As the Find Fast indexer updates indexes. it logs events and errors in a fog file.
Ffastlog.txt. Users are not alerted to errors and messages from the indexer. To see
these messages. users must click Show Indexer Log on the Index menu in the Find
Fast dialog box.

Events in the log file are listed so that the most recent events appear at the
beginming of the file. The indexer log is truncated when its size exceeds 20K.
When this happens, the log file displays a message that the log has been truncated.
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Microsoft Access Architeéture .
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1]

In This Chapter

The architecture of Microsoft Access consists of the application, the database
container or file, and the database objects, such as tables, queries, forms. reports.
macros, and modules. The Microsoft Access application stores components such
as menus and toolbars. as well-as the Microsoft Jet database engine, and any
add-ins written in Visual Basic for applications. The database container stores the
database objects, and the database objects store the data itself, as well a« OLE
custom controls and procedures for extracting and reporuing the data. This chapter
explains the distribution of data. components, and database objects across the
architect]urc of Microsoft Access. :

. Application Laver 61

Database Laver 66

Database Objects 68

Where Microsoft Access Components Reside 70 .
How Microsoft Access Resolves Conflicts 71

Application Layer

The application laver of Microsoft Access controls the user interface and provides
an environment for the Jet database engine. In addition, the application laver
makes calls to any library databases, which are collections of procedures, and
aded-ins, which are Visual Basic programs designed to accomplish specific tasks.

" When users are runr , : Micrasoft Access in a workgroup, their-preference

settings and secunty ..lormation are stored in a workgroup information file. This
section explains the Jet databuse engine, library databases. add-ins, and the
workgroup informanon file,
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Microsoft Access and the Jet Database Engine

.

i
1]

ik

Together. Microsoft Access and the Jet database engine form a complete database
management system (DBMS). Microsoft Access is the part of the DBMS that is
responsible for the user interface and all the ways that users view, edit, and
manipulate data through forms, queries, reports. and so forth. The Jet database
engine retrieves data from, and stores data in, user and system databases. It is the
data manager component of the DBMS.

Visual Basic  § i B Jet Database |
for applications § Engine

\
Medules Library Databases |- Tables " ISAMs —
Addins = I~ Queries ODBC
Workgroup Information File — Forms
— OLE Custom Controls
— Reports
— Macros

Microsoft Access

Microsoft Access is the container for the user interface and for aIE,lapplicmion
code. Itincludes alt the default settings for menus, toolbars, and database objects.
It also includes all the library database files that come with Microsott Access.

Default Settings Users can modify the look and behavior of the Microsoft Access
user interface in the Options dialog box. Some of these settings are stored in the
Windows Registry, while others are stored in the user’s workgroup information
file. System.mdw. For information about Microsoft Access entries in the
Windows Repgistry, see Appendix B. “Regisiry Keys and Values.” For information
about the setungs that are stored in System. mdw see “"Workgroup information
File,” later in this chapter.

Library Database Files The library databases that come with Microsoft Access

include all the wizards and add-ins, as well as the default System.mdw. For more

information about the library databases included wnh Microsoft Access, see
“Library Databases.” later in this chapter.
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Jet Database Engine

The Jet database engine is 4'relational database engine that handles all database
processing for Microsoft Access and Visual Basic. With Microsoft Access, the Jet
database engine can aiso provide data to Open Database Connectivity (ODBC)
client applicauons.

7 The Jet database engine is made up of a set of dynamic-link libranies (DLLs):

Jet database engine DLL The Jet database engine DLL (Msjt3032.d11) is the main
program that evaluates and executes requests for data. If the request is for narive
data—data stored in the Microsoft Access Database (.mdb) format—then
Ms;jt3032.d11 also handles the reading and writing of the data, However, if the
request involves non-native data, then Msjt3032.d1l makes calls to either the
ODBC Dnver Manager DLL (Odbc¢32.d1l) or one of the external ISAM DLLs, as
explained latcr in this section.

Data Access Ob}ects DLL The Data Access Objects DLL (Dao3032.d11) 1s the Jet
component that provides a developer interface to the Jet database engine. Data
Access Objects (DAO) includes a rich. high-level set of objects that insuiates
developers from the physical details of reading and writing records.

External [ISAM DLLs The Jet database engine provides access to several external

" Indexed Sequential Access Method ([SAM) format files using a series of

installable DLL files. The Jet database engine supports the external ISAM formats
shown in the following table. .

ISAM format Supported by DLL

Xbase (dBase and FoxPro) Msxb3032.dll
Paradox Mspx3032.dll
Lotus Msit3032.d11

Microsoft Excel Msx]13032.d1
Text Mstx3032.d1!

These DLLs handle the reading and writing of data stored in dBases, FoxPros,
Paradoxe, Lotus, M:~-osofl Excel. and text file formars.

.

Library Databases

A library database is a collection of procedures that Microsoft Access makes calls
1o for specific tasks. Library databuases contain code only. and they can be
functions that Microsoft Access calls as needed. They do not contain database
objects such as forms or tables.
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To use library databases, Microsoft Access tnust have a reference to them. Users
make this reference by clicking References in the Tools menu. Library database
files have the file extension.mda. |

Add-ins are Visual Basic programs that add functionality to Microsoft Access.
Add-in files, like library database files, have the file extension .mda. Users can
add or remove add-ins from Microsoft Access by clicking Add-ins on the Tools
menu and then clicking Add-in Manager.

Add-ins can automate complex or repetitive tasks in Microsoft Access. You can
create or customize add-ins for your users. For information about creating add-ins
in Microsoft Access, see Chapter 16 of the Microsoft Access book, Building
Applicarions.

Microsoft Access has three kinds of add-ins: wizards, builders, and menu add-ins.
Wizards and builders are contéxt-specific; they are called into the application

when the user wants to do something, such as build a form, create a table. or make
a query. Menu add-ins must be called into the application by the Add-in Manager.

Wizards

- Wizards allow users to accomplish tasks quickly and easily, without knowing

much about Microsoft Access. A wizard is usually a series of dialog boaes that
lead a user. step by step, through a complex procedure. The dialog box format
helps 1o lirit the user’s choices and provides them a defined sequence to foliow,

You can create wizards for your own users. Microsoft Access provides direct
support for some types of wizards. For example, if you create a wizard 10 design a
specific type of form. vour wizard can be installed to appear in the same list as the
Microsoft Access Form Wizard. Microsoft Access supports the following kinds of
wizards:

» Table and query wizards

= Form and report wizards

» Propenty wizards

= Control wizare - -

Builders

Builders are simpler tools than wizards. Builders usually consist of a single dialog
box or form that guides the user through the process of constructing an expression
or other single data ¢lement. The Microsoft Access Expression Builder is an
example of this tyvpe of add-in.
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Microsoft Access supporis many kinds of builders automatically. If you create
one of the following kinds of builders, it will appear on the list of Microsoft
Access builders:

s Property builders

-w  Contro!l builders

= Expression builders

Menu Add-ins

Menu add-ins are general-purpose mini-applications that accomplish tasks that are
not context-sensitive in the way that wizards and builders are. A menu add-in
usually operates on multiple objects or on the Microsoft Access application itself.
The Microsoft Access Documentor is an exampie of a menu add-in. ‘

Menu add-ins are supported by the Add-in command on the Tools menu.

Workgr‘oﬂp Information File

In M!crosoft Access installations where user and group level security is being
used, the user and group 1nformation is stored in the workgroup tnfonmation file,
System.mdw. For all Microsoft Access users, this file also stores user-specific
preferences such as custom toolbars and other options. The System.mdw file is
required for Microsoft Access to start up.

For users to share data. they join a workgroup by using the Workgroup
Admunistrator. Wrkgadm.exe. to specify the System.mdw file on the network -
share where they want to run Microsoft Access. If a password has been defined.
users are required to log on to this account. The shared System.mdw stares
passwords for each user.

The Svstem.mdw a user specifies is the file that Microsoft Access uses every time
1t starts up. until the user specifies some other System.mdw, If a user does not
belong to a workgroup and therefore specifies no System.mdw, Microsoft Access
uses the System.mdw on the local workstation, with default security settings. The
Svstem.mdw that Microsoft Access uses for any given desktop is specified in the
Registry setting

Hkev_Local_Machine\Software\Microsoft\Access\7.0Uen3. O\Engmcs\Jct as the

. stnng value for SystemDB.

Once users have joined a workgroup and established their settings, they should
back up thetr System.mdw. If the file somehow gets corrupted. the user must re-
create 1. Users must have a System.mdw to run Microsoft Access.
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“* Database Layer

Data is generally stored in tables in the database, but links can be established to
tables in other databases, to data in other file formats (such as Microsoft Excel.
dBase. and Paradox), and to ODBC data sources, such as SQL Server. These links
are stored in the database container and act like narive tables,

Installable {SAMs

ik
h
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Data that is stored separately from the main database is accessed through lookup
rables, which are Index Sequential Access Method (ISAM) files. Databases
created in formats other than Microsoft Access—such as FoxPro. dBase, and
Paradox —use ISAMs that are non-native to Microsoft Access. To enable
Microsoft Access to work with databases created in these other formats Microsoft
Access ships with installable ISAMs (IISAMs). Using IISAMs, Microsoft Access
treats non-native ISAM dala very similarly to how it treats native tables.

[ISAMs in Microsoft Access support the following ISAM file formats:

« Microsoft FoxPro. versions 2.0, 2.5, 2.6, and import/export (no linking) for
versicn 3.0

« dBase [II PLUS, dBase 1V, and dBase V

+ Paradox. versions 3x, 4 x, and 5.0

« Microsoft Excel. versions 3.0 and 7.0

» Lotus. versions 2.x. 3.x, and 4.0

« Text files (fixed-width and delimited text files)

Microsoft Access supports two methods of access to external [SAMs: hinked
tabl¢s and direct 1abie opening.

Linked Tables

Linking to tables is the preferred method for accessing external data. Linking to a
table from a non-native database attaches the non-native database 1o the user's
current Microsoft Access database. Any changes to the table are reflected in the
linked database. Using linked tables, Microsoft Access stores connéction
information by adding an 1con in the database window, so users can readily access
the exiernal wable again.

The linked table method of accessing external data is preferred, because the data
i~ ive and up 1o date. and because the link works whether the data is coming from
a table or query For exampie, if the table is moved to a SQL server, the
application can sl access the data by linking to the table,
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Direct Table Opening

The Microsoft Access user interface does not allow users to open an external table
directly. Microsoft Access opens external tables directly only through Visual
Basic. A developer might use this method to get a value quickly from a table that
does not need to be accessed very often in the application.

The disadvantage to using this method for accessing external data is that it ties the
application 1o the data source. For example, if the table is moved to a SQL server,
the data 15 no longer ISAM data. and the application will fail when attempting to
read tables directly. For more information, see “Separating the Application from
the Data,” later in this section. .

ODBC Connectivity

L3
1)

1

Microsoft Access allows users to retrieve data from Open Database Connectivity
(ODBC) data scurces. The ODBC connectivity standard is typically used to
connect to server-based database systems. Microsoft Access mc]udeq ODBC
drivers for Microsoft SQL Server.

The ODBC standard can also be used to connect to non-server databases und
spreadsheets.

As with [ISAM data, Microsoft Access can connect to ODBC data sources by
linking or opening tables. Microsoft Access also supports SQL Pass-through
{SPT) queries for retrieving ODBC data. By using pass-through queries. users
work directly with the tables on the server, rather than with linked tables. SPT
queries also allow users to run procedures that are stored on the server The
disadvantage of applications that use SPT queries is that they are not portable. For
example. an application wntien for a SQL server will fail if it attempts 10 access
an Oracle server. Users create SPT queries by clicking SQL Spec:ﬁc on the Query
menu and then clicking Pass-Through.

Separating the Application from the Data

Microsoft Access applications can be designed to be separate from the data they
store. For an example of this type of architecture, see the Northwind Order Eniry
Application (Orders.mdb) that Setup installs with Microsoft Access. The forms.
queries. reports. and other application features are self-contained within
Orders.mdb. The, database 1ables. however, are stored in the Northrwind database
(Nwind.mdb}.

This is the preferred method of developing applications in Microsoft Access.
Keeping apphication and database code separate makes both the applicauon and
the data easier to marntain. By keeping them separate, you can upgrade a database
1o future versions of Microsoft Access independently of the custom application.
Keeping the apphication separate from the database also makes 1t easier for users
with different versions of Microsoft Access 1o use the same data. "’
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Database objects are stored in the database container. which is a file with the
extension .mdb. Users can design new objects or open existing ones to work with
their database. Database objects are tables, queries, forms, reports, macros, and
modules. Each of these is described below.

Tables Tables are containers for storing data that is related in some particuiar
way. Users can define separate tables for each subject on which they wish to keep
data, such as employees. invoices, or inventory. Users can enter and modify data
in tables directly or through data entry forms, which are described below.

Queries - Users retrieve data from the database with queries. Quenes are processed
by the Jet database engine. The simplest form of queries are select queries, where
users identify data by category, range, and boolean operators. Microsoft Aceess
displays the results of selectqueries in dvnasets, which are tables that are
connected to the live data. They may appear to a user to be static tables, but they
are actually a dynamic view of the data. When users open a query in Datasheet
view, or open a form or print a report that is based on a query. Microsoft Access
creates a dynaser using the information currently stored in the database. This
allows users to enter and modify data. The changes they make effect the
underlying tables in the database itself.

Forms Forms give users a way of entering data into databases, displaying data to
the screen. and printing 1. Forms can contain text, graphics, data, color, and OLE
custom controls. The appearance of a form is congolled by a form template. For
more information, see “‘Form and Report Templates,” later in this chapter.

OLE custom controls OLE custom controls {(OCXs) are similar to Visual Basic
custom controls (VBXs). They are used 1o add custom functionality to forms and
are stored in forms. Microsoft Access 7.0 includes three OLE custom controls:
calendar control, spin box, and outline. Additional controls are available from
third parties.

Reports Reports present information from a Microsoft Access database so that it
is formatted and organired according to the user’s specifications. This formatting
and organizatiorrss ¢¢ “-olled by a report template. For more information, see
“Form and Repont Templates,” later in this chapter,

Macros Macros are actions or a set of actions that have been stored 10 automate
_tasks, They are associated with the event property of ‘a form, report, section, or
control.
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Moduies A module is a collection of Visual Basic declarations, statements. .and

procedures. Users can store related procedures in a single module. Databases can
include muitiple modules, including global, form. and report modules:

» Global médules can be used throughout the database. Microsoft Access loads
them when a user opens a database.

» Form modules are associated with a specific form Microsoft Access loads
thern when a user opens the form.

= Report modules are assoctated with a specific report. Microsoft Access loads
them when a user opens the report.

Form and Report Templates

When users create a form or report without using a wizard, Microsoft Access uses
a template to define the default characteristics of the form or report. The template .
determines which sections a form or report will have and defines each section’s
difnensions. _The template also contains all the default property settings for the
fomm.

The default templates for forms and reports are called Normal. However. users
can use any existing form or report as a template. Users specify which template -
they want to use in the Options dialog box. This setting is stored in the workgroup
information file. System.mdw, and appiies to all databases the user opens or
creates. Users can copy or export templates to use them in other databases.
Additionally, you can create corporate templates to distribute to your users.

Form and report templates define:

«  Whether to include a form or report header and footer.
» Whether to include a page header and footer.
« What the dimensions (height and width) of the'sections will be.

= Which control default properties to use. However, templates do not create
controis on new forms or reports.
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Microsoft Access components are stored with the application or an add-in: on’ )
disk. or in the Windows Registry. The following table lists components and where
thev reside.

Component Stored
Tables . . .‘On disk in the database file (*.mdb)
Queries On disk in the database file {*. mdb)
Forms ' On disk in the database file (*.mdb)
Reports On disk in the database file (*.mdb)
Macros On disk in the database file {*.mdb)
Modules ' On disk in the database file (*.mdb)
OLE custom controls In the form or report in which it was created
User passwords - T On disk in System.mdw .

" Permissions for security accounts On disk in the database file (*.mdb)
Custom toolbar settings ‘ On dish in System.mdw
Custom menu settings On disk in System.mdw
User preferences. set with Options In the Windows Registry
command on Tools menu!
AutoCorrect settings In the Windows Registry
Custom dictionary On disk in Custom.dic
AutoFormat styles In the AutoFormat Wizard
Expression Builder On disk in Utility. mda
AutoDialer On disk in Utikity.mda
Normal template for forms and reports "On disk in Utility.mda
Zoom Box On disk in Utility.mda
Save Qutput As ) On disk in Unlity.mda

I In multi-user environments. the workgroup file {System.mdw) also stores user preferences.

Where Security Settings Are Stored -

Security setungs are stored differently, depending on how a user is securing the
database. Microsoft Access provides two methods of securing a database: setting
a password for opeming the database, or employing user-level security, which
provides flexibility for aliowing different users different levels of permission for
the vanous objects in a database.
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Password Security With password security, users specify a password from the
Security command on the Tools menu. This password is stored with the database. .

in the .mdb file.

User-level Security With user-level security, System.mdw stores user accounts,
the passwords used to verify user's identities, and the groups to which users
belong. If users leave a group, they can be removed from the group and no longer
have permissions.

The actual permissions for the database objects are stored in the database file.
These permissions are associated with each object within the database as defined
by the security administrator. Perrnissions can be assigned to tndividual users and
groups.

For more information about security setlings, see Security in on-line help, or see
“Security Administration” in the Microsoft Access secuon of Chapter [5. “Using
Workgroup Features and Apphcauons with Office.’

= = *

How M'ic':rbsoi‘t Access Resolves Conflicts

Conflicts can anise in Microsoft Access when a database is being replicated. or
when more than one user attempts to edit the same record of a database, causing a
locking conflict.

Replication Conflicts

During replication setup—for example. when a vser drags a database into the
Windows 95 Briefcase —the Jet database engine requests Globally Unique IDs
(GUIDs) from the operating system that are associated with each row of data in
the design master. These GUIDs are then copied into any replica databases. If a
row changes in the design master or a replica, a counter is incremented for the
row. This makes it easy for Microsoft Access to compare the vaives of rows,
detect that a change has been made, and replicate the changed data 10 other
dutabases. If the same row is changed in more than one database simultaneously.
Microsoft Access selects between them based on the following rules:

= Microsoft Access chooses the database that has the highest value for its
counter. That is, the row that has changed most often has a higher counter,
because the counter is incremented every time a row is changed.

«If both rows have been changed the same number of times (counters arc the
same on both rows in both databases), Microsoft Access chooses a dalabase
randomiy. as the replication logic cannot reasonably know which of the two
rows has the correct data.
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Regardless of how the data is selected, users who submit the data that is not
chosen are told by a Conflict Wizard in Microsoft Access that their data was
rejected. Users can then resubmit their change or accept the other data.

ng Conflicts

If record locking 1s set to No Locks, there may be locking conflicts when more
than one user attemplts to edit or save the same record. Users can set record
locking by clicking Options in the Tools menu and selecting the Advanced tab.

The No Locks setting allows more than one user to edit a record simultaneously,
but the record is locked during the instant when it is being saved. If two users
attempt to save changes to the same record, Microsoft Access displays a message
to the second user who tries to save the record. This user can then discard the
record. copy the record to the Clipboard, or replace the changes made by the other
user. Using this option, it is possible for users to write over one another’s

=+ thanges. ae e ‘

— “For more information about record locking. see “Multiuser Settings” in the
Microsoft Access section of Chapter 15, “Using Workgroup Features and
Applications with Office.”
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CHAPTER 3

Microsoft Excel Architecture
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In This Chapter

This chapter describes the architecture of Microsoft Excel in terms of its two
primary elements: the application and the workbook. A section of the chapter lists
Microsoft Excel components and where they are stored within Microsoft Excel,
another section describes the architecture of the Microsoft Excel mapping feaure,
and the chapter concludes with an explanation of how Microsoft Excel resolves
conflicting settings. T

Overall Structure 73
Where Components Are Stored 79

Microsoft Excel Data Map 34
How Microsoft Excel Resolves Conflicts 88

Overall Structure

The architecture of Microsoft Excel consists of the Microsoft Excel apphication
and the workbook file. The Microsoft Exce! application controis the siandard’
menus, toolbars. and default settings for how workbook files are created. opened,
and stored. The workbook file is a collection of sheets: worksheets. chart sheets,
and macro sheets. The workbook file also stores workbook-level components,
such as passwords, styles, and scenanos. To standardize workbooks and the
Microsoft Excel application across your organizatton, you can save workbooks in
formats other than a workbook file. You can save workbooks as templates and as
add-ins.

Microsoft Excel Application

Microsott Excel default settings and paths that are established at setup. These
features can be customezed after instaliation for a single user. a workgroup, or
aCTOSS an enure organization.

95



74

Part 1

Architecture

i
1]

"

There are several ways to customize the Microsoft Excel application:

Through the user interface, in the Options dialog box Users can customize
Microsoft Excel on their desktop, by clicking Options on the Tools menu. The
settings they make here are stored in their Windows Registry. -

in the Windows Registry For information on Registry settings for Microsofit
Excel, see Appendix B, “Registry Keys and Values.”

With an Add-in  Another way of customizing Microsoft Excel is to create
add-ins. An add-in is a hidden, read-only workbook in which the Visual Bastc
code has been fully comnpiled from a source workbook. For a particular
workgroup’s specific tasks, you could create an add-in that runs as a
standalone, customized version of Microsoft Excel. Or, you can create add-ins
that provide supplemental functionality to your users’ version of Microsoft
Excel as installed on their system. For information about creating,
maintaining, and distributing add-ins, see Chapter 12 of the Microsoft
Excel/Visual Basic for Windows 93 Programmer’s Guide. - - -

In addition to these methods of customizing Microsoft Excel, you can also
customize specific features for vour users. Some of these customizations are
stored in a separate file on the user’s system, as explamed in the following list of
features:

Toolbar Settings and Custom AutoFill Lists When users modify their toolbar
settings, Microsoft Excel stores these settings in the file Username.xlb 1n the
user’s Windows folder, where Username is the Windows 95 logon name of the
current user. When users create their own AwtoFill lists for filling in a range of
cells with a series of data, these lists are also stored in Username.xlb.

You can distnibute a common set of custom lists for AutoFill and sorting, or
provide custom toolbars for particular tasks at your site. To do so, create the
custom lists and custom toolbars in & workbook. Save the workbook, and place
the resulting .x1b file on a network share, where users can merge the
customizations into their own workbooks by opcmng the .xIb file with the
Open command on the File menu.

Note When custom toolbars are attached to a module in a workbook, they are
not stored in the user's \Windows\Username.x1b file. Instead, they are stored
with the workbook that contains the module.
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= Startup and Alternate Startup Folders Whet. Microsoft Excel starts, it opens
all workbooks, charts, and workspace files stored in the user’s Xlstart folder.
When a user clicks New onthe File menu, the workbook templates listed are
those stored in Xlstart. If you want your users to'open a workbook
automatically when they start Microsoft Excel. move or copy the workbook to
this folder. This strategy is especially useful if a workgroup is running
Microsoft Excel from a network share, and all users are sharing the same
Xlstart folder.

If users want to start Microsoft Excel with workbooks and templates stored
somewhere other than Xlstart (such as a network share), they can specify an
alternate startup folder. Users specify an alternate startup folder on the General
tab in the Options dialog box. This setting is stored in the Windows Registry.

You might want to create an alternate startup folder for your users if they have
Microsoft Excel installed on individual workstations, each with individual
Xlstart folders. By specifying a single alternate startup folder on a network
share, you would have a single folder to maintain for any workbooks. charts.
or workspace files you want your users to open when they start Microsoft

-~ — = Excel.

= Default Startup Workbook and Autotemplates If users do not specify a starp
workbook, Microsoft Excel displays a new, unsaved workbook when they stant
Microsoft Excel. This startup workbook is derived from the autotemplate. a
- template that opens automatically because it has the reserved filename
Book.xlt. and it is stored in the user’s Xlstart or alternate startup folder. '

= = £

You can specify the default font, formatting. and other options for new
workbooks for your users by creating a custom autotemplate. For example.
vou can create a workbook autotemplate that includes customized headers and
footers and your company name or any text, formatting, formulas. and macros
that your users want as defaults when creating new workbooks.

To create a workbook autotemnplate, create or open the workbook you want to
use as the autotemplate. Chick Save As on the File menu, and save the
workbook in the template file format. with the name Book.x!t. Distribute this
file 1o your users’ Xlstan or alternate startup folder.

When users click the New button on the Standard toolbar. Microsoft Excel
creates a new workbook. based on the autotemplate. The autotemplate also
shows up as the W« | 2ook icon on the General tab in the New dialog box
when users click Ne .. on the File menu or when they click the Start a New
Document button on the Microsoft Office Shortcut Bar.

» Workspace File [f you want vour users to be able to open a group of
workbooks 1n one siep. vou can create a workspace file for them. A workspace
file contains informnation about which workbooks to open, their locatons. and
their size and position on the screen. The workspace file does not contain the
workbooks themselves. .
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Vorkbooks

To create a workspace file for your users, open ali the workbooks you want to
include in the workspace. Size and position them as you want them to appear
when the users open the file. Then, click Save Workspace on the File menu.
The default name Microsoft Excel gives to the workspace file is Resume.xlw.
You may rename the file if you want. ’

Distribute this file to vour users. If you want the workspace file to open
automauncally each time users start Microsoft Excel, copy the file to the users’
Xlstart or alternate startup folder.

Note The workbook names and folder locations are saved with the workspace
file. If the files are moved to another location, Microsoft Excel will not be able
to find them.

= = = The workbook in Microsoft Excel-is analogous to the document in Word. or

the presentation in PowerPoini. The workbook is where the data is stored. in
the Microsoft Excel file format. Microsoft Excel workbook files have the
extension .xls.

Microsoft Excel stores warkbook files in the binary interchange file format
(BIFF). Workbooks ate compound files: files that contain a hierarchical svstem of
storages and streams. A srorage is analogous to a folder. and a srream is
analogous to z file in a folder. This file formar is the OLE implementation of the
Structured Storage Model standard.

Fore more information about the Structured Storage Model, see the OLE 2
Progrummer’s Reference, Volume One, and Inside OLE. For detailed information
about the BIFF file format. see the Microsoft Excel Developer's Kir. All-of these
books are published by Microsoft Press and are available at your local bookstore.

Templates

A remplate is a special workbook used as a pattern to create other workbooks
of the same tvpe. Rather than an .xls file extension, templates have the file
extension .x]u.

You can create templates for workgroups to maintain consistency. For example,
you ¢ian create a sales report workbook, save 1t as a tempilate, and distribute itto a
workgroup. Users in the workgroup then create weekly sales reports based on the
tlemplate or insert sheets from template into their workbook.
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Settings saved in a template determine the followmg characteristics of new
workbooks based on that template:

» The number and type of sheets in a workbook

« Page formats

« Cell formats

» Row and column stvles

+ Text, dates, numbers, formulas, and graphics, such as a company name and
logo .

« Custom menu commands, macros. and toolbars attached 10 a module sheetin
the template

When users open a template, Microsoft Excel opens an untitled, unsaved copy of
the template that contains all data, formatting. formulas. macros. styles, scenarios.
and so forth that is contained in the remp[ale The original template file remains
unchanﬂed

'To create a template, first create the workbook that includes any texr. formats. and _
formulas vour users want. and then click Save As on the File menu. Enter a
filename and select the folder. such as a network share. 1o store the template. In

the Save As Tvpe box, select Template. Storing workbook templates ina user’s
Xlstart or alternate startup folder automatically makes the iemplate available
when the user clicks New on the File menu.

Note Although templates in a user’s stariup foider are automatically available tor
creating new workbooks. only the template with the reserved name Book.alt
stored in the startup folder 1s an autotemplate. When users start Microsoft Excel.
click the New button on the Standard toolbar. or click the Start a New Document
button on the Microsott Office Shoricut Bar, the new workbook is based on the
autotemplate.

Add-Ins

In addinon to saving workbooks us .xls and .x}it files. users can. also save
workbooks as add-ins. Add-Ins compiled from Microsoft Excel workbooks have
the file extension .xla.

You can create custom add-ins to assemble and distribute custom features that.
from the user’s pamnt of view. act as if they are built into Microsoft Excel itself.
For informution about creating. maintaining. and distributng add-ins. see
Chapter 12 of the Micrasoft Excel/Visual Basic for Windows 95 Programmer's
Guide. published by Microsoft Press and available from your local bookstore.
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Note Add-Ins can also be written in C. When compiled, these add-ins have the
- file extension .x1I (similar to .wll files in Word). .

Add-Ins Included with Microsoft Excel

Several add-in- are included with Microsoft Excel, although whether or not they
are installed on a user’s system depends on what kind of installation was chosen
during setup. and on which add-ins were selected during a Custom instaliation.
For information about the components installed for each type of installanon. see
Appendix C, “List of Installed Components.”

Users can tnstall additional add-ins by clicking Add-Ins on the Tools menu.

The following 1able describes the add-ins included with Microsoft Excel. Their
default installation folder is \Excel\Library and its subfolders. Some add-ins
require a dynamic link library or compiled C add-in in addition to the .xla file, as
indicated in the table. -

[ 3 e . . - .
—— ~— Add-in Filename Description
Analvsis TootPak Funcres.xla. Adds financial and engineening 1unctions., and
Procdb.xla. provides tools for performing statistical and
Analys32xll . engineering analysis.
Analvsis ToolPak - Atpvbaen.xla Adds Visual Basic functions for Analysis
VBa ToolPak.
Microsott Query! XNiguery xla Retrieves data from external database files and
tables usiny Microsoft Query.
ODBC Xlodbe xla. Adds worksheet and macro tunctions lor
Xlodbe32.dll retneving data from external sources with
Microsoit Opon Database Connectivity
(ODBO).
Report Manager Reports xta Prints reports that consist of views and
‘ SCENANAS.
Sulver Sulver.xla Calculates solutions to what-if scenarios based

on adjustable cells, constraint cells. and
opuonally. cells that must be maximized or

minimized.
Template Unlsties Tmplinum xla Adds utilities used by Microsoft Excel
temptates.
Template Wizard Wortemplixla Creates a template to export worksheet data to
with Data Tracking a database.
Lipdate Links Updtink xla Updates links to Microsoft Excel 4 0 add-ins 10

directly access the new buili-in tunctionality,
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Add-In. Filename Description

View Manager Viewsxla - Saves the current window display as a view and
lets users apply their own saved views to see
their worksheel in difierent formats.

AutoSave Autosave xla Saves workbook files automaucally.

1 To use Microsoft Query with Microsoft Excel, users must instal} the Microsoft Query applu.anon
the Microsoft Query add-in. the drivers for the types of data they want to retrieve, and the |
necessary ODBC flles. Users can install these files by cheking Add/Remove Office Programs und
selecting the Dala Access opuion. For informaunon about Data Access components, see Appendrx C,
“Last of Installed Components.™

Where Components Are Stored

Workbook components are stored on sheéts of the workbook. These componenis
include all the contents of all data cells (constant values and formulas). cell
formatting, charts, macros. add-ins, and secunty settings. Security settings can be
stored for an entire workbook. as well as for individual sheets.

This section lists the vanous components of a workbook and explains how each is
stored within the workbook. .

Constant Values of Cells

Constant values stored in cells can be numeric values inciuding date. time,
currency, percentage. or sctentific notation, or it can be text. The way Microsoft
Excel displays numbers 1n a cell depends upon the number format for the cell.
This value rmay differ from the actual value Microsoft Excel stores. which is with
15 digits of accuracy. By default, Microsoft Excel makes calculations based on -
the stored value (full precision), but users can have Microsoft Excel calculate
based on displayved values by selecting Precisjon As Displayed on the
Calculations Tab 1n the Options dialog box.

If users ure getung results from their formulas that appear to be wrong. it may be
due to the difference in precision between displayed and stored values. For
example. if two cells each contain the value 1.007, and a formuia adds them in a
thrrd cell. the result is 2.014. If all three cells are formatted to display only two
decimal places. the displayed calculation, 1.01+1.01=2.01, appears to be wrong.
Stmilarly, calculatzir on displayed values. 1.01+1.01=2.02 appears to be correct,
but this results in a value that is not as precise as 1t wouid be by calculaung on
stored values.

Cavver Once users wmch 10 calculaung on d:splaycd vatues, M:crosof{ Excel
stores all constant values as their displaved values, and full precision values
canrnot be restored :
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Formulas
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Calculating with precision as displayed:

»  Affects all worksheets in the active wd'rkbook.

* Does not affect numbers in the General format, which are always calculated
with full precision. ‘

s Slows calculation because Microsoft Excel must round the numbers as it
calcujates. ’

Formulas are a sequence of values, cell references, names, functions or operators
that produce a new value from existing values. They are part of the data that is
stored with the workbook file. Cell references in a function can be relanve.
absolute, or mixed references in the Al style, or row-and-column (R1C1) stvie: or
they can be name references.

Users who use the Al, or R1CI. reference style may experience difficulty with
formutlas if they reposition or delete cells, as these references refer to data by’
position. A way to avoid this problem is to reference cells by name.

Name References

Users can use names as references to a cell, a group of cells, a value. or a formula.
Name references can be accessible to an entire workbook or restricted to a sheet.
When restricted to a sheet. the same nameé. such as “Profit” can be used 10 define
rejated cells on different sheets 1n the same workbook. Book-level names. on the
other hand. can refer to cells on one worksheet and be used throughout the
workbook. eliminating the need to re-create names for each new worksheet or 10
type worksheet references in formulas.

When users create book-level names, they simply type the name they are defining
in the Name box un the formula bar. When they create sheet-level names,
however. they must include the name of the sheet, such as “Sheet!Profit™ in the
Name box.

Sheet-level names override book-level names when used on the sheet where they
are defined. For example. in a workbook where Profit is defined both as a book-
level name and a sheet-level name for Sheetl. if a user enters a formula that uses
the name Profit on Sheetl. the formula uses the sheei-level name rather than the
book level name’ . o

Scenarios

Scenanos are the Microsoft Excel method of allowing users to pose what-if

models in their data. To create a what-if model, users specify a set of changing
celly. or cells that store hypothetical data under a name. This name is stored with
the workhooh file
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Scenarios can be sheet-level or book-Ievel. [Jsers can merge scenarios among
different sheets in the same workbook and among multiple workbooks. To merge
scenarios among workbooks, all the workbooks must be open.

When a user merges scenarios. there may be some duplicate names. "Best Case™
and “Worst Case” are common examples, In such instances, Microsoft Excel
appends additional information to the duplicate scenario names. such as creation
date. creator name, or an ordinai number.

Users can protect scenarios by selecting the Prevent Changes and Hide options in
the Add Scenario dialog box. For the protection option to take effect, however,
the user must also activate protection for the sheet,

Cell Formattlng Styles

1)
h

L)

Cell formatting is stored separately from the cell data. as a collection of format
settings that are saved together as a style. Styles can be copied between cefls. -
changed, or deieted, without affecting the data in the cell.

The following table shows the individual format settings determined by stvles.

Setting Determines -

Number Decimal places. separator. inclusion of dollar sign. style for displaving
negative number and other options for formatting different kinds ot
numbers, such as currency, dates fractions, and so on.

Alignment Honzontal, vcmcal text onentation, and whether or not text w raps in (hc -
cell. '

Font Tvpeface, stvle. size. special effects. and color of the text n the ¢zl

Border Placement and style of the border of the ceil.

Pattern Shading and color of the cell.

Protection Whether data in the cell is locked or the formula is hidden. This option

does not take effect until the warksheet is protecied. which the user can
do by cheking Protecuon on the Tools menu.

Styles are saved with the workbook. Users can copy styles from one workbook
to another by ciicking Merge 1n the Style dialog box and then selecung the
workbook they want to merge stvies from. Both the source and destination
workbooks must be - 1. All syvles from the source workbhook are mi€rged into
the destination worke- on. If styles in the destination document have names that
match styles being merged. the user is prompted o choose whether ornot to
overwrite existing stvles in the destination workbook.
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Charts
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All cells in all of the sheets of a new workbook are initially formatted with the
Normal style. Users can change and store the settings for the Normal style. but the
change does not affect any other workbooks unless they merge the new Normal)
style into another workbook or save the workbook with the new Normal styvle'to a
template. If the Normal style has been modified in a user’s autotemplate. the .
default formatting for cells in all new workbooks is the modified Normal style.

Note The default font that the Normal style uses is specified by the Standard Fomt
setting on the General tab in the Options dialog box. This setting is stored in the
Registry key Hkey_Current_ Uscr\Software\Microsoft\Excel\? O\Microsoft Excel.
as the string value for Font. -

Users create charts based on a range of selected cells on a worksheet. Depending
upon which option the user specifies, a chart is stored either on the same  ~
worksheet as the cells it is linKed to. or it exists as an entire sheet within the

" warkbook. Charts are linked dynamically to data on 2 worksheet. This means that

changes to the data are updated in the chart. and changes to a data marker on the
chart are reflected in the linked data cells.

Data markers are the chart symbols (dot, bar, area. slice, and so on)} that represent
a single data point or value originating from a worksheet cell. Users can modity

data markers on the following types of charts only: bar, column, line. stacked. pie.
doughnut. and xy (scatter) charts. Data markers on 3-D charts cannot be modified.

Text on the chart is al<o linked to text in worksheet cells. This text appears as data
lubels. legend entries, and labels for uxis uck-marks, Editing text in the worksheet
cells affects text in the charts that are linked to the cells. Users can also edit text in
charts, but this breaks the link to the cells on the worksheet.

Microsoft Excel stores charts in the workbook file. Charts sheets can be copied
into other workbooks. and charts can be copied and pasted into other workbooks
and tnto other Office applications, such as Word documents  and PowerPoint
presentations.

AutoFormats for Charts

Instead of formatting chart items individually, users can quickly change the look
of 2 chart using AutoFormat. Microsoft Excel stores AutoFormats as charts on
separate chart sheets in a workbook with the reserved filename X15gairy.xis.
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AutoFormats, like cell styizs. are a collection of charactenistics. Each AutoFormat
is based on one of the 14 predefined chart types, and can include a chart subtype.
legend, gridline options, data labels, color settings, patterns. and layout. Microsoft
Excel includes built-in AutoFormats and also allow s users to create custom
AutoFormats by selecting User-Defined and clicking Customize in the
AutoFormat dialog box. '

To create a unified iook. vou can build a library of custom AutoFormats for
workgroups at vour site. For example. you can create a series of AutoFormats
with a consistent layout and color scheme, designed to be integrated into a
PowerPoint presentation. To do this. you create custom AutoFormats in a
workbook. and then save the workbook. When you save this file. your custom
AutoFormats are stored in X15galrv.xls.

To make the custom AutoFormats available to your users, do one of the
following:

*  Copy Xl15galrv.xls to each user’s Xlstart folder.

= =%

Macros

= Rename Xl5galry.xls and_co_p-); the file 1o the alternate startup folder defined

for each user.

Macros store Visual Basic code in workbooks. allowing users to automate .
repetitive or complex tasks. You can create macros for your users. and distnibute
them in the following ways:

As macro sheets When stored within warkbooks. Visual Basic modules are
stored on sheels called macro sheets. Users can copy these sheets into their
own workbools.

As workbooks You can create a workbook of custom macros. where each
Visual Basic module is its own macro sheet. To make the macro sheets
avatlable 10 users at sturtup, store the workbook in the users’ Xlstari or
alternate startup folder. To make the macro sheets automatically available to
users ai startup, name the Hile X15galry.xls and store it in the users™ Xlistart
folder.

As Add-Ins  You can distribute the macros as a standalone. customized version
of Microsoft Excel by saving a2 workbook as an add-in. To automaficuliv open
the add-in for users. copy the file to the users’ Xlstart or alternate startup
folder. ’
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You and your users ¢an secure specific sheets or entire workbooks, according to
how you set Protection options in the Protect Sheet or Protect Workbook dialog
boxes. Security setungs are stored with the workbook file. The enly way 10
change them is to open the workbook file. modify the protection options, then
save the file. - - :

You can also assign passwords at the sheet level or workbook level. Passwords
enable users to bypass sheet or workbook protections.

At the sheet level. the following itemns can be protecied:
« Sheet contents Protects cells on worksheets or on Microsoft Excel 4.0 macro

sheets, as well as items in charts.

« Sheet objects Protects graphic objects on worksheets and charts from being
moved. edited, resized, or deleted.

+ Scenarios Prevents chamges to'the definitions of scenarios on & worksheet.

At the workbook level. the following items can be protected:
« Structure Protects the structure of a workbook so sheets can’t be deleted.
moved. hidden. unhidden. or renamed, and new sheets can't be inserted.

» Windows Protects windows from being moved, resized, hidden. unhidden. or
closed.

Microsoft Excel Data Map

The Microsoft Excel Data Map supplies six map formats for analyzing
geographical data: Value Shading. Category Shading. Dot Density. Graduated
Symbols. Pie Charts. and Column Charts. These formats and their uses are
described i1n the Data Map Help (available only when the Data Map server is
active). The map formats allow users to spot geographical patterns in their data,
and to correlate one data wem, such as sales in a city, to another, such as a city’s
population.

Data Map and OLE'

Data Map consists of an OLE mini-server {meaning that it can only be invoked-
from within an OLE application) and a set of maps for use with the Data Map
senver Usery can insert a Data Map object in any OLE application. in OLE
container applications. such as the Office applications, users can edit the object in
place using OLE visual editing Users can also move or copy Data Map objects
between OLE apphcations using OLE drag and drop.
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Regardless of the location of a Data Map object, data for the map must come from

» . either a Microsoft Excel worksheet or a Microsoft Access database. A user can
b ) create a map in Microsoft Excel and then drag it to a Word document or

- PowerPoint presentation, but doing so breaks the link to the data: To update the
: map in Word or PowerPoint. the user must replace it with an updated copy of the
map. Creating a map in Microsoft Excel and embedding the Microsoft Excel file
in an Office Binder can also break the link to the data.

Data Map Terminology

Term

Refersto -

Example

Map Template

1)
1)
)

Feartures

Data Sel

Geographic dan

The GeoDictionary

A collection of features, such as
political boundaries, cities.
airports, and highways. Some
map templates contain a feature
that consists of points for single
data items, such as postal codes.
These single-point feature sets
are also called centroid maps.

A set of poliucal boundaries or
physical entities. such as cities,
whuch are mn a template.

Cell data that is mapped to a
map tempiate.

Cell data that corresponds to
names of boundanes and other
teatures, such as cities. in a map
template.

All Data Map map files are installed in the

US States map template consists
of the following feutures:

= UL §. state politcal
boundaries

= U S muyyor cittes

« U S. munor cities

"« U.S. airponts

« U S.terstate mghwavs

+  Centroid map for five-digit
ZIP Codes

U. S. state polhiucal bounduries.

Sales bv major U. S. ciies in the
US States map tempiite.

The cell data “AL"™ and "AK™
corresponds o the boundury
names “Alabuamu” and "Alaska,
respectively. in the US States
map template.

\Program Files\Common Files\Microsoft Shared\Datamap\Data folder. Data Map
keeps a data dictionary of all installed maps in the file Geodict.dct. The location
of the geodictionary 1s set and maintained in the Registry in the key
Hkev_local_machine\Sofiware\Microsotth DalaMap\Dlrcclonec as the text value

ior MapData.
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- For Microsoft Excel to have access to a map, the map must be registered in the
geodictionary. Therefore, if a user removes a map file from the disk. the
geodictionary will still refer to the file, and the user will get error messages when

. Microsoft Excel attempts to access the file. Similarly. users cannot add new maps
- simply by adding map files to their disk. Copying map files to the disk does not
register the files in the geodictionary.

To add or remove map files, users must use the Data Installer

(Datainst.exe), a utihity installed with Data Map. usually in the

\Program Files\Common Files\Microsoft Shared\Datamap folder. The Data
Installer provides an easy, graphical way to add and remove map files to and from
the geodictionary. The geodictionary cannot be edited directly by a user. and must
be edited using the Data Installer.

Note Removing a map from the geodictionary does not delete the files from the
user’s disk; you must delete the files manua_lly.

A

About the Map Files

Data Map map files use the same format as Mapinfo® 3.0 files. Each map consists
of four to five files. For example. the World Map consists of the following files:

File  Description

World.dat Binary file. Stores names for all boundaries or points in the map.

World.id Binary file. Stores information about relationships with other maps.

World.ind Binary file. Index vsed for spccdmg access to the .map file. Only used in
lirge maps.

World. map Binary file. Stores latitude and longitade for all points which make up all
boundaries in the map.

World.tab Map descnptor file. used for storing version information. a friendly name
tor the map. and descripuion of the map feature structure.

'How Data Map Works

There are three ways 1o create a Data Map object in Microsoft Excel:

» With a source data range selected
»  Without a range selected, on a blank sheet

+ By copying an existing Data Map object
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When the Data Map object is created, Micrcsoft Excel checks for o source data
range, which is the user’s selection. If Microsoft Excel does not find a source data

‘range, it creates a blank Data Map object. If Microsoft Excel finds a source data

range, it sends the range to Data Map. Data Map takes a sample from each column

- of the source data range and attempts to maich the sample against all installed

map templates.

Each primary map in a template contains a set of labels in the .dat file. These
labels correspond to a set of boundaries (such as “Washington.” “Colorado.” and
so on). In order for the user’s data to be displayed on a map, Data Map must be
able to match geographic data in the user’s selection to labels stored in the .dat
file.

Data Map attempts to match over 80 percent of the geographic data against an
installed map. If this level is attained, Data Map opens the matched map and
begins to plot the data.

In some cases. Data Map can match more than one map. For cxample ‘Germany ™
matches both the World by Country’ and the Europe by Country maps. In such
cases, users are prompted to choose which of the matched maps they wish to use.

If no maps are matched, Data Map disregards the data and prompts the user Lo
choose a map to display.

. If the maiching process takes more than five seconds. Data Map dbons auto-

matching and prompts the user for a map 1o use.

Once a map 1s matched. Data Map displays the map and binds the user’s dat: 10 1.
It is possible that Data Map will not recognize some geographic data, either
because the datais misspe!led or because the user used an untamihar vartanon of
a reglon "s name, such as “Mainland China" instead of *People’s Republic of
China.” Data Map displays all unknown labels one by one to help users tind an
acceptable aliemative. The file Mapstats. xls, stored in the

\Program Files\Common Files\Microsoft Shared\Datamap\Data folder. contains
lists of proper labels for all installed maps, as well as demographic data to
compare with your own dara.

By default, Data Map plots values in the firsi column 1o the right of the
geographic data as 4 Value Shaded format on the map. If Data Map finds multiple
records that pertain , :he same region, the values are aggregated.-These values
are usually added. bui 1t is also possible 1o count and average them.
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. Data-Map can map data on only one template and one map at a time. If 2 user’s

selection has labels for regions in more than one map, Data Map maiches the
greatest amount of geographic data to one map, and reads geographic data that
does not match that map as a mismatch. For example. suppose a user’s selection
inciudes several U. S. states and the country Japan. Data Map maiches the
geographic data to the US by State map, but comes up with a mismaich for the
label Japan. '

Once users have created a Data Map based on a template. they can import data to
other maps in the template. For example, suppose the active template is North
America. This template contains three maps: US States, Canadian Provinces. and
States in Mexico. The user can select geographical data for one of these maps
(US States, for example) to create the North America Data Map object. but then
the user must import data separately for the Canadian Provinces map and for the
States in Mexico map. Data Map cannot map the user’s original selection with
data for multiple maps; it must map them one at a time.

How Microsoft Excel Resolves Conflicts

Conflicts can arise in Microsoft Excel when files of the same name reside in a
user’s startup and alternate startup folders, or when the user interface has been
customized through macros or Visual Basic code. :

Startup and Alternate Startup Folders

Microsoft Excel opens files in a user’s Xlstart folder before opening files in the
alternate startup folder. If there is a file in the alternate startup folder with a name
that matches a file in the user's Xlstart folder. the file in the alternate startup
folder is ignored. For example, if XI5galry.xls exists in both the Xlstart and the
aliernate startup folder. only the custom AutoFormats defined in
\Xlstart\X15galry.xls are available to the user.

Customized Todlbars

There are two ways to create customized toolbars in Microsoft Excel.

» . With the Customize command Toolbars customized with the Customize button
in the Tool'rars dialog box are saved in the file Username.XIb when the user
quits Microsoft Excel. If the user is not logged on, the filename is Excel.xlb

« With a Visual Basic module Toolbars attached to Visual Basic modules are
stored in the workbook file.
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When.a user opens a workbook that has a toolbar attached. the attached Toolbar
definitions are saved to the user's .xlb file. These definitions will exist on the
user’s computer after the user closes or even deletes the workbook. If custom
macros are attached to'the toolbar and the user tries to implement the toolbar atter

_closing or deleting the original workbook. the user will get an error message

stating that Microsoft Excel cannot find the macro. This is because the macro
resides with the workbook where the toolbar originated.If users edit the toolbar,
their changes do not affect the original foolbar stored with the workbook. When
the user reopens the original workbook, Microsoft Excel uses the copyv of the
1oolbar stored in the user’s .xIb file rather than reloading the toolbar stored with
the workbook. To generate the original version of the toolbar, users can delete the
edited copy by selecting it and clicking Delete in the Toolbars dialog box.

For information about modifying Microsoft Excel toolbars with Visual Basic, see
Chapter 9 of the Microsoft Excel/Visual Basic for Windows 95 Progrannner's
Guide. ‘

Custonrizéd Add-Ins e

—

If an add-in's source workbook contains a reference to another add-in—for
instance, a reference to Xlodbc.xla—make sure that when you distribute the
add-ins. the referenced add-in is stored somewhere on the user’s computer where
the calling add-in can find it. You should always store a referenced add-tn in the
folder that contains the calling add-in. When you compile a source workbook to
an add-in. Microsoft Excel stores a hard-coded path to the referenced add-in in the
calling add-in, [f you move the calling add-in to another computer (for example.
when vou distnbute the add-1n to your users) and Microsoft Excel cannot find the
file 1n the hard-coded location, it searches in the following locations. 1n this order:

+ The folder that contatns the catiing add-in
« The System folder in the Windows folder
» The Windows folder

» The path defined by the Path environment setting (1o see the path. type set in
an MS-D0OSs window) )

For information about creating, maintaining, and distributing add-ins, see

Chapter 12 of the Microsoft Excel/Visual Basic for Windows 95 _Programmer's
Cuide. ’ . o
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In This Chapter

CHAPTER 4

PowerPoint architecture consists of three layers: the application, a template, and
the presentation. The application provides the default user interface for creating
presentations: menus. commands, toolbars, and tools. Templates provide a model
for creating new presentations. and contain master slides. Master slides govemn the
default look of every slide in a particular presentation. The presentation file
contains the master information, as well-as the presentation content. including
text, graphics, formatting. multimedia content. and settings such as slide setup and
view sewtings for that particular presentation.

Application Laver 91

Understanding Templates 92
Presentauon Layer 95

How PowerPoint Resolves Conflicts 95

Application Layer

The apphication laver in PowerPoint provides the default settings for users to
creaie presentations. Unlike other Office applications. such as Word and
Microsoft Excel. users cannot modify the PowerPoint application with macros or
Visual Buasic modules.

As in Microsoft Excel. users can customize their toolbar settings. And. as in all
Office applications. users can set preferences in the Options dialog box. These
setings ire stored in the Windows Registry. For information on PowerPoint
entries in the Windows Registry, see Appendix B. “Registry Keys antd Values.”
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Understandlng Templates

The key to understanding PowerPoint architecture is understanding PowerPoint
templates. PowerPoint has two kinds of templales:

. Presemanon templates

» Design temptlates "3"

Presentatlon Templates

h
1)

",

Presentation templates are presentations that serve as a pattern for creating new
presentations. By basing many presentations on a single presentation template.
users can quickly create standard presentations with consistent formatting, graphic
elements. and standard text.

. For example. a standard company presentation template can save users time by

including the company loge. providing a standard slide structure, providing layout
for speakers notes and handaouts, and providing the basic slide design using
standard company colors. fonts, and boilerplate text. With part of the work
already done for them, users simply fill in the specific information.

Presentation templates can provide the following:

= Master elements Text. graphics, and other elements that appear on each slide
of the presentation. These elements inciude standard formatting, such as fonts
and sizes. bullets, styles. slide backgrounds. and page orientation.

+ Boilerplate elements Text. graphics. and other elements such as sound clips.
graphs. or charts embedded onto particular siides (rather than appearing on
each shde) of the presentation.

These templates are available 1o users when they specify Start A New Document
on the Microsoft Office Shortcut Bar, or when they click New on the PowerPoint
File menu. By default, these templates are .pot files stored in
Wisoffice\Templates\Presentations. When users run the AutoContent Wizard. they
are accessing these templates.

Design Templates o .

Design templates contain no textual content and no actual slides. Rather, they
suppty the look of the presentation. They are what is known as Templates in
PowerPoint 4.0 Typueally. design 1emplates control the color scheme. font
selection. bullet stvie. and overall look of the slides in a presentation.
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Design templates consist of master elements only, as defined on the Slide Master
and the Title Master. Users can edit design templates, by opening them directly
and using Slide Maslcr view. Slide and Title masters are discussed later in this
chapter.

‘ - These templates are available to users when they click Apply Design Template on
the Format menu. When applied to existing presentations. the master elements in
the new design témplate replace the master elements in the presentation. Design
templates are .pot files stored in \Msoffice\Tempiates\Presentation Designs.

Templates Applied to Presentations

In PowerPoint, all presentations are based on a template. When a user creates u
new presentation. it initiaity has the characteristics of the selected presentation or
design template. Users can create a new presentation in several ways.

If the user Available templates are
=2 =  Clicks New on the File menu. . --All presentation and design templates in
.in PowerPoint \Msoffice\Templaies folder and subfolders,

Clicks Start A New Document Al Office templates as defined in the User and

on the Office Shortcur Bar Workgroup templates locations for the Oftice Shorteut
Bar. PowerPoint presentation templates are on the
Presentattons tab. Design templates are on the
Presentation Designs tab.

Clicks the New button on the Blank design template. The New dialog box does not
Standard toolbar tn PowerPoint  appear.

The default blank design template is Blank Presentation.pot. which contuins
default setings for layout. font, and ¢olor scheme. Because it is a destgn template
and not a presentation template, it contains no text. only placeholders for text and
graphics.

Users can modify a presentation at any time by applying a different design
template to an open presentation. The Apply Design Template dialog box allows
users (o apply a presentation template or a design template to an open
presentation When users apply a presentation template, it is onlty the master

- - elements that are copied (o the presentation, Any text or graphics in lhe
presentation template are not copied. ) - -

Master Elements

The master elements defined for stides in a presentation are known collectively as
the Shide Master. Users can also define a second type of master, the Title Master,
whose delault settings are a copy of the Slide Master. Design templates are
specialized templates in that they contun andv master elements.

114
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Slide Masters A Slide Master is the main master for a presentation. Users can edit
Slide Masters in master view to control the default placement and style of
elements on every slide of the presentation. When users create their presentation,
however. they can choose which master elements a slide adheres to or deviates
from. and these slides will be exceptions to the master. Slides that are excepuions
to the master are not updated if the user defines a new master or.applies a new
design template |

Title Masters A Title Master is another kind of master that users can define for
their presentations. This allows for two consistent yet independent looks in a
presentation: one for title slides (opening slide, section dividers. and ending slide,
for example). and one for slides that make up the body of the presentation. By
defauit. the characteristics of the Title Master are based on the characterisucs of
the Slide Master, Users can edit these charactenstics by modifying a title-slide in
Title Master view.

‘Note The Blank Presentation.pot design template has only a Slide Master

defined. Users can create acustomized. unique Title Master based on the Slide
Master by clicking New Title Master. All other design templates contain both
Stide and Title masters. ’

Predefined Slide Layouts

When users create a4 new presentation that is based only on a design wemplate,
PowerPoint displays the New Slide dialog box. where users choose an
AutoLayout for the first shde in therr presentation. AutoLavouts are predefined
slide lavouts that users can apply 1o any slide in their presentation The derault
AutoLayout for the first shde 15 the Title Slide layout. as shown in the Iollowing
example.

— Default layout for the first skde of a new
presentation is the Title Slide AutoLayout.

{
i
i
|
i

15
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Throughout a presentation, slides that have the Title Slide AutoLayout applied 1o
them are identified as title slides, and their default characteristics arc those of the
Title Master, which users can modify separately from the Slide Master.

Handout and Notes Masters ~,

Users can also define masters for handouts and for speaker’s notes. Design
templates do not affect the look of Handout and Notes masters. These masters are
stored with the presentation file.

Note The Qutline Master, which was available in PowerPoint 4. has been
removed for PowerPoint 7.0. Printed outlines follow the format of the Handout
Master.

Presentation Layer

= = = The presentation laver is cornparable to the docurnent laver of Word. When users
create a presentation, all the content and settings associated with the presentation
template and design template are copied to the presentation file. For example.
changes to a Slide Master 1n a presentation based on a design template affect the
active presentation only, not the design template file. Presentation files store Slide
and Titde masters, as weil as all content that is an exception to the master slides.
The presentation file also stores Handout Masters and Notes Masters.

PowerPoint stores presentartion files with the file extension .ppt.

How PowerPoint Resolves Conflicts

A slide in a presentation may seem to have many influences converging upon it:
presentation temnplates, design templates, Slide Masters. Title Masters. and layout
that i user has specified for a particular slide. In the case of contlicting settings,
the setting closest 10 the slide takes precedence. For example, if a slide’s Slide
Master i~ formatted with text in the Arial font on a blug background. but the user
specified Times Roman text on a red background for this slide. the user’s
specifications take precedence over the Slide Master. PowerPoint resolves

- " conflicts in the following order:

1. Seutings defined for an individual slide (exceptions 1o the master)

IJ

A shde’s AvtoLavout (shides whose Autolayout is Title Slide adhere to Title
Master settings )

Slwde Master and Tule Master settings

Presentation template

wok

Desuign template

16
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There are two ways PowerPoint creaies a new presentation:

From a design template In this case, PowerPoint copies all information from the
Design Template including Slide and Title master information to the preséntation
file. From that point on, everything that is added to or modified in the presentation
is stored in the presentation file. Changes to the master elements do not affect the
Design Template. : -

From a presentation template In this case, PowerPoint copies all information from
the presentatien template, including text, graphics, and custom layout, as well as
maslers for slides, handouts, and notes, to the new presentation file. All
modifications are stored in the presentation file. Changes to boilerplate text,
master elements, or any other properties of the file do not affect the presentation
template.

Slide Setup Default Settings

£ =% PowerPoint stores settings such as slide sizing and the page oriéntation of slides,
notes, handouts, and outlines with the presentation file. A new presentation based
on this presentation inherits these settings. These settings are the default settings
for the lavout of a presentation. Users specify them by clicking Slide Setup on the
File menu.

Y
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The architecture of Schedule+ is dependent on the existence of a version 1.0
Messaging Application Programming Interface (MAPI 1.0) on the local computer.
MAPI 1.0 is available by installing the Microsoft Exchange client from
Windows 95. If users have MAPI 1.0 installed, they can run Schedule+ in either
stand-alone mode or group-enabled mode. If users do not have MAPI 1.0 inswiled
on their computer, they can run Schedule+ in stand-alone mode only This chapter
—_— provides information on how the components of Schedule+ fit together. explains
the differences between running Schedule+ in stand-alone or group-enabied
mode. and describes how Schedule+ works with the Microsoft Exchange Server,

"
1]
1]
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On the user’s system, Schedule+ consists of the Schedule+ application, the
schedule file, and all the schedule items. At the top of the hierarchy 15 the
Schedule+ application. which manages any number of schedule files. Each
schedule file contains many items, such as appointments, tasks, contacts, and
projects, as shown in the following illustration. In most cases, there is one
schedule file for each user, although users can create multiple schedule files for
themselves if they want.

Schedule+ |
Application

Schedule File

!

Appointments

Tasks

Projects

Contacts

A_Iarms

Events

Roles

OB

Schedule items are like tables that can be further broken down by property. They
all have a structure similar 1o that shown in the following illustration, where
appointment items have properties such as attendees. starting date, starting time,
snd description. und attendee items have properties such as an attendee’s
free/busy status and lasi-received invitation,
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Appointments
“Tabie”

Appointment

Appointment

_Appointment

Appointment

Appointment

L}
h
i

Schedule+ Application

The Schedule+ application consists of the Schedule+ program file Schdpl32.exe
and the Schedule+ DLLs. Additional files types instafled by Setup for running
Schedule+ ure tisted 1n the following table:

File extension

. Appointment ltem .
Attendees | StartDate ]’ StariTime | Description = » =

_ Attendee ftem

_I AttendeeStatus | LastReceived I .- -]

Description

prt
S
-hip
Ao

cig

Print lavout files
Paper format description files
Online Help files

lcon files

Mail forms configuration files
/
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Users can customize Schedule+ default settings by clicking Options on the Tools
menu. These settings are stored in the Windows Registry. For information about
Registry settings for Schedule+, see Appendix B, “Registry Keys'and Values.”
Other ways in which users can customize their Schedule+ application include the
following: ’ ' L :

+ Time and date settings Schedule+ uses time and date settings that are

~ controlled in Windows, under Regional Settings in-the Control Panel. Users
can customize these settings in Schedule+ and can specify a secondary ume
zone 10 use when scheduling meetings across time zones. These custom
settings are stored in the Windows Registry.

« View settings, such as the Tab Gallery or Columns settings Users configure
these settings by using the commands on the View menu. and the settings are
stored in Username.vue, where Usernmame matches the user’s logon name. This
file also contains the list of most recently used schedule files. You cannot edit
this file directly, as it is binary. However, you can rename it, causing
Schedule+ to create a new Username.vue file with default settings the next
time the user starts Schedule+.” .

«  OLE automation The Schedule+ application can be extended with OLE
automation. using an OLE IDispatch interface. For information about
developing software that accesses Schedule+, see the documentation that
comes with the Microsoft Solutions Development Kit or the Microsof
Developer's Network (MSDN). For information about accessing MSDN. see
Appendix F, “Resources.”

Filters for Importing and Exporting Data

The Schedule+ application includes filters for exporting and importing tash,
calendar. and contact information to and from other personal information
managers, such as Lotus Organizer time management software, Sharp 9600
personal digital assistant, and Timex Data Link watch,

The following 1able shows the personal information management systems
supported by Schedule+ filters. Currently, only the Sharp digital assistants are
supported. Filters tor the rest of the personal information managers listed will be
avinlable free of charge through Microsoft support resources. For informatton
abuut these resources. see Appendix F.

In addition to the « :rers listed here, IntelliLink Corporation sup'pl'iés a translator
package that wili oe available with future updates to Schedule+. In the meantime.
vou can call IntefliLink at (603) 888-0666 for information on obtaining the
transiator packzge and the converters it contains,
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Personal Information Manager / File Format

Import/Export

Schedule+ 1.0

ACT! for Windows
ECCO Professional
Lotus Orgamizer

PackRat 4.1+

Windows Accessories

Sharp 9600
HP 951X

Sharp 5000/7000/7200
Sharp 7600/7620

Sharp 8000/8200

Sharp 8600/YQ-610

Timex Data Link Watch

CSV (comma-separated valu¢ file format)

ASCH format

Microsoft Schedule+ 1.x
Windows Cardfile and Calendar

The Text Import/Export Wizard allows information 1o be exchanged with other

- Import

Import -

Impon

tmpont

Impon

Import

Import/Expon
Import/Export
Import/Export
Import/Expont
Impor/Expor
Import/Export
Export

ImporvExport
ImporExporn
Import/Export
[mport/Export

applications using a comma-delimited (CSV) format, a standard method for

transferring text-based information. For example. this provides an easy way to
import contact information into Schedule+ for users who currently store their
contact lists in Microsoft Excel or Microsoft Access.

Users can also insert contact information into Microsoft Word documents by
using the Address Book tool in Word. Word imports the contact information by

readmf’ the Schedule+ contact list using OLE automation. In addition to accessing

address information for a specific Schedule+ contact through the Address Book.

Word can also integrate the entire Schedule+ contact list into a mail merge.

Schedule File

The Schedule file {.scd) contains ail appointments, projects, tasks. alarms. events,
contacts, and roles’for a single user. The first time a user runs Schedule+.
Schedule+ creates a schedule file on the user’s local drive. If the user is running

Schedule+ in group-enabled mode. this file is copied to the user’s server after the
user hus been runming Schedule+ for 15 minutes. By default, Schedule+ accesses
the local file rather than the user’s server file, keeping network traftic to a

minimum.

(%)
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Schedule Items
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Items are stored in the user’s schedule file, as described in the precedlng section.
Schedule itemns are appointments. tasks. projects, contacts, alarms, events. and
roles. '

Appointments Appointments in Schedule+ are activities that occur within a
specific time peried. Users create appointments in the Scheduie+ Appointment
Book. which is visible on the Daily. Weekly, Monthly, or Yearly tab.
Appointments can have reminders attached to them, and they can be made to be
private. lentative, and recurring. A private appointment is hidden to all users
except those to whom a user has granted Owner or Delegate Owner access
permission. A tentative appointment does notl show up as a busy time slot for a
user when others view the user’s schedule in their Planner. In other words. when a
user schedules a tentative appointment for themselves, they can still be considered
free 10 schedule other appointments. A recurrning appointment occurs at regular
intervals. such as 10 AM. every Thursday.

If users are running Schedule+ in group-enabled mode. they can schedule
meetings by inviting others to their appointments. The list of possible atiendees
that appears in the user’'s Meeting Attendees dialog box comes from the user’s
address list 1in the workgroup postoffice. or from the address hst supplied by the
mail server if your worksite 18 runming Microsoft Mail 3.x.

Tasks Tasks are items on a user's To Do list. They can be part of a project, or
thev can stand alone. Users can assign priorities to their tasks. and they can
schedule un end date and a duration for each task -

Projects Projects are groups of tasks. Users can create projects to organize their
tasks. although tasks do not need to be associated with a project. Users can assign
priorities to projects without affecting the priorities assigned to individual tasks
within the projects. Users can designate any project as private. which hides ali
tasks within the project so that only those users granted Owner or Delegate Owner

HCCENS permission can view the tasks,

Contacts Contacts are peaple who users keep track of in a Contact List in their
schedule tile. The Contact List stores information such as addresses. phone
numbers. and user-defined notes. This list is not connected to a user's posioffice
address list. Usess can assign access permissions to allow other users to view or
modify their contact informanion. Contacts designated as private are visible only
1o users granted Owner or Delegate Owner access permission,
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Alarms Alarms are reminders that users can set for appointments and tasks. The
reminder is a message box thal appears at a specitied interval before an
appointment or at the start of an appointed day if the reminder is associated with a
task. Reminders can be accompanied by sound if the user sets this option. The
‘default sound is provided by the file Msremind.wav, but users can use the Control
Panel to change this sound to any .wav file on the system. Users can set reminders
automatically for each new appointment or task by clicking Options on the Tools
menu and then clicking the Defaults tab. They can also set the default reminder
time on the Defaults tab. Users can change reminder settings for individual
appointments and tasks without affecting their default settings.

Events Events are activities or special occasions that occur on a specific day but
do not fill a block of time on a user’s schedule. Examples of events include
birthdays, conferences, and trade shows. Users can designate events as annual if
the event occurs on the same day every year. Events and annual events do not
appear as busy times in the Planner.

.
1]

Roles Roles are predefined combinations of access permissions. Users can assign

roles to members of their workgroup by clicking Set Access Permissions on the

Tools menu. Roles grant access to appointments, contacts, events. and tasks in a

user’s schedule, as shown in the following table.

Role Access permissions

None Cannot read or modify user’s schedule. Question mark appears neat 1o
user’s name in Invite pane of the Schcdu]e+ Planner for free/busy
times.

Reud Can read schedule. except for items designated as private.

Create Can read schedule exceplt for uems designated as private: cun create
new schedule items.

Modify Can read schedule and can modify existing items, except for items
designated as private. )

Delegate Can read schedule and modify existing items, including ifems
destgnated as pnvate. Can send and receive meeting messages on
user's behalf.

Owner Can read schedule and modify existing items. including items

Delegale Owner

Custom

designated as pnivate. Can change access permissions for user’s
schedule. Can send and receive meeting messages on user’s behudf,
Cun read schedule and modify existing items, including items
designated as pnvate. Can change access permissions for user’s
schedule.

User sets read, create, and modify permissions separately for
appouintments, coniacts, events, and tasks,
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When users run Schedule+ in group-enabled mode, Schedule+ creates files on
their workgroup server to allow group scheduling, These files include the user’s

. server schedule file. free/busy file, key file. and server files associated with the,

mail server your worksite uses to support Schedule+.

Server Schedule File Schedule+ creates the user’s server schedule file the first
time it synchronizes the user’s local .scd file with the server. This initial
synchronization creates a copy of the user’s local schedule file in the Cal
subfoider of the folder that contains the user’s postoffice. The name of the file is
hex-1D.scd, where hex-ID is a hexadecimal number that is incremented according
to the last entry in the Schedul2 key file, which is also stored in the Cal folder.

FreefBusy Files Files with the extension .pof contain a user’s free/busy
information. Schedule+ stores these ftles in the Cal folder of the user’s workgroup
postoffice. A single .pof file stores free/busy information for the entire
workgroup. If vour worksite is running Microsoft Mail 3_x with Schedule+, there

will be one .pof file for each postoffice participating in schedule distribution.

These addituonal files contain Free/Busy information for users in other
postoffices. All users in the workgroup postoffice can be invited to meetings,
whether or not they are runnming Schedule+, and regardless of whether they are
running Schedule+ in stand-alone or group-enabled mode. If users are not running
Schedule+ or are running Schedule+ in stand-alone mode, 2 quesuon mark
appears next to the their name in the Invite pane of the Schedule+ Planner view.

Key File Schedule+ creates .key files in the Cal folder of the workgroup
postoffice. These files act as a maps to identify which server schedule file belongs
to which user i the workgroup. These files contain each user’s mailbox name and
an eight-digit hexadecimal 1D that corresponds to the user’s schedule file. Users
running Schedule+ 1.0 store their schedules in .cal files. which are mapped by
Schedule key. Users running Scheduie+ 7.0 store their schedules 1n .sed files,
which arc mapped by Schedul2.key. You can use the utility Dumphey.exc to
display the contents of both .key files.

Mail Server Files Depending on the mail server you are using at your worksite to
support Schedule+. such as Microsoft Mail 3.x, you may need to install and set up
an admimstration program. a schedule distribution program, and other utilities.
For informauon about how 10 set up this software, see the documentation that
comes with your mail server.
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Runnmg Schedule+ in Stand-Alone Mode
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Users can run Schedule+ in stand-alone mode whether or not their system is set

" up with a postoffice. If a user's system is mail enabled — which means ithas a

postoffice—Schedule+ asks the user at startup whether the user wants to work in
group-enabled mode or alone. If a user’s system is not mail enabled, Schedule+
always runs in stand-alone mode.

When users run Schedule+ in stand-alone mode, they can use all the time
management features of Schedule+, create contact lists, and manage projects.
However, they cannot share-any of this information with others in their
workgroup nor can they use Schedule+ to schedule meetings with other peopie.
until they run Schedule+ in group-enabled mode.

The first time users run Schedule+ in stand-alone mode, Schedule+ prompts them
for whether they want to create a new schedule file or to use an existing one. If
users have been working group-enabled, they should use their existing .scd fite
(or .cal file if their schedule filé is in Schedule+ 1.0 format), which is stored in the

‘Msoffice\Schedule folder by default. :

If users choose to create a new schedule file. Schedule+ presents a dialog box for
the user to supply a name and location for the file. The default location is the
\Msoffice\Schedule folder, and the default name is the user’s logon name. If the
user’s system is mail enabled. the default name of the schedule file 1s the name of
the user’s mail profile, as determined by Microsoft Exchange. For more
information about creating new profiles in Microsoft Exchange. see “Profiles” in
the Microsoft Exchange online help.

Running Schedule+ in Group-Enabled Mode

Before a user can run Schedule+, MAPI 1.0 must be available on the local
workstation. Also. the user must have a valid mail account on one of the
following platforms:

+  Windows 95 Workgroup Postoffice This postoffice is included with
Windows 95. It must be accessible by ail users in the workgroup. For more
information about setting up a Windows 95 workgroup postoffice and
configuring the Microsoft Exchange client, see “Using the Microsoft
Exchange Client with Microsoft Mail” in Chapter 26 of the Micrusoft
Windows 95 Resource Kit.

- Microsoft Mail Server Microsoft Mail 3.x supplies a Schedule+ transport that
allows users 1o share schedules and invite one another to meetings across
workgroups. For information about configuring the Microsoft Mail server to
run with Schedule+, see the documentation that comes with your server.
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» Microsoft Exchange Server The Micrgsoft Exchange Server includes MAPI
drivers that extend the capabilities of the Microsoft Exchange client by
providing access to public folders, creating custom forms and shared
documents, scheduling meetings with others, managing tirhe and tasks among

- workgroups, and creating custom electronic forms. For more information
about configuring the Microsoft Exchange Server and setting up public
folders, see the documcntauon that comes with the Microsoft Exchange
Server.

When users run Scheduje+ in group-enabled mode, they can share the following
kinds of information between Schedule+ and other messaging or scheduling
applications:

» Meeting requests When users make an appointmerit and invite others.
Microsoft Exchange provides a form for sending the meeting request through
electronic mail.

- Free/busy information On the Planner tab in Schedule+, a meeting organizer
can add specific people to a list of invitees, and then check their availability
before scheduling 2 meeting. Their busy times show up as colored bars in the
Planner.

« Details If an invitee has given the meeting organizer permission to view the
details of the invitee's schedule, the meeting organizer can use the right mouse
button to click on a busy time for that person and view the details of an
appointment, such as location, purpose of the meeting, and so forth. Delails

_- also include access permissions users can give each other to specific part% of
their schedule, such as contacts or tasks.

The first time users run Schedule+ in group-eﬁablcd mode, Schedule+ creates a
schedule file on the user’s local drive, as described earlier for running Schedule+
in stand-alone mode. At a default interval of 15 minutes, Schedule+ copies the

* user’s local schedule files to the server, in the Cal folder of the ‘user’s workgroup

postoffice folder. Schedule+ synchronizes users’ local and server schedule files at
regular intervals. Users can configure the synchronization interval by clicking
Options on the Tools menu and then clicking the Synchronize tab. Scheduie+ also
synchronizes schedule files when the user quits Schedule+. and when the user
synchromzes the files manually from the Synchronize tab in the Options

dialog box. .

Note If users have been running Schedule+ in stand-alone mode, Schedule+

" synchronizes their local and server schedule files the next time they run

Schedule+ in group-enabled mode.
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During users’ initial Schedule+ session, their free and busy times are not available
on the server until the local schedule file is copied to the server. These users can
still be invited to meetings, because the:r names are in the workgroup s postofﬁce
address book. .

Running Schedule+ in group-enabled mode allows users to set access permissions
on their schedule. allowing certain users to Read, Create, or Modify appointments
and tasks. Users set access permissions by clicking Set Access Permission on the
Tools menu. By granting create permission for appointments, users can open each
other's schedules and create appointments as needed.

You can grant individuals various combinations of permissions based on the
needs at your worksite. For more information about access permissions, see the
Schedule+ online help.

When users invite attendees to their meetings, Schedule+ runs the users’ mail
software automatically. However, when users run Schedule+ in group-enabled
mode, Schedule+ adds a button to the standard toolbar with the Microsoft
Exchange Inbox icon. This button allows users to run Microsoft Exchange
manually from Schedule+, making it easy to correspond with other invutecs after
reading a meeting request.

How Schedule+ Resolves Conflicts

Conflicts can arise in Schedule+ when the local and server schedule files are
being synchronized, when backup server files are created. or during file recovery.

File Synchronization

Schedule+ synchronizes a user’s local and server schedule files by merging
changes from one file 10 the other. Dunng the merge, schedule items are merged
on a propeny by property basis. For example. if the text of an appointment is
modified in one file and the time is modified in the other file, the appointment
will have new text and a new time in the resulung merged file.

- Recovered Files

Duning normal oper: , n. Scheaule+ monitors file read and write ‘operations 10
ensure the user’s date .nlegnly remains intact. Data inlegrity is measured using
two methods.

Checksums Each block of data is validated with a checksum. A checksion is a
caicutated value used 10 test data integrity, If the checksum does not match the
recorded value, the operation fails.



108

Part1 Architecture

Data typing Each data hiack has a specific type. If the data tvpe of the written file
does not match that of the file being read, the operation fails.

If the operation fails on either method, Schedule+ calls an internal recovery
function that seeks to prevent further data loss by rebuilding the data file without
the damaged data. In recover mode, Scheduie+ removes the damaged data and
copies the valid data blocks to a new file.

If the damaged file is the local file and the server file is undamaged. the user can
synchronize with the server.file to merge undamaged data back mto the local file.
Likewise, if the damaged file is the server file, the user can merge the undamaged
local file into the server file. Users can force synchronization by clicking Options
on the Tools menu, clicking the Synchronization tab, and then clicking
Synchronize Now.

When Schedule+ recovers a damaged file, it stores the recovered file in the
user's Temp folder, or if this folder does not exist, in the Windows folder. The
filename is Recoverx.scd, where x is a number from O to 9. If files Recover0.scd
through Recoverd.scd exist on the user’s computer, Schedule+ continues to
overwrite Recover9.scd. -

How Schedule+ Works with Microsoft Exchange Server

Schedule+ works with the Microsoft Exchange client for much of its group
scheduling capabilities:

» Mecung requests and responses appear as custom forms in the Inbox.

«  Meeung attendees are selected from the Microsoft Exchange address hook.

«  Microsoft Exchange and Schedule+ use the same user list, so there is no need
to mainiain two different lists.

W hen combined-with a Microsoft Exchange Server, Schedule+ becomes an even

- more powerful group scheduling platform. In addition to all of the benefits of

using just the Microsott Exchange client:

= Schedule+ adopts the client/server architecture of the Microsoft Exchange
Server. You do not need to add anything to Schedule+: the enhancement to
Schedule+ 15 built into the Microsoft Exchange Server.

« Time zone information is stored on each Microsoft Exchange Server so that
meeting requests from a user in another time zone are booked at the correct
umes for their tine zone, and free/busy information in the planner view is
adjusted for ume zone difierences.

«  Microsoft Exchange Server public folders are used to store free/busy
informanion Because public folders can be replicated among Microsoft
Exchange Servers, this information can easily be shared with others.
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» Schedule+ can be incorporated into any public folder application. such as
customer tracking, using OLE automation.

= No separate administration is required for Schedule+ on a Microsoft Exchange
Server. All of the administrative features of the Microsoft Exchange Server
automatically incorporate Schedule+.

Accessing Personal Schedules

"W
™

Microsoft Exchange stores information in public and private folders. These
folders are kept in an information store on a Microsoft Exchange server. The
information store is made up of two elements: the public information store. where
public folders are located; and the private mformauon store. where private [olders
are iocated,

Microsoft Exchange stores users’ personal schedules in private folders on their
home servers. Each time users change their personal schedules, the Microsoft
Exchange private folder 1s updated to reflect that change. [ndividual users can
delegate access permissions to their personal schedule using the Set Access
Permissions dialog box in Schedule+.

When one user tries 10 access another user’s personal schedule in the sume site.
the following events occur:

«  Schedule+ checks to see that the user has the appropriate access permissions to
view the personal schedule information.

» If the appropriate permissions are in place, Schedule+ connects to the private
information store and logs onto the private folder where personal schedule

intformation 1s stored. -

Accessing Free and Busy Times

Schecule+ free and busy times are stored in a public folder on a Ml(.romtl
Exchange server. The Schedule+ Free Busy Information public folder is a hidden
folder and can be viewed by choosing the Hidden Recipients command trom the
View menu in the Microsoft Exchange Administrator program.

The Schedule+ Free Busy Information public folder is created automatically when
you instatl Microsoft Exchange and configure your tirst site and server. Each time
you create a new Microsoft Exchange mailbox, an entry is created in the
Schedule+ Free Busy Information public falder for the associated account. By
default. each time the users logs in und change the information in their schedule
file. their entry 1n the Schedule+ Free Busy Information public folder is updated
1o reflect the change. Individual users can prohibit the publication of their
free/busy information using the Set Access Permissions dialog box in Schedule+.
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The information in the Schedule+ Free Busy Informution public folder ig
available to all other users within a Microsoft Exchange site. When a user invites
attendees to a meeting the user scheduling, Schedule+ connects to the public
information store on the Microsoft Exchange server that contains the Schedule+
Free Busy information public folder, logs on to the public folder. and accesses all
free/busy information for the attendees.,

Sharing Free/Busy Information Between Sites

]
th

1]

Schedule+ Free Busy Information can be shared between sites, extending group
scheduling functuionality to vour entire organization. Every Microsoft Exchange
public folder is represenied by two entries: a directory entry, which records
conliguration information about the public folder, and an entry in the public
information store, which is where the actual content of the public folder is stored.

Each time you create a new site and initiate site replication between the two xites.
the directory entry for the Scheduie+ Free Busy Information public folder is
automatically replicated 1o the new site. When users in the new site invite users
from the original site to a meeting. Schedule+ detects the directory entry tor the
Schedule+ Free Busy Information pubhic folder. and attempts to connect to the
public information store on the Microsoft Exchange server that contains the
Schedule+ Free Busy information public folder. )
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CHAPTER 6 . .

" Microsoft Word Architecture

.
it

Microsoft Word architecture consists of three layers: the Word upplication. the
document, and the template. Each of these layers affects Word documents i a
different way. The Word application provides the standard Word menus,
commands, and toolbars. Templates serve a dual purpose: they provide a model
for creating new documents and also act as a storage container for styles. macros,
AutoText entries. and custemized Word commands and toolbar settings. The
- - document file contains the text. graphics, formatting. and settings such as murging
and page lavout for that particular document.

3
1)
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In This Chapter Template Laver 112
How Word Resolves Conflicting Settings 118
Where Components Are Stored 119
Managing Styles. AutoText Entries. Macros, and Toolbars 126
Wizards 126 '
Add-ins 127
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Template Layer -

The key to understanding Word archuecture is understanding how the document,
template, and application layers interact. Of the three layers. the template is the
layer that has the greatest impact on both the document and the applicauon layers.
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From;  anne Gabor Genersl Mapager
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Templates can provide the following:

« Customized menus. toolbars. and kevboard assignments that place frequently
used commands on the menus and 1oolbars, remove unused commuands from
menus and toolbars. and provide kev combinations to quickly carry out
commands and macros.

« Macrostour ute Lomnhcalcd and repetitive tasks with a4 single command.

-

- Boilerplate @ .. ld Qmphlus such as your company’s name and logo, in every
document baxcd on that template.

+  Swundard tormatting. such as tonts and sizes. stvles. margin settings, and page
orentanon

« The ability 0 automaucally insert [requently used text and graphics by
including specialized AutoText entries.,

)
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- Impact on Application Layer

Users can customize the Word application with templates. With templates. vou
can adapt Word menus, toolbars. keyboard assignments. and macros to mecet the
" needs of different types of users or for different types of documents.

For example. vou can créate a template for new users that has a toolbar with

" buttons and menus designed to step them through common tasks. More advanced
users., who are familiar with the tasks, don’t need the extra guidance and can use a
template with toolbar buttons that meet their particular needs.

Impact on Document Layer

A template provides a guide or pattern for creating documents. By basing a group,
of documents on a single template. users can quickly create standard documents,
such as letters and memeos, with consistent formatting and standard text.

1.3
L]
i )

For example. a template for mémos can save users time by setting the page

—  margins, inserting the company logo, and providing the text for standard
headings. such as “Memo.” “To.." and "From:.™ With part of the work aiready
done for them, users simply fill tn the addittonal 1ext.

- Template for a memo

World-Wide-lmporiersS ——

InterOffice-Memo T T T Text conigd trom

R s the tempiate
Te- Recipients i - '-'T"_
From~ Sendera - Forrnamng preSet
Datex Avguzt 17

by the temgplate

Subjeert  Th= Jubess
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.

| Témplates Attached to Documents

In Word. all documents are based on a template. When a user creates 4 new
document. it initiallv has the characteristics of the selected template. A user can

)
th

th

creale a new document in several ways.

If the user

Available templates are - -

Clicks New on the File menu in Word

Clicks Start A New Document on the Otfice
Shortcut Bar :

Clicks the New button en the Standard |
toolbur 1in Word

All Word templates and wizards as defined
in the user's User Templates location,
Word templates have the file exten<ion
.dot. Word wizards are specialized
templates with the file extension .wiz.

All Office templates as defined in the User
and Workgroup templates locauons for the
Office Shortcut Bar. Word templates are
on the General. Letters and Faxes. Memos,
Reports. Other Documents. and
Publications tabs.

I
Normal template. The New dialog box
does not appear

Unless users select another template when creanng a new document., Word
defauls to the Normal.dot temptate. In addition to Normal. Word come« with
templates for the most common types of documents, such as letters. memos,
reports. and mailing labels. Users can use the templates as thev are or customize
them o their ow n specifications. Users can also create their own lemplates

In addition 10 basing a new document on a template. users can attach a different
template 10 an open document at any ume by clicking Templates on the File

menu,

Global Templaiés

lrems stored in the Normal template are global—that is, avatlable to all docu-
ments. These items include AutoText entries. macros, menu assignments, toolbar
button assignments. and keyboard assignments. If a document 1s attached to a
template other thun the Normal template. the items stored in that template are

av ailable only 17 documents that are also based on that template. - -
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Document settings and commands specific to only one type of document, such as
a fax sheet. are available onlv to documents based on that template. Other
commands and components, such as AueTaxt entries, that vou want availuble 1o
all documents should be placed in a global template. By using custom and global
templates judiciously. your users have a flexible method for creating documents
that can be highly customized while adhering to company-wide standards of
destgn.
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ltems stored i the Normal template are available to all of your documents ltems stored in any other
template are avaiable only to documents based on that template,

Making Template items Global

Sometimes users may want 1o use a maero. toolbar. or AutoText entrv trom
another template. To make these items available 1o ull vpen documents. yvou cun
make i template global Users cun then use the macros, AutoText entnies. and
custornized command settings found in both the glohal and Normal templatesin
ali their documents, However. styles in the global iemplate are not added 10 vour
users’ dJocuments: Word continues to use the styles from the template on which
the document s based. Customized items in the slobal template are available tor
the remainder of the current Word session.
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Use the Templates command on the File menu to open a template as a global
template.

— Aftaching a-template replaces
the template currently itacnec
to the documenit.

L T I R T T et b 1
{7l Rl Pat CAOPRCESWANWIRD gu.dt

i >

— Customized items from selected templates are available to
all documenis. The templaie attached to each document
does not change.

Making Template Items Global at Startup

You may have special toolbar settings or other items stored in 4 template that you
want to make available to users at any nme they are using Word. For example.
vou may have a special corporate or workgroup temptlate that contains special
macros and AutoText entries that all users may want to use Rather than
duplicating this information in every eopy of the Normal template, you can make
this remplate available globally when a user starts Word.

To load a template globally at startup. make a copy of the template. Store the |
duplicate in the Startup tolder. which is inside the Winword folder (or the folder
mdicated in the Startup-path entry of the Registry key

Hhey _Current_UsenSoftware\MicrosofttWord\7.0\0ptions). Do not simply move
the template from 1ts original folder. Doing so makes the template unavaitable
when a user creates a new document by clicking New on the File menu.

S Storing Templates

/

The Othee Setup program sets default focations for different Kinds of documents
and Word components' user documents, user templates, spelling dictionanes, clip
art. and ~o forth, Users can change these default locations by choosing Opuions on
the Toals menu. For information zbout changing these defaults svstemaucally. see
“Modifying Chient Setup wth the Network Admin Wizard Apphcation™ in
Chapter v :
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Note Changing settings for Lxer Templates and Workgroup Templates mn-Word
changes them for all Office applications. For more information about specifyving
user and workgroup templates, see “Starting a New Document™ in Chapter 1.

_User and Workgroup Templates

Ina workgroup there are usua!ly two places where Word templates are stored:

+ Templates used by only a few users or thal a user may want to customize {such
as Normal, because it's always loaded globally) are usually stored in the user’s
template folder on the user’s local hard disk. The defauit location of these
templates is determined by the User Templates setting.

« Templates needed by an entire workgroup or that users do not need o
customize are typically stored on a network volume. The default locauon of
these templates is determined by the Workgroup Templates setting.

When creating a new document. templates from both the User Templates folder
and the Workgroup Templates folder are listed together in the New dialog box

= =

By default, Word stores user templates in the Template folder. For workgroup
templales. there is no ininial defauit setting. To change the default locaton. click
Options on the Tools menu. and then choose the File Locations tab. Select User
Templates or Workgroup Templates from the File Types list. and click Modify.
Enter or select the new folder for user templates and for workgroup templates.

Normal Template

At startup. Word looks for the Normal tempilate mn the following locations: the
user’'s Template folder, the Winword folder. and the current folder—in that order.
If Word cannot find the Normal template, Word uses the standard document and
command settings that have been preset by Microsoft. AutoText entries, macros,
and conrmand settings the user stored for global use in the Normal template will
not be available until the user retumns the Normal template to one of the defauli
search locations and then restarts Word.

Note When Word is first installed. there s no Normal.dot file. It is constructed
and saved the first tme a vser exits Word.

-
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" How Word Resolves Conflicting Settings

h

[
B

Throughout the discussion of templates, you may have noticed that more than one
template can affect the working environment of a document. Each document has
access to the macros, AutoText entries, and custorn commands and tootbar set-
tings from the attached 1empiate. the Normal template, and any global (emplates.
These templates, as well as add-ins or Word itself. may each define a macro or
setting in some way that differs from the other tempiates or add-ins associated
with a document. The definition or setting that takes precedence is the one that
resides closest to the document. Therefore, Word resolves such conflicts in the
following order of priority:

« Template attached to the active document
« Normal template

+ Additional global templates

»  Add-ins

« Application laver

For example. the style Heading 1 is defined in the Normal 1emplate as At bold.
}8 points. but the document is attached to a template where the style Heading | is
defined as Times Roman bold. 24 points. Word uses the setting in the attached

- template. so Text formatted to the Heading | style is in Times Roman bold.

24 points. .

If several global templates have conflicting settings, Word resolves the con*i:zts
in the order in which they are listed in the Templates And Add-ins dialog box.
Templates in the Startup folder appear at the top of the list and have a hugher
prionty. Subsequent ranking on the list is determined by alphabetic order.

-~ Templates in Startup folder show up first in alphabeticai order.

Add-ins are listed last.

— Global templates follow
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- Where Components Are Stored

The various components of Word, such as styles, macros, default page settings.
AutoText entries. AutoCorrect entries, and custom command settings are s[prLd at
two levels of Word's three-level architecture. Some components reside sinctly at
the document level, others reside at the template level, and still others are siored
with both the document and the template. Of those components that reside at the
template level, some are stored specifically with the Normal or the attached
template, while others can aiso be stored in a global tempiate. The table below
shows how components from each kind of template affect the documnent and what
is contarned in the document file. :

Docum'em Attached Normal Global

Component file template tempiate  templates
Document text and graphics v .
. Boilerplate text and graphics v 4 Vvi:

T Sivtes v v? v

" Default page settings v vl VL
AutoText entries v "4 v
Macros v v v
Custom command and toolbar v v v
seuings
AutoCorrect formatted text enines v

! Copied ta the document when it created,

= Copicd to the document when first created or each time document s opened il the option (o
sutommatically update stvles 1< selected

¥ Apphes only 1o documents attached to the Normal template

+ AH plo o text AuoCorrect entries are stored m the Windows Registry,

Text and Graphics .

When a document is first created. Word copies all information from the attached
template including boilerplate text and graphics to the document file. From that
point on. the text and graphics are saved with the document file. Change in the
boilerplate text and graphics in the template will not atfect documents previously
created with that template,
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Styles

h
]

h

When users create 4 new document. Word copies styles from the template on
which the document is based. No ink between template stvles and documents
styles is made. So. when users change the styles in the document, those changes
are saved with the document file. Likewise if users change styles in the template
after the-document is created. those changes are not automatically retlected in the
document

To automatically update the document styles to match the template. click
Templates on the File menu and select the Automatically Update Document
Stvles check box. Each time a user opens the document, Word copies the stvles in
the attached template to the document.

Styles and AutoFormat

The AutoFormat command analvzes text in a document and apphes styles as
appropriate trom the styvles that have been copied to the document. These
document stvles originally come from the attached template.

If AutoFormat cannot find an appropriate style among those in the document. it
uses the buili-in stvles provided by Word. These built-in styvles allow AuwoFormat
10 format body text. headings. bulleted lists. and other text elements. Users can
customize built-in stvies in their documents by clicking Stvle on the Format menu
and then clicking Modifv. Customizing a built-in stvle tn 2 user’s document has
no effect on the onginal stvle. because the built-in style is copied to the document
by AuteFormar.

The following illustrations show some of the built-in styles you can use 1o format
common text elements.
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1
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Style Gallery

When users apply sivles to teat in a document—either by using the AutoFormat
command of by applving styles themselves—they can use the Stvle Gallery
command on the Format menu to see how the appearance of the document
changes according what template 1s apphed.
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~ Click a template to preview its formatting. Déuble-click to capy the
i selected template stytes 10 your document and close the dialog box.
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-~ Preview your document, an example document. or samples of styles in a template.

By using the Stvle Gallerv. a user may decide to applv a different'template to the
document When a user chooses to use the stvies from another template, Word
copies all stvles from the selected template 1nto.the document. This has the

foliowing effects:
\
+ Astvle from the template that has the same name as a stvle in the document

repluces the style in the document. '
For example. suppose the Heading | stvle 1a the template is defined as
Anal 14-point boid. and the Heading 1 stvle in the document 1s Jefined as
Times | 2-point itahic. Word redefines the Heading | stvie in the document
as Arigl 14-point bold. All paragraphs formatted with the Heading | sivle
are changed to reflect the new stvie definition.

« Template sty les that ure notin the docurnent are added 1o the document.

«  Stvles unigue to the document are not affected.

The Stvle Gallenn command does not attach the selected template 1o the active
document. Rather. 1l copies the stvles from the selected template 1o the active
document The template on which the active document 1s bised remains auached
to the docement To attach a diterent template 10 a document, use the Templates
command on the File menu ‘
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AutoText

_ Users can aiso use the Stvle Gallery to preview their own templates. To create an

example document. they select the text in the template and assign it the predefined
AutoText entry Gallery Example. This predefined AutoText entry is dmp]a\ ed in

e PRVRK s o R Yye Galleny whani & DA s WRS

AutoText entries are stored in templates. In order for dsers to use the AutoText
entry in any Word document. store it in the Normal or other global template. If
vou want 1o make the AutoText entries available only in documents of the same
type as the active document, store therrrin the temptate attached to the acme
document.
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— AutoText entnes are stored in eiher the Normal template
or the template attached to ine active document,

To add or edit AutoText entries in a global template, you must open the template
1n a non-giobal mode. This 15 because global templates cannot be edited To open
a alobal template non-globaliy. you can open it directly (in the File Open dialog
box. select Document Templates in the File Of Type box). or open a document to
which the template 1s attached —not a document to which the template has been
loaded.

To determune whether a template is attached or loaded into a document, click
Tempiales on the File menu. The template whose name appears in the Document
Template box 1s the attached template. and is editable. The template whose name
appears in the Global Templates And Add-ins box ts a loaded template and ts
read-only
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Macros

"
1Y
1

AutoCorrect

1

Word stores macros in templates. When a user creates a new macro, it 1s stored by
default in the Normal template and is available globally. A user can also specity

. which template 2 macro should be attached to.

To store a new macro in a template other than Normal. either the temptate 1tself or
a document atrached to the template must be active when the user creates the
macro. If users want to create a new macro in a global template. they must open
the template itself rather than an attached document. When attached to a
document. global templates are read-only.

« To create a new macro using the Macro dialog box. the user selects the
existing template name in the Macros Available In box and then clicks Create
to open a new macro-editing window,

. To record a new macro, the user selects the existing template name in the

Make Macro Available To box in the Macro Record dialog box. '
Together. macros and ternplates can be used to create a highly customized version
of Word designed to accomplish a particular task or set of tasks. For exumple. o
group of macros and templates could be designed to automate the cresuon of
forms and other documents a company uses. Because the macros are stored in one
or more custom templates. the custom version of Word 1s relattvely simple 10
distribute; it"s just a matter of copving the templates. If the macros are stored in
the Normal template instead. it 1s much more complicated to install the custom
version on another machine. which already has its own Normal templai-

Any AutoCorrect entries that use formatted text, with Formatted Text selected in
the AutoCearrect dialog box. are specific to Word, and are stored in the user’s own
Normal template.

Custom Toolbars, Menus, and Shortcut Keys

By customizing toolbars. menus, and shorticut keys, you can change Word to
betier suit the =—»ds of vour users. For example. you can add frequently used
commands an. ~ alog bdy options Lo toolbars and menus. And you can remove
iems users rareiv use. You can also customize shortcut key assignments by
creating the shoricut heys that work best for vour users.

To customize taolbars. menus, and shericut keys. click Customize on the Tools
menu You can specify whether to store these customizations in the Normal
wemplute. an open template. or the template attached to the active document. To
mahe customized sethings available in any document. save the setines in the
Normal 1iemplate or to a template that will be made global.
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= Select template here.

Page Séfup Default Settings
- Default page settings for the document layout, such as margins. lavout. and paper
size. are sumilar 10 stvles, The default settings are saved with a template. Each
new document based on that template inherits those default settings trom the
template. Subsequent changes to the settings in the document reside with the
docuiment and are pot awomaucally saved 1o the template. However, these
settings can be stored in the template.

To save sewings from the document 1o the attached template, clich Befuaitlt in the
Page Setup dialog bos. The chunges will be retlected in subseqguent documents
created from this template. .

Save settings to the
temptate attachea to
_the active cocument.
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. Managing Styles, AutoText Entries, Macros,
and Toolbars -

Wizards

Users may want to take advantage of stvles. toolbars. macros. or AutoText entnies
that have alreadv been created in another template. They can use the Organizer
dialog box to copi these items between templates. Styles can also be moved
between templates and documents.

any two templates.

‘- You can copy macros between
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Users cun also use the Organizer to delete or rename sivles. AutoText entnies.
macros, or toolburs, To open the Orgamazer, click Temp!dlcs on the File menu and
then chiek Qroamzer.

From a user perspective, o wizard 1s a fast, easy way to creale a document —
because the wizard does the work, Architecturally. wizards are speciahized
templates. They are designated with 4 .wiz extenston instead of a .dot ealension,
and their Type s desenbed as MS Word Wizard rather than MS Ward Template.
The wizards thit come with Word all'share a common user imerface. The key
component of the wizard is the macro or set of macros stored with the lemplate,
These macros automate the creation of the document.
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Add-ins

"
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Word provides wizards to help users create.the following types of documents:
agenda, award, calendar, fax cover sheet, iegal pleading. letter, memo. newsletter,
and resume. Word also includes a wizard 10 help users create tables. You can .
create your own wizards 10 step users through complex tasks specific 1o vour
company. For more information about creating your own wizards, see “Creaiing a
Wizard.” in Chapter 9 of the Microsoft Word Developer's Kir.

Add-ins are programs written in the C programming language. They act like
custom commands or custom features you can use in Word. For more information
about add-ins, see Appendix C in the Microsoft Word Developer's Kir.

You can place add-in commands on toolbars and menus or assign them to shortcut
keys, just as you can with Word macros. Architecturally. add-ins fit in at the
template laver. They medify toolbars. menu commands. and shortcut keve pist

like templates. '

Y ou can write vour own add-ins or obtain themn from software vendors. To use an
add-in, vou must load it into Word. Add-ins are instatled and loaded the same way
global templates are. Like a template. the add-in program remains available until
you quit Word. If you want to load an add-in program automaticalty each e

Word. s iti : .
vou start Word. store it inthe Startup folder. T a
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CHAPTER 38

Installing

i3
1)
)

In This Chapter

Installation

Microsoft Office

This chapter describes the most basic installation process for Microsoft Ottice for
Windows 95. Because there is a lot of flexibility in the instailation process. the
chapter begins with the installation planning process and installation options. and

is followed by specific procedures for you to follow as you install Office.

If vour Office setup needs-to be customnized. the next chapter. “Customirzing
Client Installations,” covers how to alter Office Setup 1o customize the installation
process for vour specific needs.

Installation Planning 157

Client installation from Physical Media 166
Client Installation Over the Network 170
Installation Issues 179

Client Insiallanon Example 187

Planning

Before heginning the process of installing Office on vour users” computers. sou
need to make some decisions aboui the mnstailation and plan the process. There are
a number of options to choose trom in the following main areas,

Decision Description

I. Locauon of OfTice files W here Office files are installed
Lecal hard disk All files are instalied on user’s local hard disk.
Server Files are shared on the network sc"r.\'e'r
Buth Some components are installed localls. and some are

shared 'on the server.

Shared Windows Used with any of the above options, system files are
instilted in a shared Windows eavironment
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Decision Description
2. Installation options Which Office files are installed
Typical Installs coramon Office files.
. Compact Installs mimmum Office files.
Custom ! User selects which Office files to install.
. Run from CD " Leaves some files on CD to save disk space
3. Installation media Where Office files are coming from
Physical media Floppy disks or CD.
Network Central network share.
4. Installation method How the installation is done
Interactive User runs Setup interactively.
Baich Setup runs unatiended.
Push Setup is initiared without user intervention.
s 5. Application-specific - - “Issues that affect what must already be installed. such

installation issues

as a mail system. and what you install for the individual
Office applications.

Some of these decisions affect others. For instance. if client installations are from
phvsical media, then all files must be instaiied locally and the only tnstallation
method available 1s interactive.

Location of Office Files |

When deciding where to place Office files. consider how the client computer will
be used and evaluate the benefits of each placement option. including how each
opuon will affect your ability to support these configurations aver the long run.

*Both Windows and Office have the option of being focul (files arc 1nstalled on the
chent computer’s local hard disk} or being shared (files are located on a network
server and users share those files over the network).

Consider the tollowing as you make this decision:

Performance What is the performance on the client computer when executing
Window or Office sofiware? Executing Windows software and Office
applications locally is generally faster than executing them over the network.

_ Disk space  How much Jocal disk space is available on the client comptjler for

Otfice software” Shanng software from a server reduces the disk space needed
on u chent computer's local hard disk. while it increases the need for disk

space on the server.
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+ Maintenance and support How do you install new software in vour
organization and how are updates 10 Windows or Office software distributed t0:
users? Software on a server can be maintained and updated more easily lh.m
software on client computers.

» Availability Is Windows and Office software available when the user needs i1?
Software installed locally is always available to the user. while software
shared from a server is available only when the network is up and the server is
running.

-

Client computers can be configured to run under any combmauon of these
environments:

Local Windows, Shared Windows, Shared Windows,

local Office shared OfTice partially shared Office!
Performance Best overail Lowest overall Compromtse for Office.

lowest for Window«
Disk space _ .  Highestlocal usage. _Lowest local usage, Split betw een chent and
cT lowest server usage highest server usage servel compulers
Maintenanc® ~~  No central control Simplifies-control for both Simplifies control tor
support complicates task Offtce and Windows Windows
Availability Always as aifabie Depends on both Office Depends on bath Ottice
and Windows servers and Windows servers

I Executables for Office are local. other support files are on the server

Office software can be split between the server and client computers, or betvw. cen
the local hard disk and the CD. providing even more options for distributing disk
space and managing the software.

Windows Installed Locally vs. Shared

This decision 1s made when vou deploy Windows. If Windows 18 installed locaily,

all Windows software is on the client computer’s local hard disk. When Windows
1» shared. vou put the common Windows files on a network server and only user-
specific data files are stored on the tocal hard disk.

Oftice can bhe mstalled under either environment. Some files included with Office
are syslem-level file« and they are installed in the Windows folders. [f Office is
installed in a share: . indow » environment. those files are shared from the
Windows senver anu tite space required by Office on the local hard disk 18
reduced, even it Otfice wself 15 installed locally.

Whether Windows 1s local or shared has a bearing on the amount of available disk
space lor Office as well as overall performance of the chent computer, 1t also has
a beaning on mamtenance and support. as Windows software installed ance on a
central server s casier to control than software installed on each user’s computer.

15t



iy

160

Part 2 instailing Microsoft Office for Windows 95

g ovn

ik
13

1k

 For more information about making this decision for Windows 95. see Chapter 4,
" “Server-Based Setup for Windows 95,” i in the Microsoft Windows 95

Resource Kir.

Using Windows 95 svstem policies-és an alternate way to control the Windows
environment even if the Windows software is installed Jocally on users’
computers. For iriJormation about using Windows 95 system policies to configure
client comnputers from a central location, see “Customizing the User
Environment™ in Chapter 11. )

Office Installed Locally vs. Shared

If Office is installed from floppy disk. the only choice is to install all files localiy
and place them on the client computer’s local hard disk. If Office 1s installed from
CD. the user has the choice of installing all files on the local hard disk or
installing some files locally and leaving the rest on the CD to be accessed as

-needed. This reduces the local disk space needed for Office.

If vou instali Office from a network server, you can leave some or all of the
Office files on the server and put only some of the files on the local hard disk.
This cun be done regardless of whether Windows 1s local or shared.

InstallationTypes

There are several basic installanon types availabte in the Office Setup program
when Setup is run snteractively by the user. You can also create vour own
customized tvpe 1t the Setup program ts to be run in patch mode using a
custamized script.

Typical and Compact For these two types, a predefined set of Office features is
installed The Typical type installs the most commonly used Office components,
w hile the Compact ts pe installs only the minimum files needed to run Office. and
uses the least amount of disk space.

Custom The third tvpe gives the user a bist of all availabie Office components
and the user can select which opuions dre 1nstalled.

Runfrom CO When instalhng from CD. a fourth type is available. which leaves

sonic files on the CD to be accessed directly from there rather than copying them
to the local hard dish.

Uisine the tools avlable on the €D supplied with this book. you can also create a
custonnzed Setup sereptin which vou define the features 1o be nstalled on the
chent computer Setup s run in batch mode using this script. with no interaction
by the user. and the components are tnstalled a< you defined them. For more
informution see Chapter 9. “Customizing Chent Installations.”
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‘Installation Media

Office can be installed on a user’s computer from the floppy disks or €D. or
Office can be placad on a network server and users can install Office irom there.

Fioppy disks Floppy disks do not need special hardware (such as a CD-ROM
drive or nerworking hardware), but they require the installer to be physically
present at the computer during mstallation.

CD The CD contains additional files not avaifable on the floppy disks and a
special CD installation option allows the user to leave some files on'the CD 10
reduce local disk space usage. But a CD requires a CD-ROM drnive and it reyuires
the instalier to be physically present at the computer during installation.

Network Installing over the network simplifies the distribution of Office to users,
and it provides additional options for sharing files among users. But installing
over the nerwork requires network access during installation. und. if file< are
shared. continuous network access while Office is being used.

h
1]
]

An altemative to installing Office directily on client computers from phyvsicul
media is o perform an administrative installation that copies the Office fides on a
network server Users then install Office directly from the server. In thix case. vou
can customize the installation process by modifving the Setup script that users
will be executing on the server.

Instaliation Method

Atter decisions have been made regarding the client conftguration, there are three
methuds that can be used to instull Office on the client computers.

Interactive The interactive method means users run Setup and choosce the
instutlation opuens they want This is the only method that can be used 1 Office ~
wall be installed from physical media.

Batch The batch method involves creating a customized Setup script that pre-
defings all the installation options {ur the user. When Setup is run using the script.
instaliation occurs with no mteraction with the user.

If vou have a custom installer program that vou use in your organization {or
installing software and touls on chent computers. vou may be able to add the
mstallation of Offtce to the installer's list of software. Using the Sctup batch
capability, vou can define a commaund line for Setup that instatly Office wih the
chent options vou've chosen. Lsing Microsoft Mail, vou can create 1 message
with o Window s pachaye object that contains a link 1o the setup batch script. The
seript will'run when the user double-clicks the object in the mail messuge.

th
e
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To completely automate the instaliation process, use batch scnipts with push
installations.

"Push A push installation of Office is an installation that is run on a user’s -

computer without user intervention. You can do this by editing a user’s logon
script to launch the installation process when the user logs on 1o the network. or
by using a tool such as Microsoft Systems Management Server to perform the
installation on remote-user compuiers.

Application-Specific Installation Issues

Some Office applications have special installation requirements that vou need to
consider before completing your overall Office installation plan. If vou intend to
install these applications, this section will help you understand these requirements
betore vou continue with your Office installation.

You need to also read the Ofreadme.txt and Network.txu files included with Office
to be sure vou understand-the latest updalcs and 1ssues associated with installing
and running Office.

Electronic Mail-Enabled Applications

Because Office Setup automates the installation of electronic mail support. you
should install and set up any email client software on user systems beiore
instaliing Otfice. For example. if a user wants to use Word as their email editor.
the Windows Exchange client must be instatled before Office or Word Setup is
run. It Exchange is installed atter Office. Office or Word must be reinstilled.

If users have more than one email client, Setup asks dunng client installation
which ¢lient the Oftice applications should use.

For more information about how 1o install and contigure mail-enabled
applicauons<. inciuding using Word as your email editor, see “lnteroperability
with Electromic Mud” in Chapter 15.

Microsoft Access

- 1t you are using Microvoft Access to ink Paradox data on a network at the same

lime as users ¢ Paradox. vou must be sure 10 define a unique Paradox user pame
in the registey * : ' n

The ParudoxUserName entry is in the Windows registry folder

WHhey _Local_Machina\SoftwarezMicrosoftJet\3. O\Engines\Parados When Setup
dshs the user for a user nume and organization name. Setup puts the user name in
this rezistry hey when Office 18 installed. If the user does not specify a user name
when ashed by Setup. or if Setup 1s run with the /q command line option to run
withoul user interaction but without the /n option to specify a user nume, then
Sertnm nuts the oreanization name 1o this registry key.
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Office Setup.
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There must not be more than one user registered with the same Paradox user name
on the same network, so it is important to specify a unique user name during

Microsoft Schedule+

From the administreior’s point of view, setting up Schedule+ is somewhat
different from setting up other Microsoft Office applications. Most setup and
configuration issues for using Schedule+ in workgroup mode are taken care of as
part of the process of setting up a postoffice that can be accessed by the
Windows 95 Exchange client, or happen automatically when a user logs on 10
Schedule+ in workgroup mode for the first time.

Installation Requirements

Using Schedule+ in workgroup mode requires Windows 93, and the Wmdou 595
Exchange client connected to a MAPI- comphant postoffice. The postoffice ¢un be
one of the following:

«  Windows Messaging System (WMS) workgroup postoffice provided with
Windows 95 or Windows for Workgroups 3.x.

- Workgroup posioffice provided with Windows NT 3.x.
+  Microsoft Mail Server 3.x postoffice.

«  Microsoft Exchange Server postoftice (available afier the release of
Windows 93).

= Anv mail server or messaging service provider for which the vendor his
provided avalid MAPI 1.0 dnver and transpont specification,

Note Schedule+ for Windows 95 runs oniy in stand-alone mode on
Windows NT 3.51. When Microsoft Exchange Server is available. it will
include a Windows NT Exchange client that aliows Schedule+ (o be used 1n
workgroup mode.

To make using-Schedule+ as siraightforward as possible, set up the postoffice and
configure the Exchange client before Schedule+ is started for the first ime. 1f the
Exchange client 1s installed as part of the Windows 95 process but is not vet
connected 1o a valid postoffice. users see the following dialog box when they stan
Schedule+.

[P
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Note This dialog box also appears on workstations where the Microsoft Mail 3.x
client is installed. Because Schedule+ 7.0 requires the Exchange client for
workgroup mode. Schedule+ 7.0 can only be used in stand-alone mode on a
Microsoft Mail client workstation. Users who are working with Schedule+ 7.0 in
stand-alone mode should click No. Work Alone and Don’t Ask-Me This Question
Again before clicking OK.

For more information about the Exchange client setup process. and on how 10
specify a postoffice atier the Exchange client has already been installed. see
Chapter 26. “Electromic Mail and Microsoft Exchange.” in the Micraoson
Windesns 95 Resource Kit.

Using Schedule+ in Stand-Alone Mode

No special intervention by the adnunistrator is required for Schedule+ to he used
in suind-alone mode. The Hirst tme Schedule+ 15 staned. a new schedule {.5ed)
file i» created for the current user in the Windows folder of the local computer.

Using Schedule+ with a Windows 95 Workgroup Postoffice
The recommended steps for setting up Schedule+ for use with the Windows
Messaging System ¢ WMS) postotfice provided with Windows 95 are as follows:

I. Sciup the workgroup postoffice on a computer where all users in the
worheroup will have access.

[

Insall Window s 935 on the user machine and specify the Windows Y3
workgroup postoffice duning the Exchange-client phase of sctup.

For more mformution about how to set up a Windows 95 workgroup postoffice

ard vontigure the Exchange cltent. see “Using the Microsoft Exchunge Client
with Microsoft Maul™ in Chapter 26 ol the Microsaft Windows 95 Resonrce Kit.
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Note Installing Microsoft Exchange on a computer with Schedule+ 1.0 disables
the workgroup functions of Schedule+ 1.0. If Windows 95 is installed using

" interactive setup, and if the Exchange client is on the list of installed options and
Schedule+ 1.0 is present, the user sees a message that Schedule+ 1.0 can no
longer be used in workgroup mode, and asking if they want 10 continue anyway.
The defauit answer is Yes.

The first me a user starts Schedule+, a schedule file is created on the user’s local
computer just as in stand-alone mode. At the next synchronization interval, the
local .scd file is copied to the Cal folder on the workgroup postoffice server.
Synchronization takes place by default every 15 minutes, and also when quitting
Schedule+. The user can also force synchronization o take place by clicking
Synchronize Now on the Synchronize tab in the Options dialog box. .

The fact that a workgroup postoffice user’s schedule file is not copied 1o the
-server until the user logs on for the first time means that that user’s free and busy
*times and schedule details cannot be read until they start Schedute+ at least once.
—— A user whose local schedule file has not yet been copied to the server can sull be
invited to meetings, because their name is present in the postoffice address hook.
However, a question mark displays next to the user's name in the Invite pdm. of

the Schedule+ Planner view.

= %

‘Using Schedule+ with a Microsoft Mail Server

From the client perspective the steps i setting up Schedule+ 7.0 to work with a
Microsoft Mail version 3.x server are the same as those described in the pres us
section.

On the server side, the Schedule+ 1.0 administration program { Adminsch.exe) that
is distnibuted with Microsoft Mail Server can still be used to administer most
postoffice-related Schedule+ functions. The onlvy comands that do not work are
the Adminsch.exe commands for deteung archive information and deleting
inactive Schedule+ schedule files. Schedule+ 7.0 schedule files have a .scd
extension which the Schedule+ 1.0 admin program does not recognize.

-7 Runnming the server clean-up cnmmands ot the 9chedu[e+ I 0
admtinistration progra~ on Schedu1e+ 7.0 schedule files can damaee lhe i‘leq

An update to the Adminsch.exe program that fixes this limitation may be
avaidable at a later date through the Microsoft Product Suppont Quick-Fix
Engineenng tQFE) program,
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Using Schedule+ with Other MAPI Servers

To use Schedule+ for Windows 95 with other MAPI 1.0 mail servers, set up the
postoffice first and then install Windows 95 and the Exchange client. as
recommended above.

For information about how to best configure the MAPI server for use with
Schedule+, see the documentation that comes with your server.

Upgrading to Microsoft Exchange Server

A next-generation client-server messaging system known as Microsoft Exchange
Server will be available from Microsoft after the release of Windows 95.
Microsoft Exchange Server provides advanced electronic mail, scheduling.
groupware applications, and custom application development. Microsoft
Exchange Server includes MAPI drivers that extend the capabilities of the
Windows 95 Microsoft Exchange client. For example, when Microsoft Exchange

. 1s connected to an Exchange Server. you can access a replicated public folder.

create custom forms and shared.documents. schedule meetings with others.
manage time and tasks. and create custom electronic forms for use in business.

Microsoft Exchange Server requires a computer running Windows NT Server
version 3.3} or higher. It also includes a built-in X.400 gateway, plus support for
SMTP and for Microsoft Mail for Intele and Apples Macintoshe computers. For
more tnformation about Microsoft Exchange Server, contact your Microsoft sales
representabive.

Microsoft Word

Nort all conveners are instalied with Word in a Typical or Compact Office
installation. To ensure that vou get the converters you need. install Office using
the Custom instatlation tvpe and select the converters you want. You can reinstall
Office later to add or remove conveners as vour needs change.

For a hist of converters installed with each installation type, see Appendix C, “List
of [nstalled Components.”

Client Installation from Physical Media

If vou have decided to use physical media. either floppy disks or CD. f0 install
Office un each chient computer:

«  The user or whoeser performs the installation must be physically present at the
User’ s COmpUter.
+  Ottiee Nles are instalied on the user's local hard disk or, if installing from CD.

the user can install some components on the local hard disk and access the rest
directly Irom the CD ‘
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« The user chooses what components will be installed and the name of the top-
level folder. '

+ Setup is run interactively.

Chent Installation from Floppy DISkS

»
"

"

To install from floppy disks, you need to either purchase a copy of the product for
each user, or, if you have multiple licenses and a large number of users. vou can
copy the floppy disks to a network file server. Users can then run Setup from the
server. Setup functions the same as if it had been run from the floppy disks except
that it will not prompt the user to insert each floppy disk.

The advantage of copying the floppy disks to a server over creating a normal
administrative installation point is that this method takes less server disk space
because the files are compressed. However, it is much less flexible and provides
little opportunity for customization. For information about creating an
administrative installation point, see “Client Installation Over the Network™ later
in this chapter.

The procedures n this section cover both installing from floppy disk and from the
server.

To install from foppy disks
1. Insert Disk I into the disk drive.

2. In Windows 95 Explorer. switch to drive A, and then double- L]lCl\ Setup. or
click Run on the Start menu and type a:\setup .

In Windows NT. double-click Setup.exe in File Manager or click Run on the
Program Manager File menu and type a:\setup

3. Follow the tnstructions on the screen. H needed. give instructions 1o vour users
about what to do on each screen for your organization. Users can get help
«nile running Setup by pressing F1 or choosing the Help button.

4. Select the installation type: Typical. Compact. or Custom.

For Typacal and Compact. the components installed are predefined. For a list
of files instalied for these two installation types. see AppendixC. "List of
Installed Components.” For the Custom installation type. the user chooses
which of the Office components to install, and, for some components. can also
change the defieult destination folder.

Use the next procedure if vou have multiple licenses and want to copy the disks to
a server so users can install from there. The following example uses an MS-DOS
batch fiie for copying-all the disks to a folder on a file server. You could also
enter the equivalent command hine for Extract.exe in the Run command in the
Windows 95 Start menu or in the Run command in the File menu of Ihe

Windows NT Progrum Manager. :
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To copy floppy disks to a file server

For this example, assume the floppy disk drive is drive A: and the file server-
folder in which you wan{ to copy the Office files is X:\disks.

1. Create a foider on your file server:
mkdir x:\disks

2. Copy all the files from disk I to a subfolder called diskl.

mkdir x:idisks\diskl )
copy a:\*.* x:\disks\diskl

3. Use Extract.exe (which vou copied to X:\disks in step 1) to copy each
subsequent disk to addnional subfolders. To do this, create two baich files:

»  Create X:\disks\copydisk.bat:

echo Insert disk #%1 in drivé A

pause

mkdir x:\disksidiskkl

a:

for X%1 in (*.*) do x:\disks\diskllextract /¢ a:\%%]
- x:\disks\diskgl\Es]

X

Given a disk number in the command line (% 1). this batch file prompts vou
to insent the disk into drive A. creates the corresponding subfolder under
X:\disks. and then copies the cabinet file from the disk to the subiolder.

« Create X:\disks\copvall.bat:

@echo off

call x:\disks\copydisk.bat 2
call x:\disks\copydisk.bat 3
call x:\disks\copydrsk.bat 4

...and so on. for each disk 1 the floppy disk set. This batch file culls the
previous batch fite once for each disk.

- Run X:\disks\copyall.bat and insert each floppy disk as prompted. This
creates a complete set of subfolders under X:\disks for all the disks in the
sel.

4. Make X:\dic . vailable to users of the file server.

Users can now connect 10 the file server in folder X:\disks, run Setup.exe from the
Disk1 subfolder. and proceed as if they were running Setup directly from the
fioppy disk set. Instead of prompting for each floppy disk. Setup goes to each
subfolder of X:\disks to find the next set of files.

For more information about the floppy disk format and the Extract.exe program,
see "Copying Disks and Extracting Files Manually™ later in this chapter.
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Client Installation from CD
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To install from CD, you need to either purchase a copy of the product for each
user, or, if you have multiple licenses, you can copy the CD 10 a server. The
procedures in this section cover both cases.

If vou have a large number of users. and you have a single Office CD with
muitiple licenses, you can share the CD on a network server or you can copy the
files from the CD 1o a server. Users can then run Setup from the server. Setup
functions the same as if it has been run frem the CD except that if you copy the-
files to the server, users will not have the Run From CD instaliation option.

The advantage over creating a normal administrative installation point 1s that ths
method takes less server disk space, because the shared component files are not
duplicated. However, it is less flexible and provides less opportunity for '
customization. For information about creating an administrative installation point,
see “‘Client Installation Over the Network™ later in this chapter.

To install from CD -
1. Insert the Office CD into the dnive.

2. In Windows 95 Explorer. switch to the CD drive. and then double-click Setup,
or chick Run on the Start menu and tyvpe drive:\setup where drive 1s the the
CD-ROM drive letter. .

In Windows NT. double-click Setup.exé in File Manager or click Run on the
Program Manager File menu and type drive:\setup

3. Follow the instructions on the screen. If needed. give instructions (o s our users
about what to do on each screen for vour organtzation. Users can get help
while running Setup by pressing FI or choosing the Help button.

4. Select the instaliation type: Typical, Compact, Custom, or Run From CD.

For Typical and Compact instaliation types. the components installed are
predefined. For a hst of files installed for these two installation tvpes. see
Appendix C, “List of Instatied Components.”

For the Custom 1nstallation type, the user chooses which of the Office
components to install, and, for some components. can also change the default
destination folder.

For the Run From CD installation type. a predefined small set-of components
ts installed on the user’s hard disk while most of the files are left on the CD
and run from there. For a list of which files are installed on the disk and which
are left on the CD. see Appendix C. “List of Installed Components.™

Use the next procedure 1f vou have multiple licenses and want to copy the CD to 2
seTver so users can insiall from there. For this example. assume the CD disk is in
dnve D and the file server folder 10 which you want to copy the Office files 1s
Xo\disks
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* To copy CD contents o a file server
-1. Create a folder on your file server: .

mkdir x:\disks

The server must have enough space to hold the entire contents of the CD. For
Microsoft Office Standard for Windows 95, this is about 95 MB: for Office
Profeqsmnal itis 126 MB.~

Copv all the files from the CD to the x:\disks folder. You can use the MS-DOS
XCOPY command to copy the entire folder hlerarchy

xcopy d:\ c:\disks\ /s /e /v

13

3. Make x:\disks available to users of the file server.

Users can now connect to the file server in folder X:\disks, run Setup.exe. and
proceed as if they were running Setup directly from the CD. Setup detects that
Setup i3 not running from a CD and presents only the Typxcal Compact. and
Custom installation types. =~ 7~

Client Installation Over the Network

If vou have decided to have your users install Office over the network. -vou and
vour users will be involved in a two step process:

1. You must create the administrative insiallation point—the set of folders that
will hold all the Office software, residing on a file server to which users can
connect. )

[ R

Users will perform client installations—running Setup from the administrative
instaliation point 10 insall Office software on their computers.

Creating an admimnstrative nstaliation point is different from just copying files

from the tloppy disks or CD 1o a server. Some or all of the Office component files
can be shared from the administrative installation point reducing the disk space
used on user computers. The shared Office components, such as Spelling Checker
and ChipArt Gallery. can be installed to a different folder or even a different
server to allow for more flexibility in sharing Office components. Also, you can
modify the administrative instaltation point to customize how users install Office.
For details on how to cusiomize an admunistrative installation point, see

Chapter 9. "Customizing Client Installations.™
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While you use Setup.exe to create the administrative installation point, and users
use the same Setup.exe to install Office. it is run'in a different way for each task.

To avoid confus:on in the discussion below, these two modes will be referred to

as follows: ' ' :

« To create the administrative installation poinl, you run Setup.exe from the
physical media with the /a command line option. This is called admintstranve
Setup and is run once to create the administrative installation point.

» To perform a client installation, a user runs Setup.exe from the administrative
installation point without the /a command line option. This is called cliens
Setup and 1s done every time a user wants to install Office on his or her own
computer. :

—

Creatlng the Administrative Installation Point

"
h

L]

There are two steps to creating an administrative installation point. First. vou need
to select the server and prepare it, making sure there is enough disk space and that
it's free from viruses. Second, you install the Office software on the server.

Preparation

The admunistrative installation point contains two primary folders:

» Main Office Folder The first folder is for the main Office application nieq
‘such as Winword.exe and Excel.exe. The default folder name is \Msoffice.

If your users will be sharing these main Office files over the network rather-
than installing them locally, this is the folder they will use to access thuse files.

+ Shared Applications The second folder is for the shared application files, such
as Msspell.dll (Spelling Checker) or Artgalry exe (ClipArt Gallery). The
default folder name is \Msapps. The shared applications are those tools that are
used by more than one Office application. The shared components include:

" Spelling Checker, WordArt. Organizational Chart, Microsoft Graph 5.0, MS
Info. Clip An Gallery. graphics filters, text converters, and Microsofi Excel
sheet converters.

If vour users will be accessing these shared component files over the network
rather than installing them locally, this is the folder they will use to access -
those files. Far more "*‘ormauon about [hlS option, see ""Client Installation™
later in this ¢t = gr. ¢ - :
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When you perform an administrative installation, Setup asks for the location of

_ these two folders. They don't have to be on the same disk or even on the same file

server. But you do need to share these folders on the network so that users have
read access 1o both of them. You can either create a single server share that

contains both {olders. or you can create two separate shares. on one server or even

on separate servers. with one share for each folder. _ .

Later. during client installation, users will access these folders as you have

defined them here: they will connect to the main Office folder to run clhient Setup.

and they will be asked to identify the shared applications folder during Setup.
To prepare the administrative installation point, use the following check list:

c Pick the location of the administrative instaliation point.

g Make sure that there is sufficient 'disk space. Office Standard needs about
125 MB for the administrative installation, Office Professional needs
about 170 MB. ‘

o You need read, write, delete, and create permissions to use these folders
while doing the administrative installation.

At the admunistrative insiallation point, before beginning the installation

procedure:

i3

~ Make sure that all folders are empty. If a previous version of Otfice exists,

delete all of it: move any custom templates vou want to save. .

= All users sharing applications or running shared Windows from this server

must be logged off.

~ Lock all folders to network user access during the adminisirative
mnstallation,

Disabie virus detection software to prevent erroneous virus detection
triggers as Setup writes into vanous executable files.

The computer on which yvou will bé running Setup.exe must be running

Windows 95, Windows NT Workstation 3.51 or later, or Windows NT Server

3.5Y or later.

o Euther before or ufter running administrative Setup, share the tolder that
contains the main Office applications and the folder that contains the shared
applications. Users need read access only to these folders.

environment that vour Office users will be using. During the first client
installation, Sewp wiil place some files. such as shared applicauons, in the
server-based Windows folders for all users to share. You will need write and
create permissions 1o the server-based Windows folders. Subsequent client

installations will not need write access to the shared Windows folders because

the shared applications will aiready be there,
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Installing the Software

After you have the administrative installation point prepared. do the following to
install Office software in those folders.

To create the administrative installation point
1.

tJ

If you are installing from floppy disks, insert Disk 1. If you are instafling from
CD, insertthe CD.

In Windows 93, click Run on the Start menu and then type setup /a

In Windows NT, click Run in the Program Manager or File Manager File
menu and type setup /a

Note Because you must use the /a command line option 1o run Setup in
administrative mode, you have to type the command to start Setup rather than
double-clicking Setup.exe.

When asked. type your organization’s name.

When users install from this installation point. Setup will use the orgamizaton
name vou (vpe here as the orcanization name for each user.

Sewp will next venfy the product number.

If vou are installing from CD. enter the product 1D printed on the CD package.
If vou are installing trom floppy disks. Sewp generates a unigue product 1D
and displays it for you.

Setup will ask for the destination folder for Office. If necessary. change the
tolder name 1o the name of the folder where vou want [hL marn Otfice files to
reside.

Setup will next ask for the destination folder for the shared applications. It
necessary, change the folder name to the name of the folder where vou want
the snared apphication files (o reside.

. Sewp will ask for the server and path for the shared applications folder. Type

the exact path that users will have to type when they connect to it 10 install
Office.

. You can specily whether the shared applications folder is referenced with

drive letter or with a UNC path (UNC stands for Universal Naming - -
Convention and refers to the W\servername\sharéname syntax used lor defining
servers and shared areuas on the server for LAN Manager-compatible
networksy If vou select the Drve Letter option. the dnve letter in the Drive
bux s used tor connecting te the location of the shared files.
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Setup will try to verify the.server by connecting to it as specified If it cunnot
connect, vou'll see an error message. This error can occur for several different

reasons. The following table explains what to do in each case 1o correct the

€ITOT.

Cause

Correction

Misspelled server or share name.

Share not vet created.

You are runming directly on the server and
vou cannot connect o a local share on the
server (many network operating systems
will not allow this).

The UNC path does not work for some
other reuson,

Click Edt and correct the name

Click Continue and remember 10 create
the share before users will need

Click Continue: vou can vernifv the share
later from another computer on the
network. -

Click Continue: be sure to venfv that the
share is accessible betore telling users o
install trom ths server.

8. Setup will ask how shared applications are 10 be installed by the end user,
The option vou choose will determine whether the user can choose how 10
install the shared applications. or whether you make that choice for them.

The options ar:

P

« Server Sh.:. . applications remain on the server and users access them
over the network. Users running client Setup do not get a choice. even if

theyv ure runping Sewp interactvely,

« Local Hard Drive Shared applications are installed on the user’s local hard
dish. Users running client Setup do not get a choice.

- User's Choice Users running client Setup choose between Server and
Local Hard Daive installation options when they run client Setup.

166



Chapter 8 Instailing Microsoft Office 175

Il-r.:lud! D:hn " Sltw g [ ]

i

5

5

B

2]

]

3

”

g

H

8 i o

oy 4

“Hip T Bl B e s
EL «?'"".&;'...m:.”n-" EfrSn Lt

l'&rﬁ: T Ry e SRR e bR ) MM 2 T I T =

9. Setup will check for available disk space on the server and then copy all the
Office files from the f]oppy disks or CD 1o the administrauve installation

point.

Users can now run client Setup from this administrative installation poini and

instail Office on their computers. Based on the responses you provided while

setting up the administrative installauon point, you have customized the

——— installation process: When a user runs client Setup from the administrative
installauon point. Setup will either install Office on the user's local hard disk. or it
will configure the user’s system to run Office remotely from the server. or it mll
give the user the choice of running locally or on the server.

"
th
13

This level of customization is. generally sufficient for many installations. but there
are more elements of the client tnstallation process that you can customize. For g
description of all the wavs you can modify the administrative mstallation point to
customize client installation, see Chapter 9. “Customizing Client Installatron ~

’

Client Installation

Now that vou have created the administrative installation point. users can connect
to that location, run chient Setup. and install Office. This section describes the
client installation process.

In the foliowing installation procedure, client Setup is interactive. which means
the end user answers questions. Client Setup can also be run in a batch mude.
which means the answers to setup questions come from client Setup script files
rather than the user. You customize these scripts 10 provide the appropriate
responses. For informauon about customizing the client Setup process. see
Chapter 9. “Customizing Client Instaliation.”

When a user installs from an admmmistrative installation point, client Sewp needs
' to know where to put the main Office application files and the shared applicaton
files,
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This section describes the client installation process. highlighting the important
decision points, but doesn’t give all the details of the client installation process.

To install on the client computers

1.

I~

ha

Connect to the administrative installation pomt and access the folder
containing the main Office application files.

From this folder..run Setup.exe:

. Setup asks for the user's name and uses the organization name you entered

when you created the administrative installation point.
Setup verifies the product ID.

5. Setup then asks for the destination folder for Office.

The folder specified here can be on the local hard disk or it can be a network
drive to which you have read, write, create, and delete permissions, Even if the
software is not going to be installed locally but will be accessed from the
server, Setup still creates a folder with some user-specific files in 1.

If you chose to allow users to select where shared applications are installed.
the user selects one of the following:

» Server This option leaves the shared application files on the server and
vou run the files over the network.

» Local Hard Drive This option installs shared apphczmon files locally on
vour hard disk.

Whether this option was pre-selected during the creation of the administrative
installation point or the user selects it, Setup does the following:

- [f the option is Server, Setup configures the client svstem to point to the
server share defined during administrative installation (the server locanon
of the shared applications tolder).

.+ If the option 15 Local Hard Drive, Setup asks for a folder name and copies

the shared application files to that folder,

. Setup asks for the installation type. There are four types:

- Typical A predefined subset of components are installed representing the
most commonly used features of Otfice.

+ Compact A predefined subset of components are installed representing the
mimmal set of files that defiver basic Office features.

« Custom The user selects some or all Office compenents to be installed.

«. Run From Network Server The main Office application files are left on the
server and run from the network,

For a complete hist of the options instalied for each installation type. sece
Appendix C. "List of Installed Components.™
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If Compact is seiected. Setup displays the list of Office applications with
check boxes. The user can choose which applications are to be installed by
selting or cleaning the check box for a particular application. The list
consists of:

Office Binder and Shortcut Bar

Microsoft Excel
Microsoft Word
Microsoft PowerPoint

Microsoft Schedule+

Microsoft Access (Office Pro only}

" wew.onive
M grOft e e
M 210t Omanr g
MEror Scfecuss
Jetrg Reudy Buw

ek

ey
12

- 2er

C\WwS08oe” - . e

Soace regmed o T * ml; Rt

Soun svalade o O COTHRK-
. L

169



178 Part2 Installing Microsott Office for Windows 95

The subcomponents installed with each application are predetermined for the
Compact installation typ. and are defined to provide the basic Iuncuum of
Office using a minimum amount of disk space.

If Custom is selected, Setup displays a series of lists so vou can choose which
components to install. The first list contains the main Office components:

- Office Binder & Shortcut Bar .
» Microsoft Excel ’ ’

= Microsoft Word

= Microsoft PowerPoint

«  Microsoft Access (Office Professionat only, not in Office Standard)

« Microsoft Schedule+

« Office Tools

« Conveners, Filters, and Data Access

+ Getting Results Book

U sacrasent Excen
{7 wmciosob wWee
[¥ Mriorot & pwerFoan
\ [F Weesioh Sehegues
N7 Ghece Tool:
[ Convertec- Fier: and(ais Scees: .

7 SemrgFess bow

For each of these components. the user can click Change Option to view the
list of subcomponents within the component. For example, selecung Microsoft
" Word and c.h hang Change Option dn».pl.ws the hst:

. Murosolt Word Progr.nm Files

+ Online Help

- Wizards, Templates. and Letiers
+  Proofing Tools

+  Address'Book
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« Word Mail
» Dialog Editor
« Text Converters

Each of these subcomponents may also have more subcomponents—if o,
Change Option is enabled when the component is selected. The user can
continue 1o wzlk through all the components for Office choostng which ones
to install.

For each component displayed in the list, the check box will be in one of three
stares:

. Checked All subcomponents of this component will be instalied
+ Clear No subcomponents of this component will be installed

» Gray -Some, but not all, of the component’s subcomponents have been
selected to be installed; click Change Option to see and change the selecied
subcomponents. . -

B The Select All button allows the user to select all the components displaved in
the dialog box along with their subcomponents.

For some components. vou can change the foider where that component 1s
installed. If the folder can be changed. the Change Folder button 1s available.

8. If vou are running Windows NT. Setup asks for the Program Group for the
application icons,

Setup checks for available disk space. and starts copying files. It Setup determines
that there is not enough disk space for all the components chosen. vou have two
chorces.

« If you used the Custom installation option. you can specify a different
destinatton folder for somc components to install them on another hard disk.
Even if vou change the folder for every component. Setup will stilt instali
some files in the onginal Office folder vou specified.

« Exit Setup and restart. specifying an Office folder on a different hard disk.

Installation Issues

Thls section describes the format used on the floppy dishs and ho“ to extract files
from the disks if vou need to do so manually. It also describes the product
identification method used by Microsoft: exptains comphance checking. which
veniies that the user has an appropriate older version of Office or competitive
product installed betore mstalhng Office as an upgrude and covers the licensing
ophions avaiable from Microsott,

171



bl

180 Part2 Installing Microsoft Office for Windows 95

Copymg Disks and Extracting Files Manually

"With the exception of the Sctup disk (Disk 1), your Microsoft Office disks use 1
format called DMF (Distribution Media Format). DMF increases the capacuty of a
3,5-inch floppy disk. reducing the number of disks needed to instull your
application and therefore speeding up the instailation process.

Warnm,, Because DMF has been only recently deweloped many existing dl%lx
examination or copying utilities do not recognize DMF and can corrupt the DMF
disk. For more information, see “DMF Disk Issues” Iater in [h:s qccuon

What Is DMF?

Microsoft Office 3.5" floppy disks are created using a recently developed
compression and disk creation technology that reduces the number of tloppy disks
needed to install Office. The three parts to the new technology are Diaumand.

e Quantumn, and DMF.

Diamond A disc lavout tool used by Setup that combines muluple files into u
single cabiner {CAB file) or across multiple cabinets on separute disks.
Extract.exe is the wol used for extracting and decompressing a single tile from a
Diamond cabinet. or for copying Diamond disk images from floppies (o the
network: it cannot put new or changed files back tnto a cabiner. Extract.exe is
descnbed later 1n this section. :

Quantum New compression algorithm used by Diumond.

OMF Dustribution Media Format 1s essentially a method of storing 1.68 MB of
data on a hugh density 3.5" floppy disk. Because DMF reduces the gap between
sectors, there 15 no way to write to a DMF floppy disk using standard disk
copying toels without damaging the floppy disk.

Disk 1 of a DMF disk set is always a normal. 1.44 MB read/write disk so it canlbe
handled using normal disk utilities such as the MS-DOS COPY command.

To create or copy a DMF disk. the DiskWrite utility is used. For Select customers,
DishWnite 15 avarlable on the Select CD. For MOLP customers and corporate
accounts with di~ , :plicaupn rights. DiskWrite is available on.a.fultfillment CD
from Microsoft. C

DMF has no effect on Setup functionality and is used only for stoning software
when put on floppy media.
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DMF Disk Issues : K

Because of the way DMF modifies the disk at the sub-sector level. a DMF disk
cannot be handled in the same way as a standard MS DOS disk. Here are some of
the issues to keep in mind:

» Manv existing utilities such as Norton Disk Doctor. Microsoft ScanDisk.
MS-DOS DiskCopy. and Microsoft Windows Copy Disk do not recognize
DMF. You should not use disk utilities to examine a DMF formarned disk. as
these utilies can corrupt the DMF disk.

®  You cannat copy DMF formatied disks using MS-DOS DiskCopy or Microsoft
Windows Copy Disk. You must use the tool Extract.exe.

= Because the DMF format reduces the gap between sectors on a disk. fow-
quality or older disk drives may have trouble reading the disk.

s Any utility, or computer virus, that writes an MS-DOS type of master boot
record on the disk will render any DMF data on the disk unusable.

.

* *Using Extract.exe

= —The preferred method for placing Office files on a network server from which
users can run chient Setup 1s to create an administrative tnstallavon point, Fou
more informanon, see “Chent [nstallation Over the Network™ earlier in this
chapter. Butif vou need 10 copy the Microsofi Office disks to a network server or
other permanent storage drive. you can use the copy switch (/) with the
Extract.exe unlity on Disk | to copy the Microsott Office installation liles to the
target locantion,

To see a list of and help abourt the Extract command options. type extract /7

For example. after creaung a folder called C:\Disks on your hard disk for the
Microsoit Office files. copy all the files on Disk 1 1o that folder. Because Dish |
does not use DMF. vou can use the standard MS-DOS Copy command. copy
a\*.* c\disks. Switch to drive A and type the following command to copy the rest
of the disks to the tolder C:disk~:

FOR %I I8 (*.=) DO C:A\DISWSAEXTRACT /C A:ARD C:ADISKSAEL

A cabinet (.cabi file include~ many files stored as a singie file. If vou need onlv a
single file that 1s containe.  one ot the cabinet files. you may search for 1t using
the /d switch with Extrac * . After vou find the file. vou can use Extract.exe
again 1o make a copy of the file in the new location.

The file setupant s a dish informanon {ike for Setup that describes the contents of
each disk. For a description of the lormat of this file, see Appendix A, “Setup
Command Line Options and File Format ™
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Product Ident

Here are some examples of how to use the Extract command to find dnd extract
files from a cabinet file. )

To . l . Type this command

List all files in the cabinet file Disk1.cab. extract /d a:\disk1.cab
List all EXE files in Diskl.cab. extract /d a:\disk1.cab *.exe

Extract a file named Any.exe from Diskl.cab  extract a:\Files.cab any.exe
and copy it to the current folder. If the file

spuns more than one disk. Extract.exe will

prompt you to enter the second disk.

Extract Any.exe from Diskl.cab and copy it extract a:\files.cab /1 c:\office any.exe
1o c:\Office. )

ification _.
The product ID for Office is the unigue identifier for each license of Office. The
complete product ID consists of 20 digits and ts handled shghtly differentlv

depending on the media used to install Office.

Floppy Disk

A portion of the product ID is stamped on the floppy disks at manufacturing time
and a portion is generated at the time the software is installed from the floppy

disks. The complete ID is stamped into the Office main executable files on the

user’s hard disk (Winword.exe. Excel.exe, Msaccess.exe. Powerpnt.exe. und
Schdpl32.exe).

If muitiple installations are done from the same set of floppy disks. a differem
product ID 1s generated for each installation and is associated with the license for
that particular installation. Each product ID consists of a common root (the first
13 diguts) that were stamped on the floppy disk at manufacturing time. This
¢ommon root identifies each installation as coming from the same floppy disk set.

When installing from floppy disks. Setup keeps track of the number of different
installations performed from the same floppy disk set and displays a warning if
the legal number of installations is exceeded. Selecting Remove All from Setup
will not decrement the 1nstallaton counter. If yvou hold multiple licenses. vou can
use a command hine « ~tion for Setup to specify the number of licenses you have,
For more informatic * =out this option, see Appendix A, * Setup Command Line
Options and File Formar.™

174



Chapter 8 Installing Microsoft Office 183

CD

CDs aren’t stamped at manufacturing time as floppy disks are. so a portion of the
product ID is printed on the CD package: the user running Setup will be asked to
enter that portion manually during the installation process. The 1D is stamped into
the Office main executable files on the user's hard disk ((Winword.exe. -
Excel.exe. Msaccess.exe, Powerpnt.exe. and Schdpl32.exe).

Select CD

When installing Office from a Select CD (from the Select customer program). the
user is not prompted to enter any product ID information. A portion of the 1D 15
stamped on the CD and includes the product code and-a Select ID. The remainder
of the total product ID is generated at the time the software is installed and 1<
unique for each instaliation. Multiple client installations of Office from a single
Select CD have a common root in the product ID thart identifies each installation
as coming from the same Select CD.

Network

Every instailation done from the administrative installation point is given
umque. 20-digit product [D with a comnron root {the tirst 15 digits), The 1D is
stamped into the Office main executable files on the user’s hard disk
{Winword.exe. Excel.exe, Msaccess.exe. Powerpnt.exe. und Schdpi32.exe:

Compliance Checking‘

Microsoft Office for Windows 95 is available as an upgrade for those who have a
previous version of Office, or for those who ure moving to Office from a
competttive product. If vou purchase Microsoft Oftice for Windows 93 as an
upgrade, client Setup performs a compliance check 1o verify that the uparade 1s
being installed in accordunce with the upgrade agreement. It venfies that vou
have un appropriate older version or competitive product installed before 1
proceeds with the upgrade installaton.,

The verificauion procedure is performed according to a'table defined bv Microsoft
for each specific upgrade and that may vary for cach application. for each version,
and for each language depending on international competittve markets, The table
consists of a defined hst of products and product versions that satsfy the
cumphance check. along with a signature for cach product that defines how Setup
can tell if the product 1y instalied, -
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The signature can consist'of one or more of the following items:

s Product files, including a filename, size. and folders to search. The signature
can indicate whether to search one or more default folders only. orte search
the entire disk.

= INI file entries. including an .ini filename. key, and value. ' .

= Registry entries key and value.

Al the beginning of the client installation process, Setup works through this table,
examining the client computer for indications that at least one of the products on
the list is installed. The first product it finds satisfies the search and Setup -
proceeds with the installation. If the table instructs Setup to search the entire disk,
Setup display 4 message to this effect and lists the products it is looking for,

If no products are found from the list, Setup stops and give the user a chance to
insert the installation floppy disk for a complying product so that it can be
verified. If the user doesn’t have such a disk. Setup ends and does not install the
upgrade. In some cases, the compliance checking table for an upgrade may
specify that Setup can continue without finding a compliant product. in which

-case Setup displays a warning and then continues with the upgrade. This depends

on how Microsoft defined the compliance checking rules for a specific product
upgrade. N

The following list shows the products that are searched for by the imtial release of
the upgrade version of Microsoft Office for Windows 95, US version.

Presentation Graphics

Aldus Persuasion v 2.oxand 3.0 for Windows
Harvard Graphics 1 0. 2.0. and 3 0 for Windows
Harvard Graphies 2 3 and 3 0 tor DOS

Lotas Freelance 1x and 2.x for Windows
Lotus Freelance 4 0 for DOS

PowerPoint 4.0 or garher '

WordPerfect Presentations 2 O and 3.0 for Windows

WaordPertect Presentations 2.0 for DOS

Word Processors

Amu Pro FOO O 10,1 1B, 1.2, 2.0.30. 3,01, and 3.1 for Windows
Dpiay Wte for DOS 10,01, 20, and 2.1

First Chenee tor DOS 101

Lecacy tor Windows 1 0

Lotus Manuse lor DOS 1.0
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Word Processors (continued)
Lotus Manusc for DOS 2.1

. Mass 11 6C
.Multimalc 1.0 and 4.0

Mulumate for DOS 1.0. 3.3.3.6, and 4.0

Prof Write+ for Windows 1.0

ProfWrite for DOS 1.0

Q&A forDOS 1.0

Samna Word for DOS IV

Sprint for Windows 1.01

Volks W III for DOS 1.0

Word for Dos 2.0, 3.0, 4.0, 5.0. 5.5, and 6.0
Word for Windows 1.0, 1.1, 2.0c, 6.0, and 6.0c
WordPerfect 5.1. 6.0. 6.0A. and 6.1 for Windows
WordPerfect* 4.0, 4.1, 4.2. 5.1. and 5.2 DOS
Wordstar .0, 1.5. and 2.0 for Windows
Wordstar 2000 for DOS 3.0.3.5. and 6.0
Wordstar for DOS 1.0, 1.5, 5.3, 6.0, 7.0. and 7.0 Upgrade
Wordstar Pro for DOS 1.0 and 4.0

XyWntelll+ for DOS 3.06,3.52. and 3.36

Spreadsheets

Lotus 1-2-3 for Windows [.0. 4.0, 4.01. and 5.1

Lotus for DOS 1-2-3 201,22, 2.3, 3.1, and 4.0 Upgrade. 3.4 and 3 4A
Microsoft Excel 30.4.0.40a, 50, 50a. and 5 0c

Multipian alt versions

Quattro Profor DOS 1 0. 2.0.30.4.0. and 5 0

Quattro Pro for Windows 1 0,5 0}, and 6.0

Quattro Pro Special Ed 10

Supercalc tor DOS 3 1. 3.2.4. 5.1, and 5.5B

Databases

Alpha Five

Approach for Windows 2 |

Clipper 5.01

Chpper 502¢.502b, 5.02a_and 3 02
Clipper 5§ 2 DOS
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Databases (continued)

Dateease 1.1. 4.5, and 4.53 Exec

Dbase 1.0, 1.1, and 1.5 ’

dBASE 50 DOS

dBASE 5.0 WIN

Dbase IV 2.0

FileMaker Pro 2.0 and 2.1 WIN

FoxPro 2.0 DOS

FoxPro 2.5, 2.52, 2.5b, and 2.6 DOS

FoxPro 2.5. 2.5a. 2.5b. and 2.6 WIN

FoxPro 2.6 WIN

Microsoft Access 1.0, 1.1, and 2.0

Microsoft Office Std (all Windows versions including Office 95 Std)
* Paradox 1.0.3.0.3.5. and 3.5 Update. 4.0 and 4.5

Paradox 5.0 DOS

Paradox 3.0 WIN

Powerbwilder 3.0

Q&A 2.0and 3.0 DOS
- Q&A 4.0 Win (Checking for Q&A or QAWrite)

R:Base 2.11.3.0. 3. 1. and 4.0

R:Buse 31,4.0,4.3, and 4.5+

Superbase for Windows < 1.3

Superbased 1.2and 1 3 WIN

"
09
"

Suites

Boriand OtTice

Microsott Qffice (all Windows versions}
Microsott Works (41 Windows versions:
Pertect Office

Sman Suie

Comtact Microsoft F: ..duct Suppon for additional hélp with specific upgrading
S1TUANIGNS.
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Licensing

Each user must have a Microsoft Office license, no matter how your users install
Office. One license is provided with each retail-package of Microsoft Office.

If vou don't want to purchase a complete copy of Office for every user. you can
purchase a License Pak. Each License Pak allows you to make and use one
additional copy of Office. You don't need to store extra copleﬂ of Office or the
documentation, and it's less expensive than purchasing a retail package. For
quantities of 13 licenses or more, ask your reseller about the Microsoit Open.
Vanable, and Enterprise licensing options. -

Client Installation Example.

"
L
L]

The following example demonsirates how an administrator can prepare and
perform a basic installation of Office. For this example. no customization ts
needed. If you need to customize setup, see Chapter 9, “"Customizing Clen:
Installations.™

Corporation 1 is a mid-sized publishing firm that has just purchased licenses to
upgrade their {00 users 1o Windows 95 and Office for Windows 95, The users are
well-trained and usually install their own software. although the internal support

_ group can assist them if needed. The administrator belieyves that all the machines

have sufficient hard disk space. Users have had training on the features of Office
for Windows 95 and understand the features of Office enough 1o know what
components they should nstall. As the software was ‘purchased through @ volume
license agreement. each user does not have a copy of Office disk. und the
adminisirator wants to avold the time and cost of distributing physical media.

The administrator decides (o create an administrative installation point on o
centra’ nle server. and then the users can run the Office Setup program from
there.

Steps for Installation
+ Install Otfice for Windows 95 on the server using administrative Setup

« Inform the users that Office 1s available for installation. and sel a deadlme for
the upgrade.

+ Distnbute installation instructions to users including the path to the
agministrative 1nstallation poent

»  Confirm that users completed the installation process
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CHAPTER 12

* Support and Troubleshooting

This chapter covers issues for the Office applications that will help vou support
your users. [t also includes information about customizing templates in Oftice so
vour users can follow the standards that exist in your organization for creating
documents. \ ‘ :

Also in this chapter is informatjon about porting | 6-bit Office-based solutions to
32-bi,

In This Cha;;ie_r Supporung Microsoft Office 309

Supporting Microsott Excel 320

Supporting Microsoft PowerPoint 230

Supporting Microsoft Schedule+ 349

Supporting Microsoft Word 351

Registry Settings and .[ni Files 3539

Long Filenames 360

Puriing Your 16-Bit Office-Based Solutions to 32-Bit Otfice 360

Frequently Asked Questions 377

= <%

Supporting Microsoft Office

This section inciudes information for supporting and customizing templates for
vour organization, creaung shortcuts on the Office Shorteut Bar to aceess the
Acrosoti Network, and supporung Ofhice Binders.
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~ Supporting Custom Templates
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‘Office 95 has several features that make it easy to create files based on templates.

When a user clicks the Start A New Document bution on the Office Shortcut Bar -
or clicks New on the File menu in any Office application. the New-dialog box is

‘displaved. This dialog box has tabs listing templates available for the application.

or in the case of the Office Shortcut Bar. for all documents. When the user selects
a template. a new document is created with the attributes of the template. When

the user subsequently saves this document, the user is prompted to name it. and

the template remains intact.
You can customize the templates presented in several ways. You can:

» (reate templates customized for vour site and add them to any of the 1ab< in
the New dialog box,

» Add tabs to the dialog box to help users find the customized templates.

s Use shortcuts to add templates stored on network shares to the dialog box. If
vou have a set of shared templates used within 2 workgroup. you can designate
a workgroup template location for inclusion in the New dialog box.

The following sections explain how to add templates to the New dialog bow and

customize this dialog box to help users {ind the templates they need

Adding Custom Templates

To add a template 10 the New dialog box. copy it to the appropriate subfolder of
the Templutes folder within the Office folder. Templates added directis to the
Templates folder are listed on the General tab 1n the New dialog box. The General
1ab 15 usually reserved for blank documents.

Otfice creates the following tabs for the New dialog bux by default:

Letters & Fyxes - Other Documents Presentation Designs
Memos . Spreadsheet Solutions Binders

Reports Presentations Databases
Publications

Whenever possible vou should add vour templates to one of these categories, The
Other Documé:its tab £ provided as a locauon for miscellaneous templates,

To add 4 template stored in another folder or on a network share, create a shortcut
o the emplate in the Templates folder. For more information about creating
shortcuts, see the Windows 93 documentation or online help.
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If you want to list the template on one of the othcr tabs in the New dialog box.
copy it to the subfolder of the Templates foider :%.at has the same nanie as the lab
you want. For instance, you can copy a memo template used in your comp.m\ to
the Memos folder. so that it-appears on the Memos tab. :

You can create special- purpose templates that run programs other than the Office-
applications by setting up entries in the Windows registry. For lnformanon about
creating these enines, see “Template Settings in the Windows Regstry™ |
Appendix B, "Registry Kevs and Values.”

Adding Tabs to the New Dialog Box

In most cases. using the existing tabs is sufficient, but vou can add tubs to the
New dialog box 1t vou need them to identify and organize vour templates.

To add a tab to the dizlog box, create a subfolder in the Templates folder. Give
the subfolder the name you want shown on the tab. Then copy your templates 10
the subfolder.

* * For a subfolder to be available a5 a tab in the dialog box. it must contain at feast

— —one template. When a user clicks New on the File menu from an application. the
New dialog box displays a tab for each subfolder of the Templates folder thu
contamns at least one template tor that application. Clicking the Start A New
Document button from the Office Shorrcut Bar displays tabs for all subflders thar
contain at least one template tor any Office application.

If the folder that vou want to be uvailable as a tab is on a network share or other
folder. create a shorteut to the folder within the Templates tolder.

Note Only folders and tolder shortcuts directly under the Temiplates tolder appear
ds tabs. Templates stored in <ubfolders all appear on the same tab as the parens
folder. For example. if vou create a folder named Company Forms within the
Templates folder. and Company Forms has subtolders that contain templates. all
of these templates appeur on the Company Forms tab in the New dlog bo.

Setting the Workgroup Templates Location

In addition to the Templates tolder. vou can specify an additional folder locuvion
for shared templates used  -hin a workgroup Templates 1n this folder and 11
subfolders become tczns © 1abs i the New diatog box. along with the iempiates
and folders on the user’s lucal hard disk. Subfoiders with the same name in both
locations are merged: for example. it both the locul Templaes foider and the
Workgroup Templates folaer huve subtolders named Memos, all of the 1emplates
in both sublolders appear on the Memos tab in the New dialog box. Templates
stored directly in the Workgroup Templates tolder appear on the General tab in
the New dialog bov.
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Local templates overmide templates in the Workgroup Templates location. If a
template file has the samt name in both locations, the New dialog box presents
the file from the user’s local disk instead of the workgroup.version.

» To set the Workgroup Templates location )
1. Using the right mouse button. click the Office Shortcut Bar. and then chek

Customize.
Click the Settings tab.”
Under [tem, select Workgroup Templates location, and then click Modify.

v

Type the path 10 the network share designated for shared templates. or click
Browse to search for the share.

5. Click OK.

Note The setting for the User Tempiates location is required. Do not delete this
setting when vou add a Workgroup Templates location.

=z £ £

Using the Office Shortcut Bar with Microsoft Network
Shortcut Files g

Users who create shortcuts to Microsoft Network forums on the deskiop cannot
add these.shortcuts to the MSN toolbar by dragging and dropping. Links to MSN
forums are .mcc files. but dragging them onto the 1oolbar creates a .ink tile, which
does not appear on the MSN menu in the user’s applications.

Instead. have the user copv the .mcc file 1o the MSN oolbar folder. The default
location for this tolder is Office\Shortcut BarMSN wathin the Office installation
folder. For information about registry settings affecting toolbars and their
locations, see "Office Shortcut Bar Settings in the Windows Registry ™ in
Appendix B. '

Supporting Office Binders

Office binders provide a means of combining different tvpes of documents into a
single storage umit. Documents in a binder preserve their order, open and save
“together, print together. and are stored as a single file. Each document becomes a
section of the binder and can be manipulated using the original application via
OLE in-place editing. If needed. a binder can be broken apart into separate
documents.

Binders allow users 1o pnnt the collection of documents, in sequence. with
consecutive page numbers. as long as headers or footers are set in each document
o print page numbers and the initial page number is not reset within an individual
document -
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Users create new binders from the Office Shortcut Bar or by using the New
Binder command on the File menu. Users add sections to binders by dragging and
dropping documents from the file system or by using the commands on the
Segtion menu. The Binder menus provide commands to reorder rename: and
delete sections.

Office Binder includes templates to help you assemble common sets of business
documents such as chent billings, proposals. and presentations. These templates
are stored in the Binders folder of the Template folder.

Note If you have previously installed a Beta copy of Office 95. such as the Otiice
Preview Program. make sure that you and all your users completely remove the
earfy copy of Office and then install Office 95 before vou create or use Oftice
Binders,

The following sections provide information to heip the admimstrator support
users of Office Binders. . .

* " Required Files
" The following DLLs and other files .\uppon‘the Office Binder capability

Filename Location Purpose

Docoby.dli Windows rolder\System Provides document object capahiliy
Explode dlt Office folden\Office Provides unbind capability
Bdreg.dll Windews foldeASysiem Supports binder registration

Msobs, Window s folder\Svysiem

Binder Documents, Templates, and Wizards

Binders use the following file extensions:

Extensinn File tyvpe

obd Binder document

.obt Btnder template

obz Binder Wizard. o binder template that includes macros

There is no difference in file format among the three file types above: only the
extensions and icons are ditferent to mndicate how the files are used. A binder file
with the obt extension uses the binder templale icon: files with the .obz extension
have the Binder Wizard 1con

184-



34

Part3 Maintaining and Supporting Microsoft Office

1)
T
h

To create a template from a binder document. users can save the binder as a
template using the Save As command on the File menu. or just rename the file to
change the extension from .obd to .obt. To create a new binder based on a
template, use the New Bindgr command on the File menu. Saving the binder does
not overwrite the template. To edit the template itself. you must use the Open
commiand en the File menu in Office Binder. '

You can crezie binder templates based on séts of documents in use in vour
organization. You can add vour own templates 1o the files installed on vsers’
compuiers by editing the setup scripts vour orgdnization uses. For informauion
about custom setup scripts. see Chapter 9, “Customizing Client Installations.™

Use a wizard to tell users how to use a template or provide information they'll
need to complete the project.

To create a wizard for an Office Binder template

I. Write macros that gather information from. or give information to. users of the
template. Set up the macros to run whenever the templarte is opened.

135

Save the macros.

3. Place the document containing the macros in a binder document by dragging
its 1con mto the binder. and then click the icon in the binder to make it the
aclive document.

4. Save the binder document as a template.

Note You can edit macros only in the original document before vou place it in the
binder. Create, debug, and test vour macros first. and then assemble the hinder.
The mucros run when the document contaning them is opened.

Binder Templates in the Office Value Pack

It vour svstem uses Ad paper size. you can tahe advantage of a sel of hinder
templates designed to use vour paper smize. Run the Setup program lor the Office
Value Pack tonstall these templates.

Editing Binder Sections

Usersedita docus tina tinder by clicking its icon on the lett side of the
Binder window,. ~ © sindertnen activates the application originally used to create
the document. Because the documents in the binder are OLE objects contained in
the hinder frame. the appheation menus are combined with the Binder menus. The
Binder File menu replaces thie appheation File menu, and the applcation fife-
hased commands are not avalfable. Other commands that would normally appear
on the apphicaton File menu appear on the Section menu.
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In most Office applications. the Help menu includes the selections froni both the
Binder Help menu and the application Help menu,

Users who prefer to edit a document in its own window, similar to OLE [.0-stvle
object editing. can use the View Outside command on the Sectton menu. Using
View Outside provides the usual menus for the application. without the tunder
selections.

Binder Security

No password protection is available for binders. When a document that is
password protected is added to a binder, the binder prompts for the password.
However. after the document becames a binder section. the password protection
is lost,

To protect a binder from changes. you can place it on a read-oniy network shure,
Users can open and view the binder on the read-only share, but cannot make
changes to it or its sections. -

Binder-Compatible Applications

For an application to produce documents that can be included in binders. the
application must implement the Microsaft document objects interfuces mn addinon
to OLE 2.0 Currently Word 7.0, Microsoft Excel 7.0. and PowerPont 7.0)
documents can be included in binders.

Developers of third-party applications who want to create documents that can be
placed in binders must do three things: N

«  They must pantic:pate 1n the Office-compatbie program. For more mtormainm
about this program, contact Microsott Customer Support.

= They implement OLE 2.0 in-pluce editing.

= They must support the required document objects interfaces.

For files that don’t support document objects und OLE 2.0. drag and drop.
insertion as a secton. and dropping the document icon on a binder file 1n the
Windows Explorers are nol possible.

Unbinding into Separate Files ‘

Users can break a binder up into its component document files using the Unbind
command on the shoricut menu. This command creales a separate file for each
hinder section. using the section name as the filename. The files are copies of the
sections and are stored in e same folder as the binder. The original bindet
remains intict : )

Note The Unbind command is not avalable under Microsoft Windows NT.
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Users can also save a copy of an individual binder section in a separate tile using
the Save As File command’on the Section menu.

Using Office Binder to Slmpllfy Collaboratlng
on Documents

Briefcase. a file synchronization program mc]uded with Windows 95, can
transform Office Binder into a mulu-user authoring tool. By using Briefcase and
Office Binder together. different users can work on different sections in & hinder
while keeping the other sections current.

To use a binder with the Briefcase
1. Place a binder file on the network where others can access it.

2. lInstruct those using the binder to copy it to their local Briefcase. Each person
can then open the copy of the binder in his or her Briefcase and work on
individual sections. For more information about Briefcase. see Windows
online Help. '

3. Each person working on the binder can update his or her copy by cliching
Update All on the Briefcase menu. This command copies the individual’s
work to the binder on the network. and copies any changes in the network
copy of the binder 1o thut person’s personal Briefcase.

Note This command 1s not available under Microsoft Windows NT

Normally, Brietcase s installed only with laptop configurations of Windows 95,

To install Briefcase .

. In the Control Panel. click Add/Remove Programs.

2 Chick the Windows Sewp tah.

3., Inthe Components box. chek Accessories and then click Details.

4. In the Components box. chck Brietcase.

You cun also edit vour organizaton’s setup seript tor Windows 95 1o include
Briclease ax part of all instaliations. For details, see the Microsoft Windows 95
Resonree Kt

Briefcase Reconcilers Keep Files Synchronized

The Briefease allows for reconciliation of the original file and the file 10 the
Bricteuse. updating either ke with the most recent version. While the standard -
seconatitanen handler for Windows 93 Joes this on a file basis. the Office Binder
reconciler updates al the sectton lesel
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The binder reconctler examines the time stamps on the corresponding sections of
the two binders and determines when each was edited. The options possible are:

Section that changed Reconciliation

Neither None. :

Section in the Briefease Section in the Briefease is copied over the section in the
-original file. i

Section n the origin tile Secuon in the onginal file 1s copied over the one in the
Bricicase,

Both sections Reconciler for the applicanon used to ereate the sechon s

used to merge changes between both sections. If no
reconciler is avanlable for that applicanen. the user i~
promptzd e make the decision

Currently, Microsoft Access 7.0 1« the only Office application that provides its
own Brietcase reconciler support. Office-compatible third party apphcations may
provide reconctliation handlers; see the documentation for your upplication fu
information, St

Troubleshooting Binder Problems

The following sections provide information to heip the admnistrator solve
problems that users of Office Binders mayv encounter :

Problems with Printing

Users can print a whole binder, an individual binder secuion. or a group ot
sections. The application that created each section does the prining for the
section. The binder dispaiches each section in sequence. passing control to the
originating application for each section and receiving control back as each section
fimishes prinuing. The result 15 a single print job.

The Print Binder dialog bos. displaved by the Print command on the File menu.
fets users make print settings that apply to the entire hinder. In some cases the
origrnating application for o section can override these sethings For exampleif a
Word document resets pare numberine to puge 1. that section starts printing at
page | recardless of the starung page number tor the binder. The onginating
applicaton controls pave lavout. including orientation. margins, headers. and
footers. For page numbers to print. the user must melude them on the page o the
ongimating applicaion

Print preview is not avadable tor binders or individuy] sections.
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Possible Cause

Solution

Possible Cause

Solution

Possible Cause

Solution

Possible Cause

Solution

The following are solutions for common printing problems.

Binder too large to print )

Being collections of documents, binder files can grow quite large. Because a
binder is printed as a single print job. it can become too targe for the print
spooling system.

If a binder is too large to print in one job. print it in sections. Use the Selected
Section{s) option in the Print Binder dialog box to print smaller groups of
sections, or use the Print command on the Section menu to print one section at a
time. Consecutive page numbering should be correct, provided the binder 1s
correctly set up to print with consecutive page numbers.

Page numbers don’t print

Page numbers are not enabled tor each section in the application that created the
document.

In each section. make sure that page numbers are in place in the header or foaler.
For cxample. if the section is a Microsoft Excel workbook. the user cun use the
Page Setup command on the Section menu to add a header or footer that includes
the page number.

Wrong page numbers print

When the user selects consecutive page numbering. the binder passes the siart
page number to the application for the first section. When the section 1 fimshed
printing. 1t passes the number of pages printed and the last page number printed
back to the binder The binder passes the next page number 10 the applicat;~n for
the next section. and conninues dispatching unul all sections are printed.

If the user resets the page numbenng exphcitly in the originating applicauon, the
binder uses that page number instead of the number passed from the preceding
section. For example, 1f vou reset the first page in 2 Word document to page 1, the
brnder does not override this setting.

To locate a section that 1s resetting puge numbering. you can print each section
individually in sequence. using the Poimt command on the Section menu, and see
how cach secuon 1» numbered.

Problems with E- 1il . _ e
Becuuse binder fue « otten grow quite large, sending them through electronic mail
may nol be feasible, depending on the limitatons of your maul system,

Consider alternative ways to distnbute a large binder file: place it on a network
share. post it 1o a public folder, or use the Unbind command on the shortcut menu
to place the sections in separate fites that vou can mail or distribute individually,
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Controiling File Size

Binders that contain many document files can easilv become guite large. To
maintain the best possible performance for large binder files, users should use the
Save As command from time (o time to save the binder as a new file. and delete
the old binder file. Doing so defragments the binder file and can reduce its size.

Problems with Linked Objecté

Binders do not support external OLE links. You can embed but not link
documents in binders. You can. however, create links between two sections of the
same binder. '

Problems Opening a Binder File or Section

If you are having problems opening a Binder tile or section. load the binder. then
unbind it wto separate liles using the Unbind command on the shoricut menu. 1f
that doesn’t work. open the individual files. It vou identify a problem section.
delete that section from the binder.

Problems with Macros Stored in a Section

Users can record and run macros in individual sections by using the macro
language for the ongmnating applicatton. Users cannot, however. edit macros that
are stored within the sections while the document is in the-binder. To edit o
macro. save the section to a file using the Save Ag File command on the Section
menu. Edil the macros in the file. and then reincorporate it into the binder.

Problems with Spell Checking
Spell cheching accoss an entire binder is not provided. To spell cheeh a binder.
activate und spell check each sectuon individually.,

Commands Unavailable on Windows NT Systems

With the Windows NT 3.1 shell. the Unbind commauand 15 not available. and the
Briefcase reconciler for binders 1 not avaifable hecause Windows NT does not
include the Briefcase teature. As an alternative to the Unbind command. users
can use the Save As File commuand on the Section menu to save cach section out
to a fike.
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Possible Causes

Solution

This seciion describes common problems you or your users may encounter with
Microsoft Excel 7.0.

File is locked when you save or close a shared file

* The file you are saving or closing is open in Microsoft Quick View. Quick -
View is an application that ships with Microsoft Windows 95 that vou can use
to view a document without opening it in the application that was used to
create the document. When a non-shared file is open in Microsoft Excel. vou
cannot open the same file in Microsoft Quick View, because the file is locked
by Microsoft Excel. However, when a shared file is open in Microsott Excel.
the file is not locked (to allow for sharing} and can be viewed in Microsoft
QuickView,

= You opened a shared fite in Microsoft Excel, and then set the file attributes 1o
read-only while the file is still open.

To avoid recerving an error message that the file 1s locked when you save or close
a shared file in Microsoft Excel. vou must close the file in QuickView

Open command without SHIFT opens template for editing

When vou open a template file (.xIt). the file is opened tor editing. even if vou do
not hold down the SHIFT key. This behawvior is different from earlier versions of
Microsoft Excel. In earher versions of Microsoft Eacel. when you open a template
file without holding down SHIFT. a copy of the template was opened. rather than
the template file itself. This change in Microsoft Excel 7.0 is consistent with the-
way templates act in Microsoft Word. ’

To create 1 new worksheet. chart. macro. or workbook file based on a template
file in Microsoft Excei 7.0. do the following:

1. On the File menu, chek New.,

2. Click either the General wb or the Spreadsheet Solutions tab.

*ad

. Clich the template file.

Issuing the Shared Lists command results in an error message

The error message "Can't access read-only document filename.xis™ appears when
vou chek the Shared Lists command on the File menu. The Shared Lists dialog
box does not open. und vou cannot show the Conflict History in the file when yvou
chick Shared Lists on the File menu.
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The file is open as read-only and you cannot change the status of the Mult-User
Editing feature. When you change the status of the Multi-User Editing feature 1n'a
file. Microsoft Excel requires that you then save the file. When a file is open as
read-only, vou cannot display the Shared Lists dialog box.

Although you cannot display the Shared Lists dialog box in a read-only file. vou
can display the Conflict History by running the following procedure 1n a Visual
Basic module:

Sub Conflict_History()

' In the following commands, replace BOOK1.XLS

with the name ,of the f1le that 15 open read-only

Workbooks{"BOOK1.XLS") Activate

Workbooks("BOGK1.XLS").ShowConflictHistory = True
End Sub

+

The Conflict History is a worksheet that contains information—such as Date,
Time, Cell Location. and Value—about conflicting cells in the workbook,
Conflict history is created when more than one person edits the same file, To
display the Conflict History. do the following (the file must be open with read-
write protection}):

1. On the File menu. click Shared Lists.
2. Click the Editing tab.

3. Select the Show Conflict History check box. A Conflict History worksheet is
inserted in your workbook with the information about the conflicting cells on
the worksheet.

Save As Type box contains only the Exce! Workbook option

You selected the Allow Mulu-User Editing check box in a workbook that has not
been saved or is saved in a file format other than Microsoft Excel workbook. This
is bv design, as you cannot share a file in Microsoft Excel unless it 1s saved in the
Microsoft Excel workbook file format. Additionaliv. you cannot save a [ile in
Microsoft Excel to a file format other than Microsoft Excel workbook and still
maintain the Allow Multi-User Editing feature.

Save the file as a Micr-oft Excel workbook file.
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Save As dialog box saves the file without multi-user editing

When you save a file that has the multi-user editing feature turned on, this feature
may not be turned on in the saved {ile. This occurs when vou use the Save A
command on the File menu 10 save the file, and vou change either the iitle format
or the filename. Il you change the file format. the multu-user ediung feature is not
turmed on in the new file, because you can only share a Microsoft Excel
Workbook file. If you change only the lilename. the muiu-user editing feature 15
not turned on in the new fite. This behavior is by design. because normally. when
vou save a shared file. vou do so to make your own local copy. Therefore. the
multi-user editing feature 15 not saved to the new copy of the file.

Saving a shared workbook causes unexpected results

You see the Conflict Resolution dialog box when you save a shared workbook
and the mouse pointer changes to an hourglass; when this happens. Microsoft
Excel may or may not appear to have stopped running.

Changes vou made to the shuared file conflict with the changes saved in the same
file by another user. When a conflict occurs, the Conflict Resolution dialog box
appears. asking how vou want to resolve the conflicts. If vou click the Use All
Remaiming Changes From My Session button or the Use All Remaining Changes
From The Other Session hutton, the conflicts are resolved without prompting vou
for each conflicting cell. If there are many changes to resolve. this process cun
take o long time. perhaps as long us a few minutes. If you choose one of the Use
All Remaining Changes buttons, there is no indication that Microsoft Excel is
processing any changes while the conflicts are being resolved It you press
CTRL-ALT-DELETE (o display the Close Program dialog box. the text "Nui
responding” follows Microsoft Exeel in the list of programs.

Switch to another application in Windows while Microsoft Excel resolves the
contlicts in the workbook. Windaws 95 allows vou to work in another application
while vour original application is processing 1n the background.

The Save As dialog box does not replace an existing file if it is currently
open by another user

When you save a shared workbook using the Save As command, yvou get o
message that the tilename already exists and vou are asked whether vou want to
replace the exisung file. If vou use the Save As method in a Visual Basic for
applicanons procedure 1o save a shared workbook, you see a message asking if
vou want [0 replace the exisung file,
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This behavior occurs as expected when you save a file to the same location and
with the same name as an existing file. However. when vou are editing a shared
file. this message ts misleading because another user may be cditing the file. In
this case. if you answer Yex to replace the existing file, vou are not truly replacing
the file. You are still prompted with the Conflict Resolution dialog bov 1{'a
change you made conflicts with a change saved in the workbook by another user.
The Save As dialog box does not replace an existing tile if it 1y currently open by
another user.

When vou use a Visuval Basic for applications procedure to save a shared
workbook. you must use the Save As command if vou want 1o use the Conflict
Resolution argument to determtne whose changes ta accept in case ot a conthet
When vou use the Save command instead of the Save As commund. you cannot
use command arguments to specity information about the workbook, such as any
of the following: the filename, whose chunges Lo accept in case of a conllict,
whether to save the file exclusively, and so on.

* Chick Yes in the dialog box asking if vou want to replace the ¢xisting file. This
method saves the file the same way it does if vou click Save on the File menu.
The Conflict Resolution dialog hox will still appear if there s a contlict with'a
change vou made to the workbook,

* If vou are not using a Visual Basic procedure to save the shared workbook.
click Save on the File menu. instead of Save As. to avod receiving this
message when vou save a shared workbook.

In Microsoft Excel. when vou share a workbook, vou may make a change 1o the
workbook that conflicts with a chunge that another user has made to the
workbook The conthicting change appears 1n the Contlict Resolution diatog box.
and also appeurs on the Conthet History worksheet box when @ conflict occurs. A
conflict occurs when vou enter data in a cell that has already been used When this
occurs. the Contlict Resolunon dialog box appears and notilles vou that you made
a change that confhets with o chunge made by another user who has sdready saved
the workbook. The 1vpe of change that causes the Conflict Resolution dialog box
to appear 1~ displuved in the Your Changes On Sheet box and the Contlicting
Chunges By bow in the Conthiet Resolution dialog box, and in the Change column

con the Centlict History worksheet, The tollowing list shows the Lhd]]Lc‘ tvpe

values that can appear in these locations -

= Cell Change
»  Sheel Rename

= Runge Move

-u Sort Cells
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Commands and features unavailable in a shared workbook

When vou use the shared histy feature. some of the commands and features, that
vou normally use in your workbook are not available. This behavior is by demign.
because ot the way that a shared file s saved. For exampie, you cannot change
cell formatting in a shared workbook. The following tnformation describes the
features and commands that are not available while vou are editing a shared
workbook.

The following table contains the menu commands that are unavailable (dimmed)
in a shared workbook:

Menu Command
File Properties
Edn . Delete Sheet
. Links b
E -
Object

Insert Worksheet

' Chart {submenu items dimmed}
Macro (submenu items dimmed)
Function '
Name (submenu items dimmed)
Picture
Map
Ohpect

Format Cells
AwoFormat
Stvle

Tools Scenaros

Protection (submenu items dimmed)

Duta Subtotals
’ . Sle . N

<toup And Quihine (submenu items dimmed)

PrvorTubles

You cannot use any ol the buttons on the Formatting. Forms. Drawing. and Chart
toalbars 1n a shared workbook.

On the Standurd Toolbar, the AutoSum. Function Wizard. ChartWizard. Map, and

LIPS T i PRI AU A IR T |
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Formulas When you enter a formula on a worksheet in a shared workbuok. vou
receive a4 message that new or qopied formulas won’t be saved while the e i
being shared. You can tum this message off 1o prevent it from repeating on the
current compulter far the current session.

Objects You cannot select any objects on a worksheet in a shared workbook.
including OLE objects. drawing objects, and dialog box conrols.

Visual Basic Modules You cannot edit Visual Basic for applicatons modules in
shared mode: however you can run a macro on a module sheet in a shared
workbook. If you record a new macro in u shared workbook, the macro 1s
recorded in a new workbook. In the Record New Macro dialog hov. the New
Workbook opuon is selected by defaull. This Workbook option 1s unavailable m o
shared workbook.

Chart Sheet or Dialog Sheet Atlthough vou can select a chart sheet or dulog sheet
in a shared workbook, you cannot select any of the items on the chart or custom
dialog box.

Macro Sheet You can select a macro sheet in a shared workbook, However,
because commands on a macre sheet generally begin wath an equal sign (=) s
when vou enter a formula). vou recerve an error message  You can tun a macro
from a mucro sheet in a shared workhook, :

Unable to insert a cell not in a shared workbook

You cannot insert a cell note in a worksheet when the workbook yvou are using as
shared, When yvou use the shured hists teature. the Note commuand on the Insent
menu 1s avatlable and yvou can enter text tn the Text Note box in the Cell Notwe
dialog box. However. this text is not saved in a cell note. and the error message
that a cell cannot be inserted appears. Clicking OK closes both the error message
and the Ceil Note dialog box without saving the entered text.

New sort order in Microsoft Excel 7.0

[n Microsott Excel 7.0 und Microsatt Excel 5.0 for Windows NT (32 bin. the
order used for sorting 1~ difterent fromt that used for Micrasott Excel 5.0 [
Windows and the Mac: = sh (16 bt This occurs because Windows 95 and
Windows NT use a s © Jer disterent from the Microsolt Windows version 3¢
operating svstem. The uitferences 1t sorting ure described in the following
SeCLions,
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Special Characters The following table displays the differences in the sort order

- of special characters.

Microsoft Excel 7.0 ) Min‘:rosoft Excel 5.0 for Windows

Microsoft Excel 5,0 for NT and the Macintosh
- "
!

#
5 %
G &
& {
{ }

)
+

?
@ =
\ »
. @
_ \
+ A
= ; -

Extended Characters When vou sort extended characters {used. for example. in
intz:national versions) in Microsoft Excel 5.0 for Windows NT or Microsoft
Excel 7.0. the international characters are sorted as US English alphabetic
characters. In Microsoft Excel 3.0 for Windows or the Macintosh. extended
characters are sorted before alphabenc characters. The following table displays
some of these differences.

. Resuit in Microsoft Excel 7.0 Result in Micr95_0fl Excel 5.0 for
List and 5.0 for NT Windows or the Macintosh

Al. b Al'b Al:e*

Aler Al A2:b

Alf AT A3 f

s loswercase ¢ wath the Umiaet characrer tALT+0235)
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Result in Microsoft Excel 7.0 Result in Microsoft Excel 5.0 for
List and 5.0 for NT Windows or the Macintosh
Al:a Al:a - Al A= '
A g A2 a¥* AQ; gxxx
Al e Al b Al:a
Adfy gn¥x Ad- e Ad:b
AS:b AS, ex*s AS:e

** [.owercase @ with the Caret character {ALT+0226)
**x { owercase ¢ with the Caret character {ALT+0234) )

Case Sensitive When you select the Case Sensitive check box in the Sort Oplions
dialog box (Ascending order, Top To Bottom), in Microsoft Excel 5.0 tor
Windows NT and Microsoft Excel 7.0, vour list is sorted with the lowercase
entries at the top of the Iist. Under the same conditions in Microsoft Excel 3.0 for
- ==Windows, the list is sorted with the uppercase entries at the top of the list. The
following table displays some of the differences.

Result in Microsoft Excel 7.0 Result in Microsoft Excel 3.4
List and 5.0 for NT for Windows or Macintosh
Al A Al:a AL A
Al AAA Al A AZia
Alia Al AAA A AAA
Af Add Al:add Al ADD
A2, ADd A2 Add A2, ADd
A3 ADD A3 ADd A3: Add
A4 add Ad, ADD Ad: add

DataMap objects do not automatically update

DataMap is a new OLE object included with Microsoft Excel 7.0 that allows a
ceographical representauon of data Unlike other objects. such as charts. DataMap
objects do not automatically update when assocrated data is changed, due to the
potentially prohibitive amount of time required to update DalaMap objécte
associated with large amounts of data.
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Solutions

Possible Cause,

Solution

Solution

» Manually update by activating the object and clicking the Update bution.

* Programmatically update through a Visual Basic for applications procedure.
The following example outlines a Microsoft Excel Visual Basic for
apphications macro that updates a DataMap object on a worksheet,

Sub Update_DataMap_Object()

‘Assign DataMap Object Name to a Varieble

MapName = "Picture 1"

"Update lataMap Object

ActiveSheet . QLEObjects(MapName).Object.Refreshmap
End Sub .

You receive the error message “A column of data in your selection must
contain geographical data” when creating a DataMap object based on
ZIP Codes

A column of non-formatted zip codes is selected and you insert a DataMap object.

-Format the numeric postal codes (zip codes) with the special ZIP Code number

format. This format 15 designed to prevent the possible misinterpretation of
numeric data as ZIP Codes.

DataMap Objects Are Programmatically Limited

The only Visual Basic command available for DataMap Objects is the
RefreshMap command. This command updates a DataMap Object on a
worksheet, The following example iliustrates the use of the RefreshMap
command:

ActiveSheet . .QLEObjects("Picture 1").0bject.

You receive the error message “You must seiect celis from the workbook
workbook name” when using the Template Wizard

When vou use the Template Wizard 10 create a template. if the name of the
workbook from which you create the template contains an apostrophe character
('). vou receive this error message. In Microsoft Excel. the apostrophe character is
reserved for use in references. This problem does not occur if the name of the
template or the do* ~ase that vou create using the Template Wizard contains an
apostrophe charu. © Howeler. as a general rule. to avoid problems with hnking,
vou should not use the apostrophe character in a workbook or worksheet name in
Microsoft Excel

Rename vour workbook to a name that does not contain an apostrophe, and then
use the Template Wizard to create a template from this file.
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Possibl'e Cause

Solution

Possible Cause

Array formulas return #NUM error value

You are using an array greater than 5458 elements in a function. The maximum
array size is 5458 elements (approximately 75 rows by 75 columns) in Microsoft
Excel 7.0. In Microsoft Excel 3.0. 4.0, and 5.0, the maximum 15 6533 elemenis. In
Microsoft Excel 7.0, the maximum array size is still 64K. as it is in earher
versions of Microsoft Excel. However, because Microsoft Excel 7.0%is a 32-bit
application and uses 12-byte data types (instead of 10-bvte dat types found m
the 16-bit versions of Microsoft Excel), the maximum array size in Microsofl
Excel 7.0 holds fewer elements than the earlier versions of Microsoft Excel. The
following is a list of some of the functions 1n Microsoft Exce!l that use arravs:

= LINEST()
= MDETERM()

» MINVERSE()

s MMULT()

= SUMPRODUCT()
« TRANSPOSE(Q)
* TREND()

Recalculate vour function with a smaller array.

Microsoft Excel 5.0 file size larger after saving in Microsoft Excel 7.0

[f you open and save a file in Microsoft Excel 7.0 that you created in Microsofi
Excel 5.0. the file size increases by 4 to 6K. Even though Microsoft Excel 7.0
uses the same file format as Microsoft Excel 3.0, this occurs because of un
optinuzation in Microsoft Excel 7.0 that allows Microsoft Excel to sive files
faster than in the previous version, When vou create and save a file in Microsoft
Excel 7.0. the file is not necessarily larger than the equivalent f{ile that vou create
and syve in Microsoft Excel 5.0

Run-time error 438: Object doesn’t support this property or method

When vou use a Visuat Basic for applications procedure 1o create un Office
Binder OLE Automaunion object, and vou edit a Microsott Excel worksheet object
in the Binder. you may receive the error message that the object doesn’t support
the property or method. o

This error message occurs when you edit a Microsoft Excel worksheet object ina
Binder using OLE Automation if vou attempt 10 access a single sheet (such as a
worksheen) or an item on a single sheet (such as a cell valtue) from outside the
Apphication object without using the Parent object. This occurs becuuse the
Microsoft Excel object 18 a worksheet. even though the secuon in the Binderis a
workhook. '
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Solution

Use the Parent object 1o access a Microsoft Excel workbook object. and then use
the property or methed of the Worksheet objeci'as in the following example: The
following command adds a worksheet to section 1 (a Microsoft Excel workbook)
in the Binder MyBinder: :

MyBinder.Sections{1).0bject.Parent.Worksheets. Add

Supporting Microsoft PowerPoint

This section describes supporting some new features in PowerPoint. including the
AuwtoContent Wizard. the Pack and Go Wizard, using and managing ClipArt in
PowerPoint and other applications. customizing the style checker. and setung up
self-runming presentations. At the end of this section are common issues vou or
your users may encounter with PowerPoint 7.0

The AutoContent Wizard

The AutoContent Wizard creates a presentation and suggests an agenda for a
variely of different topics. such as "Commumncating Bad News™ and “Reporting
Progress.” Some topics are only avaitable after chicking the Other bution in the
AutoContent Wizard. For many topics. the Wizard asks questions about
presentation length, style, type of output. printing. and customization. When vou
click the Finish button. the Wizard creates a pre-formatted presentation with a
suggested agenda based on the selected topic. Each slide includes suggesuons
about when, where. and how to present the information. You simply replace lhc
tips with the content of vour presenation.

Note The starter presentation templates used by the AutoContent Wizard ure
stored in the \MSOffice\Templates\Presentations folder. You can also access them
using the New command on the File menu. or the Start a Document buuon on the
Otfice Shortcut Bar.

You can create new AutoContent templates for your users and make them
available through the wizard by storing them in the
\MSOffice\Tempiates\Presentations folder. Make sure to save the presentation in
template tormat. Choose the Save As command on the File menu and select the
Presentation Template . tion in.the Save As Type list. To access these templates
in the AutoContent Wiz.::d. click the Other button when the Wizard displays a list
of presentation (vpes to choose from. The Select Presentation Template dialog
box appears. which displavs the contents of the Presentations folder.

When vou vse the Other button to select a custom template, Lhe subsequent steps
tn the Whzard that provide opuions regarding length. style. and output are not
dnplaw_d Thus. the only element that the AutoContent Wizard s able 1o control
in a custom template is the creation of the litle shde.
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If you want a custom title slide. make sure vou create one when vou create a
template for use with the AutoContent Wizard. If vou don’t. the Wizard -
automatically inserts one for vou, formats it using the default title slide format.
and applies the master formatting to the background. If you want a custom look
for the title slide. include one in the template and format 1 the way vou want.
Because the title slide already exists, a new one is not inserted. Custom utle «J1de
text entered in the AutoContent Wizard is added to the existing title slide without
disturbing the formatting.

The Pack And Go Wizard

h

i

Presentations are frequently created and then given on different computers.
sometimes by different people. The Pack and Go Wizard assembles alt the filex
required to give the presentation and ensures that they ‘re all bundled together.
The Wizard clones the presentation. copying the presentation file and all of its
source files to a destination selected by the user.

Tip You can pack multiple presentations by holding down CTRL while selecting
files in the Pack and Go Wizard's Browse dialog box. -

Here’s how the Pack and Go Wizard works:

= When packing the active presentation. the Pack and Go Wizard saves a copy
of the presentation to the Windows\Temp folder. If the presentation has not vet
been saved, it is saved as “Untitled.ppt.”

» The temporary copy of the presentation is loaded into memory. (1f the Other
Presentations option s selected 1n the Wizard. the original file is loaded into
memory.) If your presentation contains links to two or more files with the
same name hut stored 1n ditferent folders. the Wizard renames the second and
subsequent files using the Windows GetTempFileName API function. This s
done because all files packed by the Pack and Go Wizard are unpacked
together in the sume folder at the desunation.

» It the Embed TrueType Fonts option is selected in the Wizard, a flag is set in
the presentation to embed the fonts. The font embedding code is identical to
the code used when Embed TrueType Fonts is selected in the Save As dialog
box.

s If the Package Links option is selected. the Wizard looks through the
presentatton for linked files. When a hinked file 15 found. that file is copied 1o
the Temp folder and the link source is reset accordingly in the presentation.
Because both the presentation and the link source are in the same folder when
the link source is reset, the link 15 preserved after the files are moved 10
another folder.

rJ
[
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If the Wizard detects ui: 2mbedded Media Plaver object. the user is asked o
browse for the linked file. (Embedded Media Plaver object links are not
maintained by OLE. The Wizard rmust ask for user intervention to idenufy the
source.) .

The presentation is saved to the folder used as the temporary folder (for
example. Windows\Temp), ensuring that the original presentation remitins
untouched.'If the ortginal presentation was stored in the temporary folder, the
new copy will overwrite it. All files that are copied 10 the temporary tolder
automatically overwrite existing files of the same name.

Note The location of the temporary folder is normally specified in the
Autoexec.bar file. if one exists. By default. Windows 95 sets \Windows\Temp
as the temporary folder.

If the Include PowerPoint Viewer option is selected. the Wizard checks 10 see
which version of the PowerPoint Viewer is installed. The latest version of the
Viewer will always be packed with the presentation. When vou unpack the
Viewer. vou don’t need to worry about installing an older version over a newer
version: the Wizard checks for this.

The PNGSetup.ex_ file is copied to the destination disk and renamed to
PNGSetup.exe. PNGSetup.exe is used 1o unpack the presentation.

A function in the PNGComp.dll file is called to create a cabinet file on the
destination disk. Cabinet files are compressed files that are designed 10 span
multiple disks. Each cabinet file is the same size. and the size is calculated
based on the amount of space remaining on the destination disk at the time the
firsi cabinet file is created. Thus, when packing to floppy disks. the space
remaining on Disk | will determine how much space is used on all subsequent
diskertes. If the user is pucking to a hard disk or network location. only one
cabinet file is created. and the size limit is determined by the remaining space
on the disk. Make sure. when packing 1o tloppy disks. that Disk | 1s clean. to
ensure that the mimimum number of disks are necessary.

In addition to the presentation. linked files. and the PowerPoint Viewer files,
the Wizard also packs a text file calied Playlist.lst that contains the names of
all the presentations that were pucked. This list is used to run the shdeshow
fearure from the PNGSetup program. {(This plavlist file-has no relationship
with the playlist files used with the 16-bit Viewer.)

Once all files are copied into the cabinet files, the temporary files ure removed
from the Temp folder and the working copy of the presentation is removed
from memory. The Pack and Go Wizard always leaves PowerPoint in the same
state as when tt started.
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Note An updated 32-bit version of the PowerPoint Viewer application will be
available after PowerPoint 7.0 ships. The new version will support all of the new
PowerPoint 7.0 electronic presentation features. To obtain a copy, conlact
Microsoft Customer Service. download it from the Microsoft Network. the
Microsoft forum on CompuServe, or Microsoft Seiect. For more information. see
the list of resources in Appendix F. “Resources.”

Setting Up a Packed Presentation

To give a presentation that has been packed with the Pack and Go Wizard. the
user must first decompress the packed presentation and its linked files. The Pack
and Go Wizard provides a setup program {o decompress the presentation files and
install them 1o a specified directory.

» To unpack a presentation

=

=

f.

B

3

Insert the disk containing PNGSetup.exe. or navigate to PNGSetup.exe 1n the
destination folder. -

Double-click PNGSetup.exe

Specify a destination folder for the unpacked presentation. It the folder doesn’t
exist, PNGSetup will create it

If PNGSetup detects that PowerPoint or the PowerPownt Viewer s instatled
when the presentation is unpacked. it offers the option of running the
shideshow immediately. If you chouse thrs option. PNGSetup liunches the
slideshow and shows each presentation (if more than-one was packed) in
sequence.

Removing an Unpacked Presentation

To remove the presentation from the computer when you're finished with it.
detete the tolder 10 which it was unpached Except for the Viewer tiles, all files
installed by the Pack and Go Wizard are installed to this folder.

Note If anv objects in a packed presentation have [nteractive Sertings applied.
these settings will be preserved, but anyv programs that are specified in the Run
Program edit bov in the [neracuve Sewngs dialog box will not be packed with
the presentation The user must ensure that these programs are nstalled on the
destination system.
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Clip Art in PowerPoint | :

h
1]

Microsoft ClipAnt Gallery 2.0 is an OLE 100l that ships with Microsoft Oftice.
You activate the ClipAnt Gallery by clicking the Clip Art command on the Insert
menu in PowerPoint, or by clicking the Obyect command on the Insert menu and
double-clicking Microsoft ChipArt Gallery 1n the Object Type list. ChipArt Gallery
displays graphics stored in Picture Store files. By default. the Microsott ClipAn
Gallery application is installed in the

\Program Files\Common Files\Microsoft Shared\Artgalry folder. By default. the
Picture Store files are installed in the MSOffice\Clipart\Pcsfiles folder.

The version of PowerPoint supplied on floppy disks includes a selection of clip
art spanning a vantety of categories. The version of PowerPoint supplied on CD
provides additional clip art in the Office Valupack directory.

Cenomrs & Denae S
b e

Using Clip Art in Other Applications

ChpAn Gallerv .psc file images are not negcessarily available in individual graphic
formats. such as Windows Metafile (.wml) or Tugged Image File Format (.tif).
Therefore, it migh* -~ be possible to directly insert ClipArt Gallery images into
Office document- ~ clicking Picture on the Insert menu. To access, view, and
insen graphic images from the .pes files, you must insert the image as an object
from the ClipArt Gallery. On the Insett menu. click Object. In the Object Types
list. choose Microsoft ClipArt Gallery. Select the image you want. and click OK.

You can also copy a ClipAn Gallery image already inserted into one document
and paste 1t 1nto another document.

205



Chapter 12 Support and Troubleshooting 335

Managing the Clip Art'Gallery

Click the Organize button in the ClipArt Gallery dizlog box to display the
Organize dialog box. Here you can add or update pictures in the gallery. When
you add art 1o the gallery, a thumbnail sketch is created and added to the category
of your choice. With the Add Pictures button. you can specify particular an files
10 add. Many formats are recognized. including .wmf, .tif. .eps. and .bmp. as well
as .cag (ClipAnt Gallery 2.0 database format) and proprietary formats such us
CorelDRAWe and Kodaks Photo CD. among others. The Update Pictures button
.searches your compuler for readable picture files, and updates the gallery 1o
include all the pictures it finds. This button is generally not a good chowce of you
have artwork installed that you don't want to include in the galiery.

Note The CD releases of Microsoft Office and PowerPoint include 2 ValuPack
directory containing additional clip art you can install using the methods
described above (the floppy-disk release of PowerPoint includes a separate CD .
with similar contents!. You caninstall the files from the Clipart folder onto vou

£ *hard disk, or you can conserve space by leaving the clip art files on the CD. 11 vou

_ install the clip art files on your hard disk, you must copy both the .pes and .cag
files to the same folder. If vou decide 1o leave the art on CD. vou need 1o insert
the CD when vou insert clip art from the Office ValuPak.

To change the categories in which pictures appear in the gullery. 1o create new
categories. or to change the text description of pictures in the gallery. click the
right mouse button on the thumbnail image n the ClipArt Gallery dialog box and
click the Picture Properties command. Tu delete a picture, click the Delete Picture
command. To Delete or rename the categones themselves, click the right mouse
button on the category name in the Choose A Category list and click the Edut
Category List command.

Note Whun vou add or remove pictures in the ChpArn Gallery. information such
as categorv, thumbnuil sketch, and description 1= updated in the master clip art
database file. named Artgalrv.cag. located in the Windows directory.

Installing ClipArt Gallery 2.0 Over ClipArt Gallery 1.0

Previous Versions of ClipArt Gullery created .igh and .thm database files.
contaimng index information. category information. and thumbnail art used by the
ChipAn Gailery 1o locate and organize the actual clip art fites. ClipArt Gallery 2.0
creates a single database file 1o accomplish the sume objectives. identified by the
extension .cag. If vou install ChipArt Gadlery 2.0 over o previous version, the (dx
and _thm files are merged into the new .cug file. und then they are deleted.
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Note When vou instalt PowerPoint 7.0 over PowerPoint 4.0, settings in the
Arntgalry.ins file used by ClipArntGallery 1.0 are transferred to the Windows
registry. to be used by ClipArt Gallery 2.0.

Relocating and Renaming .Cag Files

By default. each user’s .cag database file is named Angalrv.cag. and is creaed
in the vser’s \Windows folder. You can specify where the ClipArt Gallery
creates this file by adding a new string value in the Windows registry. to the
following key:

HKEY _LOCAL_MACHINEANSoftwaretMicrosoft\CTipArt Gallery©\zZ.®

The string vatue name should be “Database”. and the value should be a string
containing the full path and filename for the ClipArt Gallery database file. For
example. setting this value to

“C:AProgram Files\Common Files\Microsoft Shared\ArtgalryiMy Database.cag™
would cause ChpArt Gallery to call the database "My Database.cag.” and to store
it in the same folder with the ClipArt Gallery application. It you choose 10
custornize this property, vou should ensure that the folder you specify exists. s
writable. and is exclusive to the user (i.e. not shared). This value must be set
before ClipArt Gallery 1s launched for the first time,

Installing Clip Art on a Server

To conserve hard-disk space on users’ machines. the ClipArt Gallery .pes fies
{installed in the Msoffice\Chpart\Pesfiles folder). and any addinonal an files you
wiant to add to the gallers . can be installed on a network server. The cayg files
created by the ClipArt Gallery must be stored on the local machine, or in a private
user directory on the server. These files cannot be shared.

Some clip an packuges come pre-indcked with their own .cag files. For example,
the Cantoons pachage on the PowerPoint ValuPak CD includes two files:
Curtoons.pes and Cartoens.cag. When this package is imported into the ClipArt
Gatlery. the .cug file 1~ merged with the user’s master .cag file. then deleted from
the hard disk, Until a cag file is merged. it must be stored with the associated clip
art images. If you do not want the ClipArt Gallery to delete the .cag file after

“importing it (if 1t is stored on a server where other users need access to it. for

example). simply make the folder where they are stored read-only.

For information about setting up a custom installation, see Chapter 9.
“Customizing Chent Installations.”
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Optimizing Custom Artwork for the ClipArt Gallery

You can add custom artwork such as company logos to the ClipAn Gallery. Use
the following guidelines when creating an for the ClipArt Gallery:

= Use a vector graphic format such as .wmf (preferred) or .cgm. These formais.
are readily scalable and have transparent backgrounds. allowing the an 1o
“float™ when placed on a colored background. Don’t use raster graphic formats
such as .bmp or .tif. These formats save background pixels as well as the main
body of the art, causing a “white box™" effect when piaced on a colored
background. ‘

»  Make sure that you use colors that work well on all the computer displays used
in your workgroup. For example. if the lowest-common-denominator is 16-
color VGA, optimize the art for that display format.

»  When art is added to the ClipAnt Gallery, a thumbnail is created for display in
the ClipArt Gailery dialog box. This thumbnail uses the display settings of the
computer that is used to add the clip art to the galiery.

“How AutoClipArt Works -

" The AutoClipArt command on the Tools menu suggests spectfic clip art vou can
add to a presentation. based on the text contained in the presentation. This feature
uses a search mechanism that logks at every word in the presentation and finds,
any maiches agatnst a master list of concepts that PowerPoint stores internaliv 1f
a match is found. AutoClipArt suggests one or more pieces of ¢lip art tor each
slide in the presentation that contans text matching the internal concept list. The
following guidelines apply 1o AutoClipArt:

[~

»  You must first run the ClipArt Gallery und import the PowerPoint Popular
Clip Arr package, which 15 supplied with PowerPoint, before AutoClipArt will
work.

= The presence of the AutoClipArt feature is indicated by the appearance of the
AutoCitp key in the tollowing Windows registry location:
HKEY_C-URRENT_USER\Software\Mlcrosoft\Office\PowerPoirjt\?.@\Addlns

= AutoChpArt uses the value stored in the following key in the Windows
regisiry to locate chip art files on disk.

HKEY CURRENT _USER\Software\Microsoft\0ffice\PowerPoint\7.0VAutolYipArt

= AutoClipAn requires the Microsoft ClipArt Gallery version 2.0. whose
presence 1s tndicated by the appearance of the following Windows
registry hey:

HKEY LOCAL_MACHINEASoftware\Microsoft\Clipart Gallery\2.@

For more information about the Windows registry. see Appendix B, “Registry
Keys and Values ™
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Making You Own Art Available to AutoClipArt

By adding concept keywords 10 images you add to the ClipArt Gallery. vou can
make them available for AutoClipArt searches. To do so. activate the ClipAn
Gallerv. click the Organize button. and then click the Picture Properties bution.
Type the concept keywords into the Description box. Foliow these guidelines for
adding concept kgywords:

*  You can add multipie concept kevwords to each. piece of clip art.

s The first entry you tvpe in the Description box should be a space character, For
example, if you type “war™ as the first entry in the Category box for a piece of
art, AutoClipAn might suggest the picture when searching for the kevword
“reward.” Adding a space before the word (" war™) ensures that the search
would use only the entire word.

= You must type a single space character between each concept keyword.
= Do not use punctuation. - '

= Use only valid concept keywords: which are listed in the file named
“AutoClipArt Concepts.txt” in the \Documentation\PowerPoint folder on
Office Resource Kit CD. Keywords other than those listed here are not
recogmzed.

Customizing the Style Checker

You can specify a number of different style and punctuation preferences that the
PowerPoint Styvle Checker can look for when reviewing a presentation. For
example. vou can spec:fy that atl body text should end with a period (or with any
other character). If the Stvle Checker finds a body text item that does not end with
a period. you can have the Style Checker add one automatically.

To set these options. click Style Checker on the Tools menu and click the Options
button. The settings in the Stvle Checker Options dialog box are preserved in the
Windows registry. For more information about the spectiic regisiry settings, see
Appendix B, "Registry Keys and Values.” These options can also be set duning
installation using an installation script. For more informanon. see Chapter 4.
“Customizing Client Instailations.” ’

Setting Up Self-Running Pr-:sentations .

Presentation kiosk is a term used to describe a special presentation

implementation where a presentation runs in an unattended setting, such as a
trade-~how booth or an informanon desk. Presentation Kiosks can be interactive. if
allowing the audience to have access tu the kevboard is acceptable. but VOu can
also hide the hevbouard and mouse to prevent interaction and possible disruption of
the presentation.
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The keys to creating a presentation kiosk are using the slide timing and
presentation looping features. You can set citions for kiosk presentations so that
the slides change automatically and the presentation repeats continuously. Firsl.
click the Rehearse Timings button on the Slide Sorter toolbar in Slide Sorter view.
This starts the slide show with the Rehearsal dialog box visible..show in the
following illustration.

With the Rehearsal dialog box visible. go through vour presentation slide by shde
and click the Next button (with the right-pointing arrow) when you want to
advance to the next slide, PowerPeint records the amount of time the shide was
displayed. Be sure to aliow plenty of time to read the entire slide. When vou have
gone through the entire presentation. PowerPoint returns to Slide Sorter view.

. where the timings you recorded appear below the corresponding thumbnail for

each slide. - -

Ttp In the Rehearsal dialog box, instead of waiting for the time to clapse for cach
slide. you can type the amount of time you want in the edit box.'

Next, choose Slide Show from the View menu. click the Lse Slide Timings and

'Loop Continuously Uniil ESC options. so that the presentation will repeat

indefinitely. Click OK to start the slide show. and then press ESC. Then save the
presentation. This way. the options vou set in the Slide Show dialog box are
preserved in the presentation file.

Creating a Special Shortcut icon

You can create a duplicate PowerPoint shortcut icon that will automatically start
PowerPoint and launch a slideshow with no further user interaction. This can be
handy tor presentation kiosks where you want to allow audience snieraction using
the kevboard.

Tip Forinteractive hiosks. set up the kiosk computer with the special shortcut
icon displaved in the ¢ '1ter of the screen and hide the taskbar. Click the Windows
Start menu, choose @ 7 ;zttings. Taskbar command. and click the Auto Hide
option. Give the icon u name like “Double-click to start.” Then, if an audience
member somehow shuts down the program. getting the kiosk up and running
again is no problem,

First, vou should create a duphcate PowerPoint program icon to use specifically
for this purpose.
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To create a shortcut icon that automatically starts a slideshow

I. In the MSOffice\Powerpnt folder, select the PowerPoint program icon’
(Powerpnt.exe) and click the right moeuse button to display the shoricut meny.

2. Click Create Shoricut.

A new icon appears. entitled “Shortcut to Powerpnt.”™ Rename 1t using the
Rename command on the shortcut menu.

%]

. Click the right mouse hutton on the new shorteut icon and click Properties on
the shorlcut menu. ’

In Windows NT. click Properties on the File menu.
4. Click the Shorteut Lab.

5. Inthe Turgel edit box. after the path stoing. type a space then /s and then tvpe
the name and path of the presentation file you want to start. For example, the
complete string should resemble the following:
C:\MSOffice\Powerpnt\Powerpnt.exe /s c:\My Documents\MyKiosh.ppt.

~ In Windows NT. edit the string in the Command Line edit box.

6. Click OK. '

After vou create the special shorteut. double-chicking the 1con or choosing 11 from
the Start menu starts PowerPoint directly in slideshow view and starts the
indicated presentation. All evidence of the PowerPoint program. including the
user interfuce and the startup logo screen remain hidden. Clicking the ESC kev in
thts mode not only stops the presentation. bui also exits PowerPoint.

The Special Slide Show File Type

Another way to directly launch a presentation s to rename the three-character
extension ot o presentation file. When vou change the extension trom .ppt to .pps.
anw then click the presentation file. the presentation launches directly into o slide
show,

Using Batch File Lists

You cun create u hatch Tile list i vou want o show more than one presentation at
a time. The presentations hsted there are displaved as one continuous shde show
without interruptions. Thas feature can be useful with kiosks. allowing vou o
string 1ogether ditferent groups of presentations for different audiences.

To creite a batch file hiat, stant Microsoft Word, Notepad, or anv other word
processor. Type the Nlenames of cach presentation you want o show on a
separate hne, Then, save the document as a text file. but @ive it a .bat extension,
and save it in the same folder aiong with the presentations it opens.

To use the batch file kist, click Open on the File menu in PowerPoint. and double-
click the batch file fist document.
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Using Playlists With The 16-Bit Viewer

You can also use batch files with the 16-bit PowerPoint Viewer (shipped with
PowerPoint 4.0 and the iniual release of*PowerPoint 7.00. Instead of-naming the
text files using .bat extensions, use the .[st extension instead. The files are

‘ otherwise idenucal 10 batch files described above.

To use a playlist with the PowerPoint Viewer, double-click it in the Windows
Explorer, select the playlist file. and click the Show burtton.

Note An updated 32-bit version of the PowerPoint Viewer application will be
available after PowerPoint 7.0 ships. The new version does not support playlists.
To obtain a copy of the updated Viewer. contact Microsoft Customer Service.
download it from the Microsoft Network, the Microsoflt forum on CompuSeise. or
Microsoft Select. For more information. see the list of resources in Appendiny F.
“Resources.” ' )

+*  PowerPoint Command-Lirie Startup Switches

= =  The following startup switches can be added to end of the Target string 1 the
Windows 95 Properties dialog box (or the Command Line box in Windows NTh
to cause specific things to happen whenever you start PowerPomt. In each cuse
vou must tvpe a space before and after the switch. followed by the full path 1o

a file.

I Starts PowerPoint in Slide Show view and runs the specified presentauon oz
presentations. For more informanon, see ~Using Batch File Lists™ carlier n thi
section

p Prints the specified presentation.

/n Creates & new presentation using the specified presentation as a template

h Creutes a new presentation by inserting the shdes of the specified presentanon

Files Created Using Beta Releases of PowerPoint 7.0

Because PowerPoint 7.0 uses a file format that is different from that of previous
versions ol PowerPoint. and because the file format itself underwent mciemental
changes throughout the beta release cyele, you might experience problems with
presemtations created with a beta release of PowerPoint 7.0. Problems arc more
likelv to occur in 4 presentation that was created in one beta version of
PowerPoint. and then edited and <aved in later beta releases. Some problems that
might indicate a file-tormat problem nclude the following:

=  Embedding Word tubles produces unpredictable results.

= In Outhne view. selecting. dragging, or reordering slides sometimes produces
unpredictable results

(293
o
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PowerPoint 7

Possible Causes

Solutions

v In Notes view, slide images disappear or are incorrect.
= [n Notes printouts, slide images are incorrect,

*  When printing, bullets are repeated on a particular slide.

To alleviate these problems: -

= Evervone in your workgroup should be using the final release version of
PowerPoint 7.0. Do not allow a person who has the final release and another
who is still using a beta version to work on the same presentation. This can
cause file corruption, to the extent that the file may not even open in
PowerPornt 7.0.

= If yvou notice unusual behavior with presentations that were created using beta
versions of PowerPoint 7.0; create the files again using the final version. When
vou do so. you can copy embedded objects and paste them into the new
presentation. but don’t copy entire slides or groups of slides.

.0 Printing Issues

Printing in PowerPoint is somewhat different from printing in the other Office

apphications. Specifically, PowerPoint:

*  Uses handscape mode by defaals.

«  Uses larze text by default.

s Allows gradient fills.

s Allows lavering of graphics,

= Aflows recoloning of graphics on-the-fly (recolor picture. black and white
view ). )

v Allows scaling of documents on the fly {scale to fit paper).

* Posiuons output on the page starting at the center of the paper and working
outwards in all directions.

Slides print individually, but fail if all printed together

This problem usually occurs with a particular presentation file rather than all
presentation files

s Insufficien’ » ‘ler mumory.

s Insufficient wisk space.

*  Timeout problem.

e Check for old temporary files and delete them.
# Use un emulation printer dnver.

s (Clean up disk space by deleting old files and delragmenting:

b2
—_—
()
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Change the Windows 95 spoolzr settings.
Reduce printing resolution.

Switch HPPCL/Raster mode.

Print to a file and copy the file to the printer,

Certain slides don’t print at all
This problem usually occurs with a particular presentation file rather than all
presentation files.

.
[ ]

Corrupted graphic/OLE object.
Corrupted font.

Incorrect printer dnver.

Copy problem slides 10 new presentation to see if they print.

Select or clear the Black And White check box in the Print dialog box.

& 4jse an emulation printer driver. - -

= _If there something about that specific slide. such as the composition or content

that is unigue and causing the problem, try reformatting the slide.

Complex slides don’t print
This problem usuatly occurs wath any presentation files containing complex
slides.

Insufficient printer memory.”

Insufficient disk space,

Timeout problem.

Bad emulation printer driver

Corruptec zraphic that 13 commonly used (such as 2 logo).
Drnver hus a problem with landscape printing.

Hardwaure problem (printer or cable).

- Free disk space and remove old tlemporary and spool files.

Print using a different printer driver.

Print to a different printer.

Switch printer cables.

Print 10 a file and copy the file to the printer at the command prompt.
Look for common graphies that are used in all affected shdes.

Copy the slide to another applicution. such as WordPad. and then try to print
from there. o
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Possible Causes

Solutions

Possible Causes

Solutions

Possible Causes

Solutions

Possible Causes

All slides don't print

This problem usually occurs with any presentation file, rather than just one.

-

Printer is not connected correctly.
Inapproprate or cormupt printer driver.
Insufficient disk space.

Hardware problem (printer or cable).

Print from another application such as WordPad.

Print a portrait mode slide from PowerPoint.

Other applications don't print, either
When vou cannot print in any application:

Printer not connected correctly.
Inappropriate or corrupt printer driver.

Hardware problem (printer or cable).

Print 2 Windows 95 test page.

Use the Prnt Troubleshooter in Windows 93 or the Print Troubleshooter
inciuded on the Office Resource Kit CD.

Whole slide image is too large or too small
This problem usually occurs with all presentation files.

Slide Setwp is incorrect
You used the Scale To Fit Paper command.

Corrupt graphic/OLE Object (particularly an EPS file).

Chech PowerPoint'configuration.
Check Shde contents {does remaoving any specific element clear this up?)

Make sure that vou have the current or best printer driver.

Whole slide image is in the wrong-place
This problem vsuully occurs with all presentation files.

Printer has uneven unprintable regions (Deskjet 550, 560c¢).

Printer driver reports center of page in the wrong place (Epson Stylus,
Tektronies 2001

Printer driver i~ set up for wrong paper size.
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Solutions

" Possible Causes

Solutions

0

Possible Causes

Solutions

»  Select or clear the Scale To Fit Paper check box in the Print dialog box.

Print to legal size paper and trim off unwanted excess.

Use an emulation printer driver.

Portions of the slide image are in the wrong place
This problem usually occurs with all presentation files.

-

Corrupted gfaphic or OLE Object (often an EPS grapﬁic).
Corrupted font.
Insufficient printer memory.

Communications problem (for example, timeout or a bad cable).

Copy the slide to a blank presentation to check for a corrupted object on the
slide master.

Replace fonts.

Print to a different printer.

Use a different driver.

Adjust the Windows 95 spooler settings.

Adjust the Windows 95 printer driver settings.

Graphic prints incorrectly or not at all
This problem usually occurs with all presentation: files.

Corrupt graphic.
Printer Driver issue.

Display Driver issue.

Print the graphic from another application.
Use an updated dnver or an emulation driver.
Use standard VGA display.

Adjust the Windows 95 spooler settings.

Adjust the Window< 95 printer driver settings.

-
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Possible Causes

Solutions

PowerPoi

Text prints incorrectty or not at all
This problem usually occurs with all presentation files.

a  Corrupt font.
= Incompatible font.
» Font subsotution causing unexpected output.

» Font not available 10 printer.

= Print the text from another application.
= Remstal] the font from the original location.
» Make sure that the printer driver provides the font to the printer,

« Make sure that the display driver doesn’t prohibit the font from getting 1o the
printer.

t 7.0 OLE Troubleshooting

Here are some troubleshooting tips you can use when you encounter problems
working with embedded objects or OLE servers.

Problem is PowerPoint-Specific

Make sure that the problem 1s application-specific by tryving other OLE
applicauons (such as other Office apphications).

Check the registry Make sure that the application is properly registered in the
Windows registry. PowerPoint,will reregister when launched. if it finds o problem
with the current registration.

Compel Office to reregister This is more effective than compelling PowerPoint to
self-register alone. To do this, run Office Setup using the Run command on the
Wincows Start menu with the /y switch (type setup /v). This starts Setup
maintenance mode. Aller selecting Reinstall, Setup rewrites all the registry keys
for the last installation.

Compel! PowerPoint to self-register Delete the key for the .ppt extension from
Hkev_Classes_Root. and then launch PowerPotnt.

Maximize resources Minimize other system variables such as memory usage and
background tasks.
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Problem Is Not PowerPoint-Specific

Determine whether the problem is application”specific by trying other OLE
applications (such as other Office applications).

Check the registry Make sure that the application is properly registered in the
Windows registry. Windows 95-compatible applications will reregister if run from
outside of an application. Double click to reregister the application.

Try alternative approaches If the application has a 1oolbar button or a specific
menu ttem associated with it. try those methods. If they don’t work, try using the

. Object command on the Insert menu. If the object doesn’t appear. it is not
'registered. If 1t appears. but does not work, it is improperly registered. If 11
appears and works using the Insert command. but does not work using the toolbar
or menu, it is partially improperly registered and re-registration should fix it.

Check the path to the OLE server Check the path of the server in
Hkey_Classes_Root. Trace the path to make sure that the OLE server executable -
- =sHound. -

~Delete the server key Delete the key for the server from Hkev_Clusses_Root. If
necessary., remove and reinstall the server apphcation itself. This should refresh
all the files associated with the server. You must uninstall all of the applications
that are registered as clients while uninstalling the OLE server application Then
reinstall them all. Otherwise. the OLE server application will not be completely
uninstalied. )

Probiem Affects All OLE Applications

If none of your OLE funcuonality works from any OLE application. the problem
may be with Windows. Call Windows product support or check your Windows
technical documentation. :

Word-to-PowerPoint Interoperability

Here are some tips that may be useful when you encounter problems serting
OLE objects from Word onto a PowerPoint shde.

Inserting a Word table doesn’t work
»  Make sure that Word 1s installed und properly registered.

= Make sure that Word objects (not tables) can be inserted.

® Make sure that registration 1s complete,

Inserting Word objects wiil not work
Try inserting a Word object into another application. If that doesn™t work, Word 1«
not property registered.

218
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Word objects in PowerPoint cannot be edited

» [f the object is linked, make sure that the linked object is avaiiuble and the link
is correct. Use the Links command on the Edit menu.

m 1f the object is embedded, make sure that Word is properly registered and

available. { The Document Object command appears on the Edit menu 1ia
Word object is embedded. ).

PowerPoint-to-Word Interoperability

Here are some tips that may be useful when you encounter problems inserting
OLE objects from PowerPoint into a Word document.

Write-Up doesn’t work

»  Make sure that Word 7.0 15 installed and registered.

= Make sure that vou can put PowerPoint objects into Word without Write Up If
you cannol. reregister PowerPoint and Word.

Report-It doesn't work

= Make sure that Word 7.0 s installed and registered. If it is not instabled. vour
presentation is exported to WordPad instead.

* Mahke sure that vou can put PowerPoint objects into Word without Report-1t.
If vou cannol. reregister PowerPoint and Word. ’

Copying and pasting a slide doesn’t work
Make sure that PowerPoint Is correctly registered.

Inserting an object in PowerPoint doesn’t work
Mke sure that PowerPoint is comrectlv registered.

PowerPoint objects in Word cannot be edited
s {{the object 1s finked (check o wee if the Links command on the Edit menu is
getive), make sure that tie linked object is available und the link 15 correct. .

= [f the object 15 embedded tcheck 1o see 1f the Object command on the Edit
menu s active) mahke sure that PowerPoint 15 properly registered :ind available.

Microsoft Excei-to-PowerPoint Interoperability

Here are some tips that may be useful when vou encounter problems tnserung
OLE objects from Microsott Excel onto a PowerPoint shide.
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Inserting a Microsoft Excel worksheet doesn’t work
»  Make sure that Microsoft Excel is installed and properly registered.

»  Make sure that Microsoft Excel objects (other than worksheets froin the
toolbar) can be inserted. . : :

Inserting Microsoft Exce! objects will not work
=  Make sure that Microsoft Excel is installed and properly registered.

s Make sure that Microsoft Excel worksheets can be inserted using the Insent
Microsoft Excel Worksheet button on the Standard toolbar. Microsoft Excel
objects in PowerPoint cannot be edited.

= If the object is linked (check to see if the Links command on the Edit menu is
active), make sure that the linked object 1s available and the link 1< correct.

= If the object is embedded (check to see if the Object command on the Edn
menu is active), make sure that Microsoft Excel is properly registered and
available,

"~ PowerPoint-to-Microsoft Excel Interoperability

Here are some tips that may be usetul when vou encounter problems inserting
OLE objects from PowerPomt into a Microsoft Excel workbook,

Copying and pasting a slide doesn’t work
Make sure that PowerPoint 1s correctly rc'gistered.

Inserting a PowerPoint object doesn't work
Make sure that PowerPoint 1» correctly remistered.

PowerPoint objects in Microsoft Excel cannot be edited .
= [f the object is linked (check to see it the Links command on the Edit menu s
active). make sure that the hnked object is available and the link is correct.

» If-the abject is embedded icheck 1o see if the Object command on the Edit
menu is active), make sure’ that PowerPoint is properly, registered and
available

Supporting Microsoft Schedule+
This section contains tnturmation about possible Schedule+ user questions.

For information shout the support implhications of using Schedule+ 7.0 with
Schedule+ 10, and with ditferent miul servers and gateways. see Chaprer 13.
“Runnming Multiple Versions of Microsoft Office.”

Addinonal support issues are discussed in the Schedule+ readme fiie.
Screadme.tsl, locuted in the Microsoft Qffice Schedule+ foider.
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Using Schedule+ with a Microsoft Mail 3.X/PROFS Gateway

PROFSs users connected to Schedule+ via a Microsoft Mail 3.%/PROFS gateway
receive formatted meeting requests from Schedule+ 1.0 users. However, because
of enhancements made to the Schedule+ 7.¢ meeting request form. Schedule+ 7.0

meeting requests are transmitted to PROFS users as a plain text email message.

An update 10 the gateway software that fixes this limitation may be available at a
later date through the Microsoft Product Support Quick-Fix Engineering {QFE)
program. ’

Schedule+ 7.0 and the Timex Data Link Watch

h

Schedule+ 7.0 supports downloading schedule data to the Timex Data Link watch
on Windows 95 only. The current release of Schedule+ 7.0 running on
Windows NT does not support the Timex Data Link waich downloader.

Timex Data Link watch users can download text with international characters (for
example. € or () 1o the watch.-Due to physical limitations of the watch display,
however. accented characters will download as their non-accented equivalent (for
example, & will download as e and ¢ will download as C).

Callbratmg the Timex Data Link Watch Manually

If a user is unable to download data consistently, or does not hear the watch’s
confirming beep when lines are displayed on the workstation screen during the
download process, the display may need to be culibrated manually.

To manually calibrate the workstation display for Timex Data Link
downloading

1. On the File Menu. click Export. and then click Timex Data Link Warch.
Answer the Export Wizard quesuons and click Finish.

In the Expont To Watch dialog hox. hold down the CTRL key and click Cancel.
The Manual Calibration dialog box appears.

LV g ]

4. Inthe munual cilibration dialog box. ciick OK. Adjust the spacing between the
lines on the screen with the UP ARROW and DOWN ARROW keys. When the
watch starts ke-ping at regular intervals, press ENTER to begin the data
download pr. = 5. - ’
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- Supporting Microsoft Word

This section describes common problems you or vour users may encounter with
Word 7.0.

General Troubleshooting Tips

'

"

The cause of many Word issues can be 1solated and/or correcied by performing a
few standard procedures described below.

Isolate the Problem When possible. try to isolate whether the problem exists in all
cases or just in a specific case. For example, does the problem happen wath all
Word documents, or with just one document? Do you receive error messages
when vou try to convert any type of word processing document, or only when vou
try to convert a specific type of document? Are ali inserted graphics printing

Ancorrectly. or just one graphic? Answenng the “all or one™ question will help vou

determine whether it’s a systemr-or Word problem, or if the single document or
portion of a document is at fault.

Start Word without Loading templates or Add-ins You can start Word witheut
loading any global templates. add-ins. or settings. On the Windows Start menu.
click Run, type winword /a and then chick OK.

If the problem disappears when vou start Word this way.AIhe problem may be n
vour Normal.dot template. another global tempiate. or one of the WLLs loading
from the Startup folder. )

Rename Normal.dot There are umes when the Normal.dot template. which 1« the
global 1emplate that comes with Word, may become corrupt. and adversely affect
Word. Trv quitting Word and then renaming this file to Normal.old. Restant Word
as vou normally would Word will not locate the Normal.dot file and will resert to
the onginal settings stored in the application program. If the problem does not
reappear. it is likely that a setting, macro, or some problem in the Normal.dot
template is causing the probiem.

Tip [f the problem 15 corruption in Normal.dot, you can copy macros. styvles. and
AutoText enires o 2 new Normal.dot by using the Organizer. On the File menu.
click Templates. and then click Orgamzer.
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Use Standard VGA Video Display Incompatible or corrupt third-party video
drivers can create problems in Word. Display problems are an obvious symptom
of this, but there are other problems that can be caused by a corrupt or
incompatible video driver. such as printing problems, system stops, or even out-
of-memory error messages when trying to start Word. Switching the video driver
to the standard VGA video driver is a quick way to determine if it's a video driver

problem.

If switching to another video driver works. it may be necessary either to reinstal!
the third-party video driver or to update the incompatible driver to the latest
version. Switching to standard VGA most often won't be an acceptable fix. but it
can provide a temporary workaround until you can reinstatl the original video
driver or obtain an update.

Use the Latest Video and Printer Drivers Word is very printer and display-centric.
Word polls both the printer and video drivers for information more extensively
than most Windows applications. As a result, other applications may not exhibit a
particular problem, while Word does. Third-party video and printer dnivers. as
well as some of the printer drivers distributed by Microsoft, are updated fairly
frequently. Updating vour drivers to the latest versions will often correct display.
printing. and other system-related probiems. For information abourt obtaiming 4
updated video and printer drivers from Microsoft, see Appendix F, "Resources.”

Try using WordPad When a problem is encountered in Word. it is wise (o see if
the problem is a more global Windows prablem, so you don't waste all vour time

‘focusing on 1t as a Word-specific problem. WordPad is an excellent application in

which 1o test problems yvou encounter in Word. whether they are printing. screen
display. or other 1ssues. While other applications such as Microsoft Excel may
also be good test applications. WordPad is an exceilent choice because it 1s more
similar to Word than most Windows applications. Microsoft Excel, for example,
isn’t as concerned about printer driver information as is either Word or WordPad.
Su.if vou can, use WordPad as a test application.

Specific Troubleshooting Areas

Possible Causes

Word cannot open a document
Follow the suggested solutions in the order listed until the problem is solved.

- The document is not on a properly formatied disk.
« The document is not in a format that Word supports.
« Not enough free disk space is available.

+ The document has been corrupted.

2
(B
L
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Solutions

Possible Causes

Solutions

Possible Cause

Solutions

If working with a document on a floppy disk that is not properly formatted for
Windows, go back to the source of the document and copy 1t to a properly
formatted disk.

If the document is not in a format that Word supports. see if Word or the
Office Resource Kit CD-ROM inctudes a-converter and install it. For more
information. see Chapter 20, “Switching to Microsoft Word.” If no converter is
available for the document’s format, go back to the originating applicaiion and
save the document 1n a format that Word supports.

v

If not enough free disk space is available, free some. Try emptying the recyvele
bin, moving old, unused files to floppy disks, or deleting old, unused
programs.

If you still cannot open the document, check to see if the document is corrupt,
Try opening it in the originating application if other than Word 7.0. If the
originating application can open the document, resave it and try opentng it in
Word 7.0 again. If the originating application is Word 6.0 or Word 7.0, see
“Determine if a document is damaged” later in this section.

Word cannot save a document

Follow the suggested solutions in the order listed until the problem is solved.

Not enough free disk space.
The document is really a template.
If not enough free disk space 15 available. free some. Try emptying the recycle

bin. moving old, unused files to floppy disks, or deleting old. unused
programs.

If the document 1s really a template, select all the contents of the document
and paste 1t into a new document. and then save the new document.

When importing, Word fails to convert a graphic correctly
Follow the suggested solutions in the order listed until the problem 1s solved.

The graphics ﬁlte\r Word needs is not installed.

If the graphics filter Word needs is not installed, install it. For more
information. see Chapter 20, “Switching to Microsoft Word."” If no filter is
available for the graphic format, go back to the oniginating application and
save the graphic 1n a format that Word supports. ’

Try opening the graphic in the originating application. If the originating
application canno? open the graphic, the graphic file may be damaged.
Instead of opening the graphic with the Open command on the File menu. try
inserting the graphic with the Picture command on the Insert menu.

Try copying the graphic tn the originating application and pasuno it into
Word.
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Possible Causes

Solutions

Possible Causes

Determine whether a document is damaged

If you experience any of the following symptoms when working mth a document,
it is possible the document is damaged. Follow the Soluuom in the ordcr listed
until the problem is solved..

Tip When troubleshooting what appears to be document corruption. it is
important to first rule out the possibility that it is not document corruption at all,
but rather some unusual formatting or document setting. Save the document in
RTF format or copy and paste all but the last paragraph mark into a new
document.

Symptoms include:

® Incorrect document layout and formatting. unreadable characters on the screen,
error messages dunng processing, Word stops running when you load or view
the document.

= You are unable to save-the document.

=  Word add-ins or other programs are interfering with Word.
= The template atiached to the document is corrupted.
* The active printer driver is inlerfering with Word.

* The current video display is interfering with Word.

# Check the paragraph, character. secuon and style formatting.
*  Disable add-ins

* Disable terminate-and-stay-resident (TSR) programs and third-party software.
partcularly font driver packages.

» Attach the document to a different femplate.
» Switch to a different printer dnver.
s Change the video display to standard VGA.

¢ Trv working with the document on another computer.

1f none of these Solutions corrects the problem. it's likely that the document is

damaged. Sec "F . ver a dumaged document in Word:" in the following section.
Recover a damaged document in Word
Follow the suggested solutions in the order listed until the problem 1s solved.

s Word was interrupted while saving the document.

* The document became corrupted while stored on disk.
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Solutions
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If you can open the damaged document. save it in RTF format. close the
document, then open the'RTF document. and save that in Word format.

If you can open the damaged document. highlight a small portion of the
document and copy it to a new document based on the Normal template. [f this
portion of the document responds normally, switch back to the original
document and copy another poruon to the new file. Repeat this process untl
an error occurs. Al that point, you have isolated the problem to a specific part
of the document. Recreate that part of the document in the new file.

If vou cannot open the damaged document in Word. trv opening it in
WordPad. Start WordPad. click the Open button, and in the Files Of Type box.
make sure that Word for Windows 6.0 is selected. (Word 6.0 and Word 7.0
have the same file format.) If you can open the document in WordPad, save it
in RTF format and then try opening that in Word 7.0.

If you cannot open the damaged document in WordPad, try opening 1t in
Notepad. Start Notepad. then click Open on the File menu. In the Files Of
Type box, make sure that All Files is selected. The document will open with
gibberish characters at the top of the document, followed by your unformatted
text, followed by more gibberish characters. Copy the unformatied text out of
Notepad and paste it into a new Word document based on the Normal
template.

Wnite a macro that opens the document. turns off screen updating and change
other display options that might affect the document, as follows.

To create a macro to open a possibly corrupted document

I

5

On the Standard toolbar, click New,

. On the Tools menu. click Macro,
3. In the Macro Name boa. tvpe screen
4.
5

. Inthe macro editing window, click between the Sub Main line and the End

Click Create.

Sub fine.
Type the following:

SereenUpdating @

FileOpen.Name = c:\docsimydoc.doc
ViewNormal
ToclsCptionsView,bBraftfont = 1, _PicturePlaceHolders = 1 -
ToelsOptionsGeneral.Pagination = @

ScreenUpdating

L

. On the File menu. chek Close. and then click Yes when prompted to keep

changes to the macro Global Screen.

On the Tools menu. chick Macro.

9. Clich Screen. and then click Run.
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Possible Cause

Solution

Possible Causes

Solutions

10. If the document opens. click Save As on the File menu.
Pl. Inthe Save File As Type box. select Rich Text Format.

12. In the File Name box. give the file 2 new name. and click Save.

Word 7.0 cannot complete a macro that Word 6.0 or earlier
could complete '

If vour workgroup uses a custom macro that calls a 16-bit Windows application
programntng interface (API) or 16-bit Windows dvnamic-link library (DLL). vou
will have to rewrite the macro for Word 7.0. which is a 32-bit application,

A 16-btt WordBasic macro calls a 16-bit Windows API or 16-bit Window« DLL.

Rewrite vour 16-bit WordBasic code to make Win32e API calls when the
WaordBasic code is executed from 32-bit Word. For more information. see
“Porting Your 16-bit Office-Based Solutions to 32-bit Office™ later m this
chapter.

Word prints a document; but incorrectly
Follow the suggested solutions in the order listed untii the problem 1s seived.

= Vurnous settings m Word don't match your printer’s options.
= Qut-of-date or corrupt printer or video driver.

*  Problems with fonts.

® [t the printed output is missing graphics or underlines. make sure that Word is
not set o print draft output, On the Tools menu. click Options and then click
the Print tub. Clear the Draft Qutput check box. IT a graphic s still missing
from the printed output, see “When importing. Word fails to convert a graphic
carrectly” earlier in this section. ‘

* [f the printed output is missing portions of text or individual letters. make sure
tha the text s not formaited as hidden text or as the color white.

s Create a new document in Word with just one line of text. Try printing this
document. If it pnints correctly. return to vour ortginal document and caretully
check 1t formatung. 1w sall doesn’t print properiy. the document may be
damaged See “Determine whether u document 1s damuaged™ earlier in this
SeCLion. ;

*  Start WordPad and try to print the document from WordPad.

»  Chunge the video settings to standard VGA.

»  Turn otf backeround printing in Word. On the Tools menu, chek Options, and
then click the Print tub. Cleur the Background Printing check box.
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Possible Causes

Solutions

Use a printer font. On the Edit menu, click Select All. and then choose a fon
from the Font box on the Formatting toolbur that has a printer svmbol heside
it. If this corrects the problem, you may have a problem with the tonts vou
were originally using.

Rename Normal.dot and then restart Word,

Verifv that vou have the correct printer driver installed and it is set as the
default.

Disable TSRs and third-party software. particularly font driver packagoes.
If you're using a font cartndge. turn your printer off. remove the cartridge. and
turn your printer back on.

Double-click Printers in the Windows Control Panel. and then double-chick the
printer vou are using. In the Properties dialog box. click the Fonis tab. und
then chick Print TrueType As Graphics. For this option. vou need about 300K
of free memory per page. Some printers such as dot matrix. DeskJet. und
Bubbleldet do not support this option.

The problem may be hardware related. Try removing any switch boves, using
a new printer cable, and. if you are on 1 network, connecting the printer
locally. If this doesn’t fix the problem. vou may have a mechunical problem
with the printer. the pornt connection on vour printer. or the port connection on
vour computet.

Word cannot print a document
Follow the suggested solutions in the order histed unul the problem is sohved.

Word does not have the commect paper size or paper source scttings specitied
for the printer vou #re using

The printer does not have enough memory.

If 4n error message prints or appears on the computer screen. follow the
INstructions it contains

Check the paper stze and paper source settings in Word. On the File menu.
clrck Page Setup Chechk the setungs on the Puper Size and Paper Source tibs,

Reset the printer 1o clezr the printer buffer.

Restart the print queue by selecting Printers in the Windows Control Panel.
double-chicking the printer vou are using, and then clicking Resame Prinung
on the Document menu.

Clear the print queue by selecting Printers in the Windows Control Panel,
double-cliching the prnter vou are usmg, and cliching Cancel Printing on the
Document menu
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Possible Causes

Solutions

Page faults in Word .

This section describes page faults in Wore 7.0 running under Windows 95, which
are comparable to General Protection (GP) faults in Word 6.0 running under
Windows 3.x. Follow the Solutions in the order listed until the problem is solved. _

‘Something unexpected has happened within the Windows environment.

typically an improper memory address. For example. an application or a
Windows component might read or write to a memory location that has not
been allocated to it (memory that it does not own), potentially overwrniting and
corrupting other program code in that area of memory.

Parameters that are not valid have been passed between applications and the
Windows environment. Invalid parameters can cause tnvalid instructions to be
execuled, resulting in page faults, This is usuaily the result of the application’s
internal program code incorrectly passing specific data that coutd not be
correctly interpreted by Windows or a Windows-based application.

Change the video display to standard VGA.

Switch your printer driver to another compatible printer driver, or temporarily
switch it to the Generic\Text Only printer driver.

Temporarily remove any items located in the Windows Siartup folder.

Start Word without loading any global templates, add-ins, or settings. On the
Windows Start menu, click Run, tvpe winword /a and then click OK.

Temporanly remove all templates and add-ins from the Word Startup folder.

Quit Word. then delete the following key in the registry:
\Hkey_Current_User\Software\Microsoft\Word\7.0\Data and then resturi

- Word. For information about using the Registry Editor, see Appendix B,

“Registry Kevs and Values.”
Use the Find cornmand on the Windows Start menu to locate any AutoSave

files (look for "*.asd™}. If vou find any files with the .asd extension. rename
the extension. This prevents Word from loading the AutoSave file when 1t
starts.

Use the Find command on the Windows Start menu to locate any AutoCorrect
files (look for =*.ac!™). If vou find anv files with the .acl extension, rename the
extension. This prevents Word from loading the AutoCorrect file when it
sLarts. ;

Try removing -+ rd through the Add/Remove programs icon in the Windows
Control Panel. and then reinstalling Word.
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Registry Settings and .Ini Files

b

B

Some Office for Windows 95 applications continue to use.ini files. even though
they operate based on settings in the Windows registry. For backward
compatibility, Office applications allow the use of the /ini command line option.
Except for Word, Setup does not migrate .ini settings from previous versions of
the applications when Office for Windows 95 is instalied. Leftover .ini files have
no effect on Office for Windows 95 applications.

When Setup installs Word 7.0 onto a system with a previous version of Word.
everything in Winword6.opt and Winwordé6.ini is registered in the user’s
Hkey_Current_User registry keys. All shared components currently registered in
the user’s Win.ini (text converters, filters, proofing tools, and so forth) are
registered in the Hkey_Local_Machine registry keys.

The following table lists Office applications, whether they use .int files or the
registry only, and information about how the applications use existing .in1 files.

Application  Registry or .ini Files Use of existing .ini files

Office Registry only. When upgrading previous versions
of Office. buttons inciuded in
Msoffice.in) are migrated (o the
0O1d Office 100lbar,

Microsoft " Registry only. None.
Access

Microsoft Registry only. Naone.
Excel

Microsoft Regisiry only, except where None.

PowerPoint compatibility with PowerPoint 4.0 -
and other 16-bit applications
requires use of .ini files For
example. PowerPoint 7.0 to
PowerPoint 4.0 translator entries
are stored n an .ani file.

Microsoft Registry only. Schedule+ 7.0 reads the
Schedule+ + Schedule+ 1.0 .ini file the first ume
‘ it runs to find existing .cal file,
migrates the .cal file to an .scd file,
and sets registry entry for

LocalPath.
Microsoft Registry and .in1 files. Mstntmap.ini and Mstxicnv 1ni are

Word ' not made 1nto registry entries



360 Part 3 Maintaining and Supperting Microsoft Office

- Long Filenames

0]

h

When users transfer a file from an Office for Windows 95 application to a
previous version and then back to the original application. the long filenames
supported by Windows 95 may or may not be preserved. Each application.handles
preservanon of long filenames slightly differently.

Microsoft Access Microsoft Access doas not preserve long filenames. as users
cannot open Microsoft Access 7.0 database files in a previous version of
Microsoft Access and then move them back to version 7.0.

Microsoft Excel When opening a Microsoft Excel 7.0 workbook in Microsoft
Excel 5.0, the older version of Microsoft Excel cannot update links or find link
sources. However, when the workbook is opened again in Microsoit Excel 7.0,
the long filename is preserved, and links are preserved and can be updated
normally.

Microsoft PowerPoint When opening a PowerPoint 7.0 file using the Macintosh
installable filters, the Windows 95 long ftlenames are preserved.

When using the Save As command in PowerPoint 7.0 to save a file in

PowerPaint 4.0 format. a dialog box appears. prompting the user for a new
filename. The user must consider the destination platform of the file when numing
it. For example. if the file 1s destined for PowerPoint 4.0 running on Windows 95
or the Macintosh, long filenames are supponted. If the file will be used n
PowerPoint 4.0 for Windows 3.1, a long filename will be truncated. <o the user
might want to create an 8.3 filename. to avoid confusion,

Microsoft Schedule+ Schedule+ does not preserve long filenames. as users cannot
open a Schedule+ 7.0 schedule file in a previous version of Schedule+.

Microsoft Word In Word. the long filename of the document itself is not
preserved when the file is modified in Windows 3.x. then reopened in
Windows 95. However, document names in links are updated, and the links
still work :

Porting Your 16-Bit Office-Based Solutions
to 32-Bit Office

The mmtroduction of 32-bit Microsoft Windows 95 (and Windows NT) brings
32-but Office applications into common use and results in users switching their
Microsott Office files, macros, and solutions to the 32-bit versions. This section
assists vou 1n porting ~solution code-—that is, code written in the Microsoft Excel
macro lunguage (XLM), WordBasic. Visual Basic for applications, or Access
Basic —to 32-bit versions of Office running on 32-bit operaung systems.

b2
L
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Changes to your existing code are required if your 16-bit Office solution
(including Microsoft Access or Microsoft | vaject) calis a 16-bit Windows
application programming interface (API) or 16-bit Windows dynamic-link library
(DLL), and you are porting that code to a 32-bit Office applicanon (again.
mcludmg Microsoft Access 95 or Microsoft Project 95).

Porting vour solution code is necessary because 16-bit API calls and 16- bu DLL
calls (referred 1o in this section simply as API calls) do not execute correctly

‘when the solution code containing those calls is run 1n a 32-bit Office apphcation.

This section applies to solution code that uses APls in the following products:
Microsoft Access, Microsoft Excel, Microsoft Project, and Word for Windows.

Note 16-bit solutions ported to 32-bit Windows are not affected. For example.
existing 16-bit Office solutions, 16-bit Visual Basic, and t16-bit FoxPro
applications. even if they call 16-bit APls, will run just fine on Windows 95 or
Windows NT. It is only when users want to run solutions code that includes 16-bit
API calls on a 32-bit application that porting is required.

Solution providers and corporate developers face an important task in ensuring
that their Microsoft Office-based soluttons run successfully under Windows 93
and Windows NT.

The rule they must follow 19 this: netther a 32-bit compiled application nor
solution code called from a 32-bit Office application can make direct 16-bit API

“or DLL calls. In addition. neither a i6-bit compiled application nor solution code

called from a |6-bit application can make direct 32-bit APl or DLL calls. This
inability to make calls back and forth between 16-bit and 32-bit lavers occurs in
both the Windows 95 and Windows NT environments because of their advanced
flat-memory-model management systems, as well as the way in which thev

load DLLs.

To prepare for Office 95, vou must change your solution code to make Win32

API calls when the solution code 1s execuwted from 32-bit Office apphcations. [f
this 15 not possible (for example, you don’t have access to the source code of the
DLL). vou must change the solution code 1o thunk through an intermediaie DLL
to make the [6-bit APl call. Uipdating solution code to support Win32 AP calls 1s
a refatively simple mechanical process. A more significant task is to write code
that is operating-syvst=im--independent (that is. so the solution code will run on
both 16-bit and 32-r - -ffice voophications). This section discusses both of these
tasks, as well as other (0-10-32-bit API issues you may need to handie.

tJ
[}
-
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Note Afthough you must update API calls when porung solution code to 32-bit
operating systems, you do not need to change code that uses OLE Automation or
dynamic data exchange {DDE). All OLE and DDE code will continue to work
regardless of whether the applications are 16-bit or 32-bit. OLE and DDE insulate
automation calls, so all combinations of containers {clients) and servers (16/16,

" 16/32. 32/16. and 32/32) work under Windows 95 and Windows NT.

How This Section Is Organized

"

What vou need 1o know depends on your situation; therefore, this section s
organized in terms of complexity, from the easier issues to the more complex
ones.

s “Which API Should Your Solution Code Cali?” is a quick overview of which
API vou shouid be using. according to your application needs.

= “Calling the Win32 API” describes what an API is and discusses the issues
involved in converting existing 16-bit API calls to Win32 API culls. finding
Deciaration statements, and testing the Declare statements.

s “Wriing a Single Code Base for 16-bit and 32-bit Office Applications™
supphes code sumples for writing solution code that will run on both o 16-bit
and 32-bit Office application. )

» “Determining Whether a 32-bit Application [s Running” describes how to
determine whether vour Office application is 16-bit or 32-bit and how to select
the appropnate 16-bit or 32-bit API call.”

= “Recompiling DLLs" tells you what-vou need to do to make the DLL and
sulution code work on Windows 95 and Windows NT if yvour solution code
calls a custom DLL.

« “Thunking” tells you how. if you cannot recompile your DLLs, you cun add an
“ntermediate DLL

= “Advanced Programming Topics™ explains: translating C-API declarations to
Visual Buasic or Visual Basic for applicauons.

Which API Should Your Solution Code Call?

When you write solution code for your own use. you write it for the version of the
Office applhicauon vou have and for your own operaung system. Distributing this
solution to others means that you have to make it also work on their computers,
which may use different versions of Windows and Office applicanions than vou
used when vou wrote it. While the operating svstem isn’t an issue. whether the
tice appiication 1s 16-bit or 32-bit is important. The following table shows that
the apphicanon. and not the operating system, determines which APl vou use in
porting vour solunion code.

tJ
s
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Microsoft product Windows 3.x  Win32s . Windows NT  Windows Y5
16-bit applications 16-bit API 16-bit API I6-bit APT i6-tut API
32-bit applications N/A 32-bit API 32-bit APJ 32-bit API

Note Microsoft Office (including 32-bit Microsoft Access and 32-bit Microsoft
Project) products do not run on Win32se, but because Microsoft FoxPro does. the
Win32s column was added to show that FoxPro programmers should use the same
rules for choosing the APL Also, Win32s, Windows NT, and Windows 93 do not
have identical sets of API calls. For more information. see the Win32 SDK
documentation in the Development Library (in particular, see the Compatibility
Tables in the Win32 Programmer’s Reference, Vol. 5).

Calling the Win32 API

To wnite calls to the Win32 API, vou must do the following:

* Understand what Windows API calls are.
s Understand the differences between 16-bit and 32-bit Windows APIx,
= Use Win32api.txt to find the correct Declare statement.

s  Test an API Declare statement.

~ What Is an APi Call?

An APl call in C. Visual Basic. or other languages places a series of values
{parameiers) at a location 1t memory (the stack) and then requests the operating.
svstem or DLL to execute a function {the procedure cali} using the values
provided. The function reads the values (call stack) and executes its function cade
using those vajues or the data that the values point to. If a result 1s returned, 1t is
placed at another location (return register) for the calling application to use. This
is shown in the following illustration. To ensure accuracy. the number of bvies of
daia on the stack is veritted before and after the procedure is called. The message
“Bad DLL calling convention™ appears when the wrong number of bvtes are on
the stack.

Cali Stack ' Return Register
P ! ]
L
RN Py
\vj_\_‘ . ’ﬁ /"//,’;/
P /,' P
/
{ Procedure

[
LJd
=y



364

Part 3 - Maintaining and Supporting Microsoft Office

In practical terms. Windows API calls are hess applications request services
(screen control, printers, memory) from the operating system. There are
approximately 300 API calls in Windows 3.0, over 700 API calls in Windows 3.1,
and over 1,000 API calls in Windows 95. These API calls are packaged n
execotables and DLLs found in the Windows folder— User.exe. Gdi.exe. and one
of the following KERNEL files: Krnl286.exe, Krnl386.exe. or Kernel32 dil

To call an API from your solution code, use these four steps:

1. Identify the file containing the APL

3

Determine the parameters required by the APL
. Create a Declare statement for the APL.

3

4. Call the function with valid parameters.

The following i$ a simple example for the GetVersion API call that obtains the
version of Windows that is running. The GetVersion API call is located in
KERNEL under 16-bit Windows and does not use any parameters (so the Declare

- statement has empty parentheses). The following Declare statement is written for

[6-bit Windows for use by Visual Basic for applications:

Declare Function GetVersion Lib "KERNEL"™ () As Llong

By comparison. here is the same function as it would be used by an Office Y3

application running on 32-bit Windows:

Declare Function GetVersion Lib "KERNEL32"™ () As Long

Although the Windows API name stays the same. the location of the API has
changed to KERNEL32. Because you are calling from a 32-bit application. you
must make a 32-bit API call, The parameter data type, on the other hand. did not
change (it remained a Long). In general, the function parameters will change
more and require more attention than the parameters of the return value
Understanding the ditferences between 16-bit API calls and 32-bit AP calls is
essential to porting your solution code to Windows 95.

What Are the Differences Between a 16-Bit and a 32-Bit
Windows API? ‘

As shown in the p: C ous cx:jtnple. most 32-bit Windows API calls have the same
name or a very similar name to the 16-bit API calls. In fact. the docuinentation
may show the same arguments. with the only apparent difference being the tibrary
name change from KERNEL to KERNEL32. However. the code must handle
changes in addiion to the name change:

t
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= (Case-sensitivity .
» Unicode or ANSI options
*  Change of parameter data type (shown in the previous example)

These bulleted 1tems can require subtle changes in the Declare statements that are
not always easy to identify.

Case sensitivity

The first issue in moving to 32-bit Windows API calls is case sensitivity in the
name of the function. API calls under 16-bit Windows are not case sensitive and
work if you enter the function name as GetVERSION, GeTvErSi0n. or
getversion. In other words. in 16-bit Windows the following statements are
equivalent:

Declare Function GetVersion Lib "KERNEL" ()} As Long
Declare Function GeTvErSiOn Lib "KERNEL™ () As Laong

API calts under 32-bit Windows are case-sensitive for the function call and must
be correctly entered in the Declare statement. In other words. the following
statements are not equivalent in 32-bit Windows:

Declare Function GetVersion Lib “KERNEL32" () As Long
Declare Function GeTvErSiOn Lib "KERNEL32" () As Long

The easiest way to handle this change is to always use the Alias controt word. The

contents of an Alias string map to the actual API call name (which 1s case
sensitive). but the function name used in code. which appears between “Funcuon”
and “Lib,” 1s not case sensitive and will not change if you tyvpe it different ways in
your code or use the same name for vaniables or procedures. Using the Alias
control word. the GetVersion function (32-bit Windows) would be entered as:

Qeclare Function GetV¥ersion Lib "KERNEL32" Alias "GetVersion™ () As Long

Now the case of API numes won’t matter when writing code: as long as vou
spelied and typed the function name correctly in the Alias string and you spell the
function name 1n code the same way as in the Declare statement. the function will
be mapped by Visual Basic or Visual Basic for applications back to the correct
Declare function auto~utically.

- -

Note The Alias control word is the single most important thing vou can use n
preparing to switch to 32-bit operating systems because it means vou will only
have 1o change the contents of the Declare statement and not every instance of the
function being called in vour code.

236
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Unicode or ANS! Options

Both Windows NT and Windows 95 have two API interfaces. One interlace is
based on the American National Standards Institute (ANSI) character set, where a
single byte represents each character. The other interface was created for the
Unicode character set, where two bvites represent each character. All 16-hit
Windows operating systems and applications use the ANSI character set. All
32-bit versions of Windows added Unicode to allow foreign language characters
to be represented. C programmers handle this by setting a flag in their include file
(*.h). The flag causes hundreds of macros throughout the C include files 1o select
the correct Unicode or ANSI functions.

All western language versions of Office products use ANSI for Visual Basic for
applications code. Therefore, programmers using current versions of Visual Basic
for applications or macro languages will always use the ANSI version of the AP]
call. When using the Win32api.txt file. this choice is made for you. For more
information about this file, see “Change of Parameter Data Type.” next in this
section.

To distinguish the ANSI version from the Unicode version. the ANSI version
adds an “A™ 1o the end of the API name. and the Unicode version adds a "W, W
15 for wide. as in the width of the bytes provided for characters. The name of an
API call includes the characters A and W at the end of the API name only if the
APl requires parameters with string (character) data types.

The Win32 SDK documentation in the Development Library does not record the
permurations of the name of the APl call. The documentation gives only the name
of the root function and its library name. The actual name of the APl in the library
can be one of three possibilities:

= MyAPICall which uses no character strings in the call.

* MyAPICallA. which uses ANSI character strings in the call.
»  MyAPICallW, which uses Unicode character strings in the call.

To understand the differences. see the following diagram showing the amount
of data the APl expects to find on possible call stacks for an example function
{the 16-bit version 15 padded because 16-bit Windows always pads the stack to”
16 buts ).

.E5-bit API Cal | nwno | s | & R e ]
E%-Fg:lrm | WD ] LPSTR | & b%é&tﬂ@
| [Ezplné ;Jlmcoce ! HWND | LPSTR | &

J
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The three possible declarations for MyAPICall are shown next. formatted to
make comparison easter. All of the statements use the Alias control word so tha
the function name used in code (MyAPICall) does not have to change even if the
name of the function called is appended with an “A” or a “W™:

'16 bits
Declare function MyAPICall Lib "MYDLL.DLL™ Alias "MyAPICall™ ¢
Byval hwndForm As Integer,
ByVal l1pstrCaption$,
ByVal hAccKey As String,
Byval iMagicNumber As Integer
) As Integer
'32-bit ANSI
Declare function MyAPICall Lib "MYDLL32.DLL" Alias "MyAPICalla™ ¢
Byval hwndForm As Long,
gyV¥al lpstrCaption$,
B8yVal haccKey As String,
Byval iMagicNumber As Long
) As Long
*32-bit UNICODE * For 11lustration only.
Declare function MyAPICall Lib "MYDLL32.DLL" Alias "MyAPICallW" (
Byval hwndform As Long,
Byval 1pstrlaptions$,
ByV¥al hAcckey As String,
ByVal iMagichumber As Lcng
} As Long

Any one of these declarations would add the function MyAPICall to vour
application: vou can only have one MyAPICall function.

Note This code sample imiroduces the ByVal keyword, which enables vou 1o pass
Visual Basic parameters to a APl function by value. By Value is the default tor
functions written in C and is therefore the default for Windows API calls, The
reason vou must use ByVal s Visual Basic and Visuai Basic for applications
default to ByRef (By Reference which passes a pointer to the value rather than the
value itself) which is not what AP calls expect. ByVal can also be used 1o
convert a Visual Basic sinng 10 2 null-termmated C string. ByVal is included in
the Declare statements in Win32api txt so vou will know when 10 use it. but for
more informauon about By Val, see the MSDN article Q110219 “How to call
Windows AP] from VB.” or published references such as “The Visual'Basic
Progrummer’s Guide to the Windows API” by Dan Appleman. pubhished by
Ziff-Davis Press.
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Change of Parameter Data Type

The eastest way to learn what the new requir'cd parameter data types are for 32-bit
API functions is to have somebody else give them to you. Included on the Office
Resource Kit CD is a Visual Basic declaration file called Win32api. All you need
to do.is copy the appropriate API Declare statement from Win32apt.txt into vour
source code.

Another source of information is the Win32 Programmer s Reference on the
MSDN Development Library CD. which is discussed in "“Advanced Programming
Topics™ Jater in this section. This reference may occasionally be reguired to
resolve questions about the inclusion or exclusion of ByVal in the declaration or
the need to put parentheses around the actual value passed.

If vou use the Win32 Programmer’s Reference. however. vou must be careful to
property convert C to Visual Basic data types. For example. don't mistake a C int
for a Visual Basic for applications Integer. Many Windows data types and Visual
Basic Integer daia types are no longer the samne size, as shown in the following
table. It1s critical to remember that the sizes of many AP} parameters have
changed. and you must not assume lhey are the same.

Visual Basic 32-bit Windows data
data tvpes Size of variable  16-bit Windows data tvpes ivpes
integer 2 bvies int. short, WORD. HWND.  short, WCHAR

HANDLE. WCHAR

Long 4 byies long, LPSTR int, long. HANDLE.

HWND. LPSTR

Finally, whether vou use Win32api.txt or the Win32 Programmer’s Rererr’ncc
jJudicious use of the Alias control word may assist you with changing parameter
daia 1ypes by allowing existing 16-bit code (italicized to point out that code does
notinctude the Declare siatement. which must change 1o point 10 a 32-bit API)
that calls the APl to be left unchanged. The ByVal control word and amomatic
type conversion in Visual Basic, Access Basic, WordBasic. and Visual Basic for
applications change the size of parameters for you in many cases (Integer to
Long. for example) Aliernatively. tvpe conversion will extend integers with a
sign (+/-) that may lead to incorrect long parameters and cause overflows on
conversion trom Long 1o Integer. Again. the best solution is to chech
Win32apixtor the “"in32 qummnwr'x Reference 1o get the correct funcuons.

-

What Types of Errors Can Occur wuth an AP! Declare
Statement?

Atter vou create 2 Declare statement. it may not work. While there are many
mistakes possible in o Peclare statement. the following are the most common
SITOrs:

J/

2
L2
A=)
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Error 453: Function is not defined in specified DLL Either you misspelled the

- function name or you have a problem with cui22 in the function name. Functions

are case-sensitive in Win32; they are not case-sensitive in 16-bit Windows.

Error 48: Error in loading DLL  Usually. this error is caused by having the wrong
size or arguments, but may also occur for some of the reasons described under
Error 53,

Error 53: File Not Found Windows checks the loaded librarnes for matches. and if
the DLL is not loaded. it will attempt to load the DLL from disk. Many functions
available in the 16-bit Windows on Windows (WOW) layer on a Windows NT
svstem are not available directly from Windows NT. Calling the 16-bit Windows
and Win32 GetProfileString function from a 16-bit and a 32-bit solution will
give a confusing set of error messages. The 16-bit application call will find
KERNEL and fail to find KERNEL32, while the 32-bit application will find
KERNEL32 and fail to find KERNEL. The general cause of this error 1s a
mismatch of calls and environment. The solution 1s to write code that works 1n

-both 16-bit and 32-bit environments.

ingle Code Base for 16-Bit and 32-Bit

Office Applications

If vour vsers are running both 16-bit and 32-bit versions of Microsoft Excel.
should vou put the 16-bit API call or the 32-bit API call in vour solution’!
Microsoft Excel is not like Visual Basic version 4.0, which allows conditional
compilation of code into executables, but instead runs solution code in warkbhook
files which may be opened in either the 16-bit or the 32-bit version, The

sotunion is that vou put both the 16-bi1t API calt and the 32-bit API call inside

an If...Then...Else control structure,

With 32-bit applications using the same soiution code as 16-bit applications. you
do not know which API to cali in the solution code. Your code must determine
whether the application is a [6-bit one or a 32-bit one. How does the code answer
the following quesnons:

«  Microsoft Access: Is the host application 16-bit Microsoft Access 2.0 or earlier
{make 16-bhit API calls). or 32-but Microsoft Access for Windows 95 (muke
32-bit API callsy? .

«  Microsoft Excel: I- 7 host application 16-bit Microsoft Excel 5.0 or earlier
(make |6-bit API cuitsy or 32-bit Microsoft Excel 5.0 for Windows NT or
32-bit Microsoft Excel for Windows 95 (make 32-bit API calls)?

«  Microsoft Project: Is ihe host application 16-bit Microsoft Project 3.0 (muake
16-bit API calls) or 32-bit Microsoft Project version 4.0 or ater imake 32-bit
APl callsy?
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=  Word for Windows: Is the host application 16-bit Word 6.0 or earlier (make
16-bit API calls) or 32-bit Word 6.0 for \}'iridows NT or Word for
Windows 95 {make 32-bit API calls)?

If you make the wrong API ¢all, an error will occur. The solution code must
determine whether the application is a 16-bit application or a 32-bit application.
so it can make the appropriate call.

No 32-bit application? Yes

16-bit AP1 call 32-bit APt call

The solution is to put every API call into a wrapper—a Visual Basic procedure or
a Microsoft Excel 4.0 macro. This wrapper routine checks the “bitness™ of the

_ application and selects the appropriate API call. Place these wrappers in separate

modules so that your code can be easily reused. Some API calls (for example.
GetPrinterDriveDirectory and GetWinMetaFileBits) are not available in all
32-bit operating environments. which means that the structure of an APl wiupper
can become as complex as this:

Function MyAPICall1$(Byval Args)
If Engine32() Then
‘Select is rarely needed
Select Case 0532() 'Based on GetVersionEx API
Case @ 'Win32s

Case 1 'NT 3.1

Case 2 *NT 3.5

o

Case 3.' « 2ows &
End Select
Else ‘l16-bit

End If
End Function

241
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An APl wrapper this complex is the exception and not the rule.

Compiled languages, such as FoxPro and Visual Basic. build 16-bit or 32-bit
application executables. The executable fargets either [6-bit AP calls or 32-bit,
API calis. You can determine the appropriate API calls whtle building the
application. You can select the calls either by having all the 16-bit deciarations in
one file and all the 32-bit declarations in another file and manually switching
them in a project, or by using the #IF... #ELSE._.. directives and conditional
compilation supported by Visual Basic 4.0. If you must support Visual Basic 3.0
and Visual Basic 4.0 applications concurrently, separate files may reduce code
maintenance. If you support FoxPro, you will have no problem using ]16-bit API
calls from compiled 32-bit FoxPro solutions because the RegFN functions will
automatically thunk from the 32-bit layer to the 16-bit layer if needed.

Compiled 32-bit languages may require some minor differences in API calls
depending on the 32-bit operating system. For example. developers must program
context menus differently for Windows 95 than for Windows NT.

Determmmg Whether a 32-Bit Application Is Running

- In the previous section, writing application independent code was covered by
adding code for both 16 and 32-bit scenarios. However. vou still need to
deterrnine in source code whether the application is 2 32-bit application or a
16-bit application without doing any API calls. You cannot do an API call
because you do not know if a 16-bit API call or a 32-bit API call wili work. The
following code will determine if the application is a 32-bit application.

Note The Application.OperatingSystem property in Microsoft Eacel and
Microsoft Project does not return the version of Windows you have installed. but
the layer of Windows that the application is running on. for example. the 16-bit
subsvstern in Windows NT.

Microsoft Excel 5.0, Microsoft Excel 95, Microsoft Project 4.0, Micrasoft Project 85
Function Engine32%()

If instrtApplication.OperatingSystem.”32™) then Eng1pe32x-True
fnd Function

Word 6.0, Word 95

Function Engine32
[f Val(GetSysteminfos$(23)) > 6.3 Or Len(GetSystemInfoS(ZS)) - & Then
w fngined2 -~ - 1 £lse Engine32 -

End Function

Microsoft Actcess 1.1 or higher

Function Engine32% ()
If SysCmd(7) > 2 Then Engineld2% = True
End Function

242
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An API wrapper this complex is the exception and not the rule.

Compiled languages, such as FoxPro and Visual Basic, build 16-bit or 32-bit
application executables. The executable targets either 16-bit API calls or 32-bit
API calls. You can determine the appropriate API calls while building the-
application. You can select the calls either by having all the 16-bit declarations in
one file and all the 32-bit declarations in another file and manually switching
them in a project. or by using the #IF... #ELSE... directives and conditional
compilation supported by Visuai Basic 4.0. If you must support Visual Basic 3.0
and Visual Basic 4.0 applications concurrently, separate files may reduce code
maintenance. If you support FoxPro, you will have no problem using 16-bit AP]
calls from compiied 32-bit FoxPro solutions because the RegFN functions will
automatically thunk from the 32-bit layer 1o the 16-bit layer if needed.

Compiled 32-bit languages may require some minor differences in API calls
depending on the 32-bit operating system. For example. developers must program
context menus differently for Windows 95 than for Windows NT.

Determining Whether a 32-Bit Application Is Running

In the previous section, writing application independent code was covered by
adding code for both 16 and 32-bit scenarios. However, yvou still need to
determine in source code whether the application is a 32-bit application or a
16-bit application without doing any API calls. You cannot do an API ¢al)
because vou do not know if a |6-bit API call or a 32-bit API call will work. The
following code will determine if the application is a 32-bit application.

Note The Application.OperatingSystem property in Microsoft Excel and
Microsoft Project does not return the version of Windows vou have installed. but
the layer of Windows that the application 1s running on, for example, the 16-bit
subsystemn in Windows NT.

Microsoft Excel 5.0, Microsoft Excel 85, Microsoft Project 4.0, Microsoft Project 95
functaon Enginel2%()

If instr{Application.OperatingSystem,"32") then Enginel2%=True
End Function

Word 6.0, Word 95

Function Enginel32 ' )
[f valiGetSystemInfo$(23)) > 6.3 Or Len{GetSystemInfo$(23)) = & Then
w fngine32 = - | Else Engine32 = @

End Function

Microsoft Access 1.1 or higher

Function Engine32% (1

If SysCmd(7) > 2 Tnen Engine32% = True
End Function
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Putting It All Together

For examples of code for particular applluuons you should consult the Microsoft
Developers Network (MSDN). and find the article entitled “Corporate
Developer's Guide to Office 95 AP Issues.” For information about connecting 1o
MSDN. see Appendix F. "Resources.” The following simple example may help
you understand some 1ssues.

Declare Function GetTickCount3dZ Lib "KERNEL32" Alias “"GetTickCount™ ()
ww As Long

Declare Function GetTickCountlés Lib "USER" Alias "GetTickCount™ ()

- As Long

Function GetRightTickCount{) As Long
[f Engine32%() Then

GetRightTickCount = GetTickCount32()
Else

GetRightTickCount = GetTickCountlo()
End 1f
End Function

The GetTickCount AP has the same name for both 16-bit Windows and 32-bit
Windows, so you must use an Alias control word to change the function name in
at least one of the Declare statements. In the previous example the names n both
Declare statements were changed. to GetTickCount32 and GetTickCount16.
Next. depending on the application’s bitness. GetTickCount is mapped 10 the
correct APL function name (GetTickCount32 or GetTickCountl6) and s
associated API call. In this example. GetTickCount in your code will be mapped
10 GetTickCount32 tin the GetTickCount function). which is mapped to
GetTickCount 1n KERNEL32. when Engine32% is True.

Word Sample Declare-method Solution

Word has a differeni Declare format and svntax. The Word solution is more
camplex because vou cunnot place both the 16-bit and 32-bit Declare statements
in the same macro The solution is to create three macro libraries: APICALL16
and APICALL32. that comain the Declare statements for each operating
environment, and a 16-bit/32-bit interoperability macro, APIFCALLS.

A}

Farst. create a macre libraey called APICALL16. This macro LOﬂl‘lll’]\ all the
16-bit AP! Declar - dements. -

"Thys 15 APICALLin -- a1l l6-b1t Declare statements are placed here,
Declare funztion GetTic¥Countlh Lib "USER™ Alias "GetTicklount"()
- L Long
Function GetTickipunt
GetTickCount = GetlickCountld
tnd Functron
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Second. create a macro library called APICALL32. This macro contains all the
32-bit API Declare statements.’

‘This is APICALL32 -- all 32-bit Declare statements are placed here.
Declare Function GetTickCount32 Lib "KERNEL32"() Altias "GetTickCount"”
w As Long '

Function GetTickCount

GetTickCount = GetTickCount3?

End Function :

Third. create a macro library called APICALLS. This macro contains Engine32
and the procedures your solution code will call.
f

‘This 1s APICALLS -- no Declare statements may be !'n this macro.
Function Enginel2 i
" Engine32 -~ @
If val{Applnfos{2)} > S Then
05§ = GetSysteminfo$(23)
If Valc0S5%) > 6.3 Or Len(0S5$%) = & Then Engine3d2 = - 1
- «ENQ IF L.
End Function

Function GetTickCount
If Engine32 Tnen

GetTickCount = APICai132.GetTickCount
Else

GetTickCount = APICalll6.GetTickCount
End If
End Function
'Utﬁer AP] function calls are placed here.

You can now call this function from your solution code. Ynu must preface vour
calls with APICALLS. For example:

Sub MAIR.S
MsgBox StrS${aPICalls.GetTickCount)
End Sub

» To convert Word solutions to run on 16-bit and 32.bit products
I. Create i new module called APICALLS.

Create the Engine32 function in APICALLS.

Create 1 new module called APICALLI16.

Locate all the 16-hit Declare statements in the solution and move them to
APICALLIs.

Create a new module culled APFCALL32,
6. Create the equivaient 32-bit Declare statements and put them to APICALL32.

(o]
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4
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7. Using the template above, create functions for each AP[ in each of the three
macro libranes.

8. Add APICALLS before all calls to the API in your solution code.

9. Test each function.

This process allows existing calls in other modules to be left untouched. After
the developer defines and tests these macros. the developer can add them to
Normal.dot and reuse the macros in other solutions so as o cut conversion lime,

Recompiling DLLs

Thunking

»
| ISRV

This section has so far focused on the issue of updazling Windows API calls—
but the issues for solution code that calls 16-bit DLLs that you have bought.
developed, or simply used is exactly the same. The developer must change all

" 16-bit DLL Dectare calls in solution code to'32-bit calls. This requires creating a

32-bit version of the DLL (at least) and possibly changing the Declare statement
(in Microsoft Excel 4.0 macros. the Register function).

" This also means a separate DLL must exist.for both the 16-bit application and the

32-bit applicanion. For file management. the name of the 32-bit DLL should
include 32" at the end. The developer must recompile the DLL as a 32-bit
Ansi.dll. The parameters passed to the DLL must use the stdcall-passing protocol
to talk to 32-bit Visual Basic for applications, instead of the PASCAL-passing
protocol used with 16-bit Windows. Place the calls for the 16-bit and 32-but
versions of the DLL in a wrapper sinular to the APl wrapper described previously,

For information about recompiling appheations, see.Chapter 1, “Porting 16-bit
Code to 32-bit Windows.” in Programming Techniques from the Visual C++ 2.1
documentation 1n the Development Library, or see your C compiler
documentation.

When you do not have the source code of a DLL, your solution 1s to use thinking
to port vour solution to Windows 95. Thunking enables direct 16-bit and 32-bnt
calls but reguires much more work than simply changing the Windows API call.
If vou cannot change or recompiie the 16-bit DLL. you must write a new 32-bit
DLL wrapper to access the 16-bit DLL. The 32-bit application calls to this 32-bit
wrapper DLL. which then calls the original 16-bit DLL.

Thunking allows parameters to be pushed correctly on the stack. enables a DLL of
a different bitness to 1oad in your process. and converts memory addresses from
offset (32-bit) to segment::oflset { 16-bit) This means, however, there are some
1ssues even 1if vou do the thunking work. For example. pointers to pointers to
memory locations require additional work in 16-bit and 32-bit scenarios.,
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There are different ways to thunk depending on vour operating system.

Windows 95 and Windows NT thunk differently. For an overview of thunking
across the Windows platforms and pointers to more information about thunking,
see “Diving into the Requirements for lhe Windows 95 Logo”™ in the Development
Library.

Most developers writing solution code know the C language, and the following
information is provuded to assist them in using their knowledge of C to create
Declare statements for Visual Basic and Visual Basic for appllcauom using the
tools they already have. . - s

Working from C Declai'ationé

Apart from-the APl location changing (from KERNEL to KERNEL32). the main
issue in moving.from 16-bit API calls 10 32-bit API calls is the change in the size
of parameter data types. Some background infonnaiion may help vou understand
what has changed and why. Windows 3.0 was designed for the Intel 80286 CPU.
where the hardware handles data two bytes at-a time or in 16-bit words.

Windows 95-was'designed for later CPUs. where the hardware can handle data
four bytes at a time or in 32-bit words. The folllowing list shows how Visual Basic
represents an Integer versus how Windows represenl:, an int:

»  Integer and int are each two bvtes in the 16-bit Wmdows operating svstem
and in 16-bit Microsoft Excel. Visual Basic, Microsoft Access, Word for
Windows, and Microsoft Project.

= Integer is two byvtes in 32-bit Microsoft Excel, Visual Basic. Microsoft
Access. Word for Windows. and Microsott Project, the same as in the 16-bit
versions of these products.

* int is four bvies in the 32-bit Windows operating systems. Windows 95, and
Windows NT.

To illustrate how this change of size can change a call. recall the fictional

MyAPICall API used eurlier. The MyAPICall call needs the handle to the

applicauon’s window (HWND). a string. a character. and an integer to be placed

on the stack. In C, the function would be:

int MyAPICall (HWKD , ZForm..LPSTR lpstrCaption., TCHAR tchatcKey,
= 1nt iMagicNumber,

Each parameter has two parts: the data type (HVWWND, LPSTR. TCHAR. int) and
the field name (hwndForm. IpstrCaption. tchAccKey. iMagicNumber). Each
data type requires a specific number of bvtes to represent it. Each field name has
some odd-looking characters as a prefin —these characters (known as Hungarian
notation) indicate the duia type, such as int or Ipstr,
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Windows has many data tvpes that API calls use as paramelers. The following

- table shows some of the more significant data type‘§ used by Windows 95 AP

calls. Many Windows data types use the C data type of int. When int changed
from 16-bits to 32-bits. the related Windows data types also-changed.

‘ Windows dx: Windows for © Win32s, Windows NT,
C data type Workgroups 3.r (16-Bit) and Windews 95 (32-Bit)

unsigned int. UINT, int 2 bytes 4 bytes
short 2bytes 2 byvtes
long e dbytes 4 bytes
char, CHAR .. I byte " 1 byte
WORD 2 bytes ) ® " 2bytes
Handle 2bytes ”: 4 bytes
(hWnd, hDC, hMenu) :

LPSTR .. . * dbyles ’ ’ 4 bytes
WCHAR 2 bytes .. 2bvtes
TCHAR -~ “ bvie = ) } or 2 bytes
‘(ANSI or Unicode) . ) B -
POINT - 4 bytes . 8 bytes

Thus, converting our MyAPICall API call from C, the declarations for
MyAPICall using Visual Basic for applications, Access Basic, or WordBasic
would be as follows (formatted to make comparison easier):

16 bits

Declare Function MyAPICall Lib "MYDLL.DLL™ Alias "MyAPICall™ ¢
Byval hwndForm As Integer,
Byval ipstrCaption As 5tring,
ByVal hAccKey. As Str1ng. eyt
By¥al’ iMagicNumber As Integér '
.; As Integer S

*32 oits

. Dec}are Function MyAPICall Lib "MYDLL3Z.DLL" Alias "MyAPICa11" (

ByVal hwndForm As Long,

Byval lpstrtaptlon As String,
ByVal hAchey As String,
Byval 1Mag1cNumber As Long

) As’ Long R
IR .:’ Y T

A final tool vou may find useful is the followmg table that maps ‘c language
declaration data types to their Visual Basic equivalents.-
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C language deciaration
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. V¥isual Basic equivalent
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Call with

Baolean

i ¢ !

Pointer to a string (LPSTR); | -

. o
Zha

Pointer to an integer (LF;INT)

Pointer to a long integer
(LPDWORD)

Pointer 1o a structure (for
example, LPRECT)

Integer (INT. UINT, WORD.
BOOL)

Handle (32 bit, HWND)
Long (DWORD. LONG)

Pointer to an array of integers

., Pointer 1o a voud (void*)

Void (functi‘on retu-rn value)
NULL
Char {(TCHAR) . g

By Val B As Bp_(l:_]’ean
By Val S As String
1 As'Integer : -
"L As Long )
S As Rect

ByVal | As Integer

ByValH As Long ..

ByVal L As Long

At o

| as Integer

V As Any -

Sub Procedure
As Any
ByVal Ch As String

. (.n'f

Any Integer or Variant
variable

Any String or Variant
vanable -

Any Integer or Yariant
vanable

Any Long or Yariant
variable

Any variable of that user-
detined type

Any Integer or Variant
vanable

Any Long or Variant
vanable

Any Leng or Variant
variable

The first element of the
array. such as Ie(h

Anyv variable tuse RyVal
when passing 2 string)

nfa
ByVal 0&

Any String or Variant
variable

Using the Win32 Prd‘grammer’s Reference

The two primary sources for Win32 APl information are the Win32
Programmer’s Reference and a list of Microsoft-supplied Win32 Declare
statements for Visual Basic. such as Win32api.ixt. The Development Library
contains a listing with explanauons of the entire Win32 APlset in the Wini2 ]
Programmer’s Reference. For more information about the Development Library,
see “Microsoft Developers Network.” in Appendix F.

Frequently Asked Questions

Automated answers to common questions. sojutions to technical problems. und
lips are availabie at no cost, 24 hours a day, 7 days a week, by 1elephoning
Microsoft FastTips at (8K 936-41 (0. These tips change frequently to respond to

the Most COmMMOon ISsues.



